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R&S®VSE Documentation Overview

Release Notes and Open Source Acknowledgment (OSA)

1 Documentation Overview

This section provides an overview of the R&S VSE user documentation. Unless speci-
fied otherwise, you find the documents on the R&S VSE product page at: www.rohde-
schwarz.com/manual/VSE

1.1 User Manuals and Help

Separate user manuals are provided for the base software and additional software
applications:

® Base software manual
Contains the description of the graphical user interface, an introduction to remote
control, the description of all remote control commands, programming examples,
and information on maintenance, software interfaces and error messages.

® Software application manuals
Contain the description of the specific functions of a software application, including
the remote control commands. Basic information on operating the R&S VSE is not
included.

The contents of the user manuals are available as help in the R&S VSE. The help
offers quick, context-sensitive access to the complete information for the base software
and the software applications.

All user manuals are also available for download or for immediate display on the Inter-
net.

1.2 Data Sheets and Brochures

The data sheet contains the technical specifications of the R&S VSE. It also lists the
firmware applications and their order numbers, and optional accessories.

The brochure provides an overview of the instrument and deals with the specific char-
acteristics.

See www.rohde-schwarz.com/brochure-datasheet/VSE

1.3 Release Notes and Open Source Acknowledgment
(OSA)

The release notes list new features, improvements and known issues of the current
firmware version, and describe the firmware installation.

The open-source acknowledgment document provides verbatim license texts of the
used open source software.
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R&S®VSE Documentation Overview

Application Notes, Application Cards, White Papers, etc.

See www.rohde-schwarz.com/software/VSE

1.4 Application Notes, Application Cards, White Papers,
etc.

These documents deal with special applications or background information on particu-
lar topics.

See www.rohde-schwarz.com/application/vse/

User Manual 1176.8839.02 — 14 12


http://www.rohde-schwarz.com/software/VSE
http://www.rohde-schwarz.com/application/vse/

R&S®VSE Welcome to the R&S VSE

2 Welcome to the R&S VSE

The R&S VSE is a new high-performance Rohde & Schwarz analysis software for vari-
ous analysis tasks and input from various instruments.
The R&S VSE features analysis of:
® The same data in various applications simultaneously
® |/Q data files
® Multiple inputs from a single instrument
® |nput from different instruments, including:
- R&S®FSW
- R&S®FSWP
- R&S®FPS
— R&S®FPL1000
- R&S®FSV
- R&S®FSVA
- R&S®FSL
— R&S®FSV3000
— R&S®FSVA3000
— The R&S®RTx oscilloscope product family
— R&S®ZNL Network Analyzers (with R&S®ZNL3-B1 Spectrum Analyzer Mode
option)
— R&S®CMA Radio Test Sets
— R&S®NRQ6 Power Sensors
This user manual contains a description of the basic functionality that the software pro-

vides, including remote control operation. The latest version is available for download
at the product homepage (www.rohde-schwarz.com/product/VSE.html).
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R&S®VSE Software Installation

Installing Required Components

3 Software Installation

The R&S VSE software can be installed and executed on any PC or directly on an
instrument which will be used as input for signal analysis. See the data sheet for infor-
mation on which instruments the software can be installed on.

3.1 Installing Required Components

The following software components must be installed to run the R&S VSE successfully:
® Microsoft NET Framework 4.0

® RA&S License Server

® VISA (Virtual Instrument Software Architecture)

The R&S License Server and Microsoft .NET Framework 4.0 are installed automati-
cally during installation of the R&S VSE.

VISA can be installed directly during installation of the R&S VSE, or manually, inde-
pendently of the R&S VSE installation.

Installing the Microsoft .NET Framework

When you install the R&S VSE via the provided installation file (see Chapter 3.2,
"Installing and Starting the R&S VSE Software", on page 15), the installer automati-
cally checks whether the required Microsoft .NET Framework versions are available on
the PC. If not, version 3.5 is installed from the R&S VSE CD-ROM. An internet connec-
tion to the Microsoft website is established to download the Framework version 4.0
(due to the large file size). Thus, before attempting to install the R&S VSE software,
ensure that a strong internet connection is available from the PC, as downloading can
take some time. Alternatively, download the Framework 4.0 version from the internet
manually before you start the R&S VSE installer.

Installing VISA

It is also necessary to install VISA (Virtual Instrument Software Architecture) on the PC
to access instruments connected via IEEE or LAN bus.

It is recommended that you use the R&S VISA driver. The R&S VISA driver is supplied
with the R&S VSE installation file, and can be installed together with the R&S VSE
software (see Chapter 3.2, "Installing and Starting the R&S VSE Software",

on page 15).

O Once the R&S VSE software is installed, a status icon in the status bar indicates
= whether the VISA installation is available, see Table 6-1.
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3.2 Installing and Starting the R&S VSE Software

It is recommended that you copy the R&S VSE installation file from the installation CD-
ROM to your hard disk before you execute it. To install the R&S VSE software directly
on an instrument, copy the installation file to a USB storage device and execute it from
there.

To install the R&S VSE software

1. Insert the R&S VSE CD-ROM in the PC or the USB storage device in the instru-
ment.
If the start page does not open automatically, select the start.htm file in the main
directory.

Switch to the "Installation" tab.
Select the link to the VSESetup XXX.exe file.
Select a storage location on your hard disk.

From the hard disk, select the VSESetup XXX.exe file.

o o & w N

Select the required options to install.

Unless you have ensured the required R&S VISA is installed manually before start-
ing the R&S Vector Signal Explorer Base Software installation on a PC, be sure to
keep the "R&S VISA" option selected.

7. Select "Install".

The installer performs the following actions:

® Checks for the required Microsoft .NET Framework versions on the PC, and if nec-
essary, downloads the required version from the Internet, before installing both ver-
sions

® |f enabled, installs the R&S VISA software on the PC
® |nstalls the R&S VSE software including an uninstall tool
® Creates a shortcut on the desktop

® |[f necessary (the software specifically asks you), sets the required environment
variables
This step can require administrator rights on the PC.

When the installation is complete, the dialog box turns green and all selected options
are indicated as "OK".

To start the R&S VSE software

» Start the software via the Windows "Start Menu" entry or the shortcut on the desk-
top.
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Demo mode

Without the use of the software license provided by a smart card reader, the software
starts in "Demo-Mode". In this case, all (installed) options and remote commands are
available. However, no instruments can be configured, no I/Q files and no measure-
ment settings can be loaded or saved.

3.3 Using the Smart Card Reader

The R&S VSE software requires a smart card containing the software license to be
connected to the PC when you are using the software. The R&S®FSPC license dongle
that contains the software license consists of a smart card and a USB dongle. The
smart card can be used in the supplied USB dongle or in a smart card reader. The
R&S®FSPC license dongle is available as a separate product and must be ordered in
addition to the software.

You can connect the smart card in two ways.

® Connect the smart card in SIM format.
To connect the smart card in SIM format, use the USB smart card reader (dongle)
provided with the smart card.

® Connect the smart card in its full format.
To connect the smart card in full format, an interface compatible to the card format
is required.

The following devices are able to read the smart card in full format.

— Smart card reader integrated in a keyboard, notebook, or in a desktop PC (e.g.
OMNIKEY)

— Smart card reader connected to the computer via serial bus or USB (e.g.
OMNIKEY)

— USB reader connected to a LAN-to-USB converter to distribute the license via
the network (e.g DIGI AnywhereUSB/2)

@ Licensing support
If you have any difficulties with the licensing system, support is only assured when you
are using the R&S®FSPC license dongle.

Using the R&S®FSPC USB smart card reader (dongle)

1. The R&S®FSPC license dongle consists of a smart card in full format and a USB
smart card reader (dongle).
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& ROHDE&SCHWARZ

2. Break out the smart card in SIM format.

3. Twist out the upper part of the smart card reader.

4. |Insert the smart card with the chip facing upwards and the angled corner facing the
USB dongle, whose "Rohde & Schwarz" label is also facing upwards.
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Insert the smart card as far as possible.

5. Twist the smart card reader back into its original state.

A noHDE L SCHWARE

The smart card reader is ready for use on any USB interface.

O Drivers

When you connect the reader to the computer, MS Windows automatically installs the
necessary drivers. If not, you can install the drivers manually from the Internet site of
the manufacturer at http://support.identiv.com/utrust-token-standard/.

Problems during login due to smart card reader

When the smart card reader is connected, the operating system may falsely identify
the smart card as a medium to perform a login procedure on the PC. In this case, the
windows lock screen is displayed instead of a login window.
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You can solve this issue by editing the "DisableCAD" ("Disable Ctrl-Alt-Del") registry
key in the system registry. This key is located at
HKEY LOCAL MACHINE\SOFTIWARE\Microsoft\Windows\CurrentVersion\

policies\system.

@ Administration rights
Security policies of your network environment might prevent you from editing the sys-
tem registry or installing drivers. Contact your IT administration in that case.

To change the registry key

1. From the Windows "Start Menu", select the "Run" item.
(Windows 10: "Start > All applications > Windows System > Run")

2. Enter regedit in the dialog box to open the system registry.

3. Look for
HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\

policies\systemn.

4. Set the value of DisableCad to 0.

3.4 Using a License Server

As an alternative to the R&S®FSPC license dongle, software licenses can now also be
provided by an R&S®License Server (for R&S VSE Enterprise Edition only). In this
case, all available licenses are stored on a specified server. When you need a particu-
lar application, you can obtain a license from the server. When you no longer need the
license, you return it to the server and it becomes available to other users again. These
licenses are also referred to as floating licenses, as opposed to permanent licenses.

The R&S®License Server must be set up as described in the R&S®License Server -
Managing Floating Licenses - User Manual.

Two different kinds of floating licenses are available:

e Common floating license: retrieved from the server each time you start the
R&S VSE software, and returned 60 minutes after you close the software; license
is retrieved for each session until disabled explicitly in the software;

® Short-term (7-day) occupied license: retrieved once from the server and stored
locally for 7 days, when it automatically expires and becomes available on the
server again; no further access to server required;

Obtaining and returning floating licenses

When you first start the R&S VSE software after installation, if no license dongle is
found, the software starts in demo mode. To use floating licenses, you must specify the
connection data to one or more configured floating license servers (see "Floating
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Server" on page 154). As soon as the R&S VSE software is restarted, all available
licenses for installed applications are obtained from the specified servers. If no licenses
are found, the R&S VSE software remains in demo mode.

In the software, you can disable, re-enable or occupy licenses from the server for indi-
vidual applications. These settings are applied the next time you start the R&S VSE
software. Note that all application-specific licenses for a particular application are
always enabled or disabled together, you cannot obtain individual sublicenses (such as
K100 without K102 for the LTE application).

O The currently activated licenses are indicated in the "Versions + Options" dialog box in
= the "Help" menu, see Chapter 9.4.1, "Licensing, Versions and Options", on page 153.

To obtain a new license or return a license for an application

1. In the "Measurement Group Setup" tool window, select the "New Channel" button.

Signal + Spectrum Analyzer

MNew 3G FDD BTS 3G FDD UE Analog Demod
Channel )
¥ Option enabled
Occupy
G5M I Analyzer LTE
Replace
Current - < UL o
Channel NE-ToT OFDM VSA Pulse
r::l=:% —
- G - = -
Transient Analysis WSA WLAN
) > ()
Duplicate
Current Channel

K544 Frequency Response Carrection ™

2. For each installed application that requires a license, select one of the following

license options from the drop-down list next to the application button:

e "Option enabled": If selected, the license is obtained from the server the next
time you start the software.
If deselected, a locally stored license is returned to the server the next time you
start the software. No new license is obtained for subsequent sessions.

e "Occupy": Obtains a short-term license for 7 days the next time you start the
software. After the license has been stored locally, no further connection to the
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server is required. After 7 days, the license expires and you must obtain a new
license, if necessary.

Tip: For details on the available applications, see Chapter 5.2, "Available Applica-
tions", on page 40.

3. Restart the R&S VSE software to apply any changes to the license options, that is:
to obtain new licenses or return existing licenses.

3.5 Deinstalling R&S VSE

Access: "Start" > "All Programs" > "Rohde-Schwarz" > "VSE" > [version_number] >
"Uninstall VSE"

or: (Windows 7) "Start" > "Control Panel" > "Add or Remove Software"

or: (Windows 10) "Start" > "Settings" > "System" > "Apps & features" > "R&S VSE Sig-
nal Analyzer" > "Uninstall".

You can uninstall the software itself via the uninstall tool available in the R&S VSE
folder, or via the standard Windows "Add or Remove Software" function.
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4 Trying Out the R&S VSE

4.1

41.1

This chapter introduces the most important functions and settings of the R&S VSE step
by step. The complete and detailed description of the functionality can be found in the
subsequent chapters. Basic instrument operation is described in Chapter 6, "Operating
Basics", on page 44.

Prerequisites

® The software is installed and started as described in Chapter 3, "Software Installa-
tion", on page 14.

For these first measurements, you can use either a connected instrument in the net-
work or an input file.

e Capturing and Analyzing Data from a Connected Instrument...........cccccceeeeeeeennnnnn. 22
e Analyzing Stored Data from @ File.........ooooiiiiiiii e 31

Capturing and Analyzing Data from a Connected
Instrument

The following example demonstrates how to perform a very simple measurement on
input from a connected instrument using the R&S VSE. Only the default I/Q Analyzer
application is required.

Try out the following:

e Configuring an INStrUMENT.........oouiiii e 22
e Assigning the Instrument to a Channel.............cccoooiiii i 24
e Adding Additional Result DiSPlays........cooiiiiiiieieeeeeeeee e 25
o Rearranging WINAOWS.......cooi ittt e e e e 27
e Undocking and Resizing the Help WIiNAOW.........ccevviieeiiiiiiciiiiieeeeeee e, 28
e Adding Further Measurement Channels..........ccccceeiieeiiiiiiiiiiiiiieeeeee e, 28
e Renaming a Measurement Channel............ccooooiiiiiiiiieicccrr e 30
e Recording Measurement Data............couuviiiiiiiiiiiiiiiiie e 31

Configuring an Instrument

In the first step, we will search for instruments connected to the same network as the
PC running the R&S VSE software, and attempt to connect to one of them.

1. Select the "Instruments" tab at the upper left of the R&S VSE window.
2. Select "Search" to search for all instruments in the network.

3. To find instruments using the VXI-11 protocol, in the "Device Search" dialog box,
select the interface type "LAN VXI-11" and select "Search".
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If there are very many results, try filtering them by the type of instrument, for exam-
ple, enter FSW in the "Filter" field.

Interface Type

Search Stop LAN VXI-11 v

Results

Interface Type Model Name VISA Resource String

LAN VXI-11 R&S FSW Spectrum Analyzer | V' || TCPIPO::10. I ::inst0::IN
Filter
‘FSW‘ ‘ Connect LXI ‘

From the result list, select the instrument from which data is to be captured, then
select "OK".

In the "Instruments" window, select "Connect" to establish a connection to the
specified instrument.

The connection state should turn green and indicate "connected".

IGEGVNETEN  Measurement Group Setup

© Mew Instrument  search

FSW-26% E]

Interface Tpe
Wxi-11 -
IP Adlelress

10

Resaurce String

ToRIP: 10, 1 5 TR

Advanced ..

Calibration State calibratec Self Alignment
Cannedion State conneced

Infas & Settings Discanneadt
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4.1.2 Assigning the Instrument to a Channel

Now we must assign the configured and connected instrument as the input source for
the default measurement channel.

1. In the "Measurement Group Setup" tool window, for the default group 1, select the
"+" icon in front of the default measurement channel "IQ Analyzer".
2. Select "Instrument" as the input type.

3. From the "Instrument" selection list, select the instrument to be used for the mea-
surement.

4. From the "Input Source" selection list, select "RF".

Instruments

© Mew Group © Channel o REeplace Channel
o

Instrument:

@ Fsw_25* -

Input Saurce:
5. Select the » "Capture" icon for the "IQ Analyzer" measurement channel.

Since the default measurement mode is continuous, a continuous measurement is
started immediately on the connected instrument. The results are displayed in the
"IQ Analyzer: Magnitude" and "IQ Analyzer: Spectrum” result displays.
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Q) Analyzer = X

Ref Leve 1.00 dBm Meas Tir 11.281 ps  SRate 32.0 MHz  SGL

Att 10de  Freq 325 GHz Rec Leng RBW 123 kHz

* IQ Analyzer: 1 Magnitude ®1APClrwe 1 W

CF13.25 GHz 1001 pt=

* 1) Analyzer: 2 Spectrum ®1AP Clrw (5 W

landuvidth

| I S N || .
CF 13.25 GHz 1025 pt= 3.4 zf 3pan 32.0 MHz

41.3 Adding Additional Result Displays

For the I/Q Analyzer, up to 6 windows can be displayed for a single channel. We will
add Spectrum and Statistics result displays.
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1. Select the &1 "Add Window" icon from the toolbar.

2. Select the "Spectrum” result display.

A new window (2) for the "Spectrum” result display is opened.

1Q Analyzer
Ref Level 0.00 dém Meas Time Rate 12.5 MHz

o At 1008 Freq 10GHz Reclength 120 RBW 400 kHz

~ 1Q Analyzer: 1 Magnitude ©1APClrw (3 W | = IQ Analyzer: 2 Spectrum.

L
Span 12.519561815 MHz

3. Select the o7 "Add Window" icon again and select the "Statistics" result display.

A new window (3) for the "Statistics" result display is opened.

1Q Analyzer
Ref Level 0.00 dém [
, An 108 Freq 10GHz  RecLength

~ 1Q Analyzer: 1 Magnitude * 1Q Analyzer: 2 Spectrum @ 1APClrw 3 @ | * 1Q Analyzer: 3 Statistic ©1APClrw © 24P Cirw 5 ®

i
1001 pts 9585 ns/ | CF 10 GHz 125 MiHz/ Span 12519561815 Mz | CF 500 dém Span 1000 dBm
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4.1.4 Rearranging Windows

The R&S VSE window has now become rather crowded. Let us move the "Statistics"
window (3) behind the Spectrum window (2), so both become tabs in the same area.

» Select the window title bar of the "Statistics" window (3) and drag it over the Spec-
trum window (2). Possible new positions for the "Statistics" window (3) are indica-
ted by an empty gray space in the R&S VSE window.

* 1Q Analyzer: 3 Statistic S ®1APClrw = 24P Clrw B

» IQ Analyzer: 2 Spectrum

Figure 4-1: Moving the Statistic window over the Spectrum window

As soon as the "Statistics" window (3) is placed over the Spectrum window (2),
both windows are shown as tabs.

When you drop the window, the moved window is added as a tab.

IR R C il [ Analyzer: 2 Spectrum
- ®1APClrw - 2APClrw 3 T

Figure 4-2: Tabbed windows

To switch between the two windows, simply select the corresponding tab.
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4.1.5 Undocking and Resizing the Help Window

Displaying the help window is often useful when you need to know which values to
enter in a dialog, for example. However, if many result displays are required, the

R&S VSE window might get rather crowded. Thus, we will undock the help window and
move it outside the actual R&S VSE window.

1. Select the ?"Help" icon in the window title bar to display the "Help" window.

2. Select the &"Dock" /&"Undock" icon in the "Help" window title bar.

The window is detached and can be moved and resized independently of the
R&S VSE window.

e e

gggggggggggggg 85 s SRate 125 MHz

120 REW 400 kHz
= Group 1

e Cw T W
Y] 1Q Analyzer

eeeeee

\\\\\\\\

Displaying New Windows

For the 110 Analyzer, up to 6 windows can be displayed
for a single channel.

3. Move the "Help" window anywhere on the screen, for example next to the
R&S VSE window.

4. To resize the "Help" window, select the window frame and drag it to the required
size.

4.1.6 Adding Further Measurement Channels

In addition to the default I/Q Analyzer measurement channel, we will add a second
channel for I/Q Analysis.

1. In the "Measurement Group Setup" tool window, select the "+ Channel" button to
add a new measurement channel to the group.
2. Select the "I/Q Analyzer" measurement mode.

The channel bar and the default result displays for the new IQ Analyzer measure-
ment channel are displayed. If necessary, the previously displayed windows are
cumulated in tabs to create room on the display.
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bt apiogiitin sl ignetsdooss

i

]

I
i

Figure 4-3: Second 1Q Analyzer measurement channel ("IQ Analyzer 2")

3. Select the configured instrument as the input type for the new measurement chan-
nel.

Instruments

© Mew Graup & Channal E;' Replace Channal

Instrument:
[ L -

Input Saurce:

=¥ IQ Analyzer 2 [ [ | E
File
Instrument:
) FEW- 26 -

Input Saurce:
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Notice how the "IQ Analyzer 2" channel is now active, while the "IQ Analyzer"
channel is deactivated. This is due to the fact that both channels are based on the
same instrument, but each instrument can only perform one measurement at a
time. Thus, the channel that was assigned to the instrument previously ("IQ Ana-
lyzer") is deactivated when the instrument is assigned to a new channel ("IQ Ana-
lyzer 2").

4. Select the "Capture mode" icon to toggle between single =+ and continuous ©
measurements for each measurement channel.

5. Select the P "Capture" icon for a measurement channel to perform a measurement
on that channel. Only one channel can be started manually at a time. Before you
can start another channel, you must stop the previous measurement by selecting
the Il "Stop" icon for that channel first.

4.1.7 Renaming a Measurement Channel

The second I/Q Analyzer channel was named "IQ Analyzer 2" by default when it was
created. We will change the name to "New 1/Q Analyzer".

1. In the "Measurement Group Setup" tool window, double-click (slowly) the name of
the "IQ Analyzer 2" measurement channel.
(Alternatively, select "File" > "Measurement Group" > "Rename Measurement
Channel".)

The channel name turns into an input box.

2. Enter New I/Q Analyzer and press [ENTER)].

The channel name is changed, not only in the "Measurement Group Setup", but
also in all channel and window title bars.

MMeasurement Group Setup EEGERGTTERIG

© Mew Graup © Channel L4 Replace Channel
O+
| 4
= Y Group 1 > 1 10dB  Freq 13.25

SRS W Mew 1'Q Analyzer

* ¥ Mew [/Q Analyzer: Magnitucle
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4.1.8 Recording Measurement Data

Now we will record the measured 1/Q Analyzer data so that we can play it back again
later. We want to store all available results, regardless of how many measurements we
perform.

1. From the "File" menu, select "Preferences > Recording".
2. For the "Number of Records", select 20.

3. Close the "Preferences" dialog box.
4

Select the ® "Record" function for the "IQ Analyzer" channel in the "Measurement
Group Setup" tool window.

The captured 1/Q data is recorded.

5. To stop recording measurement results, select the Il "Pause" function for the "IQ
Analyzer" channel in the "Measurement Group Setup" tool window.

The temporary file is used as input for the "IQ Analyzer" channel, and the first
recorded record is displayed immediately in the channel's result displays.

Instruments

© Mew Graup © Channeal EE Replace Channel
= Group 1
= ‘D 10 Analyzer 1l = E ‘
Instrument
File:
c/temp IgRecarding_ 8014, tar
IQ Analyzer -

From the "File" menu, select "Save 1Q Recording" to store the file permanently.
Select the storage location and file name for the stored data.

Select the "File Type": ".ig.tar".

© © N 2

Select "Save".

The captured data is stored to a file. You can now continue with the second part of
the Trying Out chapter: analyzing stored data from a file.

4.2 Analyzing Stored Data from a File

If no instrument is available in the network to provide input to the R&S VSE, you can
also try out the software using an input file. Several input files are provided with the
software for demonstration purposes. Check the

User Manual 1176.8839.02 — 14 31



R&S®VSE Trying Out the R&S VSE

Analyzing Stored Data from a File

C:\ProgramData\Rohde-Schwarz\VSE\<version no>\user\Demo directory
for an appropriate file.

Note that this directory is not displayed in the "Load 1/Q File" dialog box, you must
enter the path and file name directly in the "File Name" field. (Tip: copy the path and
file name from the Windows Explorer window.)

4.2.1 How to Import I/Q Data for Analysis

1. In the "Measurement Group Setup" tool window, select the "+" icon in front of the
"IQ Analyzer" measurement channel.

2. Select "File" as the input type.

3. Select the "..." icon to open the "Load 1/Q File" dialog box and select the storage
location and the file name.

4. Select the » "Capture"” icon for the "IQ Analyzer" measurement channel.

The stored data is loaded from the file and evaluated in the "IQ Analyzer" result
displays.

4.2.2 Setting and Moving a Marker

Markers are useful to determine the position of particular effects in the trace. The most
common use is to determine a peak, which is the default setting when you activate a
marker. We will set a marker on the peak in the Magnitude display of the IQ Analyzer
measurement.

1. Tap the Magnitude display to set the focus on that window.

2. Select the &' "New Marker" icon from the toolbar.

Marker 1 is activated and automatically set to the maximum of trace 1. The marker
position and value is indicated in the diagram area as M1[1].

User Manual 1176.8839.02 — 14 32



R&S®VSE Trying Out the R&S VSE

Analyzing Stored Data from a File

= 3 1Q Analyzer: 1 Magnitude

CF 10 GHz 1001 pts

3. Now you can move the marker by tapping and dragging it to a different position.
The current position is indicated by a dotted blue line. Notice how the position and
value change in the marker area of the diagram.

= 3¢ 1Q Analyzer: 1 Magnitude

v*;

1001 pts
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5 Measurements and Results

The R&S VSE provides several applications for different analysis tasks and different
types of signals. The 1/Q Analyzer application is included in the basic R&S VSE soft-
ware. All other applications, such as Analog Demodulation or Vector Signal Analysis
(VSA) are optional additions and require special licenses. (See also Chapter 5.2,
"Available Applications", on page 40.)

@ Measurement CONCEPL.....ciiii it e e s e e e e e e e e e s e e e e e e ae e e e e e annnnnes 34
e Available APPlICAtIONS. .. .cii e e e e 40
o Starting an ApPlIiCatioN..........coeeiiiiieeeeee e ————— 43

5.1 Measurement Concept

As a rule, each instrument can only perform a single measurement at any time. How-
ever, the R&S VSE allows you to perform multiple measurements on the same instru-
ment sequentially, or to perform multiple measurements on different instruments in par-
allel. Thus, comprehensive data analysis with a single tool becomes quick and simple.

@ R&S VSE Enterprise Edition vs Basic Edition

The R&S VSE Enterprise Edition and Basic Edition differ in the number of channels,
groups, and instruments that can be configured at the same time, see "R&S VSE

Enterprise Edition vs Basic Edition" on page 62. Not all functions described here are
supported by the R&S VSE Basic Edition.

Basic measurement process

In a basic I1/Q measurement, data is imported from a file or captured from an instru-
ment and the measured results are displayed. Multiple applications can be used at the
same time in the R&S VSE. However, data acquisition on the same instrument is
restricted to a single application at a time.

Measurement channels

When you activate an application, a new measurement channel is created which deter-
mines the measurement settings for that application. The same application can be acti-
vated with different measurement settings by creating several channels for the same
application. Whenever you switch channels, the corresponding measurement settings
are restored.

The global information and results for each channel are displayed in separate windows
(or tabs) on the screen. The results from various applications can be displayed at the
same time. Each application may provide different result displays (see the applications'
user manual for details). The measurement windows can be rearranged and config-
ured in the R&S VSE to meet your requirements (see Chapter 6.3, "Customizing the
User Interface", on page 52).
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exists, a sequential number is added. However, the name of the measurement channel
can be changed. For an overview of default names see TNSTrument : LIST?
on page 528.

@ The measurement channels are labeled with their default name. If that name already

In the R&S VSE, measurement channels are controlled and initially configured in the
"Measurement Group Setup" tool window.

Instruments EESEERUEERCG RN

© Mew Graup © Channel _a Replace Channel
o+

- 1Q Analyzer | [E
Instrument
Fil=:

ctempIgRecarding_1233.ic.tar

I3 Analyzer T

=l [] 1G Analyzer 2 Il e [E

Instrument Filz

Instrument:
@ Fsw-26* ©

Input Saurce:

Instrument:
9 Fswe-26* =

Input Source:

Figure 5-1: "Measurement Group Setup"” tool window

For each channel, the input type (instrument or file) and the input source type must be
configured. Detailed configuration for the measurement can then be performed via the
specific configuration "Overview" which is available for each application. (For details
see the applications' user manual.)

You can configure up to 30 channels at the same time (for the R&S VSE Basic Edition,
up to three channels). However, only one measurement channel can be started man-
ually at any time. Before you can start another channel, you must stop the previous
measurement channel first.
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O [& The "running" icon in the channel function bar indicates that the channel is currently
= performing a measurement.

I The "error" icon in the channel function bar indicates that an error occurred in the
measurement channel. Check the R&S VSE status bar.

Measurement groups

As opposed to manual channel control, multiple measurements on different instru-
ments or files can be performed in parallel if controlled by the software (Enterprise Edi-
tion only). All measurement channels that are to be started at the same time must be
configured within a group. When the group is started, all included (active) measure-
ment channels are started and provide results independently as soon as their mea-
surements are completed. Note, however, that the individual measurements are not
synchronized in any way, and the results are totally independent as the input data is
different for each channel.

O Configure triggers to synchronize the individual measurements.

In the R&S VSE Enterprise Edition, multiple groups of measurement channels can be
configured, for example to define individual test scenarios.

Measurement groups are a convenient way to start multiple measurements at the
same time.
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Figure 5-2: Example for a measurement group

Active vs inactive channels

As mentioned above, only measurements on different instruments or on files can be
performed in parallel (Enterprise Edition only). If the same instrument is assigned to
multiple measurement channels of the same group, those channels cannot be pro-
cessed simultaneously. Thus, the channel to which the instrument was assigned previ-
ously is deactivated. Only active measurements are included in a group measurement.

Active channels are indicated by a checkmark in front of the channel in the "Measure-
ment Group Setup" tool window.
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Measurement groups and sequences

For multiple measurements on the same instrument, without switching between mea-
surement channels manually, the R&S VSE provides a measurement sequence (Enter-
prise Edition only). A single instrument can perform only one measurement at a time;
however, a sequence of measurements can be performed very quickly by the software.

A measurement sequence consists of a number of measurement groups, and each
group may contain multiple channels. However, only channels with distinct input types
can be active within a group during a measurement sequence. The groups themselves
can also be activated or deactivated individually. When you start a measurement
sequence, the individual groups are processed sequentially, in the order of their defini-
tion. The measurements for a single group are started simultaneously, and only when
all channels in the group have completed, the next group is processed.

User Manual 1176.8839.02 — 14 38



R&S®VSE Measurements and Results

Measurement Concept

Meazurement Group Setup IEE I
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Instrument File

Instrument:
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Figure 5-3: Example for a measurement sequence

O Active groups are indicated by a checkmark in front of the group in the "Measurement
= Group Setup" tool window.

A group that is currently performing a measurement is indicated by the "running" icon
[& next to the group's name in the "Measurement Group Setup" tool window.

A measurement sequence is a convenient way to perform multiple measurements on
an input signal in a quick succession, and to obtain results from different applications in
a relatively short measurement time without having to switch between applications
manually. For stable input data, a measurement sequence can provide results in vari-
ous applications for almost identical input data.

Measurement mode

For each measurement you can define whether a defined number of measurements is
to be performed, or a continuous measurement. This is referred to as the measure-
ment mode. The measurement mode can be defined for an individual measurement
channel, a measurement group, or an entire measurement sequence. However, the
measurement mode for the channels within a group is always the same as for the
entire group, and the mode for the groups is the same as for the sequence. Thus, if
you change the mode for a sequence, the mode for the group and the individual chan-
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nels is automatically adapted accordingly. Nevertheless, you can change the mode for
individual channels for manual measurement control.

Default measurement

The default measurement in the R&S VSE consists of a single measurement channel
(with the 1/Q Analyzer application) in a default group and a default measurement
sequence in continuous measurement mode. The measured magnitude values are dis-
played.

5.2 Available Applications

The 1/Q Analyzer application is included in the basic R&S VSE software. All other appli-
cations, such as Analog Demodulation or Vector Signal Analysis (VSA) are optional
additions and require special licenses.

If necessary, obtain a license for the application as described in "To obtain a new
license or return a license for an application" on page 20.

@ K544 Frequency Response Correction

The Frequency Response Correction option (K544) is not a separate application with
its own channel. The functionality is available in the "Meas Setup" menu for any appli-
cation. However, in order to obtain a license for this optional functionality, it is included
in the application overview.

For details on the Frequency Response Correction option, see Chapter 7.5, "Fre-
quency Response Correction (R&S VSE-K544)", on page 94.
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OFDM Vector Signal Analysis (OFDM VSA).....ccoiiiiiiiiiiee et 42
PUISE MEASUIEMENTS....coiiiiiiiii i e e e 42
TranSIENt ANAIYSIS....ciii i e e e e e e e e e e e e e e e e ——————————————— 42
Vector Signal ANalysis (VSA).. .o e e e e e e e e e e e e e e ee s 42
LT O USROS 42
3G FDD

The 3G FDD BTS and 3G FDD UE applications require the 3GPP FDD Measurements
option, R&S VSE-K72, to be installed, and an additional license. These applications
provide test measurements for W-CDMA uplink and downlink signals (base station sig-
nals) according to the test specification.

For details see the R&S VSE-K72 User Manual.
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Remote command:
INST:SEL BWCD, see INSTrument [:SELect] on page 529

5G NR
The 5G NR application requires an instrument equipped with one of the 5G NR Mea-
surements options.

The R&S VSE-K144 application provides 5G NR measurements on the downlink and
uplink.

The R&S VSE-K146 application provides 5G NR MIMO measurements on the down-
link.

For details see the R&S VSE-K144 user manuals (one for downlink, and one for uplink.

Remote command:
INST:SEL NR5G, see INSTrument [:SELect] on page 529

Analog Demodulation
The Analog Demodulation application requires an additional license. This application
provides measurement functions for demodulating AM, FM, or PM signals.

For details see the R&S VSE-K7 User Manual.

Remote command:
INST:SEL ADEM, see INSTrument [:SELect] on page 529

GSM
The GSM application requires the GSM Measurements option R&S VSE-K10, to be
installed, and an additional license. This application provides GSM measurements.

For details see the R&S VSE-K10 User Manual.

Remote command:
INST:SEL GSM, see INSTrument [:SELect] on page 529

1/Q Analyzer
The 1/Q Analyzer is the default application and provides measurement and display
functions for 1/Q data.

Remote command:
INST:SEL IQ,see INSTrument[:SELect] on page 529

LTE
The LTE application requires the LTE Measurements option R&S VSE-K10x, to be
installed, and an additional license. This application provides LTE measurements.

For details see the R&S VSE-K10x (LTE Downlink and LTE Uplink) user manuals.

Remote command:
INST:SEL LTE, see INSTrument [:SELect] on page 529

NB-loT

The NB-loT application requires the NB-loT Measurements option R&S VSE-K106, to
be installed, and an additional license. This application provides NB-loT measure-
ments.

For details see the R&S VSE-K106 (NB-loT Downlink and NB-loT Uplink) user manual.
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Remote command:
INST:SEL NIOT, see INSTrument[:SELect] on page 529

OFDM Vector Signal Analysis (OFDM VSA)

The OFDM VSA application requires the OFDM Vector Signal Analysis option,
R&S VSE-K96, to be installed, and an additional license. This application provides
measurements and evaluations for OFDM Vector Signal Analysis.

For details see the R&S VSE-K96 User Manual.

Remote command:
INST:SEL OFDMVSA, see INSTrument [:SELect] on page 529

Pulse Measurements

The Pulse application requires the Pulse Measurements option, R&S VSE-KG, to be
installed, and an additional license. This application provides measurement functions
for pulsed signals.

For details see the R&S VSE-K6 User Manual.

Remote command:
INST:SEL PULSE, see INSTrument [:SELect] on page 529

Transient Analysis

The Transient Analysis application requires the Transient Analysis option R&S VSE-
K96, to be installed, and an additional license. This application provides measurements
and evaluations for Transient Analysis.

For details see the R&S VSE-K60 Transient Analysis User Manual.

Remote command:
INST:SEL TA, see INSTrument [:SELect] on page 529

Vector Signal Analysis (VSA)

The VSA application requires the Vector Signal Analysis option, R&S VSE-K70, to be
installed, and an additional license. This application provides measurements and eval-
uations for Vector Signal Analysis.

For details see the R&S VSE-K70 User Manual.

Remote command:
INST:SEL DDEM, see INSTrument [:SELect] on page 529

WLAN

The WLAN application requires one of the WLAN options, R&S VSE-K91, to be instal-
led, and an additional license. This application provides measurements and evalua-
tions according to the WLAN IEEE 802.11 standards.

For details see the R&S VSE-K91 User Manual.

Remote command:
INST:SEL WLAN, see INSTrument [ : SELect] on page 529
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5.3 Starting an Application

The default application in the R&S VSE is the 1/Q Analyzer.

1. To start a new application, in the "Measurement Group Setup" tool window, select

the "New Channel" button.

New

Channel @ E

Analog Demod 10 Analyzer

Replace

[e:fa]
Current
Channel

Duplicate
Current Channel

2. Select the required application.

3. If necessary, obtain a license for the application as described in "To obtain a new

license or return a license for an application" on page 20.

For more information on working with applications see Chapter 7, "Controlling Instru-
ments and Capturing I/Q Data", on page 62.
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6 Operating Basics

This chapter provides an overview on how to work with the R&S VSE. It describes
what kind of information is displayed in the diagram area, how to operate the R&S VSE
via the graphical user interface, and how to use the Online Help. The information
described here refers to the basic R&S VSE functionality, and is generally available in
all supported applications. For specifics on the individual applications, see the corre-
sponding user manuals.

e Graphical User Interface Elements............uuuucciiiiiiii e 44
e Understanding the I/Q Analyzer Display Information.............cccccceiiiiiiiiiiiiiieeeeen. 50
o Customizing the User INterface...........uuuuucciiiiiiiii e 52
L I € 1= g o 1Yo S 59

6.1 Graphical User Interface Elements

All tasks necessary to operate the connected instrument can be performed using the
R&S VSE graphical user interface.

In addition to the measurement results, the display provides status and setting informa-
tion, allows you to switch between various measurement tasks, and provides access to
all measurement functions.

Figure 6-1: Graphical user interface elements
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= Menu bar with general and measurement-specific menus
= Toolbar with general and measurement-specific tools
= Tool window for measurement group tool
= Tool window for instrument configuration
Tabs for individual measurement channels
Channel bar for active channel settings
= Result display for first measurement channel (yellow line)
= Result display for second measurement channel (purple line)
= Four result displays for third measurement channel (green line)
0 = Status bar with error messages, progress bar and instrument status for active channel

6.1.1 Menus

Most functions in the R&S VSE are available from the menus at the top of the window.

The following menus provide basic functions for all applications:

e "Fijle"

e "Edit"

e "Window"
e "Help"

These functions are described in this manual. An overview is provided in Chapter A,
"Menu Reference", on page 900.

Other menus are application-specific and provide different functions depending on
the selected measurement channel, for example:

® Input

® Measurement Setup

® Trace
® Marker
® |imits

These menu functions are described in the user manual for the individual application
and in Chapter 10, "l/Q Analyzer Measurements", on page 159.

6.1.2 Toolbars

Standard functions can be performed via the icons in the toolbars.

o The toolbars can be docked anywhere alongside the outer edge of the R&S VSE win-
= dow; that is:

® Beneath the menu bar
® Above the status bar
® On the left or right edges of the window

For details, see Chapter 6.3, "Customizing the User Interface", on page 52.

For information on how to hide or display individual toolbars see Chapter 6.3.5, "Clos-
ing and Deactivating Windows and Bars", on page 59.
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Note that some icons are only available for specific applications. Those functions are
described in the user manual for the individual application.

An overview of all available toolbar functions is provided in Chapter B, "Reference of
Toolbar Functions", on page 908.

6.1.3 Status Bar

The software status, instrument status, errors and warnings and any irregularities in
the connected instrument are indicated in the status bar at the bottom of the R&S VSE
window.

- ’ ] Ready - E

O Hiding the status bar

You can hide the status bar display, e.g. to enlarge the display area for the measure-
ment results ("File > Preferences > Displayed Items").

See Chapter 9.2.1, "Displayed ltems", on page 141.

Software status

The status bar indicates the state of the VISA installation on the PC running the
R&S VSE software. The VISA installation is required to connect the R&S VSE to other
instruments.

The following VISA status icons may be displayed:
Table 6-1: VISA status icons

m VISA installation is available; network connections to other instruments are possible
I
VISA installation is available, but a firewall may be prohibiting a connection to other instru-
ments in the network.
Try one of the following to resolve the problem:
®  Check the IP addresses of the instruments configured in the "Instruments" window and
make sure you are allowed to connect to those instruments.
®  Try using HiSLIP protocol instead of VSI-11
®  Ask your local administrator to loosen the firewall restrictions on your PC.
®  Restart the instrument you want to connect to.
m VISA installation is not complete or available; network connections to other instruments are not
— possible.
See "Installing VISA" on page 14 or contact the Rohde & Schwarz Support Center (see Chap-
ter 14.3, "Collecting Information for Support”, on page 898).

O If you place the mouse over the icon, a descriptive message is displayed informing you
= what to do.
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Instrument status

The displayed instrument status information depends on the type of instrument that is
connected to the R&S VSE. For the supported Rohde & Schwarz Signal and Spectrum
Analyzers, the following types of information may be displayed, if applicable.

) The instrument is configured for operation with an external reference.
/\/ The R&S VSE software is resampling the input from the connected instrument to
obtain the required sample rate.

Progress

The progress of the current software operation is displayed in the status bar.

heasuring... ([ [[[]]

Error messages

If errors or irregularities are detected, a keyword and an error message, if available,
are displayed in the status bar. For details, see the user manual for the individual appli-
cation.

6.1.4 Windows

The R&S VSE distinguishes between three types of windows, depending on their use:

® Tool windows: provide functionality for specific global tasks, such as configuring
instruments or measurement groups; see Chapter 7, "Controlling Instruments and
Capturing 1/Q Data", on page 62

® Channel bar: provides information on measurement channel settings (one window
per active channel)

® Result displays: provide the measurement results

The layout of the individual windows is customizable and highly flexible, see Chap-
ter 6.3, "Customizing the User Interface", on page 52.

®  Channel Dar.......ooi i 47
e Result Displays / Measurement WiNdOWS.......cccoeveiiiiiiiiiiciicccceeeeeeeevvv e 48

6.1.4.1 Channel bar

For each channel, a separate window with measurement information is displayed.
When you select a result display window for a different channel, the channel bar for
that channel is also activated. Each channel bar is provided with a colored line in the
window title bar which is the same color as the corresponding channel result displays.
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12 Analvzer

Ref Level 0.00 <Bm Meas Time 31.231 ps SRate 32.0 MHz

Attt 10¢cB  Freq 4.0 GHz  Rec Length 1091

Figure 6-2: Example for channel bar (I/Q Analyzer)

O In the default configuration, the channel bars for multiple channels are displayed in
= separate tabs in the same window. Depending on which result display is currently
active, the corresponding channel information tab is displayed. However, you can sep-
arate the tabs into individual windows. See Chapter 6.3, "Customizing the User Inter-
face", on page 52.

Channel-specific settings

The channel bar provides information on channel-specific settings for the measure-
ment. A bullet next to the setting indicates that user-defined settings are used, not
automatic settings. A green bullet indicates this setting is valid and the measurement is
correct. A red bullet indicates an invalid setting that does not provide useful results.
Channel information varies depending on the active application. For details, see the
individual user manuals.

Instrument settings

In addition to the channel-specific settings, the channel bar also displays information
on general instrument settings. These settings affect the measurement results even
though it is not immediately apparent from the display of the measured values. This
information is displayed in gray font and only when applicable for the current measure-
ment, as opposed to the channel-specific settings that are always displayed.

The instrument settings depend on the type of instrument that is connected to the
R&S VSE. For the supported Rohde & Schwarz Signal and Spectrum Analyzers, the
following types of information may be displayed, if applicable.

Table 6-2: Instrument settings displayed in the channel bar

PA The preamplifier is activated
75Q The input impedance of the instrument is set to 75 Q
DC/AC An external DC or AC calibration signal is in use.

6.1.4.2 Result Displays / Measurement Windows

Measurement results can be evaluated in many different ways, for example graphically,
as summary tables, statistical evaluations, etc. Optional applications add their own
specific measurements and result displays. Thus, the result display is highly configura-
ble to suit your specific requirements and optimize analysis.

For each measurement, a separate measurement channel is activated. Each measure-
ment channel can provide multiple result displays. All windows that belong to the same
measurement (including the channel bar) are indicated by a colored line at the top of
the window title bar.
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1Q Analyzer ERUOENEGYCig 1Q Analyzer 3 1Q Analyzer 4

Ref Level 0.00 dBm Meas Time 31281 ps SRate 32.0 MHz

Att 10dE Freq 40 GHz Rec Length 1001 RBW 123 kHz

* ¢ IQ Analyzer: 1 Magnitude o1APCIrw & T
M1[1] -45.38 dBm
2848 ms

CF 1.0 GHz 1001 pts

~ IQ Analyzer 2: 2 Spectrum o 1AP Clrw = Wi | ~ 9% IQ Analyzer 3: 2 Spectrum QIAPCIrw W

is Blandwidth

Figure 6-3: Color-coded windows

Window title bar

The contents of the individual result displays are described in detail in the user manual
for the individual application.

The following common functions are available in all window title bars:

Table 6-3: Common functions and icons in the window title bar

v Change result type Displays a list of possible result types for the active channels to replace
the current display.

{}. Invalid data Indicates that invalid or inconsistent data is displayed, that is: the trace no
longer matches the displayed measurement settings. This may be the
case, for example, when you change the measurement bandwidth, but the
displayed trace is still based on the old bandwidth. As soon as a new mea-
surement is performed or the display is updated, the icon disappears.

(This icon is sometimes also referred to as a "dirty flag".)
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-

Dock / Undock win-
dow

Docks the window to the main R&S VSE window or separates it from the
main window.

See "Docked and undocked windows" on page 52

=

Delete window

Closes the selected window

6.2 Understanding the I/Q Analyzer Display Information

The following figure shows a measurement diagram during I/Q Analyzer operation. All
different information areas are labeled. They are explained in more detail in the follow-
ing sections.

= ¥ G Asabaen 3 Marker Table =k ]
1M1

1
433577 ms
-30.34 dBm

Wil
1

5577 ps
0.47 dB

il
1
4.80423 ms

Figure 6-4: Screen elements in the I/Q Analyzer application

1 = Color coding for windows of same channel

2 = Channel bar with measurement settings

3 = Window title bar with diagram-specific (trace) information

4 = Diagram area with marker information

5 = Diagram footer with diagram-specific information, depending on result display

Channel bar

The channel bar shows the most important settings for the corresponding application.
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O Select a setting in the channel bar to open the corresponding configuration dialog box
= and change the setting quickly and easily.

Right-click a setting to display a context menu for it.

For the I/Q Analyzer application, the channel bar shows the following settings:

Table 6-4: Information displayed in the channel bar for the I/Q Analyzer application

Ref Level Reference level

(m.+el.)Att (Mechanical and electronic) RF attenuation

Ref Offset Reference level offset

Freq Center frequency

Meas Time Measurement time

Rec Length Defined record length (number of samples to capture)

SRate Defined sample rate for data acquisition

RBW (Spectrum evaluation only) Resolution bandwidth calculated from the
sample rate and record length

Table 6-5: Icons in the channel bar

Icon Meaning

Indicates that the channel is currently performing a measurement.

Indicates that an error occurred in the measurement channel. Check the
R&S VSE status bar.

fo] |

Window title bar information

For each diagram, the header provides the following information:

[+ 4 10 Analyzer: 1 Maanitude ® 1AP Clrw

Figure 6-5: Window title bar information in the I/Q Analyzer application

0 = Color coding for windows of same channel

1 = Edit result display function

2 = Invalid data flag

3 = Channel name

4 = Window number

5 = Window type

6 = Trace color, trace number, detector type, trade mode
7 = Dock/undock window function

8 = Close window function
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Diagram footer information

The diagram footer (beneath the diagram) displays scaling information and depends on
the evaluation:

Magnitude and Spectrum diagrams:

® Center frequency

® Number of measurement points

® Range per division (x-axis)

® Span (Spectrum)

I/Q Vector diagram:

® Maximum value on y-axis

6.3 Customizing the User Interface

The layout of the individual windows in the R&S VSE software is customizable and
highly flexible. Apart from a few fixed interface elements (menu bar, status bar), the
windows can be positioned almost anywhere on the screen.

@ WiINAOWS CONCEPL..ciiiiieii ittt e e e e e e e e st e e e e e e e e e e e e s e nnnnraaeeees 52
O MUIIVIEW MOGE.....coiiiiiiiii e e 56
o Displaying NeW WINAOWS........ccuuiiiiiiiiiiiieiiiieieie e ee e e e e e e e e ee e 57
o Rearranging WINAOWS. ......ooi it e e e e e e e e e 58
e Closing and Deactivating Windows and Bars.........ccccuvieriiiiiiiiiiiicceeieeeeeee e 59

6.3.1 Windows Concept

Docked and undocked windows

In the default layout, all windows are positioned within the main R&S VSE window.
When you change the size of the R&S VSE window, or add new subwindows, the sub-
windows are adapted or rearranged as necessary. The subwindows are docked to the
main window.
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Figure 6-6: Example for docked windows in the R&S VSE window

Optionally, each subwindow can be undocked, that is, detached from the main

R&S VSE window. Undocked windows can be placed anywhere on the screen, even
outside of the main R&S VSE window. This is useful, for example, if a second monitor
is available and you want to take advantage of the additional display area. However,
undocked windows "float" on the screen, covering any other displays behind them.
They are not adapted or rearranged when you change the size of the R&S VSE win-
dow or add new subwindows.

Figure 6-7: Example for undocked window in the R&S VSE window

Docking areas for interface elements

The windows and other interface elements can be docked within predefined areas in

the R&S VSE window. (For details on the window types see Chapter 6.1.4, "Windows",

on page 47.)

® The menu bar and status bar are fixed elements and are always located at the
top and bottom edge of the window, respectively. No windows can be docked
above the menu bar or below the status bar.

® Toolbars can only be placed along the outer edges of the R&S VSE window, below
the menu bar and above the status bar.
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® Tool windows can only be placed along the outer edges of the R&S VSE window,
below the menu bar and above the status bar, and not outside of any toolbars.

® Channel bars can be placed above or below the result displays, at the top or bot-
tom edges of the R&S VSE window, but not outside of any tool windows or tool-
bars.

® Result displays are surrounded by all other window types and bars. They must be
placed within a grid structure of columns and rows. The number of result displays
in each column or row is restricted only by the available display space and the min-
imum window size of the individual windows.

Table 6-6: Docking areas in the R&S VSE window

— = = — [ =

Result display area

Channel info area

Docking positions

Possible docking positions for the currently selected element are indicated by an empty
gray space in the R&S VSE window.

Window tabs

As mentioned above, each window type requires a minimum amount of space for dis-
play. If not enough display space for all active windows is available, windows of the
same type are automatically arranged in tabs within one window. To switch between
displayed windows, simply select the corresponding tab.

For example, when a new channel is started or a new display is added, the existing
windows may be combined into one window using tabs. The new windows are dis-
played in maximum size.
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To save space on the screen and when not all windows are relevant at the same time,
you can also arrange windows in tabs manually. Tabs are created when you dock a
window on top of an existing window of the same type. The docking position is indica-
ted by showing the existing window with a tab, instead of providing an empty gray
space for a new window.

Table 6-7: Docking windows as tabs

K} arbyer | 4 BHveimar

1) Analyzer: 1 r-.*i_-;u]_ .t

Possible docking position: tab in existing window Result: new tab in existing window

Window size

Each window type requires a minimum amount of display space. The maximum size is
restricted only by the available display space within the R&S VSE window (for docked
windows) or on the entire screen (for undocked windows).

The result displays are placed within a grid structure (see "Docking areas for interface
elements" on page 53). Thus, the minimum width of a window may also be restricted
by other result displays in the same column. The minimum height may be restricted by
other result displays in the same row.

Active windows, selected window

When a measurement is performed in a channel, results are determined for all config-
ured result displays. Thus, to analyze result data and possibly store it to a file, you
must activate windows for the corresponding result displays. A list of all active windows
for all configured measurement channels is available from the "Window" menu.

As soon as you select a window, for example by clicking the mouse in it, any window-
specific operations you perform subsequently are applied to that window. For example,
you can set a marker or zoom in into the display of the window. Furthermore, when you
select a window, you also select the channel the selected window belongs to. The
channel bar (see Chapter 6.1.4.1, "Channel bar", on page 47) for the selected channel
is activated, and any channel-specific operations are applied to the selected channel.

Closing vs deactivating windows

If a large number of channels or result displays are active, the display may become
very crowded and confusing. Thus, if you do not require the online visualization of the
results, you can temporarily deactivate windows in the display. Deactivating a window
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simply hides the display, without losing its settings or contents. A deactivated window
can easily be restored to the display without having to reconfigure it.

Closing a window permanently deletes the result display and its contents. A new win-
dow with the same evaluation method and default settings can be added again, but the
previous settings and contents are lost.

6.3.2 MultiView Mode

By default, all windows for all active measurement channels are displayed at the same
time on the screen. This is referred to as the MultiView mode, as multiple channels are
displayed.

Py 1Q Analyzer 2 ¥ 1Q Analyzer 3

Ref Level 0.00 dBm Meas Time SRate 32.0 MHz

Att 10de  Freq 13.25GHz Rec Length 1001

® 18P Clrw . Q A ’ AP C 28P Clrue * 3% IQ Anal

20.0 dB

0.00 dBm 101 pts 0.0 dBm
0.00 dBm
0.00 dB

0.00 dB

0.00 dB

0.00 B -

0.00 dt -Valu K ver -151.79 dBm

Figure 6-8: MultiView display of several measurement channels

You can disable this mode in order to display only the windows for a single measure-
ment channel at a time. In this case, the windows for each channel are displayed in
individual tabs. Only the windows for the currently selected channel are visible. To
switch between channels, simply select the corresponding tab. This is particularly use-
ful if the screen gets too confusing.
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It Py 1Q Analyzer 2 Y 1Q Analyzer 8

Ref Level 0.00 cBm Meas Time 31.281 ps  SRate 32.0 MHz

10dE  Freq 13.25 GHz Rec Length 1001

101 pts

Figure 6-9: MultiView disabled - display of a single measurement channel only

To toggle between the two views

» Select the "Multiview mode" icon in the main toolbar.

To change the default behavior

> Select "File" > "Preferences" > "Displayed Items" > "Multiview mode". "On""/""Off".

6.3.3 Displaying New Windows
For the I/Q Analyzer, up to six windows can be displayed for a single channel.

To add a new window

1. Select the global information window or any other measurement window of the
measurement channel you want to add a window for.

2.0'1

Select the "Add Window" icon or
From the "Window" menu, select "New Window".

3. Select the result display you want to add a window for.
The available result display types depend on the selected application.
For other applications, see the application-specific documentation.

A new window for the result display is opened.

If not enough display space for all active windows is available, the existing win-
dows are combined into one window using tabs, while the new window is displayed
in maximum size.
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To replace the contents of a measurement window

1. In the window whose contents you want to replace, in the window title bar, select
the Bl "Replace" icon.

2. Select the result display.
The window displays the newly selected result display for the selected measure-
ment channel.

Remote commands:

LAYout :GLOBal:ADD[:WINDow] ? on page 573

LAYout :GLOBal:REPLace [ :WINDow] on page 578

6.3.4 Rearranging Windows

To dock or undock a window

» Select the 88"Dock" /&"Undock" icon in the window title bar.

If the window was docked, it is detached and can be moved and resized independ-
ently of the R&S VSE window.

If the window was undocked, it is docked to its default position in the R&S VSE
window.

(For details see "Docked and undocked windows" on page 52.)

To change the position of a window or bar

» Select the bar or window title bar and drag it to a new position on the screen. Pos-
sible docking positions for the currently selected element are indicated by an empty
gray space in the R&S VSE window or by showing the underlying window with a
tab.

When you drop the window or bar, it is docked to the selected position.

If you drop the window on top of an existing window of the same type, the moved
window is added as a tab.

To switch between displayed windows, simply select the corresponding tab.

To resize a window

» To resize a window, select the window frame and drag it to the required size. Note
the restrictions concerning the minimum window size described in "Window size"
on page 55.

O To restore the default configuration for the measurement channel, use the Preset >
= Selected Channel function in the "File" menu.
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6.3.5 Closing and Deactivating Windows and Bars

Closing a window permanently deletes the result display and its contents, while deacti-
vating a window simply hides the display, without losing its settings or contents. Tool
windows and channel bars cannot be closed permanently.

(For details see "Closing vs deactivating windows" on page 55).

To hide or display a toolbar

1. Right-click any toolbar or the menu bar.

A context menu with a list of all available toolbars is displayed.

2. Select the toolbar you want to hide or display.

A checkmark indicates that the toolbar is currently displayed.

The toolbar is toggled on or off.

To deactivate or reactivate a tool window or channel bar

» From the "Window" menu, select the tool window or channel bar.

The window is toggled on or off.

To deactivate or reactivate a result display

1. From the "Window" menu, select "Active Windows".
Alternatively, right-click the window title bar of a result display that belongs to the
same channel.

2. Select the result display you want to deactivate or reactivate.

A checkmark indicates that the window is currently active.

The window is toggled on or off.

To close a result display

>
Select the "Delete" icon in the window title bar.

The result display is permanently removed.

Remote command:

LAYout :GLOBal:REMove [ :WINDow] on page 578

6.4 Getting Help

If any questions or problems concerning the R&S VSE arise, an extensive online help
system is provided in the software and can be consulted at any time. The help system
is context-sensitive and provides information specifically for the current operation or
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setting to be performed. In addition, general topics provide an overview on complete
tasks or function groups as well as background information.

6.4.1 Calling Up Help

The online help can be opened at any time by selecting one of the "Help" icons on the
toolbar or by selecting the F1 key.

Calling context-sensitive help

» To display the "Help" dialog box for the currently focused screen element, e.g. a
softkey or a setting in an opened dialog box, select the "Help" icon on the toolbar.

?

The "Help" dialog box "View" tab is displayed. A topic containing information about
the focused screen element is displayed.

If no context-specific help topic is available, a more general topic or the "Contents
tab is displayed.

For standard Windows dialog boxes (e.g. Print dialog, Device Search, VISA Resource
String Builder etc.), no context-sensitive help is available.

» To display a help topic for a screen element not currently focused:

a) Select the "Help pointer" icon on the toolbar.
R?

The pointer changes its shape to a "?" and an arrow.
b) Select the screen element to change the focus.

A topic containing information about the selected (now focused) screen element is
displayed.

6.4.2 Using the Help Window

The Help window contains several tabs:

® "View" - shows the selected help topic

® "Contents" - contains a table of help contents

® "Index" - contains index entries to search for help topics
® "Search" - provides text search

The Help toolbar provides some buttons:

® To browse the topics in the order of the table of contents: Up arrow = previous
topic, Down arrow = next topic
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® To browse the topics visited before: Left arrow = back, Right arrow = forward
® To increase or decrease the font

FEaEEEE

To search for a topic in the index

The index is sorted alphabetically. You can browse the list, or search for entries in the
list.

1. Switch to the "Index" tab.
2. Select the "Keyboard" icon besides the entry field.

3. Enter the first characters of the keyword you are interested in.

The entries containing these characters are displayed.

4. Double-click the suitable index entry.

The "View" tab with the corresponding help topic is displayed.

To search topics for a text string
1. Switch to the "Search" tab.
2. Select the "Keyboard" icon besides the entry field.

3. Enter the string you want to find.
If you enter several strings with blanks between, topics containing all words are
found (same as AND operator).

For advanced search, consider the following:

e To find a defined string of several words, enclose it in quotation marks. For
example, a search for "trigger qualification" finds all topics with exactly "trigger
qualification". A search for trigger qualification finds all topics that contain the
words frigger and qualification.

Use "Match whole word" and "Match case" to refine the search.
Use operators AND, OR, and NOT.

To close the Help window

» Select the "Close" icon in the upper right corner of the help window.
Or: Press the [ESC] key.
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71

71.1

Input Sources

Controlling Instruments and Capturing 1/Q
Data

A key feature of the R&S VSE is the ability to capture data from various instruments or
retrieve data from stored measurement files, and to analyze this data in various appli-
cations.

R&S VSE Enterprise Edition vs Basic Edition

The R&S VSE Enterprise Edition and Basic Edition differ in the number of channels,
groups, and instruments that can be configured at the same time:

Supported number of Enterprise Edition Basic Edition

Instruments 128 1

Groups 30 1

Channels 30 3

®  INPUE SOUIMCES.....coeiiieittitt ettt et et e e e e ettt ettt e it aaseaeeeeaaaaaaaaeeseeeeeesseserares 62
e  Configuring INSIIUMENTS......cciiiiiiee e aaaa s 64
e Controlling Measurement Channels, Groups, and Sequences.............ccceeveeeveeennns 82
e Configuring Measurements in Expert Mode.............coooveiriiieieieeeeeivccc e, 93
e Frequency Response Correction (R&S VSE-K544).........cooiiiiiiiiiieee 94
@ OUIPUL SEHINGS. ..t e e e e e e e 105
e Receiving and Providing Trigger SignalS...........ccoeviiiciiiiiiiiiieeee e 106

Input Sources

The input source selects the source of the data to be analyzed. You can either analyze
a live signal or a signal that has been recorded previously and whose characteristics
have been saved to a file.

Connected Instrument

Any instruments that are to provide signals to the R&S VSE must be configured in the
software. The R&S VSE then manages all connections to the other instruments. If the
instrument configured for a particular measurement channel is changed, the R&S VSE
software adapts the measurement settings, if necessary and possible. Thus, the mea-
surement and analysis tasks performed using the R&S VSE software are mostly inde-
pendent of the underlying instrument.

Currently, the following instruments can be connected to the R&S VSE software to pro-
vide signal input:
® R&S®FSW Signal and Spectrum Analyzers
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® R&S®FSWP Phase Noise Analyzer and VCO Tester

® R&S®FPS Signal and Spectrum Analyzers

® R&S®FPL1000 Signal and Spectrum Analyzers

® R&S®FSV Signal and Spectrum Analyzers

® R&S®FSV3000 Signal and Spectrum Analyzers

® R&S®FSVA3000

® R&S®FSL Signal and Spectrum Analyzers

® R&S®ZNL Network Analyzers (with R&S®ZNL3-B1 Spectrum Analyzer Mode
option)

® R&S®RTx oscilloscope product family

® R&S®PCMA Radio Test Sets

The instrument connected to and controlled by the R&S VSE software is referred to as
the connected instrument throughout this documentation.

Input sources

Depending on the type of instrument and the connectors it provides, the R&S VSE soft-
ware supports the following source of input:
® RF

Captures and analyzes the data from the RF input of the connected instrument.

® QOscilloscope Baseband Input
Captures and analyzes complex Oscilloscope Baseband Input from multiple chan-
nels of a connected R&S® oscilloscope. You must specify which channels are used
for input. Oscilloscope Baseband Input requires firmware version 3.0.1.1 or later on
the oscilloscope. Not all applications in the R&S VSE software support Oscillo-
scope Baseband Input.
For details see Chapter 10.2.5, "Oscilloscope Baseband Input", on page 177.

R&S FSW and B2000

The R&S VSE software supports input from a connected R&S FSW with a B2000
option installed. However, the R&S FSW interface to the oscilloscope must be set up
and aligned directly on the instrument before the R&S VSE software can start analyz-
ing the input.

Once the B2000 option has been aligned and activated, the R&S VSE applications can
process I/Q data with a bandwidth of up to 2 GHz, with a center frequency starting at

8 GHz, up to the maximum frequency supported by the instrument model (the useful
range may be restricted, see data sheet). The record length may be restricted by the
connected oscilloscope (see its data sheet).

For details on R&S FSW and B2000 see the R&S FSW 1/Q Analyzer and 1/Q Input
Interfaces user manual.
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@ Oscilloscope input
Input from an R&S oscilloscope with a firmware version 3.0.1.1 or higher can be provi-
ded as the original waveform data, or as converted 1/Q data. Depending on the mea-
surement requirements and the application, either format may be more suitable.

For details see "Capture Mode" on page 190.

7.1.2 File Input

Alternatively to "live" data input from a connected instrument, the R&S VSE software
can also analyze measurement data provided "offline" by a stored data file. This allows
you to perform a measurement on any instrument and store the results to a file. Then
you can analyze the stored data partially or as a whole at any time using the R&S VSE
software.

Currently, the R&S VSE software supports the following file formats as signal input:

® . ig.tar (compressed data format)

® .Csv

® _.mat (matlab)

e _igw

e .igx

For more information, see also Chapter 8.3.4, "Recalling Measurement Data from
Files", on page 126.

7.2 Configuring Instruments

Access: "Window" > "Instruments"

The R&S VSE can capture and analyze data from various instruments. These instru-
ments must be configured before measurements can be performed on them via the
R&S VSE. Instruments are configured in the R&S VSE's "Instruments" tool window.

Note: In the R&S VSE Basic Edition, you can configure only one instrument at a time.

e Remote Control Interfaces and ProtoCols..........cccueiiiiiioiiiiciiieeeeeeeeeeee e 65
e Defining the Connection Information Manually............cccceiiiiiiiiniiii e 67
e Connecting to the Host Instrument (Localhost).........occveviiiiiiieiiiiie e, 69
e Determining the Address with Software Support.........ccccccveeeiiiiiiicccee e, 70
e Searching for Connected Instruments Automatically............cccooevereriiiiiieiiiiiee, 73
e Obtaining Information on Versions and Options on the connected instrument....... 74
e Deleting All Instrument Configurations. ... 75
e |Initializing a Self-Alignment on the connected instrument.............coooooceeenn. 76
e Configuring the Behavior During Remote Control.........ccccooccueeeiiiiiinie i, 76
o Configuring the Use Of @ POWET SENSON.........coiiiiiiiiiiiiiie e 77
e Configuring a Frequency Reference for the Connected Instrument....................... 80
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Remote Control Interfaces and Protocols

The software supports different interfaces and protocols for remote control. The follow-
ing table gives an overview.

Table 7-1: Remote control interfaces and protocols

Interface Protocols, VISA" address string Remarks
Local Area | ® HiSLIP High-Speed LAN Instrument Protocol (1VI-6.1) The interface is based on TCP/IP and
Network TCPIP::host address::hislipO[::INSTR] supports various protocols.
(LAN) ° VX1 -
TCPIP: :host address::instO[::INSTR] For a description of the protocols refer
Library: VISA to:

VXI-11 Protocol
HiSLIP Protocol

") VISA is a standardized software interface library providing input and output functions to communicate with instruments. A VISA
installation on the controller is a prerequisite for remote control using the indicated interfaces.

(See also "VISA library" on page 65).

7211

LAN Interface

For remote control via a network, the PC and the instrument must be connected via the
LAN interface to a common network with TCP/IP network protocol. They are connected
using a commercial RJ45 cable (shielded or unshielded twisted pair category 5). The
TCP/IP network protocol and the associated network services are preconfigured on the
instrument. Software for instrument control and the VISA program library must be
installed on the controller.

VISA library

VISA is a standardized software interface library providing input and output functions to
communicate with instruments. The 1/O channel is selected at initialization time by the
channel-specific address string ("VISA resource string") indicated in Table 7-1, or by an
appropriately defined VISA alias (short name).

A VISA installation is a prerequisite for remote control using the LAN interface.

IP address

Only the IP address or a valid DNS host name is required to set up the connection.
The host address is part of the "VISA resource string" used by the programs to identify
and control the instrument.

The VISA resource string has the form:
TCPIP::host address|[::LAN device name] [::INSTR]
where:

® TCPIP designates the network protocol used
® host address is the IP address or host name of the device

® LAN device name defines the protocol and the instance number of a subinstru-
ment;
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— 1instO0 selects the VXI-11 protocol (default)
— hislip0 selects the newer HiSLIP protocol
® INSTR indicates the instrument resource class (optional)

Example:

® Instrument has the IP address 792.1.2.3; the valid resource string using VXI-11
protocol is:
TCPIP::192.1.2.3::INSTR

® The DNS host name is VSE-123456; the valid resource string using HiSLIP is:
TCPIP::VSE-123456::hislip0

@ Identifying instruments in a network

If several instruments are connected to the network, each instrument has its own IP
address and associated resource string. The controller identifies these instruments by
the resource string.

For details on configuring the LAN connection, see Chapter 12.3, "How to Set Up a
Network and Remote Control", on page 481.

L Y B I ] (0 Yo o 66
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VXI-11 Protocol

The VXI-11 standard is based on the ONC RPC (Open Network Computing Remote
Procedure Call) protocol which in turn relies on TCP/IP as the network/transport layer.
The TCP/IP network protocol and the associated network services are preconfigured.
TCP/IP ensures connection-oriented communication, where the order of the
exchanged messages is adhered to and interrupted links are identified. With this proto-
col, messages cannot be lost.

HiSLIP Protocol

The HiSLIP (High Speed LAN Instrument Protocol) is the successor protocol for
VXI-11 for TCP-based instruments specified by the VI foundation. The protocol uses
two TCP sockets for a single connection - one for fast data transfer, the other for non-
sequential control commands (e.g. Device Clear or SRQ).

HiSLIP has the following characteristics:

® High performance as with raw socket network connections

® Compatible IEEE 488.2 support for Message Exchange Protocol, Device Clear,
Serial Poll, Remote/Local, Trigger, and Service Request

e Uses a single IANA registered port (4880), which simplifies the configuration of fire-
walls

® Supports simultaneous access of multiple users by providing versatile locking
mechanisms

® Usable for IPv6 or IPv4 networks
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Using VXI-11, each operation is blocked until a VXI-11 device handshake returns. How-
ever, using HiSLIP, data is sent to the device using the "fire and forget" method with
immediate return. Thus, a successful return of a VISA operation such as viWrite ()
does not guarantee that the instrument has finished or started the requested com-
mand, but is delivered to the TCP/IP buffers.

For more information see also the application note:

1MA208: Fast Remote Instrument Control with HiSLIP

Defining the Connection Information Manually

Access: "Window" > "Instruments"

If you already know the network connection information of the instrument you want to
control using the R&S VSE software, you can enter it directly in the "Instruments" tool
window.

INEQUDENEN  NMeasurement Graup Setup

& Hew Instrument & search

FSw-26* (%]
Interface Trpe
Wxi-11 -

IP Acldress
1o
Resaurce String

ToPIP: 10, 15 TR
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Calibration State calibrated Self Alignment

Connedion State connectead

Infas & Settings Discannect
[N LA ] (T = o | 68
RS ] 1 68
ClOSE INSITUMEBNT.....eeciieeeeee et e e e st e e e e e e b s e e s e eab e eaeeeanan 68
T (=T = Vot Y] o = SRR 68
| = To [0 [ { YT R U SPPTPPRR 68
[N T Yo U ] (ot (4 o TR 69
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New Instrument
Displays the configuration dialog for a new instrument. You can also configure instru-
ments that are not connected to the PC running the R&S VSE software.

Note: In the R&S VSE Basic Edition, you can configure only one instrument at a time.

To configure a new instrument quickly while the "Instruments" tool window is closed,
select the "File > Instruments > New window" menu item. The "Instruments" tool win-
dow is displayed with an entry for a new instrument.

Remote command:
DEVice:CREate on page 493

Search
Starts a search for all instruments connected to the same network as the PC running
the R&S VSE software.

(See Chapter 7.2.5, "Searching for Connected Instruments Automatically”,
on page 73).

Close Instrument

You can delete an instrument that is no longer available or required by the R&S VSE
software. Select the X "Close" icon next to the instrument name in the "Instruments”
tool window.

Remote command:
DEVice:DELete on page 494

Interface Type

Specifies the interface protocol used to connect the instrument to the network.

For details on interfaces see Chapter 7.2.1, "Remote Control Interfaces and Protocols",
on page 65

"VXI-11" Standard TCP/IP-based protocol

"HiSlip" High performance protocol

Remote command:
DEVice:TARGet : TYPE on page 496

IP address
Unique IP address of the connected instrument. The five most recently selected IP
addresses are available from the dropdown list.

(To delete this list, select "File > Preset > Reset VSE Layout", see "Restoring User-
Specific Settings (Reset VSE Layout)" on page 111.)

The IP address consists of four number groups separated by dots. Each group con-
tains 3 numbers in maximum (e.g. 100.100.100.100), but also one or two numbers are
allowed in a group (as an example see the pre-installed address).

For information on how to determine the IP address see the instrument's documenta-
tion.

Remote command:
DEVice:TARGet on page 496
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Resource String

VISA resource string used by the R&S VSE to identify and control the connected
instrument. The five most recently selected resource strings are available from the
dropdown list.

(To delete this list, select "File > Preset > Reset VSE layout", see "Restoring User-Spe-
cific Settings (Reset VSE Layout)" on page 111.)

For details, see Chapter 7.2.1.1, "LAN Interface", on page 65.

Remote command:
DEVice:CREate on page 493

Advanced Settings

Opens the "VISA Resource String Builder" which supports you in determining the
required resource string, see Chapter 7.2.4, "Determining the Address with Software
Support", on page 70.

Calibration State/ Self Alignment

Indicates whether the connected instrument is calibrated. If necessary, a self-alignment
can be initiated on the connected instrument (see Chapter 7.2.8, "Initializing a Self-
Alignment on the connected instrument”, on page 76).

Connection State
Indicates the current state of the connection to the specified instrument in the network.

Remote command:
DEVice:STATe? on page 495

Infos & Settings

Displays additional information on the connected instrument, if available. See Chap-
ter 7.2.6, "Obtaining Information on Versions and Options on the connected instru-
ment", on page 74.

Remote command:
DEVice:INFO:HWINfo? on page 497
DEVice:INFO:0PT? on page 498
DEVice:INFO:IDN? on page 498

Connect / Disconnect / Reconnect
(Re-)Establishes a connection to the specified instrument in the network, or discon-
nects an existing connection.

Remote command:
DEVice:CREate on page 493
DEVice:DISConnect on page 494
DEVice:REConnect on page 495

Connecting to the Host Instrument (Localhost)

Access: "Window" > "Instruments" > "This Instrument"
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If the R&S VSE software is installed directly on a supported instrument, you can con-
nect the software to that instrument quickly and easily.

File Edit Input & Output Meas Setup  Trace  Marker |
- - p—
] m i E? ﬂ' ﬂ o’j@ — I Analyze

Measurement Group Setup Instrurnents

o Search

o This Analyzer o Mews Instrument

» In the "Instruments" tool window, select "This Instrument".

The software automatically establishes a connection to the instrument. The instrument
is displayed in the "Instruments" tool window. You can configure a measurement on
that instrument from the R&S VSE software immediately.

Determining the Address with Software Support

Access: "Window" > "Instruments" > Advanced > "VISA Resource String Builder"

If you do not know the network address of the connected instrument, the R&S VSE
software can help you determine the correct connection information using the "VISA
Resource String Builder".
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Alias Timeout

‘ FSW-8* ‘ | 3000 ‘

Remote Interface Assistant

Interface Type Address

‘LANV)(I—ll v | ||PV4 ' |

|1::- |- .= ‘- ‘

Board Number

LAN device name

VISA Resource String Status

‘TCPIP::ID._:INSTR ‘ )—G-—(
Check

N L= 71
T 41T 0TV N 71
] =T a 2= Lot Y o1 T PP 71
e [o | =Y TSN 0] ' = TP 72
| = To [0 [ £ =TT PR 72
HOSE NAMIE.... et ettt e e et e e e e e et e e e e e eaabe e e e e eeranas 72
[2To = 1o I N[0T a1 o =T SR 72
LAN dEBVICE NAME.......ccoceeii ettt e e ete e e e e e ee e e e e e e e eabe e e e e e eesaaaeeeeeenannns 72
VISA RESOUICE SENG...ciiiiiiiiiiiiiiiiiee ettt ettt sttt ettt e e e s st et e e e s snbee e e e s abeeeeesanee 72
] = 0N 72
CBCK ..ottt ettt et e e e e e e e et et ettt e e e ae bbb aeieaeeeeaaaaeaerererrrra———————————————— 73
Alias

A logical name used to identify the instrument more easily in the network and connec-
tion settings in the R&S VSE software.

Timeout
Time in which the network connection to the instrument must be established before the

attempt is aborted.

Interface Type
Specifies the interface protocol used to connect the instrument to the network.
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For details on interfaces see Chapter 7.2.1, "Remote Control Interfaces and Protocols",
on page 65

"VXI-11" Standard TCP/IP-based protocol
"HiSlip" High performance protocol

Remote command:
DEVice:TARGet : TYPE on page 496

Address (format)
Defines the format used to specify the instrument's network address

"IPv6" Internet protocol version 6

"IPv4" Internet protocol version 4

"Host name" Computer name of the instrument instead of IP address
IP address

Unique IP address of the connected instrument. The five most recently selected IP
addresses are available from the dropdown list.

(To delete this list, select "File > Preset > Reset VSE Layout", see "Restoring User-
Specific Settings (Reset VSE Layout)" on page 111.)

The IP address consists of four number groups separated by dots. Each group con-
tains 3 numbers in maximum (e.g. 100.100.100.100), but also one or two numbers are
allowed in a group (as an example see the pre-installed address).

For information on how to determine the IP address see the instrument's documenta-
tion.

Remote command:
DEVice:TARGet on page 496

Host name
Unique host computer name of the connected instrument (if Address (format) is "Host
name".

Board Number
Unique board number of the connected instrument.

LAN device name
Defines the protocol and the instance number of a sub-instrument;

"inst0" VXI-11 protocol
"hislip0" HiSLIP protocol

VISA Resource String
The VISA resource string determined from the defined information, to be used by the
R&S VSE to identify and control the connected instrument.

For details, see Chapter 7.2.1.1, "LAN Interface", on page 65.

Status
Indicates the current state of the connection to the specified instrument in the network
after a Check was performed.
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Check
Checks the connection state to the instrument specified by the VISA resource string.
The result is indicated under Status.

Searching for Connected Instruments Automatically

Access: "Window" > "Instruments" > "Search"

Alternatively to defining the connection information manually, the R&S VSE can search
for all instruments connected to the same network as the PC running the R&S VSE
software. You can then select the instrument you want to control with the R&S VSE
software from the detected instruments.

Interface Type
Search Stop LAN VXI-11
Results
Interface Type Model Name VISA Resource String

LAN WXI-11 R&S FSW Spectrum Analyzer | W' || TCPIPO::10. N ::instO::IN
Filter
‘FSWI ‘ Connect LXI ‘

7= T= (o] o SRR 73
) (o] o TP PUUURR 74
T (=T =Yoo = T PP 74
LS TS] U €N 74
1 (Y R 74
(7o) a1 aT<Yox B 1. R 74
Search

Starts a network search for connected instruments using the specified Interface Type.

Note that this search can take a while. Results are only displayed when the search is
completed.
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Stop
Stops a search for connected instruments.

Interface Type
Specifies the interface protocol used to connect the instrument to the network.

For details on interfaces see Chapter 7.2.1, "Remote Control Interfaces and Protocols",
on page 65

"VXI-11" Standard TCP/IP-based protocol
"HiSlip" High performance protocol

Remote command:
DEVice:TARGet : TYPE on page 496

Results
For each instrument detected in the network, the following information is provided:
® |nterface Type
® Instrument model name
® VISA Resource String
(The full information is displayed when you select the arrow button for a result
entry.)

Filter
Applies a filter to the instrument search. Only instruments whose resource string con-
tains the specified characters are displayed.

Connect LXI

Opens the LXI configuration home page for the connected instrument. This allows you
to configure or operate the instrument directly from a Web browser. For details see the
instrument's user documentation.

Obtaining Information on Versions and Options on the connected
instrument

Access: "Window" > "Instruments" > "Info & Settings" > "Info" tab

Information on the firmware version and options installed on the connected instrument
is provided.
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General Reference Info

Ino & Settings: FSW - IR Y

Device Options

1
Identification String: Rohde&:Schwarz, FSW-3,1312.83000K08,/101366,2.10
Option Mame
B3 AM/FM Audio Demaodulator
B3 Resolution Bandwidth > 10 MHz
B13 Highpass Filter for Harmonic Measurements
B24 RF Preamplifier
B25 Electronic Attenuatar
B28 28 MHz Analysis Bandwidth
R4 40 MH7 &nalvsis Randwidth
[entification STING.......eoiii et e e s e e 75
L] 0] 1] 1= USEUURR 75

Identification String
Indicates the instrument identification for the selected instrument.

The syntax is:

"Rohde&Schwarz,<instrument type>,<part number>/serial
number>, <firmware version>"

Remote command:
DEVice:INFO:IDN? on page 498

Options
Provides a list of all hardware and software options installed on the instrument.

For details on options, refer to the instrument's documentation.

Remote command:
DEVice:INFO:HWINfo? on page 497
DEVice:INFO:OPT? on page 498

Deleting All Instrument Configurations

Access: "File" > "Instruments" > "Delete All"

You can delete the connection settings of all defined instruments in one step. Note that
after deleting a connection, the instrument is no longer known to the R&S VSE soft-
ware.

Instrument configurations are also deleted when you use the preset function "File" >
"Preset" > "All & Delete Instruments”, see "Restoring All Default Settings and Deleting
Instrument Configurations (Preset All & Delete Instruments)” on page 110.
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Remote command:

DEVice:DELete:ALL on page 494

Initializing a Self-Alignment on the connected instrument

Access: "Window" > "Instruments" > "Self Alignment"

Once configured, you can perform a self-alignment on any instrument connected to the
R&S VSE software.

When you put the instrument into operation for the first time or when strong tempera-
ture changes occur, it may be necessary to align the data to a reference source.

During instrument start, the installed hardware is checked against the current firmware
version to ensure the hardware is supported. If not, self-alignment fails until the firm-
ware version is updated.

The correction data and characteristics required for the alignment are determined by
comparing the results at different settings with the known characteristics of the instru-
ment's high-precision calibration signal source.

Remote command:

DEVice:CALibrate[:INIT] on page 501

DEVice:CALibrate[:INIT] :ABORt on page 501

Configuring the Behavior During Remote Control

Access: "Window" > "Instruments" > "Infos &Settings" > "General" tab

When the R&S VSE software is used to capture and analyze input from a connected
instrument, the instrument is operated in remote mode. Some general settings are
available to define how the instrument behaves during remote control and whether
access by multiple users to the same instrument is allowed.

General Reference Info

Remote Display

Local Lockout Off
Display Update Cn

VISA connection

WVISA lock state On
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Local Lockout
If enabled, the instrument is set to be controlled remotely (that is, by the R&S VSE soft-
ware) and the keys or graphical user interface are disabled.

See also Chapter 12.1.7, "Locking Instruments for Exclusive Remote Control",
on page 478.

Remote command:
DEVice:GENeral : LLO on page 499

Display Update
Defines whether the display of the connected instrument is updated while it is being
controlled by the R&S VSE software.

Turning off the display update function improves performance.

Tip: you can also turn off the display update function for the R&S VSE software, see
"Remote Display Update" on page 480.

Remote command:
DEVice:GENeral :DISPlay on page 499

VISA lock state

Locks or unlocks the VISA connection to the selected instrument. If the connection is
locked, no other devices can operate the same instrument remotely. If no connection to
the instrument has been established yet, any subsequent connection to it is locked
immediately (see also Chapter 12.1.7, "Locking Instruments for Exclusive Remote
Control", on page 478).

Tip: you can change the default value for the VISA lock for subsequent connections in
the user preferences, see "Lock new VISA connections" on page 480.

Remote command:
DEVice:LOCKing on page 500
DEVice:LOCKing:ALL on page 500

Configuring the Use of a Power Sensor

Access: "Window" > "Instruments" > "Infos &Settings" > "General" tab / "Reference"
tab

You can connect an R&S NRQ6 power sensor to the R&S VSE software. In this case,
some additional general and reference settings are available.
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m Reference  Info

r Remate Display ————————————————  Master/ Slawe Settings
Syhc Mode Marne Mazter Slawe
Local LDCkDUt
Mazter Trigger Source Host-Interface [Extl) Ext 2
Display Upcite [ o | o]
Trigger Output Port Off Host-Interface [Extl) Ext2

r WISA Connection

WISA Lock State off an

Figure 7-1: Power sensor general settings

General Info

|

r Reference Frequency Input

r L0 & Sampling CLK————

= L& Source Int f=as
@ Interhal Reference

External Reference 10 MHz LO Out On L
Frequency | 10.0 MHz

() Ext.Reference 10|20]30/40 MHz sampl. CLK Source ||Int .

Sync Trigger
Sampl, CLE Qut [o1f Off

r Reference Frequency Output

output 100 MHz (| On |
Output 640 MHz || O |

Cutput Sync Trigger -

o] ]
H H

Set To Default

Figure 7-2: Power sensor reference settings
For details see the R&S NRQ6 user manual.

External reference settings for the power sensor are described in

O An application sheet describes the use of the R&S NRQ6 as an 1/Q data source for the
= R&S VSE software. It has the title "VSE Feed (I/Q Capturing)" and is available at:

www.rohde-schwarz.com/manual/NRQ6

Sync Mode

.................................................................................................................... 79
=TS (= W e o =Y S To T U o= PR 79
LI e o L= @ U1 01U | =) S PUPPURR 79
Local OsCillator (LO) = SOUICE.......uuiiiiiiiiieeee e e e e ettt e e e e e e e ee et re e e e e e e e e e s s eannreaeeees 79
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Sync Mode

Requires the R&S NRQ6-K1 and -K3 options.
Defines the synchronization mode for phase-coherent measurements.
"Off" No synchronization

"Master" If the R&S NRQ6 is the trigger master, the power sensor outputs a
digital trigger signal in sync with its own trigger event. The trigger sig-
nal is output at the selected port (see "Trigger Output Port"
on page 79).

"Slave" The R&S NRQ6 is triggered by the master (the connected instru-
ment).

Remote command:
[SENSe: ] TRACe:IQ:SYNC:MODE on page 568

Master Trigger Source
Effective only if the R&S NRQ6 is trigger master (see Sync Mode):

Selects the trigger input for the R&S NRQ6.

"Free Run" Default: the R&S NRQ6 triggers when a measurement is started in
the R&S VSE software.

"Host-Interface  The R&S NRQ6 "Host Interface" connector provides the trigger sig-
(Ext1)" nal.

"Ext2" The R&S NRQ6 "Trigger 2 1/0" connector provides the trigger signal.

Remote command:
TRIGger:IQ:MASTer : SOURce on page 569

Trigger Output Port
Effective only if the R&S NRQ6 is trigger master (see Sync Mode):

Selects the port where the R&S NRQG6 outputs a digital trigger signal.
"Off" Default: the trigger master uses its internal trigger source

"Host-Interface  The R&S NRQ6 "Host Interface" connector is used as external trigger
(Ext1)" output port.

"Ext2" The R&S NRQ6 "Trigger 2 1/0" connector is used as external trigger
output port.

Remote command:
TRIGger:MASTer : PORT on page 568

Local Oscillator (LO) - Source
Sets the local oscillator source for the power sensor.

"Internal” Uses the internal LO signal.

"External" Uses the external LO signal fed into the LO connector. The internal
LO generation is disabled.
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Remote command:
[SENSe: ] FREQuency:CONVersion:MIXer:LO:SOURce on page 566

LO Out

Enables or disables the output of the power sensor's local oscillator signal.

"Off" No signal is output. You can use the LO connector as an input.
"On" LO signal is output.

Remote command:
[SENSe: ] FREQuency:CONVersion:MIXer:LO:OUTPut: STATe on page 566

Sampl. CLK Source
Sets the sampling clock source for the power sensor. By default, the R&S NRQ6 gen-
erates its sampling clock internally. Alternatively, you can use external clock sources.

"Internal” Uses the internal sampling clock.

"External" Uses the external sampling clock signal fed into the CLK connector.
The internal sampling clock is disabled.

Remote command:
[SENSe:]ROSCillator:PASSthrough on page 567

Sampl. CLK Out
Enables or disables the output of the power sensor's sampling clock signal.

"Off" No signal is output. You can use the CLK connector as an input.
"On" Sampling clock signal is output.

Remote command:
[SENSe:]SAMPling:CLKio:OUTPut on page 567

Configuring a Frequency Reference for the Connected Instrument

Access: "Window" > "Instruments" > "Infos & Settings" > "Reference" tab

An connected instrument can use the internal reference source or an external refer-
ence source as the frequency standard for all internal oscillators. A crystal oscillator is
used as the internal reference source. If an external reference is used, all internal oscil-
lators of the connected instrument are synchronized to the external reference fre-
quency.

External references must be connected to the connected instrument correctly.

For details see the instrument's "Getting Started" manual.
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Info 8 Settings: FSW-8*

Reference Frequency Input

() Internal Reference Tuning Range +{-0.5 ppm
@ External Reference 10 MHz @ =+/-&ppm
() External Reference 1..20 MHz
- Frequency 10.0 MHz
) External Reference 100 MHz
Loop Bandwidth 10 Hz -

) sync Trigger

Reference Frequency Output

Cutput 100 MHz on Cutput Sync Trigger on
Output 640 MHz On

Set To Default

The default setting is the internal reference. When an external reference is used, "EXT
REF" is displayed in the status bar.

Reference Frequency INPUL SOUICE.........ccooiiiiiiiiieeeeeeee e e e e e e e e e eeeees 81
TUNING RANGE.... et e e s e e e e s abr e e e e s ennneee s 81
(=T o [ 5= o3 PSP POPPP 81
e To] o = 7= T T 117/ T 1| o 82
Reference FrequenCy OULPUL.........uuuiiiiiiii i e e e e e 82
Resetting the Default ValUEs..........oovii i 82

Reference Frequency Input Source

Various sources are available to provide a reference frequency to the connected instru-
ment, depending on the type of instrument. The available reference parameters also
depend on the instrument type.

Remote command:
DEVice:EXTRef : SOURce on page 503

Tuning Range

The tuning range is only available for the variable external reference frequency. It
determines how far the frequency may deviate from the defined level in parts per mil-
lion (10°6).

Remote command:

DEVice:EXTRef : TRANge on page 504

Frequency
Defines the external reference frequency to be used (for variable connectors only).

Remote command:
DEVice:EXTRef: FREQuency on page 501

User Manual 1176.8839.02 — 14 81



R&S®VSE

Controlling Instruments and Capturing I/Q Data

7.3

7.3.1

®

Controlling Measurement Channels, Groups, and Sequences

Loop Bandwidth
Defines the speed of internal synchronization with the reference frequency. The setting
requires a compromise between performance and increasing phase noise.

Remote command:
DEVice:EXTRef:LBWidth on page 502

Reference Frequency Output

The connected instrument can provide a reference frequency to other instruments that
are connected to this instrument. If one of the options is activated, the reference signal
is output to the corresponding connector.

Remote command:
DEVice:EXTRef:0100 on page 502
DEVice:EXTRef:0640 on page 502
DEVice:EXTRef:0SYNc on page 503

Resetting the Default Values

The values for the "Tuning Range", "Frequency" and "Loop Bandwidth" are stored for

each source of "Reference Frequency Input”. Thus, when you switch the input source,
the previously defined settings are restored. You can restore the default values for all

input sources using the "Preset Channel" function.

Controlling Measurement Channels, Groups, and
Sequences

Access: "Window" > "Measurement Group Setup"

Measurement channels, groups, and sequences are configured and controlled in the
"Measurement Group Setup" tool window.

®  SEQUENCE FUNCHONS......ciiiiiiiicceieie e e ettt se s e e e e e e e aaaaeaaaeeeeeeeees 82
L I €1 (o 1N o 3N U1 g o3 1 oo 75 84
®  Channel FUNCHIONS. .....oi et e e e e e e 87

Sequence Functions

A measurement sequence can perform multiple measurements on the same instru-
ment, without switching between measurement channels manually.

A measurement sequence consists of a number of measurement groups, and each
group may contain multiple channels.

In the R&S VSE Basic Edition, you can configure only one group with up to three chan-
nels at a time. In this case, the sequence functions have the same effect as the group
functions (see Chapter 7.3.2, "Group Functions", on page 84).

User Manual 1176.8839.02 — 14 82



R&S®VSE Controlling Instruments and Capturing I/Q Data

Controlling Measurement Channels, Groups, and Sequences

The functions for a measurement sequence are provided above and below the mea-
surement groups in the "Measurement Group Setup" tool window.

For details, see "Measurement groups and sequences" on page 38.

heasurement Group Setup ISy

© New Group © Channel SE Replace Channel
= [V Group 1 P o |
= I Analyzer ’ 11 (:) [ ] n

Instrument File

Instrument:
@ F5i-26% v
Input Source:
RF T
| 4
=¥ Group 2 PO X |

Instrumemnt File

Instrument:
@9 FPL10D3* ©

Input Source:

RF M
P Play ) CONT Iﬂ‘
= S 83
] (o o USSR 83
Measurement mode (Single/CONtINUOUS)......cccoiiiiiiiiiiiiieee et 84
[C=ToTo] (o FU PP PP PPPPPPPTP 84

p Play
"Play" starts a new measurement sequence according to the "Measurement mode

(Single/Continuous)" on page 84.

Remote command:
INITiate:SEQuencer:IMMediate on page 545

I Stop
Stops a running measurement sequence.

Remote command:
INITiate:SEQuencer :ABORt on page 545
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Measurement mode (Single/Continuous)
Defines the measurement mode for the entire measurement sequence and all mea-
surement groups and channels it contains.

For details, see "Measurement mode" on page 39.

"Single" Each measurement group is started one after the other in the order of
definition. All measurement channels in a group are started simulta-
neously and performed once. After all measurements are completed,
the next group is started. After the last group, the measurement
sequence is finished.

"Continuous" Each measurement group is started one after the other in the order of
definition. All measurement channels in a group are started simulta-
neously and performed once. After all measurements are completed,
the next group is started. After the last group, the measurement
sequence restarts with the first one and continues until it is stopped
explicitly (see "Play" on page 83).

Remote command:

INITiate:SEQuencer:MODE on page 545

Record
Currently not available.

Group Functions
All measurement channels that are to be started at the same time must be configured
within a group.

Multiple groups of measurement channels can be configured (Enterprise Edition only),
for example to group measurements for a specific test scenario.

The functions for a measurement group are provided in a function bar with the group
name in the "Measurement Group Setup" tool window.

For details, see "Measurement groups" on page 36.
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IGEGUNEINCE  TMeasurament Group Setup

© Mew Graup © Channel SE Replace Channel

= Group 1

= 1) Analyzer | E]
Instrument
Fil=:

c/temp/IgRecarding_1233.iq.tar

IQ Analyzer -
=l [] 16 Analyzer 2 Pl e [E
Instrument File
Instrument:
@ Fsw-26™ -

Input Saurce:

Instrument:

@ Fsw-26* E

Input Saurce:

[& The "running" icon in the group function bar indicates that the group is currently per-
forming a measurement (within a sequence, see "Measurement groups and sequen-
ces" on page 38).
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Yo 0] o PR 86
L0301 SRR 86
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Activate/Deactivate Group
If activated, the group is included in a measurement sequence.

Remote command:
INSTrument :BLOCk: USE on page 544
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New Group
Inserts a new group in the "Measurement Group Setup" tool window.

Note: In the R&S VSE Basic Edition, you can configure only one group.

Remote command:
INSTrument :BLOCk:CREate [ :NEW] on page 533

Capture

Starts a new measurement (and restarts averaging) for all active measurement chan-
nels in the group. Only channels with distinct input types can be active at the same
time. The results for each channel are displayed whenever the measurement is com-
pleted, independently of the other channels.

Remote command:
INITiate:BLOCk:IMMediate on page 531

Pause / Cont
"Pause" stops a running measurement on the group.

"Cont" continues a measurement group (including any averaging procedures) that was
temporarily interrupted.

To restart averaging with the next measurement, use the » ("Capture") function after
stopping the last channel.

Remote command:
INITiate:BLOCk:ABOREt on page 530
INITiate:BLOCk:CONMeas on page 530

Measurement mode (Single/Continuous)
Defines the measurement mode for the group itself and all measurement channels it
contains.

For details, see "Measurement mode" on page 39.

"Single" All measurement channels in the group are started simultaneously
and performed once.

"Continuous"  All measurement channels in the group are started simultaneously.
After all measurements are completed, the group restarts all mea-
surements again.

Remote command:
INITiate:BLOCk:CONT on page 531

Record
Currently not available.

Close
Removes the group and closes all measurement channels and windows it included.

Note: In the R&S VSE Basic Edition, you cannot delete the group as there is only one.

Remote command:
INSTrument :BLOCk:DELete on page 533
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Rename Group
Access: "File" > "Measurement Group" > "Rename Group"

Or: Double-click (slowly) on group name in the "Measurement Group Setup" tool win-
dow

The selected group name turns into an input box so you can enter a user-defined
name. Note that you cannot assign an existing group name to another group.

MMeasurement Group Setup

& Mew Graup

Remote command:
INSTrument : BLOCk : REName on page 544

Channel Functions
A measurement channel determines the measurement settings for a specific applica-
tion.

The functions for a measurement channel are provided in a function bar with the chan-
nel name in the "Measurement Group Setup" tool window.

For details, see "Measurement channels" on page 34.

= IQ Analyzer 2 Il @ E
File
Instrument:
& FSW- 26+ M

Input Source:

[& The "running" icon in the channel function bar indicates that a channel is currently
performing a measurement.

U The "error" icon in the channel function bar indicates that an error occurred in the
measurement channel. Check the R&S VSE status bar.

Activate/Deactivate Channel........... ..o 88
Assigning the Channel INPUt SOUICE........ooiuiiiiiiiii e 88
L Input Type (INStruMENt / Fil€).......c.eueveveeeeeeeeeeeeeeeeeeeeeeeeee et eeees e e e eseesaeaeenee 88

L INSHIUMENL. ..ottt et en e et nnn e 88

L INPUL SOUICE. ...ttt ee et en e et s 88
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L CRANNEL ..ttt 90
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Activate/Deactivate Channel
If activated, the measurement is included in a group measurement.

Note that channels are deactivated automatically if the same instrument is assigned to
multiple measurement channels of the same group (Enterprise Edition only). The chan-
nel to which the instrument was previously assigned is deactivated (the checkmark is
removed).

Remote command:
INSTrument :BLOCk:CHANnel [ : SETTings] : USE on page 532

Assigning the Channel Input Source

For each measurement channel, the input source must be configured. The following
settings are displayed when you expand the channel settings in the "Measurement
Group Setup" tool window (toggle the +/- icon).

Input Type (Instrument / File) — Assigning the Channel Input Source
Selects an instrument or a file as the type of input provided to the channel.

Note: External mixers are only available for input from a connected instrument.

Remote command:
INSTrument :BLOCk:CHANnel [ : SETTings] : SOURce<si> on page 521
INPut<ip>:SELect on page 594

Instrument — Assigning the Channel Input Source
Specifies a configured instrument to be used for input.

Remote command:
INSTrument :BLOCk:CHANnel [ : SETTings] : DEVice<d> on page 520

Input Source < Instrument — Assigning the Channel Input Source
Configures the source of input (and channel) on the selected instrument to be used.

Note: External mixers are only available for RF input.
Not all input sources are supported by all R&S VSE applications.

"RF" Radio Frequency ("RF INPUT" connector)

"Channel 1 | Channel 2 | Channel 3 | Channel 4 "
Oscilloscope input channel 1, 2, 3, or 4
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"Channel 1,2 (I+Q)"
I/Q data provided by oscilloscope input channels 1 and 2 (for oscillo-
scopes with 2 channels only)

"Channel 1,3 (1+Q) | Channel 2,4 (1+Q)"
I/Q data provided by oscilloscope input channels 1 and 3, or 2 and 4
(for oscilloscopes with 4 channels only)

"Channels 1-4 (diff. [+Q)"
Differential 1/Q data provided by oscilloscope input channels (for oscil-
loscopes with 4 channels only):
Channel 1: | (pos.)
Channel 2: T (neg.)
Channel 3: Q (pos.)
Channel 4: Q (neg.)

"Channels 1,3 Waveform data provided by oscilloscope input channels 1 and 3 (for
(Waveform)" oscilloscopes with 2 channels only)

"Channels 2,4 Waveform data provided by oscilloscope input channels 2 and 4 (for
(Waveform)" oscilloscopes with 2 channels only)

"Channels 1-4 Waveform data provided by oscilloscope input channels 1 to 4 (for
(Waveform)" oscilloscopes with 4 channels only)

Remote command:
INSTrument :BLOCk:CHANnel [ : SETTings] : SOURce<si>:TYPE on page 521
INSTrument :BLOCk:CHANnel [ : SETTings] : SOURce<si>:CONFig on page 521

File — Assigning the Channel Input Source
Specifies the 1/Q data file to be used for input.

Select a file from the list of recently loaded files, or select "..." to open the "Recall 1/Q
Recording" dialog box (see Chapter 8.3.4.1, "Loading the 1/Q Data File and Essential
Measurement Information"”, on page 127).

Note: The data to be imported must be stored in a specified file format, see Chapter E,
"Reference: Supported 1/Q File Formats", on page 915.

Encrypted . wv files can also be used as input. Note, however, that traces resulting
from encrypted file input cannot be exported or stored in a saveset (see Chapter 8.3,
"Recording and Recalling Captured 1/Q Data for Evaluation", on page 119 and Chap-
ter 8.5, "Storing Graphical Results to an ASCII File", on page 138).

Tip:

You can load a file simply by selecting it in a file explorer and dragging it to the

R&S VSE software. Drop it into the "Measurement Group Setup" window or the chan-
nel bar for any channel. The channel is automatically configured for file input, if neces-
sary. If the file contains all essential information, the file input is immediately displayed
in the channel. Otherwise, the "Recall I/Q Recording" dialog box is opened for the
selected file so you can enter the missing information.

If the file contains data from multiple channels (e.g. from LTE measurements), it can be
loaded to individual input sources, if the application supports them.

For more information see "To import data via drag&drop" on page 441.
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Remote command:

INSTrument :BLOCk:CHANnel [ : SETTings] : FILE<fi>:IQTar on page 509
INSTrument :BLOCk:CHANnel [ :SETTings] : FILE<fi>:CSV on page 506
INSTrument :BLOCk:CHANnel [ :SETTings] :FILE<fi>:IQW on page 510
INSTrument :BLOCk:CHANnel [ :SETTings] : FILE<fi>:MAT on page 513
INSTrument :BLOCk:CHANnel [:SETTings] :FILE<fi>:REPLace on page 516
INSTrument :BLOCk:CHANnel [ : SETTings] : FILE<fi>:WV on page 519
INSTrument :BLOCk: FILE<fi>:CSV on page 535

INSTrument :BLOCk:FILE<fi>:TIQTar on page 536

INSTrument :BLOCk:FILE<fi>:IQW on page 537

INSTrument :BLOCk: FILE<fi>:MAT on page 540

INSTrument :BLOCk:FILE<fi>:REPLace on page 541

INSTrument :BLOCk:FILE<fi>:WV on page 542

Channel < File — Assigning the Channel Input Source

Determines which of the 1/Q channels stored in the file is to be restored to the selected
measurement channel. This is relevant only for files that contain data from multiple
channels.

"Auto" imports all available channels in the file, if supported by the application.

Remote command:

INSTrument :BLOCk:CHANnel [ :SETTings] : FILE<fi>:STReam on page 519
INSTrument :BLOCk :CHANnel [ : SETTings] : FILE<fi>:STReam:AUTO

on page 518

To determine which data channels are available: INSTrument :BLOCk : CHANnel [ :
SETTings] :FILE<fi>:STReam:LIST? on page 518

Zero Padding <— Assigning the Channel Input Source

Enables or disables zero padding for input from an I/Q data file that requires resam-
pling. For resampling, a number of samples are required due to filter settling. These
samples can either be taken from the provided I/Q data, or the software can add the
required number of samples (zeros) at the beginning and end of the file.

If enabled, the required number of samples are inserted as zeros at the beginning and
end of the file. The entire input data is analyzed. However, the additional zeros can
effect the determined spectrum of the I/Q data. If zero padding is enabled, a status
message is displayed.

If disabled (default), no zeros are added. The required samples for filter settling are

taken from the provided 1/Q data in the file. The start time in the R&S VSE Player is
adapted to the actual start (after filter settling).

Note: You can activate zero padding directly when you load the file, or afterwards in
the "Input Source" settings.

Remote command:
INPut<ip>:FILE:ZPADing on page 505

e xr New Channel
A selection list of available applications is displayed. A new channel for the selected
application is created.
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For a list of available applications, see Chapter 5.2, "Available Applications",

on page 40

If necessary, obtain a license for the application as described in "To obtain a new
license or return a license for an application" on page 20.

Remote command:
INSTrument:CREate [ :NEW] on page 526
INSTrument [:SELect] on page 529

Duplicate Current Channel < New Channel

Alternatively to selecting a new application from the selection list of available applica-
tions, you can duplicate the currently active channel. In this case, a new measurement
channel of the same type and with the identical measurement settings is started. The
name of the new channel is the same as the copied channel, extended by a consecu-
tive number (e.g. "Spectrum” -> "Spectrum 2").

Remote command:
INSTrument:CREate:DUPLicate on page 526

Replace Current Channel
A selection list of available applications is displayed. The currently selected channel is
replaced by the selected application.

For a list of available applications, see Chapter 5.2, "Available Applications",
on page 40

If necessary, obtain a license for the application as described in "To obtain a new
license or return a license for an application" on page 20.

Remote command:
INSTrument:CREate:REPLace on page 527

> Capture
Starts a new measurement (and restarts averaging) for the measurement channel.

Remote command:
INITiate<n>[:IMMediate] on page 525

[l Pause/Cont
"Pause" stops a running measurement.

"Cont" continues a measurement (including any averaging procedures) that was tem-
porarily interrupted.

To restart averaging with the next measurement, use the ® ("Capture") function after
stopping the last measurement.

Remote command:
ABORt on page 523
INITiate<n>:CONMeas On page 524

—| Measurement mode (Single/Continuous)
Defines how data is captured during the measurement.

For details, see "Measurement mode" on page 39.
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=+/"Single" A single measurement is performed, that is: data is captured for the
specified measurement time.
For the "Input Source": "File", a single record is replayed. To replay
subsequent records, continue the measurement using the Il ("Pause/
Continue") function.

@"Continuous" A continuous measurement is performed, that is: data is captured
continuously until the measurement is stopped manually using the Il
("Pause/Continue") function.

For the "Input Source": "File", the data from the 1/Q file is replayed
continuously until stopped.

Remote command:
INITiate<n>:CONTinuous on page 524

Record

Starts a measurement and stores the measurement data to a temporary file. You can
then use the data in the stored file as input for analysis later or using a different appli-
cation.

For details, see Chapter 8.3.1, "Recording Measurement Data", on page 120.

Remote command:
INSTrument :BLOCk:CHANnel [ : SETTings] :RECord on page 526

New Measurement Window
Adds a new window with the selected result display for the measurement channel.

Close
Removes the measurement channel from the group and closes all windows.

Select Channel

10 Analyzer ~

Selects a channel from the list of configured channels in the "Control" toolbar.

In the "Measurement Group Setup" window, the selected channel is highlighted. The
corresponding channel bar info is displayed and the focus is set on the default window
for that channel. The menus are adapted to the selected application.

Remote command:
INSTrument [ :SELect] on page 529

Rename Measurement Channel
Access: "File" > "Measurement Group" > "Rename Measurement Channel"

Or: Double-click (slowly) on channel name in the "Measurement Group Setup" tool win-
dow

The selected channel name turns into an input box so you can enter a user-defined
name. Note that you cannot assign an existing channel name to another channel.
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Configuring Measurements in Expert Mode

Remote command:
INSTrument : REName on page 529

Configuring Measurements in Expert Mode

Access: "Meas Setup" > "Expert mode"

The R&S VSE software provides an expert configuration mode for supported

Rohde & Schwarz oscilloscopes. Using this mode, you can configure a connected
oscilloscope independently of the R&S VSE software. Thus, you can configure settings
that are not accessible directly via the R&S VSE software. You can then perform a
measurement on the connected instrument from the R&S VSE software as usual. If
any conflicts are to be expected due to the changed settings, a warning is displayed.

We recommend using the expert mode only to configure settings not otherwise suppor-
ted by the R&S VSE software.

If expert mode is disabled (default behavior) you cannot change settings directly on a
connected instrument. The R&S VSE software sets any connected instruments to
remote mode automatically. The instrument's display is blocked for local operation.
Even if you return to local mode on the instrument manually, the software automatically
resets it to remote mode as long as the instrument remains connected in the software.

During expert mode, you cannot configure the connected instrument or the measure-
ment channel in the R&S VSE software. You must manually disable expert mode first.

Expert mode is automatically disabled if you change the assigned instrument or input
source (channel) for the measurement channel.

Modified settings

When you disable expert mode, the R&S VSE software checks whether any settings
on the connected instrument are not identical to those in the software. In this case, you
have the following possibilities:
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Changes were made on the device during Expert mode which are not reflected in the VSE.
Please select how to proceed:

Revert all changes made on the device back to the setting before activation of the Expert mode.
All changes on the device are lost.
[Recommended)

Please select all the settings which you would like to keep and synchronize with the VSE as best as possible.
O Unchecked settings will be kept unchanged, but are out of sync with VSE.
[May cause the measurement to fail or be inaccurate)

Channel 1Y Axis Range

10 Mode Demodulation Bandwidth
Channel 1 Center Frequency
Trigger Source

Channel 1 Reference Level
Channel 1 Recard Length

1Q Analyzer

QK

Revert all changes
The settings on the instrument are reset to those defined in the

R&S VSE software before activating expert mode.

Synchronize settings

A list of changed settings on the instrument is displayed. Select the
settings you want to maintain. The R&S VSE software tries to syn-
chronize the settings, that is: adapt the settings defined in the soft-
ware accordingly, if possible. Note that interdependent settings can
be changed as well, such as the record length for a changed sample
rate. Any changed settings that are not selected are maintained on
the instrument, but do not correspond to the settings in the software.
In this case, the measurement can fail or be inaccurate.

7.5 Frequency Response Correction (R&S VSE-K544)

O If the Frequency Response Correction option is installed, the R&S VSE supports fre-
= quency response correction using Touchstone (. snp) files or . fres files.

The Frequency Response Correction option requires a separate license, see Chap-
ter 3.4, "Using a License Server", on page 19.
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Frequency Response Correction (R&S VSE-K544)

Basics on Frequency Response Correction

Input-specific frequency correction

Frequency response correction can be configured individually for all available input
types (RF, oscilloscope baseband channels, file). The settings in the "User-defined Fre-
quency Response Correction" dialog box apply to the currently selected input type. Be
sure to select the appropriate input source before you define the correction data (see
"Assigning the Channel Input Source" on page 88). In remote operation, be sure to use
the correct command for the required input type (see "Input-specific frequency correc-
tion" on page 547).

Otherwise the correction may seem to fail because it was defined for a different input
type than the one being used.

MIMO measurements

For MIMO measurements, which use multiple input sources, frequency response cor-
rection can be configured individually for each source.

Touchstone (.snp) files

Touchstone (. snp) files contain data to characterize a measurement setup in respect
to the gain and phase error over frequency. Such files are generated by network ana-
lyzers, for example. The R&S VSE can use such files to compensate for any gain or
phase errors between the DUT and the connection from the DUT to the instrument.

Touchstone files can be defined for a varying number of input and output ports. The
total number of ports configured in the file is indicated by the file extension; the "n"

in . snp is merely a placeholder. Thus, a file for a cable with one input and one output
is referred to as an S2P file. A file for a switch with one input and 3 outputs is referred
to as an S4P file etc.

fres files

Additional frequency response correction files in . fres format allow you to correct
effects from components for which no Touchstone files are available.

Files in . fres format correspond to an S1P file. They contain exactly three values for
each frequency:

® The frequency
® The magnitude correction value
® The phase correction value

Instead of the magnitude and phase correction values, the | and Q values can be provi-
ded.

These values are applied to the input data. If the file contains any other data, it cannot
be loaded.

For . fres files, magnitude and phase correction can be activated separately.
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Group delay compensation

The phase correction values can be used to compensate for a group delay. However,
to calculate the correction correctly, the distance between two values must not be too
large. Thus, the application requires a minimum number of values in the correction file.
Define at least enough values so the following equation is true:

Group delay * Frequency Spacing * 360 < 180

Combining multiple correction files

Since the measurement setup may consist of several cables, DUTs and other compo-
nents, multiple Touchstone and frequency response files can be required for full com-
pensation. In this case, the order in which the files are applied is important. The

R&S VSE combines all active Touchstone files to a single S2P file, and creates the
required filter or correction factors for the measurement.

For MIMO measurements, separate filters are created and used for each input source.

@ Correction filters for 1/Q data
Filters can only be applied to 1/Q data if they are defined for the complete analysis
bandwidth. Therefore, if the combined frequency response filter does not cover the
complete analysis span, it is invalid and cannot be used for the measurement. See
also "Recognizing frequency response correction in measurement results"
on page 96.

Correcting data in one or more applications

Frequency response correction files can be configured either for the current application
only, or for all measurement channels.

Thus, you can configure different files for individual measurement setups with a partic-
ular input source and channel setup. For example, you can set up three different 1/Q
Analyzer channels in parallel and use different Touchstone files for each measurement
channel.

Recognizing frequency response correction in measurement results

If frequency response correction is active for a measurement channel, "FRCORR" is
indicated in the channel bar. The status of the correction settings is indicated by the
color of this message:

Color Meaning

Green Active correction settings valid and in use

Red Correction settings active, but not in use, e.g. due to invalid settings
(see "Correction filters for I/Q data" on page 96)

Remote command:

[SENSe:]CORRection:FRESponse<si>:USER:VALid? on page 565
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Since multiple correction settings can be active at the same time, the channel bar
merely indicates that frequency response correction is being applied, but not which
files are being used. To find out which correction files are being used for the active
application, open the "User-Defined Frequency Response Correction" dialog box (see
Chapter 7.5.2, "User-defined Frequency Response Correction Settings",

on page 97).

Storing frequency response correction settings

You can store frequency response correction settings to a file (saveset) and load them
for future measurements. For details see "Save Settings" on page 100.

Storing SaveSets with a loaded Touchstone file

If you store the settings for a measurement using a Touchstone file in a saveset, only
the link to the Touchstone file name is actually stored. That means that if you change
the settings in the file and recall the saveset for the measurement later, the results will
differ from the original measurement.

Imported 1/Q data

Correction factors are also applied to input from 1/Q data files. Ensure the frequency
range in the correction file corresponds to the frequency settings for the measurement
of the input file.

Restrictions

Currently, the R&S VSE has the following restrictions for Touchstone file support:

® Trace data containing corrections from Touchstone files cannot be returned in 1/Q
block format
(See TRACe:IQ:DATA:FORMat on page 819).

User-defined Frequency Response Correction Settings

Access: "Meas Setup" > "User Correction”

User-defined frequency response correction can be defined in one or more Touchstone
files and in one or more frequency response (. fres) files, or a combination of them. A
configuration of correction files can be stored to and loaded from a file.
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Frequency response correction can be configured individually for all available input
types (RF, oscilloscope baseband channels, file). The settings in the "User-defined Fre-
quency Response Correction" dialog box apply to the currently selected input type. For
MIMO measurements, frequency response correction can be configured individually for
each source in separate tabs.
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State

Enables or disables the general usage of user-defined frequency response correction
settings. If activated, the data in the active correction files is combined to create a filter.
This filter is applied to the measurement results of subsequent sweeps.

For MIMO measurements, this function enables or disables frequency response cor-
rection for all sources.

Remote command:
[SENSe:]CORRection:FRESponse<si>:USER:STATe on page 564
Testing the validity of the correction setting:
[SENSe:]CORRection:FRESponse<si>:USER:VALid? on page 565

Link sources (MIMO only)

If enabled, the frequency response correction settings for the currently selected input
source (tab) are copied to all input sources for the channel. If any settings already exist
in other tabs, a message is displayed. If you confirm, the settings are overwritten. As
long as this function is enabled, any changes in one tab are automatically applied to all
tabs.

This function is only available for MIMO measurements and only for channel-specific
configuration (Apply to = "Channel").

Remote command:
[SENSe:]CORRection:FRESponse<si>:LSOurces:STATe on page 555

Adjust Ref Level

Activates or deactivates the automatic adjustment of the reference level to the active
filter calculation configuration. The offset is the mean of the filter calculation. The refer-
ence level offset is calculated individually for each channel the frequency response
correction settings apply to (see "Apply to" on page 100).
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Note the following prerequisites and restrictions concerning the automatic reference

level adjustment:

® The reference level offset is only applied if frequency response correction is
enabled (see "State" on page 99). If you disable frequency response correction,
"Adjust Ref Level" is automatically set to "Manual".

® The reference level offset is only applied if the center frequency is within the cur-
rently covered filter frequency range.

"Auto" Activates the automatic adjustment. The original dynamic range of
the reference level is shifted by the filter calculation offset.

"Manual" Deactivates the automatic adjustment. Adjust the reference level in
the "Amplitude” settings (see " Reference Level " on page 206).

Remote command:
[SENSe: ]CORRection:FRESponse<si>:USER:ADJust:RLEVel:STATe
on page 549

Apply to

Determines which channels the correction settings are applied to.

"All" The frequency response correction settings are applied to all active
measurement channels with the same input type. A new filter is cal-
culated for each measurement channel as soon as you switch to it, or
when a measurement is performed (e.g. by the Sequencer).

"Channel" The frequency response correction settings are applied to the cur-
rently selected channel only.

Remote command:
[SENSe:]CORRection:FRESponse<si>:USER:SCOPe on page 556

Load Settings

Loads a stored saveset for a user-defined frequency response correction scenario.
Existing settings in the dialog box are overwritten. The settings apply to the currently
selected channel or all channels, depending on the Apply to setting.

Only .df1 files can be loaded. The default storage directory for correction files is
C:\ProgramData\Rohde-Schwarz\VSE\<version no>\user\FResponse

For MIMO measurements, the loaded settings are applied to all sources.

Remote command:
[SENSe:]CORRection:FRESponse<si>:USER:LOAD on page 556

Save Settings

Stores a saveset for a user-defined frequency response correction scenario. As for all
instrument settings, a . df1 file is created for the correction data. Note that only the
settings defined in this dialog box are stored, not the contents of the files themselves.
Whether the settings for the currently selected channel only or for all channels are
stored depends on the Apply to setting.

The default storage directory is
C:\ProgramData\Rohde-Schwarz\VSE\<version no>\user\FResponse

Remote command:
[SENSe:]CORRection:FRESponse<si>:USER:STORe on page 564
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Clear Settings
Clears all current user-defined frequency response correction settings, either for the
currently selected channel only or for all channels, depending on the Apply to setting.

For MIMO measurements, the settings for all sources are cleared.

Remote command:
[SENSe:]CORRection:FRESponse<si>:USER:PRESet on page 556

Touchstone File Information
Provides information on loaded Touchstone files and the order of their application.

ID «— Touchstone File Information

Consecutive number which determines the order in which the correction files are
applied to the measurement data. The maximum number of files per configuration is
15.

Filename «— Touchstone File Information
Name of a loaded Touchstone file.

Active — Touchstone File Information
Activates or deactivates the selected file for the current configuration. Only active files
are included in filter calculation.

Remote command:
[SENSe:]CORRection:FRESponse<si>:USER:SLISt<sli>:STATe on page 563

To - From — Touchstone File Information
Touchstone files can be defined for a varying number of input and output ports.

You must define the ports from the Touchstone file whose data is to be applied.

Remote command:

[SENSe: ]CORRection:FRESponse<si>:USER:SLISt<sli>:PORTs:TO
on page 560
[SENSe:]CORRection:FRESponse<si>:USER:SLISt<sli>:PORTs:FROM
on page 560

Add Touchstone File

Loads a new Touchstone file for the current configuration. The maximum number of
files per configuration is 15. The new file is added below the currently selected file. To
change the order of the files, use the Move File Up or Down icons.

The file extension of the Touchstone file must correspond to the number of ports inclu-
ded in the file. For example, a file containing 4 parameters for S11, S22, S12 and S21
must have the extension . s2p.

A minimum number of values is required to compensate for a group delay, see "Group
delay compensation" on page 96.

The default directory for Touchstone files is
C:\ProgramData\Rohde-Schwarz\VSE\<version no>\user\Fresponse

Remote command:
[SENSe:]CORRection:FRESponse<si>:USER:SLISt<sli>:INSert
on page 558
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Remove File
Removes the selected Touchstone file from the current configuration.

Remote command:

[SENSe: ]CORRection:FRESponse<si>:USER:SLISt<sli>:REMove

on page 561

[SENSe:]CORRection:FRESponse<si>:USER:SLISt<sli>:CLEar on page 557

Move File Up or Down
Moves the selected Touchstone file one position up or down in the list of files, changing
the order in which the correction data is applied.

Remote command:
[SENSe:]CORRection:FRESponse<si>:USER:SLISt<sli>:MOVE on page 559

Frequency Response active

Activates or deactivates the use of additional frequency response (. fres) files. The
correction data is these files is applied after any correction settings in active Touch-
stone files. Only active files are included in filter calculation.

Remote command:
[SENSe:]CORRection:FRESponse<si>:USER:FSTate on page 554

Frequency Response File Information
Provides information on loaded frequency response files and the order of their applica-
tion.

ID — Frequency Response File Information

Consecutive number which determines the order in which the correction files are
applied to the measurement data. The maximum number of files per configuration is
15.

Filename «— Frequency Response File Information
Name of a loaded Touchstone file.

Magnitude < Frequency Response File Information
Activates or deactivates the use of the correction data in the selected file for magnitude
results.

Remote command:
[SENSe:]CORRection:FRESponse<si>:USER:FLISt<fli>:MAGNitude]:
STATe] on page 552

Phase — Frequency Response File Information
Activates or deactivates the use of the correction data in the selected file for phase
results.

Remote command:
[SENSe:]CORRection:FRESponse<si>:USER:FLISt<fli>:PHASe[:STATe]
on page 552
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Add Freq Resp File
Loads a frequency response (. fres) file to the current configuration. The maximum
number of files per configuration is 15.

A minimum number of values is required to compensate for a group delay, see "Group
delay compensation" on page 96.

The default directory for . fres files is
C:\ProgramData\Rohde-Schwarz\VSE\<version no>\user\Fresponse

Remote command:
[SENSe:]CORRection:FRESponse<si>:USER:FLISt<fli>:INSert
on page 551

Remove Frequency Response File
Removes the selected frequency response (. fres) file from the current configuration.

Remote command:

[SENSe: ]CORRection:FRESponse<si>:USER:FLISt<fli>:REMove

on page 553

[SENSe:]CORRection:FRESponse<si>:USER:FLISt<fli>:CLEar on page 550

Preview
The preview of the (combined) user correction files shows the correction values.

Remote command:
[SENSe:]CORRection:FRESponse<si>:USER:PSTate on page 561

Selected File — Preview

The preview of the selected user correction file shows the correction values for the
specified frequency range. The values for individual ports can be activated or deactiva-
ted.
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Figure 7-3: Preview of selected user correction file

Remote command:
[SENSe:]CORRection:FRESponse<si>:USER:FLISt<fli>:DATA:FREQuency?
on page 551
[SENSe:]CORRection:FRESponse<si>:USER:FLISt<fli>:DATA:MAGNitude?
on page 551
[SENSe:]CORRection:FRESponse<si>:USER:FLISt<fli>:DATA:PHASe?

on page 551

[SENSe:]CORRection:FRESponse<si>:USER:SLISt<sli>:DATA:
FREQuency<spi>? on page 558
[SENSe:]CORRection:FRESponse<si>:USER:SLISt<sli>:DATA:
MAGNitude<spi>? on page 558
[SENSe:]CORRection:FRESponse<si>:USER:SLISt<sli>:DATA:
PHASe<spi>? on page 558

IQ Mode « Preview

The preview in IQ Mode indicates the frequency ranges covered by the individual cor-
rection files. The blue bar indicates the valid frequency range for which all files contain
values.

The lower part shows the combined correction values for the valid frequency range.
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r Previewe [SMP File)
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Figure 7-4: 1Q Mode preview of user correction files

Remote command:
[SENSe:]CORRection:FRESponse<si>:USER:IQ:DATA:FREQuency?

on page 555
[SENSe:]CORRection:FRESponse<si>:USER:IQ:DATA:MAGNitude?

on page 555

[SENSe:]CORRection:FRESponse<si>:USER:IQ:DATA:PHASe? on page 555

Output Settings

Access: "Overview" > "Output”

The R&S VSE can control the output provided by the connected instrument to special
connectors for other devices.

Which output settings and connectors are available depends on the connected instru-
ment.

For details on the output connectors refer to the instrument's Getting Started manual.
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IF/Video Output
IF Qut Frequency 50.0 MHz

Moise Source Cn
Trigger 2 Cutput

Trigger 3 COutput

The trigger output settings are described in Chapter 7.7, "Receiving and Providing Trig-
ger Signals", on page 106.

IF/Video Output, IF Wide Out FreqQUENCY........eeiiiiiiiiiiiieee e 106
NOISE SOUICE CONIIOL... et et e e e e e e e e e e r e e e e e enaans 106

IF/Video Output, IF Wide Out Frequency
Not available for the R&S VSE software.

Noise Source Control

The R&S VSE provides a connector ("NOISE SOURCE CONTROL") with a 28 V volt-
age supply for an external noise source. By switching the supply voltage for an exter-
nal noise source on or off in the firmware, you can enable or disable the device as
required.

The connected instrument may provide a connector ("NOISE SOURCE CONTROL")
with a voltage supply for an external noise source. By switching the supply voltage for
an external noise source on or off via the software, you can enable or disable the con-
nected device as required.

External noise sources are useful when you are measuring power levels that fall below
the noise floor of the connected instrument itself, for example when measuring the
noise level of an amplifier.

In this case, you can first connect an external noise source (whose noise power level is
known in advance) to the connected instrument and measure the total noise power.
From this value you can determine the noise power of the connected instrument. Then
when you measure the power level of the actual DUT, you can deduct the known noise
level from the total power to obtain the power level of the DUT.

Remote command:
DIAGnostic:SERVice:NSOurce on page 570

7.7 Receiving and Providing Trigger Signals

Using one of the "TRIGGER INPUT / OUTPUT" connectors of the connected instru-
ment, the R&S VSE can use a signal from an external device as a trigger to capture
data. Alternatively, the internal trigger signal used by the connected instrument can be

User Manual 1176.8839.02 — 14 106



R&S®VSE

Controlling Instruments and Capturing I/Q Data

Receiving and Providing Trigger Signals

output for use by other connected devices. Using the same trigger on several devices
is useful to synchronize the transmitted and received signals within a measurement.

For details on the connectors see the R&S VSE "Getting Started" manual.

External trigger as input

If the trigger signal for the R&S VSE is provided by an external device, the trigger sig-
nal source must be connected to the connected instrument and the trigger source must
be defined as "External" in the R&S VSE.

Trigger output

The connected instrument can provide output to another device either to pass on the
internal trigger signal, or to indicate that the connected instrument itself is ready to trig-
ger.

The trigger signal can be output by the connected instrument automatically, or man-
ually by the user. If it is provided automatically, a high signal is output when the con-
nected instrument has triggered due to a measurement start ( "Device Triggered " ), or
when the connected instrument is ready to receive a trigger signal after a measure-
ment start ( "Trigger Armed" ).

Manual triggering

If the trigger output signal is initiated manually, the length and level (high/low) of the
trigger pulse is also user-definable. Note, however, that the trigger pulse level is always
opposite to the constant signal level defined by the output "Level" setting, e.g. for
"Level" = "High", a constant high signal is output to the connector until the "Send Trig-
ger" button is selected. Then, a low pulse is provided.

v v

trigger trigger
5 - 5 | “
gi_n_) | i
low-level constant, high-level constant,
high-level trigger low-level trigger
THGQEE /213t e ettt e e s s ea b et e e e s sbte e e e e s aabeeeeeeanee 108
L OULPUL TYPE ettt ee et ee et en e e e 108
L LEVEI et 109
L PUISE LENGHN 1.ttt 109
L SENA THOGET ettt ettt n e 109
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Trigger 1/2/3
Trigger Source Trigger In/Qut
Trigger 2 Input
Output Type User Defined T Level (W8 High
Pulse Length 100.0 s send Trigger L

Trigger 3 Cutput

Defines the usage of variable trigger input/output connectors on the connected instru-
ment. Which output settings are available depends on the type of connected instru-
ment. For details, see the instrument's documentation.

Defines the usage of the variable Trigger Input/Output connectors, where:
"Trigger 2" : Trigger Input/Output connector on the front panel

"Trigger 3" : Trigger 3 Input/Output connector on the rear panel

(Trigger 1 is INPUT only.)

"Input" The signal at the connector is used as an external trigger source by
the connected instrument. Trigger input parameters are available in
the "Trigger" dialog box.

"Output” The connected instrument sends a trigger signal to the output con-
nector to be used by connected devices.
Further trigger parameters are available for the connector.

Remote command:
OUTPut<up>:TRIGger<tp>:DIRection on page 570

Output Type — Trigger 1/2/3
Type of signal to be sent to the output

"Device Trig- (Default) Sends a trigger when the connected instrument triggers.
gered "

"Trigger Sends a (high level) trigger when the connected instrument is in
Armed" "Ready for trigger" state.

This state is indicated by a status bit in the STATus : OPERation reg-
ister (bit 5), as well as by a low-level signal at the AUX port (pin 9).
For details, see the description of the STATus : OPERation register
in the R&S VSE User Manual and the description of the AUX port in
the R&S VSE Getting Started manual.

This state is indicated by a status bit in the STATus : OPERation reg-
ister (bit 5), as well as by a low-level signal at the AUX port (pin 9) of
the connected instrument, if available.

For details, see "STATus:OPERation Register" on page 469 and the
instrument's documentation.

"User Defined" Sends a trigger when you select the "Send Trigger" button.
In this case, further parameters are available for the output signal.
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Remote command:
OUTPut<up>:TRIGger<tp>:0TYPe on page 571

Level — Output Type < Trigger 1/2/3
Defines whether a high (1) or low (0) constant signal is sent to the trigger output con-
nector.

The trigger pulse level is always opposite to the constant signal level defined here. For
example, for "Level = High", a constant high signal is output to the connector until you
select the Send Trigger function. Then, a low pulse is provided.

v trigger v trigger
5 - 5 | “
gi_n_) | i
low-level constant, high-level constant,
high-level trigger low-level trigger

Remote command:
OUTPut<up>:TRIGger<tp>:LEVel on page 571

Pulse Length — Output Type — Trigger 1/2/3
Defines the duration of the pulse (pulse width) sent as a trigger to the output connector.

Remote command:
OUTPut<up>:TRIGger<tp>:PULSe:LENGth on page 572

Send Trigger «— Output Type — Trigger 1/2/3
Sends a user-defined trigger to the output connector immediately.

Note that the trigger pulse level is always opposite to the constant signal level defined
by the output Level setting. For example, for "Level" = "High", a constant high signal is
output to the connector until you select the "Send Trigger" function. Then, a low pulse
is sent.

Which pulse level will be sent is indicated by a graphic on the button.

Remote command:
OUTPut<up>:TRIGger<tp>:PULSe:IMMediate on page 572
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8 Data Management

8.1

The captured data and measurement results from the R&S VSE can be stored to files.
Furthermore, measurement and software settings can be stored.

e Restoring the Default Software Configuration (Preset).......cccceveviiiiiiiiiiiiniiiienenns 110
e Storing and Recalling Measurement Settings............uuiccciiiiiiiieiiiieeeeeeeeeeeeeeeeeeeas 111
e Recording and Recalling Captured I/Q Data for Evaluation.............cccccoecueeeennnnne. 119
e Printing Current Measurement RESUIS......ccoooivviiiiiiiiie e 135
e Storing Graphical Results to an ASCII File........ccooiiiiiiii e, 138
e Copying Graphical Results to the Clipboard.........cccccceeeiiiiiiiciiiiiiieeeeeee e 138

Restoring the Default Software Configuration (Preset)

Access: "File" > "Preset"

When delivered, the R&S VSE has a default configuration. You can restore this defined
initial state at any time as a known starting point for measurements. This is often rec-
ommendable as a first step in troubleshooting when unusual measurement results
arise.

Settings can be restored in different levels:

Restoring All Default Settings (Preset All).......c..eovi it 110
Restoring All Default Settings and Deleting Instrument Configurations (Preset All &

Delete INSIIUMENES)...ciiiiii e e e e e e e e e e nnnrenee s 110
Restoring Channel Settings (Preset Selected Channel)........cccceeeeieieiiiiiiiiiiiiiiiiieieeenns 111
Restoring User-Specific Settings (Reset VSE Layout)..........ooueiiiiiiciiiiiiiiinnenee, 111

Restoring All Default Settings (Preset All)

Restores the initial software state, that is: all measurement sequences, groups and
channels are stopped and all windows are closed; the default group and 1/Q Analyzer
measurement channel are restored.

Settings concerning the layout of the R&S VSE window, for example the display and
position of toolbars and special tool windows, remain unchanged.

Note:
The initial software state is also restored if you delete the shutdown file (see "Deleting
the Shutdown File" on page 140).

Remote command:
*RST on page 491 or SYsTem: PRESet on page 829

Restoring All Default Settings and Deleting Instrument Configurations (Preset All
& Delete Instruments)

Restores the initial software state, that is: all measurement sequences, groups and
channels are stopped and all windows are closed; the default group and 1/Q Analyzer
measurement channel are restored.

In addition, all instrument configurations are deleted (see ).
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Settings concerning the layout of the R&S VSE window, for example the display and
position of toolbars and special tool windows, remain unchanged.

Remote command:
*RST on page 491 or SYSTem: PRESet on page 829
+

DEVice:DELete:ALL on page 494

Restoring Channel Settings (Preset Selected Channel)
Resets the currently selected measurement channel only to its default settings.

This function has the same effect as the "Preset Channel" on page 186 function in the
Configuration "Overview".

Remote command:
SYSTem:PRESet :CHANnel [ :EXEC] on page 829

Restoring User-Specific Settings (Reset VSE Layout)

Restores user-defined settings, for example the display and position of toolbars and
special tool windows or lists of most recently defined input values (e.g. IP addresses of
connected instruments).

Measurement channels remain unchanged.

User-defined settings are stored in the file
C:\ProgramData\Rohde-Schwarz\VSE\<version no>\user\

settings pcsw_user.xml.

8.2 Storing and Recalling Measurement Settings

Possibly you would like to restore or repeat a measurement you performed under spe-
cific conditions using the R&S VSE. In this case, you can store and recall software and
measurement settings, and possibly other related measurement data.

Two different methods are available for managing measurement settings:

® Quick Save/Quick Recall - a defined set of measurement or channel settings are
stored or recalled quickly in just one step

® Configurable Save/Recall - a user-defined set of measurement or channel settings
are stored to a definable storage location
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Restrictions when recalling measurement settings
When recalling a saved configuration file, the following restrictions apply:

® The connected instrument and the channel application must support the frequency
range defined in the configuration file.

® Configuration files created using an instrument with certain options in use will not
work using an instrument without these options

® Files created with newer software versions may not work with a previous version

® Files created with the R&S VSE Enterprise Edition may not work in the Basic Edi-
tion, for example if more than one instrument, more than one group, or more than
three channels are defined

® Depending on the general software setting, instrument configurations are restored,
but the connections may have to be established manually (see "Reconnect saved
connections after recall” on page 140).

® Traces resulting from encrypted file input cannot be stored in a saveset.

e Quick Save/QUICK RECaIl...........cooeiieeeeeeeee et 112
e Configurable Storage and Recall..............uuuuiiiiiiiiiiiiieeeeeeeeeeeeeeee 114

Quick Save/Quick Recall

The Quick Save and Quick Recall functions allow you to store channel settings very
easily and quickly in one step. Up to ten different sets of settings can be stored to or
recalled from "save sets". Each save set is identified by its storage date and contents
(all channels or specific channel) in the display. The save sets are stored in the
C:\ProgramData\Rohde-Schwarz\VSE\<version no>\user\QuickSave
directory, in files named QuickSavel.dfl to QuickSavel0.df1l. The storage file
names and locations cannot be changed.

During recall, save sets of type "All channels" replace the settings of the entire soft-
ware. All other save sets start a new measurement channel with the stored settings.

A measurement channel with the same name as the channel to be restored may
already be active. In this case, the channel name for the new channel is extended by a
consecutive number:

+ 10 Analvzer

- I Analyzer 2
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Quick Save / Quick Recall Settings

Access: "File" > "Save"/"Recall" > "Quick Save"/ "Quick Recall"

The "Quick Save" and "Quick Recall" dialog boxes are very similar and closely related.

Save
Quick Save Save
Mo Okt 6 2014
13:47:02
QuickSave 2 QuickSave 3 QuickSave 4 QuickSave 5
All Channels
QuickSave & QuickSave 7 QuickSave 8 QuickSave @ QuickSave 10

Type:

All Channels

Current Channel:

IQ Analyzer
QuickSave 1/ .../ QUICKSAVE 10......iieeiiieeee ettt e e e e e e e ean 113
Storage TYPE (SAVE ONIY)...ceiiiiiiiiiiiiiie et e e e 113
[T o= | | T 113

QuickSave 1/ .../ QuickSave 10

Selects one of the save sets to store the current settings in or to be recalled. At the
time of storage, the "QuickSave 1/ ... / QuickSave 10" placeholder is replaced by a
label indicating the storage date and time and the storage type.

During recall, save sets of type "All channels" replace the measurement settings of the
entire software. All other save sets start a new measurement channel with the stored
settings.

Storage Type (Save only)
Defines which type of settings are stored in the save set.

"All channels"  The measurement settings for all currently active channels are

stored.
"Current Chan- Only the measurement settings for the currently selected measure-
nel" ment channel are stored.
Recall

Restores the channel settings as saved in the selected settings file. If the settings file
contains settings for a specific channel only a new channel with the stored settings is
activated, otherwise the entire measurement settings are loaded.
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Note: A measurement channel with the same name as the channel to be restored may
already be active. In this case, the channel name for the new channel is extended by a
consecutive number:

I Analyzer

10 Analyzer 2

In remote commands, you must append this number to the channel name, as well.
Remote command:

MMEMory : LOAD: STATe on page 838
8.2.2 Configurable Storage and Recall

The more sophisticated storage and recall functions allow you to define which settings
are stored, and where the settings file is stored to. Any settings file can be selected for

recall.

LIS (o] ¢=To [ = = T Y/ o1 SRR 114
e Storage Location and File Name..........ooooviiiiiiiiiiiiiiie e 114
e Save and Recall Dialog BOXES........uuuuuiuiiiiiiiiieie e e 115
o Startup Recall SettingsS. ... .. 117

8.2.2.1 Stored Data Types

The following types of data can be stored to and loaded from files via the "Save" dialog
box on the R&S VSE:

Table 8-1: Items that can be stored to files

Item Description
Current Settings Current software and measurement settings
All Traces All active traces;

Traces resulting from encrypted file input are not stored.

All Limit Lines All limit lines (Note: information on which limit lines are active is stored with
the "Current Settings")

Not available for I/Q Analyzer

Spectrogram Spectrogram display

Only available for 1/Q Analyzer and Analog Demod applications

8.2.2.2 Storage Location and File Name

The storage location and file name are selected in a file selection dialog box which is
displayed when you perform a storage function.

By default, the name of a settings file consists of a base name followed by an under-
score and three numbers, e.g. 1imit lines_ 005. In the example, the base name is
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limit lines. The base name can contain characters, numbers and underscores.
The file extension df1 is added automatically. The default folder for settings files is
C:\Programbata\Rohde-Schwarz\VSE\<version no>\user.

Hidden folder

Note that the ProgrambData folder is not visible in the Windows Explorer in its default
settings. However, if you enter the path with the file name, you can access the files
stored there.

Alternatively, enable the "Files and Folders: Hidden files and folders: Show hidden
files, folders, and drives" option in the Windows Explorer. (Press the [Alt] key to display
the menu bar. Select "Tools > Folder Options" > "View" tab.)

For more information, refer to the Microsoft Windows documentation.

Save and Recall Dialog Boxes

Access: "File" > "Save"/"Recall" > "Save"/"Recall"
The "Save" and "Recall" dialog boxes are very similar and closely related.

Chprogramdata\Rohde-SchwarzWSEVL 30-17,4.10. huser

» FsL “ | Files bt
> OKData
Rsvisa . chan_tab
SoftwearePlatform . Demo
- WSE
> ., 1.30-17.3.39.0 i LTE
> 1.30-17.4.1.0 predefined
4 1.30-17.4.10.0
> DemoTestData v
>  acp_std
> devicedata
. install
limits
log
. results
scpilogging
>l sem_std
> user -
File Mame Save
Comment
File Type Ttems:

Current Settings

Current Channel:
IQ Analyzer

Save
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Selecting Storage Location - Drive/ Path/ Files.........cooiiiiiiiii e 116
1TSS NN F=T 0 = 116
(070] 19104 T=T0 | S 116
1 LT Y o L= T PP POPRPPTPPPP 116
1 =Y 0 0 FS RPN 116
SAVE FlB. ettt et e e et e e e e et e e e e e raa e e eeaaaan 117
Recall in New Channel / Recall in Current Channel...........ccoooovveiieiiiiiiiiiieeeeeeeeen. 117

Selecting Storage Location - Drive/ Path/ Files
Select the storage location of the file on the software or an external drive.

The default storage location for the settings files is:
C:\ProgrambData\Rohde-Schwarz\VSE\<version no>\Save

Note that the ProgrambData folder is not visible in the Windows Explorer in its default
settings. However, if you enter the path with the filename, you can access the files
stored there. See also "Hidden folder" on page 115.

The default storage location for the SEM settings files is:
C:\ProgramData\Rohde-Schwarz\VSE\<version>\sem std

File Name
Contains the name of the data file without the path or extension.

File names must be compatible with the Windows conventions for file names. In partic-

wanEn non

ular, they must not contain special characters such as ":", "*",

For details on the filename and location, see Chapter 8.2.2.2, "Storage Location and
File Name", on page 114.

For details on the filename and location, see Chapter 8.2.2.2, "Storage Location and
File Name", on page 114.

Comment
An optional description for the data file. A maximum of 60 characters can be displayed.

Remote command:
MMEMory : COMMent on page 831

File Type
Determines whether the global software settings with all channels are stored or recal-
led, or the current channel settings only.

Items

Defines which data and settings are stored or recalled. Depending on the "File Type",
only channel settings or global settings are available. Which items are available also
depends on the installed options (see also Chapter 8.2.2.1, "Stored Data Types",

on page 114).

Remote command:

MMEMory:SELect [: ITEM

[: :ALL on page 835
MMEMory:SELect [ : ITEM

[:

[:

:DEFault on page 835
:HWSettings on page 835
:LINes:ALL on page 836

MMEMory:SELect [:ITEM
MMEMory:SELect [:ITEM

e e

User Manual 1176.8839.02 — 14 116



R&S®VSE Data Management

Storing and Recalling Measurement Settings

MMEMory:SELect [ : ITEM] : NONE on page 836
MMEMory:SELect [ : ITEM] : TRACe<1...3>[:ACTive] on page 837

Save File
Saves the settings file with the defined file name.

Remote command:
MMEMory : STORe<1 | 2>:STATe on page 840
MMEMory: STORe<1|2>:STATe:NEXT on page 840

Recall in New Channel / Recall in Current Channel

Restores the measurement settings as saved in the selected settings file. If the set-
tings file contains settings for a specific channel only, select "Recall in New Channel" to
activate a new channel with the stored settings. Select "Recall in Current Channel" to
replace the current channel settings.

Note: A measurement channel with the same name as the channel to be restored may
already be active. In this case, the channel name for the new channel is extended by a
consecutive number:

- 17 Analyzer

¥ IQ) Analyzer 2

In remote commands, you must append this number to the channel name, as well.

Note: Files created with the R&S VSE Enterprise Edition cannot be recalled in the
Basic Edition if more than one instrument, more than one group, or more than three
channels are defined.

Remote command:
MMEMory: LOAD: STATe on page 838

8.2.2.4 Startup Recall Settings

Access: "File" > "Recall"> "Startup Recall"

By default, the settings from the shutdown file (see "Create Shutdown File"
on page 140) or the default settings are restored when the R&S VSE software is star-
ted. However, you can select a different settings file to be restored.
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Quick Recall Recall Startup Recall

Startup Recall

r Select File

. Chprogramdata\Rohde-Schwarzw'SEvL30-17.4.10.0user

* L0 RSMGRT | Files Size
4 | Rohde-Schwarz
. Certificates

> . DeviceFootprint . chan_tab
4 F5L
) Install
D> OKData JLTE
] GEYER . predefined
. SoftwarePlatform
4 WSE
> . 1.30-17.3.33.0
¢ 0 L30-17.4.L0
4 . 1.30-17.4.10.0
» |0 DemaoTestData

. Demo

L wsa

» L acp_std
= 1) devicedata
. install
o limits
W log
L results
. scpilogging
s L sem_std
> | W user
s L0 130-17.4.8.101

-

File Mame

Comment

Select File

= 3 (0] o 3N =T || U EUURRUNE 118
Selecting Storage Location - Drive/ Path/ Files......ccccooeviiiiiiiiiiiiiee, 118
1 Lo N = o = PP 119
{70 101 4= o | 119

Startup Recall

Activates or deactivates the startup recall function. If activated, the settings stored in
the selected file are loaded each time the software is started or preset. If deactivated,
the default settings are loaded.

Note that only All Channels settings files can be selected for the startup recall function,
not single channel settings files.

Note: Settings stored with the R&S VSE Enterprise Edition cannot be recalled in the
Basic Edition if more than one instrument, more than one group, or more than three
channels are defined.

Remote command:
MMEMory : LOAD: AUTO on page 838

Selecting Storage Location - Drive/ Path/ Files
Select the storage location of the file on the software or an external drive.

The default storage location for the settings files is:
C:\Programbata\Rohde-Schwarz\VSE\<version no>\Save.
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Note that the ProgrambData folder is not visible in the Windows Explorer in its default
settings. However, if you enter the path with the filename, you can access the files
stored there. See also "Hidden folder" on page 115.

The default storage location for the SEM settings files is:
C:\ProgramData\Rohde-Schwarz\VSE\<version>\sem std.

File Name
Contains the name of the data file without the path or extension.

File names must be compatible with the Windows conventions for file names. In partic-
ular, they must not contain special characters such as ":", "*", "?".

For details on the filename and location, see Chapter 8.2.2.2, "Storage Location and
File Name", on page 114.

For details on the filename and location, see Chapter 8.2.2.2, "Storage Location and
File Name", on page 114.

Comment
An optional description for the data file. A maximum of 60 characters can be displayed.

Remote command:
MMEMory : COMMent on page 831

8.3 Recording and Recalling Captured 1/Q Data for Evalu-
ation

By default, when data is captured during a measurement, it is stored on the connected
instrument. The R&S VSE software accesses this data to analyze and display the
results for the channel.

If the captured 1/Q data is required for further analysis later or in a different application,
possibly using different settings, you can record the captured data. In this case, the 1/Q
data is stored to a temporary file on the PC running the R&S VSE software. These files
can then be exported, that is: stored to a file permanently, at a user-defined storage
location. Exported 1/Q data can then be recalled and used as input for further measure-
ments and analysis by the R&S VSE software.
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@ Difference between Save and Export functions

The "Save" function described in Chapter 8.2, "Storing and Recalling Measurement
Settings", on page 111 stores the finished measurement results (and settings), so that
the same results can be restored later in the same application.

You can also store the raw I/Q data as it is captured, without further evaluation func-
tions applied, to evaluate it using other functions or in a different application. In this
case, use the "Save I/Q Recording" functions described here. Note that to export the
raw (resampled) data for a continuous measurement, you must start recording directly
at the time of capture. Once the data has been captured without being recorded, it can
no longer be exported as raw (resampled) data.

Exception: I/Q data from a single run measurement can be exported for a limited
amount of time after the measurement, but only until measurement settings are
changed or a new measurement is performed (see "Data to export" on page 124).

An application note on converting Rohde & Schwarz 1/Q data files is available from the
Rohde & Schwarz website:

1EF85: Converting R&S 1/Q data files

aQ)

Auxiliary tools to convert 1/Q files using Matlab®

aQ)

The R&S VSE installation now also includes some additional tools to convert I/Q files

using Matlab®. The tools are stored in the

C:\ProgramData\Rohde-Schwarz\VSE\<version no>\user\tools directory.

The following tools are provided as Matlab® files:

® 1load_iq_tar file.m: provides functions to convert . iq. tar files created or
exported by the R&S VSE software to .mat files that can be imported by Matlab®.

® save iq_tar_ file.m: provides functions to convert I/Q data created in Matlab®
to .1qg. tar files that can be imported by the R&S VSE software

® write matforvse.m: provides functions to convert I/Q data created in Matlab®
to .mat files that can be imported by the R&S VSE software

e Recording Measurement Data.............ouuviiiiiiiiiiiiiiii e 120
o General Recording SettingsS....cccooieiiiiii i 121
e Exporting Captured and Recorded I/Q Data.........cccoeveieeiiiiiiiiiiieeeeeee e 123
e Recalling Measurement Data from Files.........ccoooviiiiiiiiiiiiiee e 126

8.3.1 Recording Measurement Data

If the captured I/Q data is required for further analysis later or in a different application,
you can record the measurement results for a specific channel. In this case, the
(resampled) I/Q data is stored to a temporary file on the PC running the R&S VSE soft-
ware. The record length is defined as:

[<Measurement time> * <Number of records>] + <Additional settling samples>
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Where <Measurement time> is defined in the channel capture settings, and <Number
of records> and <Additional settling samples> are general recording settings (see
Chapter 8.3.2, "General Recording Settings", on page 121).

Alternatively, the measurement time can be set to the maximum provided by the con-
nected instrument automatically.

When the recording is finished, the temporary file is automatically set to be the input
source for the selected channel. The measurement results stored in the first record are
immediately displayed. The temporary file can then be exported, that is: stored to a file
permanently. Recorded 1/Q data files are available for export until one of the following
actions occur:

® A new measurement is performed. The temporary file is overwritten with each mea-
surement.

® The measurement channel is closed.

® The R&S VSE software is closed.

® The data acquisition settings are changed. In this case, the stored data no longer
matches the current settings and the data becomes "invalid". It can no longer be
exported.

Note that if a recording is aborted before it has completed, the temporary file is deleted
and the captured data is not available for evaluation or display.

To start recording measurement data for a channel

» To record measurement results, select the ® "Record" function for the channel in
the "Measurement Group Setup" tool window (see also "Record" on page 92).
Alternatively, select the "Record" icon in the toolbar to record the results for the cur-
rently active measurement channel.

The captured I/Q data is recorded until the defined number of records have been
captured or recording is stopped manually.
The first recorded record is displayed immediately in the channel's result displays.
After recording has finished, the I/Q data can be exported to a file permanently, see
Chapter 8.3.3, "Exporting Captured and Recorded 1/Q Data", on page 123.

To stop data recording

» To stop recording measurement results, select the Il "Pause" function for the chan-
nel in the "Measurement Group Setup" tool window.

Note that if a recording is aborted before it has completed, the temporary file is
deleted and the captured data is not available for evaluation or display.

Remote command:

INSTrument :BLOCk:CHANnel [ : SETTings] :RECord on page 526

8.3.2 General Recording Settings

Access: "File" > "Preferences" > "Recording"
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Some general settings concerning recording in the R&S VSE are available in the gen-
eral software settings.

o Limits "Window  Hel
Preferences P —— D
General Displayed items  Theme + Color  Metwork + Remote
Number of Records: 1 The recording is always limited to the

max. record length of the instrument !

Default Comment

|:| Always Maximum Record Length
Additional Settling Samples

NUMDET Of RECOIAS. ....ciiiiiiiiiiie ettt ettt et e e e st eee e e e seabeeeeessnreeeeeeanes 122
Default ComMMENT.....coo et e e e e 122
Always Maximum Record LENGth..........ueiiiiiiiiiiieie e 122
Additional Settling SamPIES. ... 122

Number of Records

Defines the number of records to be stored. One record contains the data captured
during the defined measurement time for a single channel. If more measurements are
available than the specified number (x) of records, only the most recent (x) measure-
ment results are stored. As a rule, the recording is limited by the maximum record
length provided by the instrument.

Alternatively, all available records for a channel can be stored (see "Always Maximum
Record Length" on page 122). In this case, the "Number of Records" are disabled.

Remote command:
RECording:COUNt on page 847

Default Comment
Defines a default text for the comment to the stored data file. This default comment is
displayed in the "Save 1/Q Recording" dialog box (see Comment).

Remote command:
RECording:COMMent [ :DEFault] on page 847

Always Maximum Record Length
If enabled, all available records for a channel are stored. The "Number of Records" is
ignored (and disabled).

If disabled, only the most recent "Number of Records" on page 122 are stored.

Remote command:
RECording:MAXimum:RLEN on page 848

Additional Settling Samples
Stores additional samples (in addition to the specified "Meas Time" ) for the channel to
compensate for settling effects.

This setting is required for connected instruments that require resampling. The addi-
tional samples compensate for settling effects in the filters used by the resampler.
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You can recognize the use of a resampler by the "Resampler active" message in the
status bar of the R&S VSE.

Remote command:
RECording:SETT1ing:TIME on page 848

Exporting Captured and Recorded 1/Q Data

Access: "File" > "Save 1/Q Recording"

Captured and recorded data from a connected instrument can be stored to a file per-
manently. You can then use the data in the export file as input for analysis later or
using a different application.

Recall /Q Recording Save [/Q Recerding

General

|| CprogramdatatRohde-Schward\WSEVL 3017, 4,10, 0use]
Data to export Recarding
> L user & | Files size P -
> 130-1. File Type: igtar
> L) symEFasL
> Symantec chanktal Transient Analysis
> L syncowery Dema
|| firebird Comment
|| regid.1991-06.., LTE
regid 1882-12... predefined Meta Data
D
= wsa Setting: Max
= b [7] Amplitude Parameters
i Frequency Parameters
&
. ’ b [Z] Input Parameters
2h b [7] G Parameters
P L > Trigger Parameters
=3
» L
F=
> G 0
> &8 P hd
File Name
Save

Results can only be stored for the currently selected measurement channel and only
after measurement data has explicitly been recorded or for a limited amount of time
after a single measurement (see Chapter 8.3.1, "Recording Measurement Data",

on page 120).

Exporting MIMO data with multiple 1/Q streams

MIMO data that contains multiple streams is recorded in one file for each stream (input
channel).

When exporting MIMO data, however, the data from all streams is stored in one file.
Within the file, each stream is named LTE Source <n>, where <n>is a sequential
number.

For . igw file format, only one stream can be stored in each file. In this case, one file is
created per stream, and each file is extended by a " source<n>" suffix.
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Selecting the Storage Location - Drive/ Path/ Files...........coooiiiie 124
1 L= 1N = o = P 124
D= 2= T (0 I = o o ) o R 124
1 LT Y o L= TP TP P POPTPRTPPPP 124
L070] 0 010 1Y o | SR 125
Meta Data SettiNgS......uuiuuuuiiiiiii i a e 125
RS T= Y USSR 126

Selecting the Storage Location - Drive/ Path/ Files
Select the storage location of the 1/Q data file on the PC or an external drive.

Remote command:
MMEMory : CATalog on page 830

File Name
Contains the name of the data file without the path or extension.

For details on the file name and location, see Chapter 8.2.2.2, "Storage Location and
File Name", on page 114.

Remote command:

INSTrument :BLOCk:CHANnel [ :SETTings] : FILE<fi>:IQTar on page 509
INSTrument :BLOCk:CHANnel [:SETTings] :FILE<fi>:CSV on page 506
INSTrument :BLOCk:CHANnel [ :SETTings] :FILE<fi>:IQW on page 510
INSTrument :BLOCk:CHANnel [ :SETTings] : FILE<fi>:MAT on page 513
INSTrument :BLOCk:CHANnel [:SETTings] :FILE<fi>:REPLace on page 516
INSTrument :BLOCk: FILE<fi>:CSV on page 535
INSTrument:BLOCk:FILE<fi>:TIQTar on page 536

INSTrument :BLOCk: FILE<fi>:TIQW on page 537

INSTrument :BLOCk: FILE<fi>:MAT on page 540
INSTrument:BLOCk:FILE<fi>:REPLace on page 541

Data to export
Defines whether the currently captured data in the capture buffer is exported to a file,
or the most recently recorded data for the selected measurement channel.

Note that the currently captured data is only available for export directly after a single
run measurement was performed, and only until any measurement settings are
changed.

See also Chapter 8.3, "Recording and Recalling Captured I/Q Data for Evaluation",
on page 119.

Remote command:
EXPort:I0Q:INPut on page 843

File Type
Various file types are supported for 1/Q data import and export.

Note: For best performance and to ensure comprehensive meta data is available, use
the ig.tar format. This is a widely used file format for Rohde & Schwarz products.

Note: For MIMO measurements, all streams are exported in a single file. Only
for . igw format each stream is stored in a single file, whose name is extended by a
" source<n>" suffix.
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For details on the supported file formats see Chapter E, "Reference: Supported 1/Q File
Formats", on page 915.

"ig.tar" Compressed file format for an individual measurement channel or
several channels with identical capture settings (sample rate, band-
width)

"csv" Comma-separated ASCII file format

"iqw" Binary file format; contains only I/Q data from a single channel, with-
out any meta data

"igx" (Import only)

Binary file format; contains (large amounts of) I/Q data from a single
channel, plus trigger information as markers

"mat" Matlab file format v.4 or v.7

Remote command:
Exporting 1/Q recording files:
EXPort:IQ:FORMat on page 842

Comment
Inserts a descriptive comment to the data file.

Tip: if a default comment is defined in the general recording settings (see "Default
Comment" on page 122), it is provided as a default here.

Remote command:
MMEMory : STORe<n>:TQ:COMMent on page 845

Meta Data Settings

Defines which meta data is included in the data file. Meta data is required to restore
the measurement settings when the data file is recalled as input for the R&S VSE soft-
ware later.

Note that only the settings used during recording are stored; subsequent changes to
the settings are ignored.

For igw file format, no meta data is available.

"Min" The minimum set of measurement settings required to restore the
channel later are stored. In particular, this includes:

® Reference level
Center frequency
Input path

Analysis bandwidth
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"Max" All available meta data from the entire signal processing chain (input
path to the output) is stored.

In particular, this may include (depending on the type of measure-
ment channel and connected instrument):
® Amplitude parameters:
— Reference level
— Electronic attenuation
— Mechanical attenuation
—  Preamplifier
— Input impedance
— Input coupling
— Range
® Frequency parameters:
— Center frequency
® |nput parameters:
— Recording device (instrument providing the data)
— Calibration state
— External reference
— Input path
— Highpass filter state
— YIG preselector
® |/Q parameters:
— Analysis bandwidth
— Filter settings
® Trigger parameters:
— Trigger source
— Trigger position
— Trigger level
— Trigger slope
— Trigger holdoff
— Trigger hysteresis

"Custom" A user-definable set of meta data (subset of "Full") is stored.

Remote command:
EXPort:IQ:META:DATA<da> on page 843
EXPort:IQ:META:DATA<da>:SET on page 844

Save
Stores the captured data to the specified file.

Remote command:
EXPort:IQ:FILE on page 842
MMEMory: STORe<n>:1Q:STATe on page 846

8.3.4 Recalling Measurement Data from Files
When measurement (I/Q) data is recorded to a file, not only the result data is stored,

but also the essential instrument and measurement settings required to obtain those
results. Thus, when you recall a measurement file, the stored settings are restored in
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the R&S VSE software, as well. This enables you to repeat the stored measurement
under the same conditions - assuming the file was recorded on a compatible instru-
ment and contains the required measurement information.

When you recall measurement data from a file, a measurement channel is activated
with the input source "File". You can then "replay” the measurement and the stored
results, or even just an extract of the entire measurement.

When measurement results are recorded, the recorded data is immediately used as

@ input for further analysis in the R&S VSE software. Therefore, the input source is
switched to "File", rather than "Instrument". However, the instrument settings are main-
tained so that you can switch back to the instrument as an input source quickly.

To recall measurement results, the I/Q data file and essential measurement information
must first be selected. Then the results of the entire measurement, or only a specific
extract of it, can be restored.

The data to be imported must be stored in a specified file format, see Chapter E, "Ref-
erence: Supported 1/Q File Formats", on page 915.

e Loading the I/Q Data File and Essential Measurement Information..................... 127
e Restoring the Measurement Results - R&S VSE Player...........oooovvvviiiiiiicccennn. 131

8.3.4.1 Loading the I/Q Data File and Essential Measurement Information

Access: 1/Q files are recalled using the "Recall I/Q Recording" dialog box which is dis-
played when you do one of the following:

® Select the @"Recall I/Q Recording" icon from the main toolbar.
® Select the "File > Recall IQ Recording" menu item.

® Select the "Input & Output > Input Source" menu item and switch to the "I/Q File"
tab. Select the "Select file" button.

® Select the "Input source": "File" for a measurement channel, then select the "..."
button to select the 1/Q data file to be loaded.

® |nthe R&S VSE Player ("Window > Player"), select the "..." button to select the 1/Q
data file to be loaded.

O Loading a file via drag&drop
= You can load a file simply by selecting it in a file explorer and dragging it to the
R&S VSE software. Drop it into the "Measurement Group Setup" window or the chan-
nel bar for any channel. The channel is automatically configured for file input, if neces-
sary. If the file contains all essential information, the file input is immediately displayed
in the channel. Otherwise, the "Recall I/Q Recording" dialog box is opened for the
selected file so you can enter the missing information.

If the file contains data from multiple channels (e.g. from LTE measurements), it can be
loaded to individual input sources, if the application supports them.

For more information see "To import data via drag&drop" on page 441.
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The data to be imported must be stored in a specified file format, see Chapter E, "Ref-
erence: Supported 1/Q File Formats", on page 915.

Recall [/ Recording
Essential Information
L CASimulation\ES-MAIN_18.7.16.0_sim\userDema
. = Center Frequency 1.0 GHz
= user 4 | Files Size -~
B | chan_tsb sample Rate 3200 MHz
ol
N [(] WLAN-NON_HT_Bi20_1T MCS3.i.tar 215 kB fequisition Bandwidth  160.0 MHz
ema
- aen ] wianN_640am.iq.tar 441 KB 1Q Channel LA -
£ LTE - i
. - D WLAN-HT_MM_Bvd0_1Tx_MCS6 iq.tar 275 kB /G Format
oise [ ¥iLaas_840aM_50MHz_ShartcRig tar 1MB
B0 NR5G O Zero Padding File Repetitions
E\ i predefined WLANC_640AM_SIMHZ_LongCR.ig.tar 1MB
= L user [] WiLAMac 64Q4M_40MHz ShortCP.ig.tar 843 kB Zero Padding  On File Repetitions: 1
=
] H ool (] WiLaa:_84QaM_40MHz_LongCF.ig.tar 10 kB
o i wsa Meta Information
[ wiaMac_64QaM_20MHz_ShortCR.ig tar 501 KE
= L0 Waveforms
I vna_flash [] wiaNac_540amM_20MHz_LangCPig.tar 535 kB Sz By Y A2l T2 EEE
1 wna_preliminary I [] wiLaMac 64Q4M_160MHz ShortCPig.tar 2 MB Camment
<58 1)
WLANaC_G40AM_160MHz_LongCR.ig.tar IMB i 3
I wedmaliines | -BA0AM. Longehia Date and Time 2016-10-24 175147
B 7 wiana_s4cam.ig.tar 472 kB
temp > Mumber of Samples 44800
- »
Duration of Signal - 1400 |
File Mame  WWLAN-YHT_BWE0_1T:_MC55.iq.tar
Scaling Factor 10y
Select

Encrypted . wv files can also be imported. Note, however, that traces resulting from
encrypted file input cannot be exported or stored in a saveset (see Chapter 8.3,
"Recording and Recalling Captured 1/Q Data for Evaluation", on page 119 and Chap-
ter 8.5, "Storing Graphical Results to an ASCII File", on page 138).

Selecting the Storage Location - Drive/ Path/ Files.........cccccciiiiiiiiiiieee 128

1 L= N = 0 = R 128

Essential Information.............. ...129
L CNtEr FIEQUENCY......eeeeeeee ettt e e 129
L SAMPIE RALE..... ettt ettt ee e 129
L AcqUIsition BanAWIAth............c.ceoeeeeeeeeeeeeeceeeeeeeeeese et 129
L 1/Q CRANNEL ..ttt 129
L 1/Q FOIMAL. ettt en e 130

Zero Padding....cccoeeeeeeeeiieeieeeeeeeee

File Repetitions

Meta INfOrmMatioN........ooi i 131

Selecting the Storage Location - Drive/ Path/ Files
Select the storage location of the 1/Q data file on the PC or an external drive.

Remote command:
MMEMory :CATalog on page 830

File Name
Contains the name of the data file without the path or extension.

128



R&S®VSE Data Management

Recording and Recalling Captured 1/Q Data for Evaluation

For details on the file name and location, see Chapter 8.2.2.2, "Storage Location and
File Name", on page 114.

Remote command:

INSTrument :BLOCk:CHANnel [ :SETTings] : FILE<fi>:IQTar on page 509
INSTrument :BLOCk:CHANnel [ :SETTings] : FILE<fi>:CSV on page 506
INSTrument :BLOCk:CHANnel [ :SETTings] :FILE<fi>:IQW on page 510
INSTrument:BLOCk:CHANnel [ : SETTings] :FILE<fi>:MAT on page 513
INSTrument :BLOCk:CHANnel [:SETTings] :FILE<fi>:REPLace on page 516
INSTrument :BLOCk:FILE<fi>:CSV on page 535
INSTrument:BLOCk:FILE<fi>:TIQTar on page 536

INSTrument :BLOCk: FILE<fi>:TQW on page 537

INSTrument :BLOCk:FILE<fi>:MAT on page 540

INSTrument :BLOCk: FILE<fi>:REPLace on page 541

Essential Information

Defines the channel-specific information required to re-configure the recorded mea-
surement. If the I/Q data file contains measurement information, it is displayed read-
only. For files that do not contain this information, the essential information must be

provided manually. In particular, for:

iqw files

Simple csv files

Simple mat files

Files stored by applications other than R&S VSE

Center Frequency — Essential Information
The center frequency of the data that was stored to the file, if available.

Otherwise, it is set to 0 Hz.

Sample Rate «— Essential Information

If a stored sample rate is available, it is indicated for reference only and cannot be
changed. If not available, the sample rate used to obtain the stored data must be
specified manually.

Acquisition Bandwidth — Essential Information
The bandwidth of the data that was stored to the file.

If the bandwidth of the stored data is available, it is indicated and cannot be changed.

If the bandwidth was not stored, a default value of 0.8 * Sample Rate is used. This
value can be changed manually.

I/Q Channel — Essential Information

Determines which of the 1/Q channels (streams) stored in the file is to be restored to
which input source of the selected measurement channel. This is relevant only for files
that contain data from multiple channels (for example from MIMO measurements).

You can easily switch between different channels to be used as input from the import
file in the "Measurement Group Setup" window.

Note: Loading input files with multiple 1/Q streams. For MIMO measurements, multiple
data streams are required for the multiple input sources. If the streams are stored in
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individual files, you must load a separate file for each input source. If several streams
are stored in one file, the streams are loaded to the input sources in the order they
were stored, that is: the first stream is loaded for input source 1, the second stream for
input source 2, etc.

See also "Exporting MIMO data with multiple 1/Q streams" on page 123.

Remote command:

INSTrument :BLOCk:CHANnel [ :SETTings] : FILE<fi>:STReam on page 519
INSTrument :BLOCk :CHANnel [ : SETTings] : FILE<fi>:STReam:AUTO

on page 518

INSTrument :BLOCk:CHANnel [ : SETTings] :FILE<fi>:STReam:LIST?

on page 518

1/Q Format — Essential Information
Determines how the stored 1/Q data is interpreted. The available formats depend on

the file type.
"1QQ | First all I-values are listed, then the Q-values
IQBLock" (LLLLEL...Q,Q,Q,Q,Q,Q)

. igw format only

"IQIQ | IQPair"  One pair of I/Q values after the other is listed
(La,LQ,LQ...).
. igw format only

"Complex" .ig.tar format only (cannot be edited)

"Polar" .ig.tar format only (cannot be edited)

Zero Padding

Enables or disables zero padding for input from an I/Q data file that requires resam-
pling. For resampling, a number of samples are required due to filter settling. These
samples can either be taken from the provided I/Q data, or the software can add the
required number of samples (zeros) at the beginning and end of the file.

If enabled, the required number of samples are inserted as zeros at the beginning and
end of the file. The entire input data is analyzed. However, the additional zeros can
effect the determined spectrum of the 1/Q data. If zero padding is enabled, a status
message is displayed.

If disabled (default), no zeros are added. The required samples for filter settling are

taken from the provided I/Q data in the file. The start time in the R&S VSE Player is
adapted to the actual start (after filter settling).

Note: You can activate zero padding directly when you load the file, or afterwards in
the "Input Source" settings.

Remote command:
INPut<ip>:FILE:ZPADing on page 505

File Repetitions

Determines how often the data stream is repeatedly copied in the 1/Q data memory to
create a longer record. If the available memory is not sufficient for the specified num-
ber of repetitions, the largest possible number of complete data streams is used.
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Recording and Recalling Captured 1/Q Data for Evaluation

Remote command:
INSTrument :BLOCk:CHANnel [ : SETTings] :FILE<fi>:REPetition:COUNt
on page 515

Meta Information
Provides additional general information on the data file, if available. This information is
provided for reference only and cannot be edited.

Restoring the Measurement Results - R&S VSE Player

To replay the stored measurements in individual channels, the R&S VSE software pro-
vides a special tool: the R&S VSE Player. Using the R&S VSE Player you can play
back the entire measurement, or only a specific time span, and you can define how to
process multiple records.

The R&S VSE Player is available via the "Window > Player" menu item.

[
I} anakyzer &
(] 1] [@) File: .
Flayback
Start Time 0.0s Cumrent Pazition 0.0 5 Stap Time 003
Civerlap
Averaging Om: T5.0 %o of meastime Averaging Off: 750 % af maastima

If available, the loaded 1/Q file for the selected measurement channel is displayed. You
can also load a different I/Q file directly in the R&S VSE Player.

Alternatively to the R&S VSE Player you can use the P ("Play") function in the "Mea-
surement Group Setup" tool window to replay a channel for which the "Input Source":
"File" is selected and a file is loaded.

For details, see "Play" on page 83.

You can also set an option in the general software settings so that the R&S VSE Player
is automatically displayed when you select a file as input for a measurement channel
(see "Show Player Automatically" on page 142).
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O Changing data acquisition settings for a stored measurement

When replaying stored measurement data from a file, you can change the Data Acqui-
sition and Bandwidth Settings, for example:

® Sample rate / Analysis bandwidth: The R&S VSE provides an internal resampler,
which allows you to change the sample rate, or bandwidth, or both, of the replayed
I/Q data

® Center frequency: You can shift the center frequency of the current measurement
compared to the stored measurement data. The maximum shift depends on the
current analysis bandwidth in the channel.
For details, see " Center Frequency " on page 218.

® | and Q paths: Swap the | and Q values for the measurement, for example to com-
pare the data to another measurement in which the instrument ports were swap-
ped.

O Zero padding
s You can activate or deactivate zero padding for a loaded input file in the "Input Source"
settings. For details, see "Zero Padding" on page 90.

L02=1 o) (1] YRR 132
e VU [T A O] o | S UUSURRRR 132
Measurement mode (Single/COoNtiNUOUS)......c..oiiuiiiiiiriiiiee et 133
LSRR 133

L CRANNEL. ... ettt en e, 134
1= 14 =Y o 1o TSR 134
Playback SetliNgS......cooiiiiiiiiee e e e e e e 134
OVErlap SEHINGS. .uuuuciiiii e e e e e e ————————— 135

> Capture

Starts replaying the data from the 1/Q file from the beginning for the measurement
channel. Any averaging procedures are restarted.

In "Single" measurement mode, the first record in the 1/Q data file is replayed.

For . igx files that contain trigger markers, the record is replayed from the selected
trigger marker to the next marker. To continue from the next marker, select "Cont".

In "Continuous" measurement mode, the entire measurement in the 1/Q data file is
replayed continuously, starting at the beginning.

Remote command:
INITiate<n>[:IMMediate] on page 525

[l Pause/Cont
"Pause" stops replaying data.

"Cont" continues replaying data (including any averaging procedures) at the current
position.

In "Single" measurement mode, the next record in the 1/Q data file is replayed.

For . igx files that contain trigger markers, the record is replayed from the selected
trigger marker to the next marker.
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To restart averaging, use the P ("Capture") function after stopping the last measure-
ment.

Remote command:
ABORt on page 523
INITiate<n>:CONMeas On page 524

—| Measurement mode (Single/Continuous)
Defines how data is replayed during the measurement.

=+|"Single" A single record is replayed. To replay subsequent records, continue
the measurement using the Il ("Pause/Continue") function.

@"Continuous" The data from the 1/Q file is replayed continuously until stopped.

Remote command:
INITiate<n>:CONTinuous on page 524

File
Specifies the 1/Q data file to be used for input.
Select a file from the list of recently loaded files, or select "..." to open the "Recall 1/Q

Recording" dialog box (see Chapter 8.3.4.1, "Loading the 1/Q Data File and Essential
Measurement Information”, on page 127).

Note: The data to be imported must be stored in a specified file format, see Chapter E,
"Reference: Supported 1/Q File Formats", on page 915.

Encrypted . wv files can also be used as input. Note, however, that traces resulting
from encrypted file input cannot be exported or stored in a saveset (see Chapter 8.3,
"Recording and Recalling Captured 1/Q Data for Evaluation", on page 119 and Chap-
ter 8.5, "Storing Graphical Results to an ASCII File", on page 138).

Tip:

You can load a file simply by selecting it in a file explorer and dragging it to the

R&S VSE software. Drop it into the "Measurement Group Setup" window or the chan-
nel bar for any channel. The channel is automatically configured for file input, if neces-
sary. If the file contains all essential information, the file input is immediately displayed

in the channel. Otherwise, the "Recall I/Q Recording" dialog box is opened for the
selected file so you can enter the missing information.

If the file contains data from multiple channels (e.g. from LTE measurements), it can be
loaded to individual input sources, if the application supports them.

For more information see "To import data via drag&drop" on page 441.

Remote command:

INSTrument :BLOCk:CHANnel [ : SETTings] :FILE<fi>:IQTar on page 509
INSTrument :BLOCk:CHANnel [ :SETTings] : FILE<fi>:CSV on page 506
INSTrument :BLOCk:CHANnel [ :SETTings] : FILE<fi>:IQW on page 510
INSTrument :BLOCk:CHANnel [: SETTings] :FILE<fi>:MAT on page 513
INSTrument :BLOCk:CHANnel [ : SETTings] : FILE<fi>:REPLace on page 516
INSTrument :BLOCk:CHANnel [ :SETTings] : FILE<fi>:WV on page 519
INSTrument :BLOCk:FILE<fi>:CSV on page 535

INSTrument :BLOCk:FILE<fi>:IQTar on page 536
INSTrument:BLOCk:FILE<fi>:TQW on page 537

INSTrument :BLOCk:FILE<fi>:MAT on page 540
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INSTrument :BLOCk:FILE<fi>:REPLace on page 541
INSTrument :BLOCk: FILE<fi>:WV on page 542

Channel < File

Determines which of the I/Q channels stored in the file is to be restored to the selected
measurement channel. This is relevant only for files that contain data from multiple
channels.

"Auto" imports all available channels in the file, if supported by the application.
Remote command:

INSTrument :BLOCk:CHANnel [ : SETTings] : FILE<fi>:STReam on page 519
INSTrument :BLOCk:CHANnel [ :SETTings] : FILE<fi>:STReam:AUTO

on page 518

To determine which data channels are available: INSTrument :BLOCk : CHANnel [ :
SETTings] :FILE<fi>:STReam:LIST? on page 518

Marker Info
(For . igx files only:)

Markerinfo:

-43.57%4 ms

1 RF Power Trigger

2 RF Power Trigger - 383.57& ms

3 RF Power Trigger - 72

Current Position | 43.57% ms

-1.06357 s

4 RF Power Trigger

Displays the trigger markers provided by the . igx file. Select the required marker to
start recalling the 1/Q data from the trigger position. In Single mode, you can replay the
data from one marker to the next using the "Cont" function.

Remote command:
TRIG:SEQ:SOUR MAIT, see TRIGger [:SEQuence] : SOURce on page 628

Playback Settings
The data to be replayed can be restricted to a specified "Meas Time" within the stored
measurement data.

Use the sliders or enter time values to define:

e Start time: the measurement time at which replay starts

® Current Position: the time in the measurement span that is currently being dis-
played

® Stop time: the measurement time at which replay stops

Remote command:

INSTrument :BLOCk :CHANnel [ : SETTings] : FILE<fi>:STARt:TIME

on page 517

INSTrument :BLOCk:CHANnel [ : SETTings] :FILE<fi>:STARt:SAMPle

on page 516

INSTrument :BLOCk:CHANnel [ : SETTings] : FILE<fi>:CURRent:TIME

on page 508

INSTrument :BLOCk:CHANnel [ : SETTings] :FILE<fi>:CURRent:SAMPle

on page 507
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Printing Current Measurement Results

INSTrument :BLOCk:CHANnel [ :SETTings] : FILE<fi>:STOP:TIME on page 517
INSTrument :BLOCk:CHANnel [ : SETTings] :FILE<fi>:STOP:SAMPle
on page 517

Overlap Settings
The overlap settings determine how successive records within one data file are
replayed.

After the first record has been replayed, the specified percentage (x) of the next record
is displayed together with the remaining data (meas time - x) from the previous record.

The larger the overlap, the slower the display is updated.

The behavior can be defined depending on the used trace mode. Note that the behav-
ior is applied to all windows of the same channel.

"Averaging Applies if any trace in the channel uses average, max hold or aver-
On:" age trace mode.

"Averaging Applies if no averaging trace modes are used in the channel.

Off:"

Remote command:

INSTrument :BLOCk :CHANnel [ : SETTings] : FILE<fi>:OVERlap:AVG:0ON
on page 515

INSTrument :BLOCk:CHANnel [ : SETTings] :FILE<fi>:0OVERlap:AVG:OFF
on page 514

Printing Current Measurement Results

Access: "File" > "Print"

To document the graphical results and the most important settings for the currently per-
formed measurement, you can create a hardcopy or screenshot of the current display.

Remote commands for these settings are described in Chapter 13.7.6, "Storing or
Printing Screenshots”, on page 848.
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Print @
e -QQAW ¢ 1409 [JHD
-
Printer
ﬂ Printto:  VpmuddP-rLI0995 -
Print Capies 1
Select Items ta Print:
Print Loga
Print Date and Time
Comment:
o din
Windows:
4 IQ Analyzer
1Q Analyzer: 1 Magnitude . £
R
o
Optians:
Crientation Partrait Landscape
il T
Saaling IMaintain aspect ratia Size to fit
Windaows / Page 1 -
Calars E
< I +

To print a screenshot of the current display with the current settings immediately, with-
out switching to the "Print" dialog, use the & "Print" icon in the toolbar.

o 136
4T O (o TSRS 137
170 o =T S 137
] 01 0 o o o F OO UP PP P PPPPP 137
Print Date and TiME.....cceee e et e e e e e e e e e eaans 137
(07010010 01=T 0 | SO 137
WWINAOWS ... ettt ettt e e e ettt e e e e et eat e e e e e eee b e e eeeesaba s eeeseetanaaeesenranns 137
(@4 T=T0] ¢= 1 (o] o SRS 137
S To= 10 o TP PTTPPP 137
WINAOWS / PGttt et e e e aeaeeaeean 137
(7o) (o] =70 138
miPrint

Starts printing all measurement results displayed on the screen: diagrams, traces,
markers, marker lists, limit lines, etc.. Optionally, comments and the date and time are
included at the bottom margin of the printout. All displayed items belonging to the soft-
ware user interface (e.g. toolbars or dialog boxes) are not printed.

Remote command:
HCOPy:ITEM:ALL on page 851
HCOPy:PRINt on page 851
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Print to
Specifies a printer configured for the PC the R&S VSE software is installed on.

Copies
Defines the number of copies to be printed.

Print Logo
Activates/deactivates the printout of the Rohde & Schwarz company logo in the upper
left corner.

Remote command:
DISPlay:LOGO on page 849

Print Date and Time
Activates/deactivates the printout of the current date and time at the bottom of the
screenshot.

Remote command:
HCOPy:TDSTamp:STATe<1 | 2> on page 852

Comment

Defines an optional comment to be printed with the screenshot of the display. Maxi-
mum 120 characters are allowed. 60 characters fit in one line. In the first line, at any
point a manual line-feed can be forced by entering "@".

The comment is printed below the diagram area, but not displayed on the screen.

Remote command:
HCOPy:ITEM:WINDow<1|2>:TEXT on page 851

Windows
Selects the result display windows to be included in the screenshot. By default, all
active windows are included.

Orientation
Selects the page orientation of the printout: portrait or landscape

Remote command:
HCOPy:PAGE:ORIentation<1|2> on page 852

Scaling
Selects the scaling of the printout on the paper. A preview using the selected setting is
displayed in the dialog box.

"Maintain The diagram is scaled only as required to fit the available paper size,
aspect ratio" while maintaining the original aspect ratio.
"Size to fit" (Default) Scales the printout to fit the paper size optimally.

Windows / Page
Defines the number of diagrams to be printed on a single page.
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Colors
Opens the "Print Color" dialog box to configure the colors for printing screenshots. For
details, see " Print Colors " on page 144.

8.5 Storing Graphical Results to an ASCII File

Access: "Edit" > "Trace Export"

For some applications, the graphical measurement results can be stored to an ASCII
file for evaluation using different software. If available, these functions ("Trace Export")
are described in the trace configuration settings for the specific application.

8.6 Copying Graphical Results to the Clipboard

Access: "Edit" > "Copy to Clipboard"

For some applications, the graphical measurement results in an individual diagram can
be copied to the Windows clipboard in ASCII format for further processing. When you
select this function, the result data in the currently selected window of the active mea-
surement channel is copied to the clipboard. The data is equivalent to the ASCII data
stored to a file using the "Trace Export" functions.
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General Software Behavior

9 General Software Preferences and Informa-

9.1

tion

Some basic software settings can be configured independently of the selected operat-
ing mode or application. Usually, you will configure most of these settings initially when
you set up the software according to your personal preferences or requirements and
then only adapt individual settings to special circumstances when necessary. Some
special functions are provided for service and basic system configuration.

Recording, Network and Remote Settings
Recording settings are described in Chapter 8, "Data Management", on page 110.

Settings for network and remote operation are described in Chapter 12.2, "Network
and Remote Control Settings", on page 479.

o General Software BEhavVior...........ooieiiiiiiiiiiie e 139
®  Display SettiNgS. ... e 141
®  ApPlICation StArtEr.. ..o —————————— 147
e Software Information and SUPPOIt........ceeviiiieiiii i 153

General Software Behavior

Access: "File" > "Preferences" > "General"

You can determine the behavior of the software when it is being shut down and restar-
ted.

Displayed ltems ~ Theme + Color ~ MNetwork + Remote  Recording

r General Settings

Create shutdown File
The shutdown file is located at: D:/oitESMain/HAUNOLDE ES-MAIN 15.7.4.0 view/Build/"/515x64/bin/results/
Reconnect Saved Connections on startup

Reconnect Saved Connections After Recall
Show hidden entries in |/Q File explorer

Create ShutdOWN File......oooi e 140
Reconnect saved connections on startup..........oooeeeeeeiiiiiiiiiicceeree e 140
Reconnect saved connections after recall...........cccccvevieeiiiiieii i, 140
Show hidden entries in I/Q File EXPIOrEr.......cuuiiiiieiieiiccciiiiieieeee et e e 140
Deleting the ShutdOWn File.........u i e e e e e e e e e e eeeees 140
Defining a Startup Settings File... ... e 141
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Create Shutdown File

If activated, a shutdown file is created when the R&S VSE software is closed. The
shutdown file contains information on the defined connections, as well as measure-
ment sequence and channel configuration, such as which input sources are used for
which measurement channels and which result displays are active.

When the R&S VSE software is started again, the previously stored configuration is
restored. If you delete the shutdown file (see "Deleting the Shutdown File"
on page 140), the R&S VSE software starts in the default configuration the next time.

The shutdown file is stored located at
C:\ProgramData\Rohde-Schwarz\VSE\<version number>\results\
Shutdown.dfl.

Reconnect saved connections on startup

If activated, when the R&S VSE software is started, a connection is automatically
established to all configured instruments (see Chapter 8.2, "Storing and Recalling Mea-
surement Settings", on page 111).

If deactivated, the instrument configurations are restored in the "Instruments" window;
however, the connections must be established manually (see "Connect / Disconnect /
Reconnect" on page 69).

This function is only available if a shutdown file is available (see "Create Shutdown
File" on page 140).

Reconnect saved connections after recall

If activated, when stored measurement settings are recalled, a connection is automati-
cally established to all configured instruments (see Chapter 8.2, "Storing and Recalling
Measurement Settings", on page 111).

If deactivated, the instrument configurations are restored in the "Instruments" window;
however, the connections must be established manually (see "Connect / Disconnect /
Reconnect" on page 69).

This function is only available if a shutdown file is available (see "Create Shutdown
File" on page 140).

Show hidden entries in 1/Q File Explorer

If enabled, files usually hidden by the Windows File Explorer are displayed in file selec-
tion dialog boxes used by the R&S VSE software. This is useful, for example, to
access demo files provided by Rohde & Schwarz in the
C:\ProgramData\Rohde-Schwarz\VSE\<version no>\user\Demo\ directory.

If disabled, "hidden" files are not displayed for selection. However, if you enter the full
path and file name, you can still access them.

Deleting the Shutdown File
Access: "Start" > "All Programs" > "Rohde-Schwarz" > "VSE" > <version_number> >
"Delete Shutdown File"

In the Windows "Start" menu, an additional function is provided to delete the file that
stores the current software configuration during shutdown, if available (see "Create
Shutdown File" on page 140). If you delete the shutdown file, the R&S VSE software
starts in the default configuration the next time the R&S VSE software is started again.
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Deleting the shutdown file does not affect settings concerning the layout of the basic
R&S VSE window. The display and position of toolbars and special tool windows are
retained.

Deleting the shutdown file has the same effect as Restoring All Default Settings (Pre-
set All) directly after startup.

Defining a Startup Settings File
You can define a settings file other than the shutdown file to be restored during soft-
ware startup, see Chapter 8.2.2.4, "Startup Recall Settings", on page 117.

9.2 Display Settings

Some general display settings are available regardless of the current application or
operating mode.

Access: "File" > "Preferences"

L I I 11T o] F= Y=Y 1 =Y o 141
o Display Theme and CoOlOrS.........euuuiiiiiiiiiiiiiieie e e e e ee e e e e e e e 142
e How to Configure the Colors for Display and Printing..........cooooeeioiieieee 146

9.2.1 Displayed Items

Access: "File" > "Preferences" > "Displayed Items"

Several elements on the screen display can be hidden or shown as required, for exam-
ple to enlarge the display area for the measurement results.

M Theme + Color  Metwork + Remote  Recording

Multiviews mode O

Showr player automatically o Off

Status Bar off

Annotation “ O
Y LU AV g o T [N 141
Show Player AutomMatiCally...........ooiiiiiiiiii e 142
] =Y (U ST == 142
[DIE=Te] ¢=Taall atele) (=T AN aTaTo] =1 iloT o | PSSR 142

Multiview mode
By default, all windows for all active measurement channels are displayed at the same
time on the screen (see also Chapter 6.3.2, "MultiView Mode", on page 56).
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Disable this option to display only the windows for a single measurement channel at a
time. In this case, the windows for each channel are displayed in individual tabs. Only
the windows for the currently focused channel are visible. To switch between channels,
select the corresponding tab.

Remote command:
DISPlay:FORMat on page 585

Show Player Automatically

If enabled, the R&S VSE Player is displayed automatically if a file is selected as the
input source of a measurement channel (see "Assigning the Channel Input Source"
on page 88).

Status Bar
The status bar beneath the diagram indicates the global software settings, the software
status and any irregularities during measurement or display.

Some of the information displayed in the status bar can be queried from the status reg-
istry via remote commands, see Chapter 13.10.1, "Using the Status Register",
on page 864.

Remote command:
DISPlay:SBAR[:STATe] on page 855

Diagram Footer (Annotation)

The diagram footer beneath the diagram contains information on the x-axis of the dia-
gram display, such as the current center frequency and span settings, the displayed
span per division and the number of measurement points.

Remote command:
DISPlay:ANNotation:FREQuency on page 855

9.2.2 Display Theme and Colors

Access: "File" > "Preferences" > "Theme + Color" .
You can configure the used colors and styles of display elements on the screen.

For step-by-step instructions see Chapter 9.2.3, "How to Configure the Colors for Dis-
play and Printing", on page 146.
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Preferences D |
General  Displayed kems Metwork + Remote  Recording
Theme
|
Screen Colors - Print Colors
|
Default Colors 2 Optimized Colors
User Defined Colors User Defined Colaors
Screen Colors (Hardcopy)
D Show Print Colors on Display
’ Modify User Defined Colors ] [ Madify User Defined Colors I

[ ’ Set User Defined Colors To Default ] [ Set User Defined Colors To Default l
TREIME ettt e e s e e e eeeeaeaaaaaeeeeeeeeeeraaararr b a—————— 143
SCIEEN COlOIS ...t e et e et e e e e e e e e e e e oottt ettt et et aeseeeeeaaaaaaaaseseeeeeeanennes 144
PrINT COIOIS oottt e e e e e e e e e e e e e e e e e e e e e e e e eeaeaesssrabananaannnns 144
Showing Print Colors on DiSplay.........ccccuuiiiiiiieiieee e e e e e e 144
Modifying User-Defined Color ASSIGNMENTS.........ccccuviiiiiiiieeeee e 144

L SeleCting the ODJECL.........cveeeeeeeeeeeeeeeee ettt et en s n e 145

L Predefin@d COlOrS .......c.c.cveeeeecececeeeeteteteteeeeeeeeeeesaeaete ettt es s s e s nananaeaeeas 145

L PrOVIEW .ottt s s ee e e et et e st s et esenen s enanananenaeeas 145
Defining User-specific COIOIS. .....ouii ittt 145
Restoring the User Settings to Default Colors..........ccovviiieiiiiiiiiieee e 146
Theme
The theme defines the colors and style used to display softkeys and other screen
objects.

The default theme is "PCSW" .
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Remote command:
DISPlay:THEMe:SELect on page 857

Screen Colors
Two different color sets are provided by the software, a third user-defined set can be
configured.

The default color schemes provide optimum visibility of all screen objects when regard-
ing the screen from above or below. Default setting is "Default Colors 1" .

If "User Defined Colors" is selected, a user-defined color set can be defined (see
"Defining User-specific Colors" on page 145).

Remote command:
DISPlay:CMAP<it>:DEFault<ci> on page 856

Print Colors
Defines the color settings used for printout.

In addition to the predefined settings, a user-defined color set can be configured (see
"Defining User-specific Colors" on page 145).

If "Show Print Colors on Display" is activated, the currently selected print colors are
displayed as a preview for your selection.

Gui setting Description Remote command

"Optimized Colors" Selects an optimized color setting for the HCOP:CMAP:DEF2
printout to improve the visibility of the colors
(default setting). Trace 1 is blue, trace 2
black, trace 3 green, and the markers are
turquoise. The background is always printed
in white and the grid in black.

"Screen Colors (Print)" | Selects the current screen colors for the HCOP:CMAP:DEF1
printout. The background is always printed in
white and the grid in black.

"Screen Colors Selects the current screen colors without any | HCOP: CMAP : DEF4
(Screenshot)" changes for a screenshot.
"User Defined Colors" | Selects the user-defined color setting. HCOP:CMAP:DEF3

Remote command:
HCOPy:CMAP<it>:DEFault<ci> on page 849

Showing Print Colors on Display
Temporarily shows the currently selected print colors on the screen display. This func-
tion can be used as a preview for printing.

Modifying User-Defined Color Assignments
You can configure the colors used to display and print individual screen objects accord-
ing to your specific requirements.

The colors are configured in the (identical) "Screen Color Setup" / "Printer Color Setup”
dialog boxes.
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Display Settings
Screen Color Setup ‘ L
Selected Object:
Background -
Predefined Colors

| Preview

OK Cancel

Userdefined Colors ...

Selecting the Object «— Modifying User-Defined Color Assignments
Selects the object for which the color is to be defined. Colors can be defined for the
following objects:

Background

Grid

Individual traces

Display lines

Limit lines and check results
Markers and marker information

Remote command:
Each object is assigned to a specific suffix of the CMAP commands, see Chap-
ter 13.8.4, "CMAP Suffix Assignment", on page 858.

Predefined Colors «— Modifying User-Defined Color Assignments
Displays the available colors from the predefined color set that can be used for the
selected object.

Remote command:
HCOPy:CMAP<it>:PDEFined on page 850

Preview — Modifying User-Defined Color Assignments
Indicates the currently selected color that will be used for the selected object.

Defining User-specific Colors
In addition to the colors in the predefined color set you can configure a user-specific
color to be used for the selected object.

When you select "Userdefined Colors..." , the set of predefined colors is replaced by a
color palette and color configuration settings.
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-

ScmmCoIorSe!qp_- |

Selected Chject:
Background

fa
! Preview Tint: 50
Saturation: 0
Brightness: 0
ARGE: FRO00000
Predefined Colars ...
oK Cancel

The color palette allows you to select the color directly. The color settings allow you to
define values for tint, saturation and brightness.

Remote command:
HCOPy:CMAP<it>:HSL on page 850

Restoring the User Settings to Default Colors

In addition to the predefined color settings, a user-defined setting can be configured.
By default, the same settings as defined in "Default Colors 1" are used. They can then
be modified according to user-specific requirements (see "Modifying User-Defined
Color Assignments" on page 144).

The "Set to Default" function restores the original default settings for the user-defined
color set. You can select which of the three default settings are restored.

Remote command:
DISPlay:CMAP<it>:PDEFined on page 857

9.2.3 How to Configure the Colors for Display and Printing

You can configure the style and colors with which various screen objects are displayed
or printed.

To select a color set
1. Select "File" > "Preferences" > "Theme + Color".

2. Inthe "Screen Colors" area, select a predefined set of colors to be used for screen
display, or select "User Defined Colors" to configure the color set yourself.
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3. Inthe "Print Colors" area, select a predefined set of colors to be used for printing
screenshots, or select "User Defined Colors" to configure the color set yourself.
Activate the "Show Print Colors on Display" option to see a preview of the print col-
ors.

To configure a user-defined color set

1. Inthe "Theme + Color" tab of the "Preferences" dialog box select "User Defined
Colors" either for the screen or the print colors.

2. Select "Modify User Defined Colors".

The "Screen Color Setup" dialog box is opened.

3. From the "Selected Object" list, select the object to which you want to assign a
color.

4. Select a color from the "Predefined Colors" or select the "Userdefined Colors..."
button to define a different color.

The "Preview" area indicates the currently selected color.

5. To assign a user-specific color to the selected object, do one of the following:

Select the color from the palette.
Enter values for the "Tint", "Saturation", and "Brightness".
Note: In the continuous color spectrum ("Tint") red is represented by 0% and
blue by 100%.
e Enter an "ARGB" value in hexadecimal format.

6. Select the next object to which you want to assign a color from the "Selected
Object" list and assign a color as described.
Repeat these steps until all objects you want to configure have been assigned a
color.

7. Select "OK" to close the dialog box and apply the colors to the assigned objects.

9.3 Application Starter

The Application Starter allows you to start any external application directly from the
R&S VSE firmware.

User Manual 1176.8839.02 — 14 147



General Software Preferences and Information

R&S®VSE

9.3.1

Application Starter

External Applications User Applications

- jeCwin32 K¥0_Setup_GSM_EDGE_Signal_Medium

Add Application

This is useful, for example, for the following scenarios:

® Starting analysis software for the measurement data, such as R&S Vector Signal
Analysis (VSA) software

e Starting the provided auxiliary tool IECWIN to test a remote command script that
was created using the SCPI Recorder, for example

e Start an application to send the measurement results to a connected PC or cloud

e Start any custom application script to provide additional functionality to the firm-
ware, such as measurement-specific auto leveling

Application Starter Functions

Access: Toolbar
The Application Starter dialog box provides different tabs for different types of applica-
tions:

e "External Applications": contains applications that are provided with, but are not
part of the R&S VSE, such as auxiliary tools

e "User Applications": contains any user-defined applications that can be accessed
from the R&S VSE, such as command scripts

® "R&S Applications": contains applications predefined by Rohde & Schwarz to
enhance the functionality of your R&S VSE

You can add further applications to the "User Applications" and "External Applications"
tabs as you like. They are separated only to improve usability if you have a large num-
ber of applications. The "R&S Applications" tab cannot be edited by users.

The Application Starter provides the following functions.

PN o] ][ Toz= 1T 4 I o101 (o] o < TSR 149
Add Application/ Change ApPliCatioN...........coiiii i 149
L Drive/ Path/ File NAME.........cccvieeeeeeeeeeeeeeeeeeeeesese e ess s 149
L TS Y= TR 149
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L SIECE. ...ttt ettt ettt ettt ettt en s e en e ananaeen 149
L 0T 0 1= (=S 149
L APPICALON. ...ttt et en e 150
L P AIAMELETS .. ettt ettt et et e et et et e e e et e e ee e e eee e e e eaeen 150
L WOTKING DIFECIOTY.......cvveeeeceeee ettt e et e e en e s s s st e e s eaenseanas 150
L DiSPIAY NAME.... ..ttt ettt e en e en s en e s eeen e e 151
L CROO0SE ICON. .ttt ettt et et e et et e e et eaeee et eteeeeeeaeeeeaeenene 151
[T =] (ST N o RN 151
Yo (o IR (o T [ Yo 1| oY= 151
[ LoV 0] ' I FoTo]| 7= 151

Application buttons
Start the selected application directly on the R&S VSE. Any application windows, out-
puts, or results are displayed on the R&S VSE screen.

Add Application/ Change Application
Opens the "Add Application"/ "Change Application" dialog box. Both dialog boxes are
identical.

This function is not available for applications on the "R&S Applications" tab.

Remote command:
SYSTem:PLUGin:APPStarter:ADD on page 859

Drive/ Path/ File Name — Add Application/ Change Application
Defines the path and file name of the application.

Remote command:
SYSTem:PLUGin:APPStarter:PATH on page 861

File Type «— Add Application/ Change Application

Defines a filter for the type of application, for example an .exe, . inp (IECWIN script)
or other file.

If you select a file type other than . exe, the R&S VSE searches for the appropriate
application to start your file with.

For . inp files, for example, the IECWIN tool provided by Rohde & Schwarz to execute
scripts is preselected as the application to start.

Select — Add Application/ Change Application
Closes the "Add Application"/ "Change Applicaiton" dialog box and opens the "Edit
Properties" dialog box.

Remote command:
SYSTem:PLUGin:APPStarter:SELect on page 861

Edit Properties
Access: Application button context menu
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External Applications User Applications

iecwin32

Edit Froperties
Delete Link

Remove from Toolbar

Defines the display and behavior of the selected application.
This function is not available for applications on the "R&S Applications" tab.

Anplication CASimulationyES-MAIN 19.7.16.0 simbbinReleaseliecwind 2. exe

Parameters L27.0.0. 10 hislip0 SO FFSWSIHus\inputh KFOET0_Setup_ GSM_EDGE_Signal_Medium.inp”
wWorking Directory  SWFAFSW_Siriusfinput/k¥o

Display Name K70 _Setup_GSM_EDGE_Signal_Medium

i_
Choase Ican

o].4

Tip:
For . inp files, the IECWIN tool provided by Rohde & Schwarz to execute scripts is
preselected as the application to start. The script is defined as the parameter for the

application. The file name without the extension is used as the application name. The
IECWIN icon is selected as the application icon.

Application — Edit Properties
Indicates the application selected in the "Add Application" dialog box. Provides access
to the Add Application/ Change Application dialog box to change the application.

Remote command:
SYSTem:PLUGin:APPStarter:PATH on page 861

Parameters < Edit Properties
Defines parameters that are provided with the application for execution, for example
arguments for a custom script.

Remote command:
SYSTem:PLUGin:APPStarter:PARams on page 861

Working Directory — Edit Properties
Defines the working directory used by the selected application.

Remote command:
SYSTem:PLUGin:APPStarter:DIRectory on page 860
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Display Name — Edit Properties
Defines the name of the application as displayed on the button in the "Application
Starter" dialog box.

Remote command:
SYSTem:PLUGin:APPStarter:NAME on page 861

Choose Icon < Edit Properties
Defines an icon for the application to be displayed on the button in the "Application
Starter" dialog box and optionally in the toolbar.

Remote command:
SYSTem:PLUGin:APPStarter: ICON on page 860

Delete Link
Access: Application button context menu

Removes the application from the "Application Starter" dialog box and the toolbar.
This function is not available for applications on the "R&S Applications" tab.

Remote command:
SYSTem:PLUGin:APPStarter:DELete on page 860

Add to Toolbar
Access: Application button context menu

Inserts the specified application icon in the R&S VSE toolbar.

Remove from Toolbar
Access: Application button context menu

Removes the application icon from the R&S VSE toolbar.
9.3.2 How to Work With the Application Starter

To start an application

1. Select the Application Starter icon from the toolbar.

The "Application Starter" dialog box is displayed.
2. Select the required application from the dialog box.

The application is started and displayed on the R&S VSE screen.

To return to the R&S VSE

% 1. If no external keyboard is connected to the instrument, select the online keyboard
icon.

2. Press the [Alt]+[Tab] keys.
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To add an application to the Application Starter

™ 1. Select the Application Starter icon from the toolbar.
The "Application Starter" dialog box is displayed.
2. Select "Add Application".
3. Select the file type of the application to filter the file selection in the dialog box.
4. Select or enter the file name of the required application.
5. Select "Select".
The "Edit Properties" dialog box is displayed.
Edit Properties -~ EE
Application ChSimulationES-MAIM 19,7, 16.0 sim\binReleaseliecwindd, exe
Parameters L27.0.0. 1 hizlipl "S AP ESA_Sirusinputl K7 T 0_Setup GEM_EDGE_Signal_Medium.inp”
Working Directory  S0FFSW_Sirius/inputykT0
Display Hame K70_Setup_GSM_EDGE_Signal_Medium
Chaaose Ican
914
6. Optionally, define parameters to be provided to the application.
7. Define the working directory to be used by the application.
8. Define the name to be displayed on the button in the "Application Starter" dialog
box.
9. Select an icon to be displayed on the button in the "Application Starter" dialog box
and optionally in the toolbar.
10. Select "OK".
The application is available in the Application Starter.
11. Optionally, add an icon for the application to the toolbar.
To add an icon for the application to the toolbar
1. Select the Application Starter icon from the toolbar.

The "Application Starter" dialog box is displayed.
2. Right-click the application button in the Application Starter.
3. Select "Add to Toolbar".
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9.4.1

®

Software Information and Support

Software Information and Support

Some general software functions are available concerning optional functionality, licen-
ses, service functions, or system messages. These settings are available from the
"Help" menu.

o Licensing, Versions and OpPtioNS.......cccouiiieieiiiiiiee e 153
o R&S Support INfFOrmation............uueieiiiieee e 155
®  SYSIEM MESSAQES. . ..o i i i i it e e e e e e e e e e e —————————— 157

Licensing, Versions and Options

Access: "Help" > "License"

Information on the R&S VSE software version and additional licensed options is provi-
ded in the "Versions + Options" dialog box. The unique Rohde & Schwarz device ID is
also indicated here, as it is required for license and option administration. Furthermore,
you can also install new firmware options in this dialog box.

Finally, an open source acknowledgment is available at the bottom of the table.

To simply find out the version of the R&S VSE software, select "Help > About".

Ttem | Option | ‘ersion ‘ License -
{R&s Device 1D 1310,0002K02-90001.4-if
R&E WSE 1.30-17.3.5.0 Beta [2017-03-07)
Time Control Management active
Smart Card Senvice installed
Pulse Measurements Kb 1.30 permanent, maintenance until 2018-09-30
G5M/ED GE/EDGE Evo/vAMOS Measurements K10 1.30 permanent, maintenance until 2018-09-30
Transient Analysis Keo 1.30 Beta permanent, maintenance until 2013-09-30
Transient Chirp Measurements ke0C 130 permanent, maintenance until 2018-09-30
Transient Hop Measurements k60H 130 permanent, maintenance until 2018-03-30
Wedkor Signal Analysis K¥0 130 permanent, maintenance until 2018-09-30
3GPPFDD (WCDME) Measurements K72 1.20 permanent, maintenance until 2018-09-30
s02.11ac Measurements K91-11AC 130 permanent, maintenance until 2013-03-30
802.11a/b/a/i Measurements kgl 130 permanent, maintenance until 2018-09-30
602,110 Measurements K31n 130 permanent, maintenance until 2018-03-30
Open Source Acknowledgement open . !

Install Option Install Option by XKML

Expired option licenses

If an option is about to expire, a message box is displayed to inform you. You can then
use the "Install Option" function to enter a new license key.

If an option has already expired, a message box appears for you to confirm. In this
case, all software functions are unavailable (including remote control) until the

R&S VSE is rebooted. You must then use the "Install Option" function to enter the new
license key.
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Remote commands:

DIAGnostic:SERVice:VERSinfo? on page 854

Open Source Acknowledgment: OPEN.........ueeiiiiieeeie i i e e e e e 154
TS 2= | I @] o] 1T ] o T PSR 154
Install OPtioN DY XIML.....uueiiiiiiiei ettt e e e e e e s r e e e e e e e e e e s snnnnes 154
[ [0 T LT e TS =T YT 154
L USAG. ettt ettt et ee et e e e e 155
L P/ HOSE NAME.......eeceeeeee ettt 155
L PO / RPOM. ...ttt 155
L DESCIIPHON. ...ttt et e e et s s s e e s s nn e 155
L APy ettt ettt n et et et nen et nen e 155
X o OO 155
=Y 1T 12 RO 155
L OPEN MANAGET........ocuieieeeeeeeeeeeeeeeee ettt en et enan e 155

Open Source Acknowledgment: Open
Displays a PDF file containing information on open source code used by the R&S VSE
software.

Install Option
Opens an edit dialog box to enter the license key for the option that you want to install.

Only user accounts with administrator rights are able to install options.

Install Option by XML

Opens a file selection dialog box to install an additional option to the R&S VSE using
an XML file. Enter or browse for the name of an XML file that contains the option key
and press "Select".

Only user accounts with administrator rights are able to install options.

Floating Server

| Versions Options Floating Server

This table shows all floating license servers configured in your local License Manager. You may add or remove servers, edit or enabled/disable them as you like. All enabled servers are searched
- forfloating licenses on application startup. If you change settings in this table, please make sure to restart both the local License Service and this application.

1P / Host name | RPart | Description

| Port -
-

Apply Add Remove Open Manager

Indicates the currently configured floating license servers. All enabled servers are
searched for floating licenses when the R&S VSE software starts. Note that changes to
the list of servers only take effect after the R&S VSE software is restarted. To abort any
changes, simply close the dialog box.

This function is only available for the R&S VSE Enterprise Edition.

User Manual 1176.8839.02 — 14 154



R&S®VSE General Software Preferences and Information

Software Information and Support

For more information, see Chapter 3.4, "Using a License Server", on page 19.

Usage < Floating Server
Only enabled servers are searched. Disable servers you do not want to remove perma-
nently, but which are currently not used.

IP / Host name < Floating Server
IP address or host name of the server. Ask your administrator for details.

Port / RPort — Floating Server
Port information for the server. Ask your administrator for details.

Description < Floating Server
Optional description of the configured server.

Apply < Floating Server
Stores the edited floating license server list and asks you to restart the R&S VSE soft-
ware so that the changes take effect.

Add < Floating Server

Inserts a new line in the server list to configure a floating license server. The server
must be connected to the same network as the R&S VSE software, and set up as
described in the R&S®License Server - Managing Floating Licenses - User Manual
(see also "Open Manager" on page 155). The server is automatically enabled for use
by default. Any changes to the list of servers only take effect after the R&S VSE soft-
ware is restarted (see "Apply" on page 155).

Remove — Floating Server
Removes the selected server from the list permanently.

Tip: To disable the server without removing it permanently, deselect the Usage check-
box.

Open Manager < Floating Server

Displays the R&S®License Server Manager window. Press [F1] or select "Help" >
"Show Help" in this window to obtain more information on managing floating licenses.

9.4.2 R&S Support Information

Access: "Help" > "Support" > "R&S Support"

In case of errors you can store useful information for troubleshooting and send it to
your Rohde & Schwarz support center.
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R&S Support System Messages

Create R&S Support Information Location: CyProgramData\Rohde-Schwarzy\WSE\1.05_05\user,

In case of problems, please write an email with the error description,
attach the Support Information file
and send the email to the Rohde&Schwarz Support Center.

Sawve Device Footprint Location: C\ProgramData\Rohde-Schwarz\\WSE\1.05_05\devicedata'\ XML\,

Contact Information

Customer Support Europe, Africa, Middle East:  Phone <49 83 412912345

customersupport@rohde-schwarz.com

Customer Support Morth America: Phone 1-588-TEST-RSA [1-888-837-8772)

customer.support@rsa.rohde-schwarz.com

Customer Support Latin America: Phone =1-410-210-7938

customersupport.la@rohde-schwarz.com

Customer Support Asia/Pacific Phone <6565 13 04 88

customersupport.asia@rohde-schwarz.com

Customer Support China: Phone <86-800-810-8228 / +856-400-650-55%

customersupport.china@rohde-schwarz.com

Create R&S Support Information ... e 156
Save Device FOOIPIINT........ooiiieeccrre e e e e e e e e e e 156

Create R&S Support Information

Creates a *.zip file with important support information. The *.zip file contains the sys-
tem configuration information ( "Device Footprint" ), the current eeprom data and a
screenshot of the screen display.

This data is stored to the following directory on the PC the R&S VSE software is instal-
led on:

C:\ProgramData\Rohde-Schwarz\VSE\<version no>\user

The file name consists of the unique device ID and the current date and time of the file
creation.

Example: VSE 1310.0002K02-900014-1f 20140807 091003.zip.

If you contact the Rohde & Schwarz support to get help for a certain problem, send
these files to the support in order to identify and solve the problem faster.

For more helpful information for support, see also "To create Windows event log files"
on page 899

Remote command:
DIAGnostic:SERVice:SINFo? on page 853

Save Device Footprint
Creates an *.xml file with licensing information on installed software versions.
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This data is stored to the following directory on the PC the R&S VSE software is instal-
led on:

C:\ProgramData\Rohde-Schwarz\VSE\<version no>\devicedata\xml\.
Itis also included in the service.zip file.

The file name consists of the unique device ID and the current date and time of the file
creation, e.qg.
DeviceFootprint 1310.0002K02-900014-if 2014-08-07T06-58-29.xml.

Remote command:
SYSTem:DFPRint on page 854

System Messages

Access: "Help" > "Support" > "System Messages"

Any messages that are displayed in the status bar during operation can also be dis-
played in the "System Messages" tab of the "Support" window. The messages are dis-
played in the order of their occurrence; the most recent messages are placed at the top
of the list. Messages that have occurred since you last visited the system messages
tab are marked with an asterisk "™'.

. e ——C

R&S5 Support Service Function System Messages

0x3004b035 2014-01-16 10:10:08 -
‘Missing smartcard or smartcard not initialized' !

COMMON

0x8004b038  2014-01-15 10:47:33

‘Missing smartcard or smartcard not initialized' !

COMMON

Clear All Messages

Clear All Messages

If the number of error messages exceeds the capacity of the error buffer, "Message
buffer overflow" is displayed. To clear the message buffer use the "Clear All Messages"
button.

The following information is available:
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No device-specific error code

Date/Time date and time of the occurrence of the message

Message brief description of the message

Component hardware messages: name of the affected module
software messages: name of the affected application

Remote command:
SYSTem:ERRor:CLEar:ALL on page 868
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10.1

10.1.1

Measurements and Result Displays for the I/Q Analyzer

/Q Analyzer Measurements

Measurements and Result Displays for the 1/Q Ana-
lyzer

The 1/Q Analyzer analyzes the 1/Q data that was captured by the connected instrument
or imported to the R&S VSE in various different result displays. By default, a basic I/Q
measurement is performed on the | and Q components of the data.

Alternatively, the 1/Q Analyzer can also perform measurements on the captured 1/Q
data in the frequency domain. In order to do so, the I/Q Analyzer performs an FFT
sweep on the captured 1/Q data, providing power vs frequency results. This data is
then used for the common frequency or time domain measurements provided by a
common spectrum analyzer, such as ACLR or OBW.

Maximum span for RF measurements

The maximum span for RF measurements is restricted to the maximum usable 1/Q
bandwidth of the connected instrument.

For detailed information on these measurements see:

® Chapter 10.4.1, "Channel Power and Adjacent-Channel Power (ACLR) Measure-
ment", on page 244

® Chapter 10.4.2, "Occupied Bandwidth Measurement (OBW)", on page 293
® Chapter 10.4.3, "Spectrum Emission Mask (SEM) Measurement", on page 300
® Chapter 10.4.4, "Time Domain Power Measurement”, on page 341

o Selecting the MeasuremMeNt........c.cooiiiiiiiiiiei e 159
Result Displays for Basic I/Q Measurements..........cccceeeveeeeeeiiiccciniinieeeeeeeeee e s 160
Result Displays in the Time and Frequency Domain............cccccvccecceeiiiieieeeneeeenn, 167

Selecting the Measurement

Access: "Meas Setup" > "Select Measurement"

Which type of measurement is to be performed - conventional I/Q data analysis or a
time or frequency domain measurement - is selected in the "Select Measurement” dia-
log box.

User Manual 1176.8839.02 — 14 159



R&S®VSE 1/Q Analyzer Measurements

10.1.2

Measurements and Result Displays for the 1/Q Analyzer

r Power Measurements ——— Basic Measurements

Channel Power ACLR

IQ Analyzer

All Fundctions Off

For details on RF measurements see:

® Chapter 10.4.1, "Channel Power and Adjacent-Channel Power (ACLR) Measure-
ment", on page 244

® Chapter 10.4.2, "Occupied Bandwidth Measurement (OBW)", on page 293

® Chapter 10.4.3, "Spectrum Emission Mask (SEM) Measurement”, on page 300

Remote command:

ACLR, OBW:

CALCulate<n>:MARKer<m>:FUNCtion:POWer<sb>:SELect on page 678
CALCulate<n>:MARKer<m>:FUNCtion:POWer<sb>[:STATe] on page 678
SEM:

[SENSe: ] SWEep:MODE on page 695

INITiate<n>:ESPectrum on page 694

All Functions Off
Switches off all RF measurement functions and returns to conventional 1/Q data analy-

SIS.

Remote command:
CALC:MARK:FUNC:POW:STAT OFF

Result Displays for Basic I/Q Measurements

The following result displays are available for (default) basic 1/Q measurements.
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@ Spectrograms
Spectrograms are not configured as separate result displays, but as a subwindow of an
existing 1/Q Analyzer Spectrum or Magnitude window. They are activated and deactiva-
ted in the "Spectrogram" tab of the "Traces" settings (see "Spectrogram Settings"
on page 377).

MaGNITUAE ..ot e e e e e s e e e e e e e e e 161
0T 0= o1 1 U o R 161
FL @ Y <Y1 (o] 162
== VA g =T T ) LR 163
SHALISHC AP e e e e e ———————— 163
] E= 1 (o3 01 0 I | R 164
e AP TR LT T o1 YR 166
= T L= A =1 o L= TN 166
Magnitude

Shows the level values in time domain.

* IQ Analyzer: 1 Magnitude ®1APClrw A W
D4[1] -4,91 dB

-735.766 ps

M1[1] -42.59 dBm

4,336 ms

CF 1.0 GHz 1001 pts

Remote command:

LAY:ADD:WIND? '1',RIGH,MAGN, see LAYout:ADD[:WINDow]? on page 579
Results:

TRACe<n>[:DATA] ? on page 823

Spectrum
Displays the frequency spectrum of the captured 1/Q samples.
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* IQ Analyzer: 3 Spectrum e1APClrw & W

Bandwidth

524288 pts Span 32.0 MHz

Tip: You can analyze the levels per frequency over time using a Spectrogram, see
"Working with Spectrograms" on page 366.

The specified Analysis Bandwidth is indicated by vertical blue lines.

Remote command:

LAY:ADD:WIND? '1',RIGH,FREQ, see LAYout:ADD[:WINDow]? on page 579
Results:

TRACe<n>[:DATA] ? on page 823

1/Q-Vector
Displays the captured samples in an I/Q-plot. The samples are connected by a line.

* 1Q Analyzer: 4 IQ-Vector ®1APCIrw & W

Ymax 10.00 mv

Note: For the 1/Q vector result display the number of I/Q samples to record ( "Record
Length" ) is automatically set to the number of measurement points. The number of
measurement points cannot be changed for this result display.

User Manual 1176.8839.02 — 14 162



R&S®VSE 1/Q Analyzer Measurements

Measurements and Result Displays for the 1/Q Analyzer

Remote command:

LAY:ADD:WIND? '1',RIGH,VECT, see LAYout:ADD[:WINDow] ? on page 579
Results:

TRACe<n>[:DATA] ? on page 823

Real/lmag (1/Q)
Displays the | and Q values in separate diagrams.

* 1Q Analyzer: 1 Real/Imag (1/Q) Real ®1APCIrw & W

1Q Analyzer: 1 Real/Imag (I/Q) Imag ® 1AP Clrw

CF 1.0 GHz

Remote command:

LAY:ADD:WIND? '1',RIGH,RIM, see LAYout:ADD[:WINDow] ? on page 579
Results:

TRACe<n>[ :DATA] ? on page 823

Statistic APD

Shows a histogram of measured I/Q magnitudes. The number of bins used for the his-
togram, that is, the number of different measurement values the statistical occurrence
is determined for, can be defined.
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* IQ Analyzer: 2 Statistic ®1AP Clrw ®2APClrw B W

CF -30.0 dBm 101 pts Span 100.0 dBm

Remote command:
LAY:ADD? '1',RIGH,STAT, see LAYout:ADD[:WINDow] ? on page 579

Statistic CCDF

The Complementary Cumulative Distribution Function (CCDF) shows the probability
that the mean signal power amplitude will be exceeded in percent. The level above the
mean power is plotted along the x-axis of the graph. The origin of the axis corresponds
to the mean power level. The probability that a level will be exceeded is plotted along

the y-axis.
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* 3 IQ Analyzer: 2 Statistic CCDF 8/ 1AP Clrw
M1[1]

20.0 dB

Samples 0
Trace 1

0.00 dBm
0.00 dBm
0.00 ¢B
0.00 de
0.00 d
0.00 d
0.00 de

A red line indicates the ideal Gaussian distribution for the measured amplitude range.
The number of Quantize Bins (2048) is indicated in the center of the diagram footer.

The displayed amplitude range is indicated as "Mean Pwr" + "<x dB>" in the diagram
footer.

The scaling for both the x-axis and y-axis of the statistics diagram can be configured.
In particular, you can restrict the range of amplitudes to be evaluated and the probabili-
ties to be displayed (see Chapter 10.3.3.5, "Scaling for Statistics Diagrams",

on page 214).

In addition to the histogram, a result table is displayed containing the following informa-
tion:
® Number of samples used for calculation
® For each displayed trace:
— Mean amplitude
— Peak amplitude
— Crest factor
The crest factor is defined as the peak power to mean power ratio or, logarith-
mically, as the peak level minus the average level of the signal.
— Levels for the probability values 10 %, 1 %, 0.1 %, 0.01 %

A special percentage marker is available for CCDF diagrams, which can be set to a
probability value (see " Percent Marker (CCDF only)" on page 241). Thus, the power
which is exceeded with a given probability can be determined very easily.

Note: Make sure the defined Analysis Bandwidth is wide enough for the signal band-
width of the device under test to be fully analyzed (see Chapter 10.3.6.1, "Data Acqui-
sition", on page 233).

In order to analyze the complete signal, make sure the " Meas Time " on page 235 is
longer than one period of a bursted signal.
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Remote command:
LAY:ADD? '1l',RIGH,CCDF, see LAYout:ADD[:WINDow]? on page 579

Phase vs. Time
Shows the phase values in the time domain.

* IQ Analyzer: 2 Phase vs.Time o 1AP Clrw W

CF 1.0 GHz 524288

Remote command:
LAY:ADD? '1l',RIGH, POLar, See LAYout:ADD[:WINDow]? on page 579

Marker Table
Displays a table with the current marker values for the active markers.

This table is displayed automatically if configured accordingly.

(See " Marker Table Display " on page 399).

X-Value Y-Value
0.256 0.00 dB

415.512 -1.94 dB
489.512 -1.95 dB
266.512 -2.00 dB

Remote command:

LAY:ADD? '1',RIGH, MTAB, see LAYout:ADD[:WINDow]? on page 579
Results:

CALCulate<n>:MARKer<m>:X On page 765
CALCulate<n>:MARKer<m>:Y on page 826
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10.1.3 Result Displays in the Time and Frequency Domain

The following result displays are available for I/Q measurements in the time and fre-
quency domain.

D 1= | = o SR 167
YT =T =1 o] 1= T 167
MarkKer PEaK LISt ......oouuiiiiiiiiiicieie e s e s e s e e e e e e e e e e e e e e e e e eeeeeeeanrnnes 167
RESUIL SUMIMANY oot e s s ee e e e 168
Diagram

Displays a basic level vs. frequency or level vs. time diagram of the measured data to
evaluate the results graphically. This is the default evaluation method. Which data is
displayed in the diagram depends on the "Trace" settings. Scaling for the y-axis can be
configured.

See Chapter 10.5.1, "Trace Configuration", on page 360 and Chapter 10.3.3.4, "Scal-
ing the Y-Axis", on page 212.

Remote command:

LAY:ADD? '1l',RIGH, DIAG, See LAYout:ADD[:WINDow]? on page 579

Results:
TRACe<n>[:DATA] ? on page 823

Marker Table
Displays a table with the current marker values for the active markers.

This table is displayed automatically if configured accordingly.
(See " Marker Table Display " on page 399).
* 3 Marker Table

X-Value Y-Value
0.256 0.00 dB

415.512 -1.94 dB
489.512 -1.95 dB
266.512 -2.00 dB

Remote command:

LAY:ADD? '1',RIGH, MTAB, see LAYout:ADD[:WINDow]? on page 579
Results:

CALCulate<n>:MARKer<m>:X on page 765
CALCulate<n>:MARKer<m>:Y on page 826

Marker Peak List

The marker peak list determines the frequencies and levels of peaks in the spectrum or
time domain. How many peaks are displayed can be defined, as well as the sort order.
In addition, the detected peaks can be indicated in the diagram. The peak list can also
be exported to a file for analysis in an external application.
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‘kear Peak List

Remote command:

LAY:ADD? '1l',RIGH, PEAK, see LAYout:ADD[:WINDow]? on page 579
Results:

CALCulate<n>:MARKer<m>:X on page 765
CALCulate<n>:MARKer<m>:Y on page 826

Result Summary

Result summaries provide the results of specific measurement functions in a table for
numerical evaluation. The contents of the result summary vary depending on the
selected measurement function. See the description of the individual measurement
functions for details.

Offset Power
-0.86 dBm

-0.86 dBm
er

-79.59 dB -80.34 dB
-85.04 dB -83.85 dB

Uipper

Remote command:
LAY:ADD? '1',RIGH, RSUM, see LAYout:ADD[:WINDow]? on page 579

10.2 Basics on I/Q Data Acquisition and Processing

Some background knowledge on basic terms and principles used when describing 1/Q
data processing in the R&S VSE software in general, and in the 1/Q Analyzer applica-
tion in particular, is provided here for a better understanding of the required configura-
tion settings.
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Principally, the R&S VSE (and all its applications) analyze data that was captured on a
connected instrument, or directly from a file with stored 1/Q data. The software itself
does not capture data.

The 1/Q Analyzer provides various possibilities to acquire the I/Q data to be analyzed:
® Capturing analog I/Q data from the [RF Input] connector of a connected device

® Capturing Oscilloscope Baseband Input from multiple channels of a connected
oscilloscope

® Importing 1/Q data from a file

Background information for these scenarios and more is provided in the following sec-
tions.

o  Analyzing 1/Q Dat@....ccceiiiiiiie e 169
e How Much Data is Measured: Capture Count and Measurement Points............. 170
L I = 2 T Tt o o T e SRR 171
L J I = Vot =T 4o Yo 4 11 o TS 176
e Oscilloscope Baseband INPUL.........coeeieiiccciiiiiiieiie e 177
o Basics 0N EXternal MIXErS........ccoiuiiiiiiiiecie ettt e e et e e e e 180

Analyzing I/Q Data

In the telephone systems of the past, baseband data was transmitted unchanged as an
analog signal. In modern phone systems and in radio communication, however, the
baseband data is modulated on a carrier frequency, which is then transmitted and must
be demodulated by the receiver. When using modern modulation methods (e.g. QPSK,
QAM etc.), the baseband signal becomes complex. Complex data (or: //Q data) con-
sists of an imaginary (1) and a real (Q) component.

The R&S VSE software can analyze the individual | and Q components of the complex
signal.

Sample Rate, Record Length and Analysis Bandwidth

Definitions

® |nput sample rate (ISR): the sample rate of the useful data provided by the device
connected to the input of the connected instrument

® (User, Output) Sample rate (SR): the sample rate that is defined by the user (e.g.
in the "Data Aquisition" dialog box in the "I/Q Analyzer" application) and which is
used as the basis for analysis or output

e Usable I/Q (Analysis) bandwidth: the bandwidth range in which the signal
remains undistorted in regard to amplitude characteristic and group delay; this
range can be used for accurate analysis by the R&S VSE

® Record length: Number of 1/Q samples the connected instrument captures during
the specified measurement time; calculated as the measurement time multiplied by
the sample rate. By default, the record length is set to the number of measurement
points, and the measurement time and sample rate are adapted accordingly. The
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maximum record length is 524288, but may not exceed the number of samples
provided by the connected instrument.

For the I/Q data acquisition, digital decimation filters are used internally in the connec-
ted instrument. The passband of these digital filters determines the maximum usable
I/Q bandwidth. In consequence, signals within the usable 1/Q bandwidth (passband)
remain unchanged, while signals outside the usable I/Q bandwidth (passband) are
suppressed. Usually, the suppressed signals are noise, artifacts, and the second IF
side band. If frequencies of interest to you are also suppressed, you should try to
increase the output sample rate, since this increases the maximum usable 1/Q band-
width.

As a rule, the usable I/Q bandwidth is proportional to the output sample rate. However,
the bandwidth used by the R&S VSE software is restricted by the bandwidth provided
by the connected instrument.

How Much Data is Measured: Capture Count and Measurement
Points

The number of measurements to be performed in single measurement mode is defined
by the "Capture Count". Values from 0 to 200000 are allowed. If the values 0 or 1 are
set, one measurement is performed. The capture count is applied to all the traces in a
diagram.

If the trace configurations "Average", "Max Hold" or "Min Hold" are set, the "Capture
Count" also determines the number of averaging or maximum search procedures (see
"Analyzing Several Traces - Trace Mode" on page 362).

The number of points configured in the capture settings is not actually the number of
points to be captured (that is defined as the Record Length ), but rather the number of
points to be evaluated in each trace (also referred to as measurement points). Thus,
the number of measurement points is window-specific. (However, all time-based dis-
plays (except for 1/Q Vector) use the same number of measurement points.)

For I/Q Vector displays, the number of measurement points is always coupled to the
Record Length , which has a maximum of 524288 points.

For Spectrum displays and all time-based displays (except for the 1/Q Vector), the num-
ber of measurement points can either be defined manually or automatically.

In Auto mode, the number is coupled to the number of frequency points (" FFT Length
"on page 237).

In Manual mode, all values from 51 to 524288 can be set. The default value is 1001
points.

For details on how the number of points and the capture count affect the trace results
on the screen, see "Mapping Samples to measurement Points with the Trace Detector"
on page 360.
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Basics on FFT
The 1/Q Analyzer measures the power of the signal over time. In order to convert the
time domain signal to a frequency spectrum, an FFT (Fast Fourier Transformation) is

performed which converts a vector of input values into a discrete spectrum of frequen-
cies.

N AN 7
Wi

t[s]

f[Hz]

Frequency Resolution of FFT Results - RBW

The resolution bandwidth defines the minimum frequency separation at which the
individual components of a spectrum can be distinguished. Small values result in a
high precision, as the distance between two distinguishable frequencies is small.
Higher values decrease the precision, but increase measurement speed.

The RBW is determined by the following equation:

Sample Rate
Window Length

RBW = Normalized Bandwidth *

Equation 10-1: Definition of RBW

(Note: The normalized bandwidth is a fixed value that takes the noise bandwidth of the
window function into consideration.)

The maximum RBW is restricted by the Analysis Bandwidth, or by the following equa-
tion, whichever is higher:

i i *
RBW.. - Normalized Bandwidth * Sample Rate

max
3

If a higher spectral resolution is required, the number of samples must be increased by
using a higher sample rate or longer record length.

The minimum achievable RBW depends on the sample rate and record length, accord-
ing to the following equation:
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RBW,. - NormalizedBandwidth*Sample Rate
524288

RBW and FFT mode

Depending on the selected RBW mode, the resolution bandwidth is either determined
automatically or can be defined manually.

Auto mode:

This is the default mode in the 1/Q Analyzer. The RBW is determined automatically
depending on the Sample Rate and the Record Length .

A single window is used, thus the Window Length corresponds to the Record Length .
A Flatop window function is used.

(Note: if you enter an RBW value in Auto mode, the mode is automatically switched to
Manual.

Manual mode:

The RBW can be defined by the user. The required Sample Rate, Record Length and
the " Meas Time " on page 235 are adapted accordingly.

A single window is used, thus the Window Length corresponds to the Record Length .
A Flatop window function is used.
Advanced FFT mode

The RBW is determined by the advanced FFT parameters. Using advanced FFT
mode, multiple overlapping FFT windows can be used with an averaging transforma-
tion algorithm (see "Combining Results - Trace Detector" on page 175).

10.2.3.2 FFT Calculation Methods
FFT calculation can be performed using different methods.

Single

In single mode, one FFT is calculated for the entire record length, that means the win-
dow length is identical to the FFT length, and both are identical to the record length.

Window Length

Figure 10-1: FFT parameters for single FFT calculation
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Averaging

In averaging mode, several overlapping FFTs are calculated for each record; the
results are combined to determine the final FFT result for the record.

The number of FFTs to be combined is determined by the Window Overlap and the
Window Length .

N N I window Lerain | 0

= Ovizriap- FFT Length -

Figure 10-2: FFT parameters for averaged FFT calculation

Window Functions

In advanced FFT mode, the Fourier transformation is not performed on the entire cap-
tured data in one step. In this case, an averaging transformation algorithm is used,
which uses only a limited number of samples to calculate an individual result. This
process is called windowing.

After sampling in the time domain, each window is multiplied with a specific window
function. Windowing helps minimize the discontinuities at the end of the measured sig-
nal interval and thus reduces the effect of spectral leakage, increasing the frequency
resolution.

Various different window functions are provided in the R&S VSE to suit different input
signals. Each of the window functions has specific characteristics, including some
advantages and some trade-offs. These characteristics need to be considered carefully
to find the optimum solution for the measurement task.

@ Ignoring the window function - rectangular window

The rectangular window function is in effect not a function at all, it maintains the origi-
nal sampled data. This may be useful to minimize the required bandwidth; however, be
aware that if the window does not contain exactly one period of your signal, heavy
sidelobes may occur, which do not exist in the original signal.

Table 10-1: Characteristics of typical FFT window functions

Window type Frequency Magnitude Sidelobe sup- | Measurement recommendation
resolution resolution pression
Rectangular Best Worst Worst No function applied.

Separation of two tones with almost
equal amplitudes and a small fre-
quency distance

Blackman-Harris | Good Good Good Harmonic detection and spurious
(default) emission detection

Gauss (Alpha = | Good Good Good Weak signals and short duration
0.4)
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Window type Frequency Magnitude Sidelobe sup- | Measurement recommendation
resolution resolution pression
Flattop Worst Best Good Accurate single tone measurements
5-Term Good Good Best Measurements with very high
dynamic range

Overlapping

The averaging transformation algorithm in advanced FFT mode calculates multiple
FFTs per measurement by dividing one captured record into several windows. Consec-
utive windows may overlap. Overlapping "reuses" samples that were already used to
calculate the preceding FFT result.

. Record
- length '
g Window
ength
~

| Owverlap area

In advanced FFT mode with averaging, the overlapping factor can be set freely. The
higher the overlap factor, the more windows are used. This leads to more individual
results and improves detection of transient signal effects. However, it also extends the
duration of the calculation. The size of the window can be defined manually according
to the record length, the overlap factor, and the FFT length.

With an overlap of the FFTs of 67%, for example, the second data block the R&S VSE
performs the FFT on covers the last 67% of the data of the first FFT with only 33% new
data. The third data block still covers 33% of the first data block and 67% of the second
data block and so on.
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Figure 10-3: Overlapping FFTs

Combining Results - Trace Detector

Multiple overlapping windows are combined to create the final spectrum using the
selected trace detector. If necessary, the trace detector is also used to reduce the num-
ber of calculated frequency points (defined by the FFT length) to the defined number of
measurement points. By default, the Autopeak trace detector is used.

Due to the fact that the frequency points are reduced to the number of measurement

@ points, using a detector other than Auto Peak may lead to wrong level results if the
measurement points are fewer than the number of calculated frequency points (defined
by the FFT length) .

max. 524288 samples
(=record length)

2

n
use trace detector to combine these FFTs
(averaging) -= freq. points = FFT length

-

use trace detector to reduce to
measurement points

Y

Dependencies Between FFT Parameters in Averaging Mode

Advanced FFT analysis in the R&S VSE is highly configurable. Several parameters,
including the record length, FFT length, and Window length, can be defined according
to the user's requirements. Note, however, that these parameters are correlated and
cannot be configured independently of the others.
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Record Length

Defines the number of I/Q samples to capture from the connected instrument. By
default, the number of measurement points is used. The record length is calculated as
the measurement time multiplied by the sample rate.

The maximum record length is 524288, but may not exceed the connected instrument
or the number of samples provided by the input file.

FFT Length

Defines the number of frequency points determined by each FFT calculation. The more
points are used, the higher the resolution in the spectrum becomes, but the longer the
calculation takes.

If you use the arrow keys or the mouse wheel to change the FFT length, the value is
incremented or decremented by powers of 2. If you enter the value manually, any inte-
ger value from 3 to 524288 is available.

If the FFT length is longer than the Window Length the sample data is filled up with
zeros up to the FFT length. The FFT is then performed using interpolated frequency
points.

For an FFT length that is not a power of 2, a DFT (discrete Fourier transform) is per-
formed, which requires more time for calculation, but avoids the effects of interpolation.

In order to display all calculated frequency points (defined by the FFT length), the num-
ber of measurement points is set to the FFT length automatically in advanced FFT
mode.

Window Length

Defines the number of samples to be included in a single window in averaging mode.

Values from 3 to 524288 are available. However, the window length may not be longer
than the FFT Length .

If the window length is shorter than the FFT Length , the sample data is filled up with
zeros up to the FFT length.

If the window length is longer than the Record Length (that is, not enough samples are
available), a window length the size of the Record Length is used for calculation.

The window length and the Window Overlap determine how many FFT calculations
must be performed for each record in averaging mode (see " Transformation Algorithm
"on page 237).

10.2.4 Trace Smoothing

(Software-based) smoothing is a way to remove anomalies visually in the trace that
can distort the results. The smoothing process is based on a moving average over the
complete measurement range. The number of samples included in the averaging proc-
ess (the aperture size) is variable and is a percentage of all samples that the trace con-
sists of.
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number of samples (e.g. 1000}

aperture gize (e.g. 5% = 50 samples)

Figure 10-4: Sample size included in trace smoothing

The application smoothes the trace only after the measurement has been finished and
the data has been analyzed and written to a trace. Thus, smoothing is just an enhance-
ment of the trace display, not of the data itself. This also means that smoothing is
always applied after any other trace averagings have been done, as these happen dur-
ing the measurement itself.

You can turn trace smoothing on and off for all traces individually and compare, for
example, the raw and the smooth trace.

Oscilloscope Baseband Input

As described above, the R&S VSE software can acquire the power values provided at
the RF input of a connected instrument and transform them into complex (1/Q) values.
As an alternative, the R&S VSE software can analyze complex baseband (1/Q) input
directly. This is useful for measurements in the early stages of signal processing or
radio transmission, when the analog baseband signal has not yet been modulated.

Complex signal input (1+Q)

Complex signal input must be provided to the R&S VSE software by a connected oscil-
loscope. The | and Q signal components are input in different channels, and transfer-
red to the R&S VSE software in waveform mode.

Distortion due to different cables

For complex signal input (I+Q), it is recommended that you use two identical cables for
the | and Q connectors (same length, same type, same manufacturer). Otherwise, time
delay or gain imbalance may occur between the different cables. If necessary, you can
define fixed deskew values for individual channels.

The R&S VSE software can process both single-ended (unbalanced) and differential
(balanced) input. For single-ended data, you can select any two input channels on the
oscilloscope. For differential data, four input channels on the oscilloscope are required.
For a detailed channel mapping, see "Input Source" on page 88.

Data acquisition

The | and Q data is input using 2 channels of the oscilloscope. Thus, the usable 1/Q
bandwidth in the R&S VSE software depends on the bandwidth provided by the oscillo-
scope.

max. BWyge = max. BW,; (I-channel) + max. BW,. (Q-channel) = 2 * max. BW;
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Applications supporting Oscilloscope Baseband Input

Oscilloscope Baseband Input is captured as waveform data. Currently, only the follow-
ing applications support waveform input in the R&S VSE software:

® |/Q Analyzer

® Analog Demodulation (K7 option)

® Vector Signal Analysis (VSA, K70 option)

® OFDM Vector Signal Analysis (OFDM VSA, K96 option)

Voltage levels - full scale level

For RF input, the maximum expected voltage level is defined by the reference level.
For Oscilloscope Baseband Input, the maximum expected voltage level for each com-
ponent (1 or Q) is defined by the full scale level. The full scale level defines the maxi-
mum power you can input without clipping the signal.

The full scale level can be defined manually or automatically, such that the power of |
and Q does not exceed the reference level.
Triggering

The following trigger sources are supported for Oscilloscope Baseband Input (see "
Trigger Source " on page 224):

e External

® Time

® Trigger channels 2, 3, 4 - if not used as an input channel

10.2.5.1 1/Q Processing Modes

The R&S VSE software provides different methods of processing the baseband input,
depending on the measurement requirements.

Complex baseband mode (I+Q)

In the (default) complex baseband mode, the analog input signal is assumed to be a
complex baseband signal. There is no need to equalize any IF filter or mix the signal
into the complex baseband. The software just has to ensure that the final I/Q data
stored in the capture buffer has the correct sample rate for the application. No level
compensation is necessary. The resulting data can be processed by the selected appli-
cation.

S(f)
A

1’1‘: 4
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Figure 10-5: Spectrum in complex baseband (I+Q) mode

User Manual 1176.8839.02 — 14 178



R&S®VSE 1/Q Analyzer Measurements

10.2.5.2

User Manual 1176.8839.02 — 14

Basics on 1/Q Data Acquisition and Processing

The complex spectrum of the input signal is displayed. You do not have to move the
center frequency, but you can, as long as the selected spectrum remains within the
maximum analysis bandwidth (see Chapter 10.2.5.2, "Sample Rates and Bandwidths
for Oscilloscope Baseband Input", on page 179).

Low IF mode (I only)

In low IF mode, the real signal from the in-phase (I) component is assumed to be a
modulated carrier with a specific center frequency. The signal is down-converted to the
selected center frequency (= low IF frequency). The center frequency must be higher
than 0 Hz so that no part of the negative mirrored spectrum lies within the analysis
bandwidth. Select the center frequency such that the displayed spectrum remains
within the maximum analysis bandwidth (see Chapter 10.2.5.2, "Sample Rates and
Bandwidths for Oscilloscope Baseband Input”, on page 179).

S(f)
Fy

| ] | - |

Y | » f
|
-BWna'2 -I;

-
BWian'2

Figure 10-6: Spectrum in low IF mode

Compared to the initial complex baseband signal that was input, the down-converted |
component contains only half the spectrum (i.e. one sideband less) after passing the
filter. The power is thus reduced by one half (or: -3 dB). This power loss is compensa-
ted for by increasing the power of the resulting spectrum by +3 dB.

The digitized data is brought to the desired sample rate using a downsampling filter
and fractional resampling.

Sample Rates and Bandwidths for Oscilloscope Baseband Input

As described above, the usable 1/Q bandwidth in the R&S VSE software depends on
the bandwidth provided by the oscilloscope.

max. BWyge = max. BW; (I-channel) + max. BW . (Q-channel) = 2 * max. BW,;

The usable 1/Q bandwidth is the bandwidth range in which the signal remains undistor-
ted in regard to amplitude characteristic and group delay. It is also the range that can
be used for accurate analysis by the R&S VSE. The analysis bandwidth and the sam-
ple rate are interdependent and are adapted according to the following formula in the
I/Q Analyzer:

Sample rate = Analysis bandwidth / 0.8
(For | only: Sample rate = Analysis bandwidth / 0.4)

However, the bandwidth used by the R&S VSE software is restricted by the bandwidth
provided by the connected instrument.
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Furthermore, the actual sample rate required by the application can be lower, in which
case the data is downsampled. Depending on the application used to process the data,
the required sample rate is defined by the application itself or by the user.

Spectrum limits

The analog baseband spectrum to be analyzed depends both on the analysis band-
width and on the center frequency, which defines the middle of the spectrum. Thus,
always select the maximum analysis bandwidth and the position of the center fre-
quency such that the spectrum remains within the available limits. You are not forced
by the R&S VSE to do so, but a warning message is displayed if the limits are excee-
ded.

Basics on External Mixers

Some background knowledge on basic terms and principles used with external mixers
is provided here for a better understanding of the required configuration settings.

®  FreqUENCY RANQES.. ...t 180
o Two-port and Three-port IMIXEIS........uuuuuueeiieieieieeeeeeeee e e 181
L I = = S U4 =Y o SRR 182
@  ConVersion LOSS TabIES.....uuuiiiiiiiiiiiccceiee e e e 182

Frequency Ranges

In a common spectrum analyzer, rather than providing one large (and thus inaccurate)
filter, or providing several filters to cover the required frequency range of the input sig-
nal (at a high cost), a single, very accurate filter is used. Therefore, the input signal
must be converted to the frequencies covered by the single accurate filter. This is done
by a mixer, which converts and multiplies the frequency of the input signal with the help
of the local oscillator (LO). The result is a higher and lower intermediate frequency (IF).
The local oscillator can be tuned within the supported frequency range of the input sig-
nal.

In order to extend the supported frequency range of the input signal, an external mixer
can be used. In this case, the LO frequency is output to the external mixer, where it is
mixed with the RF input from the original input signal. In addition, the harmonics of the
LO are mixed with the input signal, and converted to new intermediate frequencies.
Thus, a wider range of frequencies can be obtained. The IF from the external mixer is
then returned to the spectrum analyzer.

The frequency of the input signal can be expressed as a function of the LO frequency
and the selected harmonic of the first LO as follows:

fin=n"flo+fF
Where:
f.n: Frequency of input signal

n: Order of harmonic used for conversion
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fir: Intermediate frequency (variable; defined internally depending on RBW and span)

Thus, depending on the required frequency band, the appropriate order of harmonic
must be selected. For commonly required frequency ranges, predefined bands with the
appropriate harmonic order setting are provided. By default, the lowest harmonic order
is selected that allows conversion of input signals in the whole band.

For the band "USER", the order of harmonic is defined by the user. The order of har-
monic can be between 2 and 128, the lowest usable frequency being 16.88 GHz.

The frequency ranges for pre-defined bands are described in Table 13-12.

Changes to the band and mixer settings are maintained even after using the [PRESET]
function. A "Preset band" function allows you to restore the original band settings.

Extending predefined ranges

In some cases, the harmonics defined for a specific band allow for an even larger fre-
quency range than the band requires. By default, the pre-defined range is used. How-
ever, you can take advantage of the extended frequency range by overriding the
defined start and stop frequencies by the maximum possible values ("RF Overrange"
option).

Additional ranges

If due to the LO frequency the conversion of the input signal is not possible using one
harmonic, the band must be split. An adjacent, partially overlapping frequency range
can be defined using different harmonics. In this case, the sweep begins using the har-
monic defined for the first range, and at a specified frequency in the overlapping range
("handover frequency"), switches to the harmonic for the second range.

10.2.6.2 Two-port and Three-port Mixers

External mixers are connected to the R&S VSE at the LO OUT/IF IN and IF IN connec-
tors.

When using three-port mixers, the LO signal output from the R&S VSE and the IF input
from the mixer are transmitted on separate connectors, whereas for two-port mixers,
both signals are exchanged via the same connector (LO OUT/IF IN). Because of the
diplexer contained in the R&S VSE, the IF signal can be tapped from the line which is
used to feed the LO signal to the mixer.
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Two-port mixer

Three-port mixer

IF 1IN IF 1M
L =
[ S
LO OUIT/IFE 1IN LD QUTAHFE IN
LOVIF
External External
Mixer RF Mixear

RF

INPUT INPUT

10.2.6.3

10.2.6.4

In both cases, the nominal LO level is 15.5 dBm.

Bias Current

Single-diode mixers generally require a DC voltage which is applied via the LO line.
This DC voltage is to be tuned to the minimum conversion loss versus frequency. Such
a DC voltage can be set via the "BIAS" function using the D/A converter of the connec-
ted instrument. The value to be entered is not the voltage but the short-circuit current.
The current is defined in the "Bias Settings" or set to the value of the conversion loss
table.

See " Bias Value " on page 203.

Conversion Loss Tables

Conversion loss tables consist of value pairs that describe the correction values for
conversion loss at certain frequencies. Correction values for frequencies between the
reference values are obtained by interpolation. Linear interpolation is performed if the
table contains only two values. If it contains more than two reference values, spline
interpolation is carried out. Outside the frequency range covered by the table the con-
version loss is assumed to be the same as that for the first and last reference value
(see Figure 10-7).
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Figure 10-7: Conversion loss outside the band's frequency range

Predefined conversion loss tables are often provided with the external mixer and can
be imported to the connected instrument.

Importing CVL tables

The conversion loss table to be used for a particular measurement range is also
defined in the "External Mixer Configuration" dialog box.

The frequency range that the cvl table must cover depends on the used IF, which var-
ies depending on the instrument and installed bandwidth extension options. Thus,
external mixers from Rohde & Schwarz provide multiple conversion loss table files.
When you select a storage path containing cvl files, or a particular cvl file from a
Rohde & Schwarz mixer for import, all available files are copied to the
C:\ProgramData\Rohde-Schwarz\VSE\<version no>\user\cvl\ directory on
the connected instrument. Provided . ac1 files are renamed according to the following
syntax:

<serial number> <harmonic_ order> <IF>.acl,
€.9.12345 2 1330M.acl

To select a conversion loss table for use in a measurement, you merely have to select
the serial number for the external mixer in use. The R&S VSE automatically selects the
correct cvl file for the current IF. As an alternative, you can also select a user-defined
conversion loss table (. ac1 file).

Before copying any files to the
C:\ProgramData\Rohde-Schwarz\VSE\<version no>\user\cvl\ directory,
the R&S VSE firmware moves any existing user-defined cvl tables to a backup subdir-

ectory. To use a user-defined cvl table later, select the file in the
C:\ProgramData\Rohde-Schwarz\VSE\<version no>\user\cvl\backup

directory.
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A validation check is then performed on the selected table to ensure that it complies
with the settings. In particular, the following is checked:

® The assigned band name

® The harmonic order

® The mixer type

® The table must contain at least one frequency that lies within the frequency range
for the band

Reference level

The maximum possible reference level depends on the maximum used conversion loss
value. Thus, the reference level can be adjusted for each range according to the used
conversion loss table or average conversion loss value. If a conversion loss value is
used which exceeds the maximum reference level, the reference level is adjusted to
the maximum value permitted by the firmware.

10.3 Basic I/Q Measurement Configuration

™" Access: "Meas Setup" > "Overview"
The easiest way to configure a measurement channel is via the "Overview" dialog box.

Alternatively, you can access the individual dialog boxes from the corresponding menu
items, or via tools in the toolbars, if available.

In this documentation, only the most convenient method of accessing the dialog boxes
is indicated - usually via the "Overview". For an overview of all available menu items
and toolbar icons see Chapter A, "Menu Reference", on page 900 and Chapter B,
"Reference of Toolbar Functions”, on page 908.

The remote commands required to perform these tasks are described in Chapter 13.6,
"Remote Commands for the I/Q Analyzer", on page 585.
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e Trigger and Gate Configuration...............cciiiiiiii oo 219
e Data Acquisition and Bandwidth Settings...........ccocoiiiii e 233
o CCDF (Statistics) Settings.......uueeiiiiiiiiie e e 241
o Adjusting Settings Automatically............coiiiiiiiiiiiii 242

10.3.1 Configuration Overview

=% Access: "Meas Setup" > "Overview"

The easiest way to configure an I/Q Analysis channel is via the "Overview" dialog box.
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Overview D -
IQ Analyzer
Ref Level 0.0 dBm
Level Offset 0.0 dB
Mech Att 10.0 dB Center 4.0 GHz Source Free Run
Input RF El Att 0.0 dB Freq Offset 0.0 Hz Level
Power Sensor Preamp Off Freq Offset 0.0 Hz Gated Trigger Off
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Input Amplitude Frequency Trigger/Gate
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Output Bandwidth Analysis
Video Out IF sample Rate 320 MHz Trace 1 Clear Write
Trigger Out Off Filter BW 256 MHz Detector Auto Peak
Meas Time 31.28 ps Marker 1 Off
Record Length 1001 Limits
Lines Off

_ Specifics for 1: Magnitude

Figure 10-8: Configuration Overview for I/Q Analyzer

The "Overview" indicates the most important currently defined settings for the mea-
surement channel and provides quick access to the main settings dialog boxes. The
individual configuration steps are displayed in the order of the data flow. Thus, you can
easily configure an entire measurement channel from input over processing to output
and analysis by stepping through the dialog boxes as indicated in the "Overview".

The Overview varies depending on the application; for detailed descriptions see the
corresponding application's User Manual.

Furthermore, the overview may vary for measurements in the time and frequency
domain. For measurement-specific settings see:

® Chapter 10.4.1.4, "Channel Power Configuration", on page 257
® (Chapter 10.4.2.3, "OBW Configuration", on page 296
® Chapter 10.4.3.5, "SEM Configuration”, on page 313

The "Overview" for the (default) basic I/Q Analyzer measurement provides quick
access to the following configuration dialog boxes (listed in the recommended order of
processing):

1. Input settings
See Chapter 10.3.2, "Data Input Settings", on page 186

2. Amplitude settings
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See Chapter 10.3.3, "Amplitude", on page 203

3. Frequency settings
See Chapter 10.3.4, "Frequency Settings", on page 217

4. Optionally, Trigger/Gate settings
See Chapter 10.3.5, "Trigger and Gate Configuration", on page 219

5. Bandwidth (data acquisition and capture) settings
See Chapter 10.3.6, "Data Acquisition and Bandwidth Settings", on page 233

6. Optionally, output settings
See Chapter 10.3.2, "Data Input Settings", on page 186

7. Analysis settings and functions
See Chapter 10.5, "Analysis", on page 360

To configure settings

» Select any button in the "Overview" or select a setting in the channel's global info
bar to open the corresponding dialog box.

For step-by-step instructions on configuring I/Q Analyzer measurements, see Chap-
ter 11, "How to Perform Measurements with the R&S VSE", on page 439.

Preset Channel
Select the "Preset Channel" button in the lower lefthand corner of the "Overview" to
restore all measurement settings in the current channel to their default values.

This function has the same effect as the "Preset > Selected Channel" menu item.

Remote command:
SYSTem:PRESet :CHANnel [ : EXEC] on page 829

Specifics for

The channel may contain several windows for different results. Thus, the settings indi-
cated in the "Overview" and configured in the dialog boxes vary depending on the
selected window.

Select an active window from the "Specifics for" selection list that is displayed in the
"Overview" and in all window-specific configuration dialog boxes.

The "Overview" and dialog boxes are updated to indicate the settings for the selected
window.

10.3.2 Data Input Settings

Access: "Input & Output”

The R&S VSE can control the input sources and output connectors of the connected
instruments.
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Radio Frequency Input

Access: "Overview" > "Input" > "Input Source" > "Radio Frequency"
Or: "Input & Output" > "Input Source" > "Radio Frequency"

The default input source for the connected instrument is "Radio Frequency". Depend-
ing on the connected instrument, different input parameters are available.

Instrument: &9 FSW-85* T InputSource: RF T

Input 1 Input 2
External Input Coupling DC
Mixer
Impedance 750
1/Q File
E High Pass Filter 1 to 3 GHz on
2 YIG-Preselector On
<
o
B2
eeossae on
Oscilloscope |
1P Address

Figure 10-9: RF input source settings for an R&S FSW with B2000 option

If the Frequency Response Correction option (R&S VSE-K544) is installed, the 1/Q
Analyzer also supports frequency response correction using Touchstone (. snp) files
or . fres files.

For details on user-defined frequency response correction, see Chapter 7.5, "Fre-
quency Response Correction (R&S VSE-K544)", on page 94

Input Type (INStrUMENt / Fl€)....uue e, 188
T 1S3 (8 0 =T o PSP 188
T 01U A 1o o U SO 188
10T 018 a7 o0 o] 11 T 5P RPN 188
1 g oYY =1 o Vo7 SO 189
DIreCE Path ..t e e e 189
High Pass Filter 110 3 GHZ .....evviiiccceece e 189
YIG-PreSEIECION ...ttt e e e e e e e e e e e e 189
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Input Type (Instrument / File)
Selects an instrument or a file as the type of input provided to the channel.

Note: External mixers are only available for input from a connected instrument.

Remote command:
INSTrument :BLOCk:CHANnel [ : SETTings] : SOURce<si> on page 521
INPut<ip>:SELect on page 594

Instrument
Specifies a configured instrument to be used for input.

Input 1/ Input 2
For instruments with two input connectors, you must define which input source is used
for each measurement channel.

Note that you cannot use both RF inputs simultaneously.

"Input 1" R&S FSW85: 1.00 mm RF input connector for frequencies up to
85 GHz (90 GHz with option R&S FSW-B90G)

"Input2" R&S FSW85: 1.85 mm RF input connector for frequencies up to
67 GHz

Remote command:
INPut<ip>:TYPE on page 594

Input Coupling

The RF input of the R&S VSE can be coupled by alternating current (AC) or direct cur-
rent (DC).

The RF input of the connected instrument can be coupled by alternating current (AC)
or direct current (DC).

This function is not available for input from the optional Digital Baseband Interface or
from the optional Analog Baseband Interface.

AC coupling blocks any DC voltage from the input signal. This is the default setting to
prevent damage to the instrument. Very low frequencies in the input signal may be dis-
torted.

However, some specifications require DC coupling. In this case, you must protect the
instrument from damaging DC input voltages manually. For details, refer to the data
sheet.

Remote command:
INPut<ip>:COUPling<ant> on page 588
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Impedance
For some measurements, the reference impedance for the measured levels of the con-
nected instrument can be set to 50 Q or 75 Q.

Select 75 Q if the 50 Q input impedance is transformed to a higher impedance using a
75 Q adapter of the RAZ type. (That corresponds to 25Q in series to the input impe-
dance of the instrument.) The correction value in this case is 1.76 dB = 10 log (75Q/
50Q).

This value also affects the unit conversion (see " Reference Level " on page 206).

This function is not available for input from the optional Digital Baseband Interface or
from the optional Analog Baseband Interface . For analog baseband input, an impe-
dance of 50 Q is always used.

Remote command:
INPut<ip>:IMPedance<ant> on page 590

Direct Path
Enables or disables the use of the direct path for small frequencies.

In spectrum analyzers, passive analog mixers are used for the first conversion of the
input signal. In such mixers, the LO signal is coupled into the IF path due to its limited
isolation. The coupled LO signal becomes visible at the RF frequency 0 Hz. This effect
is referred to as LO feedthrough.

To avoid the LO feedthrough the spectrum analyzer provides an alternative signal path
to the A/D converter, referred to as the direct path. By default, the direct path is

selected automatically for RF frequencies close to zero. However, this behavior can be
disabled. If "Direct Path" is set to "Off" , the spectrum analyzer always uses the analog

mixer path.

"Auto" (Default) The direct path is used automatically for frequencies close
to zero.

"Off" The analog mixer path is always used.

Remote command:
INPut<ip>:DPATh on page 588

High Pass Filter 1 to 3 GHz

Activates an additional internal high-pass filter for RF input signals from 1 GHz to

3 GHz. This filter is used to remove the harmonics of the analyzer to measure the har-
monics for a DUT, for example.

This function may require an additional hardware option on the connected instrument.

(Note: for RF input signals outside the specified range, the high-pass filter has no
effect. For signals with a frequency of approximately 4 GHz upwards, the harmonics
are suppressed sufficiently by the YIG-preselector, if available.)

Remote command:
INPut<ip>:FILTer:HPASs[:STATe] on page 589

YIG-Preselector
Enables or disables the YIG-preselector, if available on the connected instrument.
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An internal YIG-preselector at the input of the connected instrument ensures that
image frequencies are rejected. However, this is only possible for a restricted band-
width. To use the maximum bandwidth for signal analysis you can disable the YIG-pre-
selector at the input of the connected instrument, which can lead to image-frequency
display.

Note that the YIG-preselector is active only on frequencies greater than 8 GHz. There-
fore, switching the Y1G-preselector on or off has no effect if the frequency is below that
value.

In order to make use of the optional 90 GHz frequency extension (R&S VSE-B90G),
the YIG-preselector must be disabled.

Note:

For the following measurements, the YIG-Preselector is off by default (if available).
® |/Q Analyzer

Real-Time (and thus in all slave applications in MSRT operating mode)
Multi-Carrier Group Delay

GSM

VSA

Remote command:
INPut<ip>:FILTer:YIG[:STATe] on page 590

SAW filter

The R&S VSE hardware contains both a wide and a narrow IF path. Depending on the
used analysis bandwidth, the R&S VSE determines which IF path to use automatically.
The wide IF path allows for a smoother signal at the center frequency, while the narrow
IF path supresses possibly distorting signals further away from the center frequency.
Using this setting, you can affect which IF path is used.

"Auto" The R&S VSE determines which IF path to use automatically,
depending on the used analysis bandwidth.

"Off" The wide IF path is always used.

Remote command:
INPut<ip>:FILTer:SAW on page 590

Capture Mode
Determines how data from an oscilloscope is input to the R&S VSE software.

This function is only available for a connected R&S oscilloscope with a firmware ver-
sion 3.0.1.1 or higher (for other versions and instruments the input is always 1/Q data).

"1/Q" The measured waveform is converted to I/Q data directly on the R&S
oscilloscope (requires option K11), and input to the R&S VSE soft-
ware as I/Q data.

For data imports with small bandwidths, importing data in this format
is quicker. However, the maximum record length is restricted by the
R&S oscilloscope. (Memory options on the R&S oscilloscope are not
available for 1/Q data.)

This mode is not available for Oscilloscope Baseband Input.
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"Waveform" The data is input in its original waveform format and converted to 1/Q
data in the R&S VSE software. No additional options are required on
the R&S oscilloscope.

For Oscilloscope Baseband Input, the capture mode is automatically
set to "Waveform". | and Q data is sampled in separate channels in
its original waveform format. The separately captured | and Q wave-
form samples are converted to complex I/Q data in the R&S VSE.
For data imports with large bandwidths, this format is more conven-
ient as it allows for longer record lengths if appropriate memory
options are available on the R&S oscilloscope.

"Auto" Uses "I/Q" mode when possible, and "Waveform" only when required
by the application (e.g. Pulse measurement, Oscilloscope Baseband
Input).

Remote command:

INPut<ip>:RF:CAPMode on page 592

B2000 State
Activates the optional 2 GHz bandwidth extension (R&S FSW-B2000).

Note: The R&S VSE software supports input from a connected R&S FSW with a
B2000 option installed. However, the R&S FSW interface to the oscilloscope must be
set up and aligned directly on the instrument before the R&S VSE software can start
analyzing the input.

The analysis bandwidth is defined in the data acquisition settings of the application as
usual. Note that the maximum bandwidth cannot be restricted manually as for other
bandwidth extension options.

Manual operation on the connected oscilloscope, or remote operation other than by the
R&S VSE, is not possible while the B2000 option is active.

Remote command:
SYSTem:COMMunicate:RDEVice:0SCilloscope[:STATe] on page 595

Oscilloscope Sample Rate
Determines the sample rate used by the connected oscilloscope.

This setting is only available if an R&S oscilloscope is used to obtain the input data,
either directly or via the R&S FSW.

"10 GHz" Default for waveform Capture Mode (not available for I1/Q Capture
Mode); provides maximum record length

"20 GHz" Achieves a higher decimation gain, but reduces the record length by
half.
Only available for R&S oscilloscope models that support a sample
rate of 20 GHz (see data sheet).
For R&S oscilloscopes with an analysis bandwidth of 4 GHz or larger,
a sample rate of 20 GHZ is always used in waveform Capture Mode

"40 GHZ" Provides a maximum sample rate.
Only available for I/Q Capture Mode, and only for R&S RTP13/RTP16
models that support a sample rate of 40 GHz (see data sheet)
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Remote command:

Input source R&S FSW via oscilloscope:
SYSTem:COMMunicate:RDEVice:0SCilloscope: SRATe on page 596
Input source oscilloscope waveform mode:
INPut<ip>:RF:CAPMode:WAVeform: SRATe on page 593

Input source oscilloscope 1/Q mode:
INPut<ip>:RF:CAPMode:IQ:SRATe on page 592

Oscilloscope Splitter Mode

Activates the use of the power splitter inserted between the [IF 2 GHZ OUT] connector
of the R&S FSW and the [CH1] and [CH3] input connectors of the oscilloscope. Note
that this mode requires an additional alignment with the power splitter.

For details see the R&S FSW 1/Q Analyzer and 1/Q Input User Manual.

Remote command:
SYSTem:COMMunicate:RDEVice:0SCilloscope:PSMode[:STATe] on page 596

Oscilloscope IP Address

When using the optional 2 GHz bandwidth extension (R&S FSW-B2000) with an R&S
FSW as the connected instrument, the entire measurement, as well as both instru-
ments, are controlled by the R&S VSE software. Thus, the instruments must be con-
nected via LAN, and the TCPIP address of the oscilloscope must be defined in the
R&S VSE software.

For tips on how to determine the computer name or TCPIP address, see the oscillo-
scope's user documentation.

Remote command:
SYSTem:COMMunicate:RDEVice:0SCilloscope: TCPip on page 595

Preselector State
Turns the preselector on and off.

When you turn on the preselector, you can configure the characteristics of the prese-
lector and add the preamplifier into the signal path.

When you turn off the preselector, the signal bypasses the preselector and the pream-
plifier, and is fed into the input mixer directly.

Remote command:
INPut<ip>:PRESelection[:STATe] on page 592

Preselector Mode
Selects the preselection filters to be applied to the measurement.

"Auto" Automatically applies all available bandpass filters in a measurement.
Available with the optional preamplifier.

"Auto Wide" Automatically applies the wideband filters consecutively:

® | owpass 40 MHz

® Bandpass 30 MHz to 2250 MHz
® Bandpass 2 GHz to 8 GHz

® Bandpass 8 GHz to 26.5 GHz

Available with the optional preselector.

User Manual 1176.8839.02 — 14 192



R&S®VSE 1/Q Analyzer Measurements

Basic 1/Q Measurement Configuration

"Auto Narrow"  Automatically applies the most suitable narrowband preselection fil-
ters in a measurement, depending on the bandwidth you have
selected.

For measurement frequencies up to 30 MHz, the connected instru-
ment uses combinations of lowpass and highpass filters. For higher
frequencies, the connected instrument uses bandpass filters.
Available with the optional preselector.

"Manual" Applies the filter settings you have defined manually.

Remote command:
INPut<ip>:PRESelection:SET on page 591

10 dB Minimum Attenuation
Turns the availability of attenuation levels of less than 10 dB on and off.

When you turn on this feature, the attenuation is always at least 10 dB. This minimum
attenuation protects the input mixer and avoids accidental setting of 0 dB, especially if
you measure EUTs with high RFI voltage.

When you turn it off, you can also select attenuation levels of less than 10 dB.

The setting applies to a manual selection of the attenuation as well as the automatic
selection of the attenuation.

Remote command:
INPut<ip>:ATTenuation:PROTection:RESet on page 587

10.3.2.2 Oscilloscope Baseband Input

Access: "Overview" > "Input" > "Input Source" > "Oscilloscope Baseband"

Input Source

File Instrument: 6 RTO [3* T InputSource: Channels 1-4 [diff, I+Q] 7
rIgMode ————————————  Impedance Matching
Radio 1Q Mode 10 0
ode
T Skeww Deskewy
r Signal Path
Analog-1Q Center Frequency

16.0 MHz

O If the Frequency Response Correction option (R&S VSE-K544) is installed, the I/Q
= Analyzer also supports frequency response correction using Touchstone (. snp) files
or . fres files.

For details on user-defined frequency response correction, see Chapter 7.5, "Fre-
quency Response Correction (R&S VSE-K544)", on page 94
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Input Type (Instrument / File)
Selects an instrument or a file as the type of input provided to the channel.

Note: External mixers are only available for input from a connected instrument.
Remote command:

INSTrument :BLOCk:CHANnel [ : SETTings] : SOURce<si> on page 521
INPut<ip>:SELect on page 594

Instrument
Specifies a configured instrument to be used for input.

Input Source
Configures the source of input (and channel) on the selected instrument to be used.

Note: External mixers are only available for RF input.
Not all input sources are supported by all R&S VSE applications.

"RF" Radio Frequency ("RF INPUT" connector)

"Channel 1 | Channel 2 | Channel 3 | Channel 4 "
Oscilloscope input channel 1, 2, 3, or 4

"Channel 1,2 (1+Q)"
I/Q data provided by oscilloscope input channels 1 and 2 (for oscillo-
scopes with 2 channels only)

"Channel 1,3 (1+Q) | Channel 2,4 (1+Q)"
I/Q data provided by oscilloscope input channels 1 and 3, or 2 and 4
(for oscilloscopes with 4 channels only)

"Channels 1-4 (diff. [+Q)"
Differential 1/Q data provided by oscilloscope input channels (for oscil-
loscopes with 4 channels only):
Channel 1: | (pos.)
Channel 2: T (neg.)
Channel 3: Q (pos.)
Channel 4: Q (neg.)

"Channels 1,3 Waveform data provided by oscilloscope input channels 1 and 3 (for
(Waveform)" oscilloscopes with 2 channels only)

"Channels 2,4 Waveform data provided by oscilloscope input channels 2 and 4 (for
(Waveform)" oscilloscopes with 2 channels only)

"Channels 1-4 Waveform data provided by oscilloscope input channels 1 to 4 (for
(Waveform)" oscilloscopes with 4 channels only)
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Remote command:
INSTrument :BLOCk:CHANnel [ : SETTings] : SOURce<si>:TYPE on page 521
INSTrument :BLOCk:CHANnel [ : SETTings] : SOURce<si>:CONFig on page 521

I/Q Mode
Defines the format of the input signal.

For more information, see Chapter 10.2.5.1, "l/Q Processing Modes", on page 178.

"/Q" Both components of the complex input signal (in-phase component,
quadrature component) are filtered and resampled to the sample rate
of the application.

"I Only / Low IF I"
The input signal at the channel providing | data is filtered and resam-
pled to the sample rate of the application.
The input signal is down-converted with the center frequency (Low IF

).
Remote command:
INPut<ip>:IQ:0SC:TYPE on page 599

1/Q Skew
Compensates for skewed 1/Q values, e.g. due to different input cables

I Q

Channell 0.0 ys T Channel 3 0.0 s

Channel 2 003 Channel 4 0.0 3

IQ Analyzer

Define the delay values individually for the | and Q channels. For differential input,
changing the positive skew automatically also changes the negative skew (but not vice
versa).

Depending on the connected oscilloscope, values between £100 ns are allowed.

Remote command:

INPut<ip>:IQ:0SC:SKEW: T on page 598
INPut<ip>:IQ:0SC:SKEW:I:INVerted on page 599
INPut<ip>:TQ:0SC:SKEW:Q on page 599
INPut<ip>:IQ:0SC:SKEW:Q:INVerted on page 599

Impedance
For some measurements, the reference impedance for the measured levels of the con-
nected instrument can be set to 50 Q or 75 Q.

Select 75 Q if the 50 Q input impedance is transformed to a higher impedance using a
75 Q adapter of the RAZ type. (That corresponds to 25Q in series to the input impe-
dance of the instrument.) The correction value in this case is 1.76 dB = 10 log (75Q/
50Q).

This value also affects the unit conversion (see " Reference Level " on page 206).
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This function is not available for input from the optional Digital Baseband Interface or
from the optional Analog Baseband Interface . For analog baseband input, an impe-
dance of 50 Q is always used.

Remote command:
INPut<ip>:IMPedance<ant> on page 590

Center Frequency
Defines the center frequency for Oscilloscope Baseband Input.

Note: If the analysis bandwidth to either side of the defined center frequency exceeds
the allowed range, an error is displayed. In this case, adjust the center frequency or the
analysis bandwidth.

For details on frequency ranges and the analysis bandwidth, see Chapter 10.2.5.2,
"Sample Rates and Bandwidths for Oscilloscope Baseband Input”, on page 179.

Remote command:
[SENSe: ] FREQuency:CENTer on page 621

Signal Path
lllustrates the signal path used for the currrent baseband input settings.

10.3.2.3 I/Q File Input

Access: "Overview" > "Input" > "Input Source" > "1/Q File"

Or: "Input & Output" > "Input Source" > "I/Q File"

O Loading a file via drag&drop

You can load a file simply by selecting it in a file explorer and dragging it to the

R&S VSE software. Drop it into the "Measurement Group Setup" window or the chan-
nel bar for any channel. The channel is automatically configured for file input, if neces-
sary. If the file contains all essential information, the file input is immediately displayed
in the channel. Otherwise, the "Recall I/Q Recording" dialog box is opened for the
selected file so you can enter the missing information.

If the file contains data from multiple channels (e.g. from LTE measurements), it can be
loaded to individual input sources, if the application supports them.

For more information see "To import data via drag&drop" on page 441.

The "Input Source" settings defined in the "Input” dialog box are identical to those con-
figured for a specific channel in the "Measurement Group Setup" window.

(See "Assigning the Channel Input Source" on page 88).
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Input Source

Instrument File Instrument: | MORE “ | Input Source: EI
r Input File
Radio Wiinputh k9 swizard\WLANac_64QAM_20MHz_Long CPR.ig.tar Select File
Freguency
Saved by Rohde and Schwarz IQ File Converterversion 1.2 Beta 10
Comment: File generated by the RS IQ File Converter, see hitpi/fnavow rohde-schwarz.comfappnote/1EFES
Date & Time: 2015-07-25 17:4852
Sample Rate: 20 MHz

Mumber of Samples: 48000

Duration of Signal: 2.4 ms

Murber of Channels: 1

r Settings

If the Frequency Response Correction option (R&S VSE-K544) is installed, the I/Q
Analyzer also supports frequency response correction using Touchstone (. snp) files
or . fres files.

For details on user-defined frequency response correction, see Chapter 7.5, "Fre-
quency Response Correction (R&S VSE-K544)", on page 94

Encrypted . wv files can also be imported. Note, however, that traces resulting from
encrypted file input cannot be exported or stored in a saveset.

See Chapter 8.3, "Recording and Recalling Captured 1/Q Data for Evaluation”,

on page 119 and Chapter 8.5, "Storing Graphical Results to an ASCII File",

on page 138.

Input Type (INStrUMENT / Fle)....ceiiiiiiiei e 197
LT o UL 1= TP 197
4= o TN =T o [ T R 198

Input Type (Instrument / File)
Selects an instrument or a file as the type of input provided to the channel.

Note: External mixers are only available for input from a connected instrument.

Remote command:
INSTrument :BLOCk:CHANnel [ : SETTings] : SOURce<si> on page 521
INPut<ip>:SELect on page 594

Input File
Specifies the 1/Q data file to be used for input.

Select "Select File" to open the "Load I/Q File" dialog box.

(See Chapter 8.3.4.1, "Loading the I/Q Data File and Essential Measurement Informa-
tion", on page 127).
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Zero Padding

Enables or disables zero padding for input from an 1/Q data file that requires resam-
pling. For resampling, a number of samples are required due to filter settling. These
samples can either be taken from the provided 1/Q data, or the software can add the
required number of samples (zeros) at the beginning and end of the file.

If enabled, the required number of samples are inserted as zeros at the beginning and
end of the file. The entire input data is analyzed. However, the additional zeros can
effect the determined spectrum of the 1/Q data. If zero padding is enabled, a status
message is displayed.

If disabled (default), no zeros are added. The required samples for filter settling are
taken from the provided I/Q data in the file. The start time in the R&S VSE Player is
adapted to the actual start (after filter settling).

Note: You can activate zero padding directly when you load the file, or afterwards in
the "Input Source" settings.

Remote command:
INPut<ip>:FILE:ZPADing on page 505

10.3.2.4 External Mixer Settings

Access: "Overview" > "Input" > "Input Source" > "Ext. Mixer"

Or: "Input & Output" > "Input Source" > "Ext. Mixer"

If installed, the optional external mixer can be configured from the R&S VSE software.

L V13 G S 1Y 11T 1SS 198
O BasiC SettiNgsS. ..o e 202
Mixer Settings

Access: "Overview" > "Input” > "Input Source" > "Ext. Mixer" > "Mixer Settings"

Or: "Input & Output" > "Input Source" > "Ext. Mixer" > "Mixer Settings"
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Input Source

m File Instrument: @8 FSW-26% ~ Input Source: RF T
Radio
On off
Frequency| (HEEEH
mﬂ Basic Settings

Band Settings Mixer Type
/0y File RF Start 400 GHz 3.port
RF Stop 60.0Hz
> )
Handover Freq 0.0Hz
Band u T
[] rF overrange Preset Band ’@

Mixer Settings

Range Harmonic Type Harmonic Order Conversion Loss

1 Even T2 Al ~verso: 0 |24.DdE

Oz 2 ] |[sverane] ]| | 2408
External MiXer (STat@)........ueuiii i 199
ST =1 S (o o PSSR 199
[ F= T o (01 Z=T il = o PP 200
2= o T PP UPUPRRR 200
RF OVEITANGE ... e e e e e e e e s e e e e e 200
=TS = 7= 1 o o SRR 200
MBI TYPE ettt et r e e e e e e s e e e et et e e e e e e s e e e e e e eeeeeas 200
Mixer Settings (Harmonics Configuration)..........cccoocueeeiiiiiiiiree e 201
L RANGE T/ RANGE 2 ..ottt ettt s n e 201
L HAIMONIC TYPE vttt ettt ee st s s seen e 201
L HAMMONIC OFAET ...ttt 201
L CONVETSION LOSS ...t s e s s ee et 201

External Mixer (State)

Activates or deactivates the external mixer for input. If activated, "ExtMix" is indicated
in the channel bar of the application, together with the used band (see " Band "

on page 200).

Remote command:

[SENSe: MIXer<x>[:STATe] on page 600

RF Start / RF Stop
Displays the start and stop frequency of the selected band (read-only).

The frequency range for the user-defined band is defined via the harmonics configura-
tion (see " Range 1/Range 2 " on page 201).

For details on available frequency ranges, see table 13-12 on page 604.

Remote command:
[SENSe: MIXer<x>:FREQuency:STARt on page 603
[SENSe: ]MIXer<x>:FREQuency:STOP on page 603
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Handover Freq

If due to the LO frequency the conversion of the input signal is not possible using one
harmonic, the band must be split. An adjacent, partially overlapping frequency range
can be defined using different harmonics. In this case, the sweep begins using the har-
monic defined for the first range. At the specified "handover frequency" in the overlap-
ping range, it switches to the harmonic for the second range.

The handover frequency can be selected freely within the overlapping frequency
range.

Remote command:
[SENSe: |MIXer<x>:FREQuency:HANDover on page 602

Band
Defines the waveguide frequency band or user-defined frequency band to be used by
the mixer.

The start and stop frequencies of the selected band are displayed in the "RF Start" and
"RF Stop" fields.

For a definition of the frequency range for the pre-defined bands, see table 13-12 on
page 604.

The mixer settings for the user-defined band can be selected freely. The frequency
range for the user-defined band is defined via the harmonics configuration (see "
Range 1/ Range 2 " on page 201).

Remote command:
[SENSe: |MIXer<x>:HARMonic:BAND on page 603

RF Overrange

In some cases, the harmonics defined for a specific band allow for an even larger fre-
quency range than the band requires. By default, the pre-defined range is used. How-
ever, you can take advantage of the extended frequency range by overriding the
defined "RF Start" and "RF Stop" frequencies by the maximum values.

If "RF Overrange" is enabled, the frequency range is not restricted by the band limits
("RF Start" and "RF Stop" ). In this case, the full frequency range that can be reached
using the selected harmonics is used.

Remote command:
[SENSe: ]MIXer<x>:RFOVerrange[:STATe] on page 607

Preset Band
Restores the presettings for the selected band.

Note: changes to the band and mixer settings are maintained even after using the
[PRESET] function. This function allows you to restore the original band settings.

Remote command:
[SENSe: |MIXer<x>:HARMonic:BAND:PRESet on page 603

Mixer Type

The External Mixer option supports the following external mixer types:
"2 Port" LO and IF data use the same port

"3 Port" LO and IF data use separate ports
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Remote command:
[SENSe: |MIXer<x>:PORTs on page 607

Mixer Settings (Harmonics Configuration)
The harmonics configuration determines the frequency range for user-defined bands
(see " Band " on page 200).

Range 1/ Range 2 — Mixer Settings (Harmonics Configuration)
Enables the use of one or two frequency ranges, where the second range is based on
another harmonic frequency of the mixer to cover the band's frequency range.

For each range, you can define which harmonic to use and how the conversion loss is
handled.

Remote command:
[SENSe: ]MIXer<x>:HARMonic:HIGH:STATe on page 604

Harmonic Type < Mixer Settings (Harmonics Configuration)

Defines if only even, only odd, or even and odd harmonics can be used for conversion.
Depending on this selection, the order of harmonic to be used for conversion changes
(see " Harmonic Order " on page 201). Which harmonics are supported depends on
the mixer type.

Remote command:
[SENSe: | MIXer<x>:HARMonic:TYPE on page 605

Harmonic Order < Mixer Settings (Harmonics Configuration)
Defines which order of the harmonic of the LO frequencies is used to cover the fre-
quency range.

By default, the lowest order of the specified harmonic type is selected that allows con-
version of input signals in the whole band. If due to the LO frequency the conversion is
not possible using one harmonic, the band is split.

For the "USER" band, you define the order of harmonic yourself. The order of har-
monic can be between 2 and 128, the lowest usable frequency being 16.88 GHz.

Remote command:
[SENSe: |MIXer<x>:HARMonic[:LOW] on page 605
[SENSe: |MIXer<x>:HARMonic:HIGH[:VALue] on page 604

Conversion Loss — Mixer Settings (Harmonics Configuration)
Defines how the conversion loss is handled. The following methods are available:

"Average" Defines the average conversion loss for the entire frequency range in
dB.
"Table" Defines the conversion loss via the table selected from the list. Pre-

defined conversion loss tables are often provided with the external
mixer and can be stored on the connected instrument.

Remote command:

Average for range 1:

[SENSe: |MIXer<x>:LOSS[:LOW] on page 607

Table for range 1:

[SENSe: | MIXer<x>:L0SS:TABLe[:LOW] on page 606
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Average for range 2:
[SENSe: |MIXer<x>:L0OSS:HIGH on page 605

Table for range 2:
[SENSe: |MIXer<x>:L0SS:TABLe:HIGH on page 606

Basic Settings
Access: "Overview" > "Input" > "Input Source" > "Ext. Mixer" > "Basic Settings"
Or: "Input & Output" > "Input Source" > "Ext. Mixer" > "Basic Settings"

The basic settings concern general use of an external mixer. They are only available if
the External Mixer (State) is "On" .

Input Source

m File Instrument: EFSW-EE* T  Input Source: RF T

Radio
o Off
Frequenq

Mixer Settings  JEEE[SAS 0l

LO Level 15.5 dBm

I/ File
- Bias Settings Range 1
Bias Value | 0.0 A
- Bias Settings Range 2
Bias Value | 0.0 A
External MiXer (STat@)........uouii i e 202
I I P UPURRR 202
T E= TS = 10T USSP 203

External Mixer (State)
Activates or deactivates the external mixer for input. If activated, "ExtMix" is indicated

in the channel bar of the application, together with the used band (see " Band "
on page 200).

Remote command:

[SENSe: |MIXer<x>[:STATe] on page 600

LO Level
Defines the LO level of the external mixer's LO port. Possible values are from
13.0 dBm to 17.0 dBm in 0.1 dB steps. Default value is 15.5 dB.

Remote command:
[SENSe: ]MIXer<x>:LOPower on page 601
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10.3.3.1

0,

Basic 1/Q Measurement Configuration

Bias Value

Define the bias current for each range, which is required to set the mixer to its optimum
operating point. It corresponds to the short-circuit current. The bias current can range
from -10 mA to 10 mA. The actual bias current is lower because of the forward voltage
of the mixer diode(s).

Tip: The trace in the currently active result display (if applicable) is adapted to the set-
tings immediately so you can check the results.

Remote command:
[SENSe: ] MIXer<x>:BIAS[:LOW] on page 601
[SENSe: |MIXer<x>:BIAS:HIGH on page 601

Amplitude

Access: "Overview" > "Amplitude"
or: "Input & Output" > "Amplitude"

Amplitude settings affect the y-axis display in power diagrams.

e Impact of the Vertical AXiS SEtliNgS.....ccuviiiiiiiiiicccieeee e 203
@  AMPIItUAE SETNGS..ciiiiiiii i e e e e e e e e e nanaes 205
e Amplitude Settings for Oscilloscope Baseband Input..........cccccceeeeeiiineiiininnneennn, 210
®  SCaAlING the Y-AXIS. ..t e e e e e e e e e e e 212
e Scaling for Statistics DiagramsS..........ueeiieiieriiiiiiiiieee e 214

Impact of the Vertical Axis Settings

Some background knowledge on the impact of the described settings is provided here
for a better understanding of the required configuration.

@ REFEIENCE LBVEL....ceeiee ettt e e e et e et e e e e 203
L N £ (=) g [V F= 1 (o] o T 204
L IS T~ 1T TSR 205

Reference Level

The reference level value is the maximum value the AD converter can handle without
distortion of the measured value. Signal levels above this value will not be measured
correctly, which is indicated by the "IF Overload" status display.

Internally, the reference level is also used to determine the optimum hardware settings
for the R&S VSE. The defined reference level should correspond with the maximum
expected RF input level.

When determining the expected input level, consider that the power from all input sig-
nals contribute to the total power. The reference level must be higher than the total
power from all signals.

The optimum reference level for the current measurement settings can be set automat-
ically by the R&S VSE (see " Reference Level " on page 206).
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In general, the connected instrument measures the signal voltage at the RF input. The
level display is calibrated in RMS values of an unmodulated sine wave signal. In the
default state, the level is displayed at a power of 1 mW (= dBm). Via the known input
impedance, conversion to other units is possible.

See " Impedance " on page 189.

Reference level offset

If the signal is attenuated or amplified before it is fed into the R&S VSE, you can define
an (arithmetic) offset to the reference level so the application shows correct power
results. All displayed power level results are shifted by this value, and the scaling of the
y-axis is changed accordingly.

To determine the required offset, consider the external attenuation or gain applied to
the input signal. For attenuation, define a positive offset so the R&S VSE increases the
displayed power values.

If an external gain is applied, define a negative offset so the R&S VSE decreases the
displayed power values.

Note, however, that the internal reference level (used to adjust the hardware settings to
the expected signal optimally) ignores any "Reference Level Offset" . Thus, it is impor-
tant to keep in mind the actual power level the R&S VSE must handle, and not to rely
on the displayed reference level.

internal reference level = displayed reference level - offset

Example
1. The initial reference level is 2 dBm with no offset.
Both the displayed reference level and the internal reference level are 2 dBm.

2. An offset of 3 dB is defined.

The displayed reference level is adjusted to 5 dBm.
The internal reference level remains at 2 dBm.
(5 dBm (displayed ref level) - 3 dB (offset) = 2 dBm)

3. Now the user decreases the reference level to 1 dBm.

The displayed reference level is adjusted to 1 dBm.
The internal reference level is adjusted to:
1 dBm (displayed ref level) - 3 dB (offset) = -2 dBm.

RF Attenuation

The attenuation is meant to protect the input mixer from high RF input levels. The level
at the input mixer is determined by the set RF attenuation according to the formula:

"levelmixer = levelin,,: — RF attenuation”
The maximum mixer level allowed depends on the connected instrument.

Mixer levels above this value may lead to incorrect measurement results, which is indi-
cated by the "RF Overload" status display. Furthermore, higher input levels may dam-
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age the instrument. Therefore, the required RF attenuation is determined automatically
according to the reference level by default.

High attenuation levels also avoid intermodulation. On the other hand, attenuation
must be compensated for by re-amplifying the signal levels after the mixer. Thus, high
attenuation values cause the inherent noise (i.e the noise floor) to rise and the sensitiv-
ity of the analyzer decreases.

@ For ideal sinusoidal signals, the displayed signal level is independent of the RF attenu-
ation.

Depending on the type of measurement you must find a compromise between a low
noise floor and high intermodulation levels, and protecting the instrument from high
input levels. You achieve this best by letting the connected instrument determine the
optimum level automatically (see " Attenuation Mode / Value " on page 208).

Scaling

In a linear display, the measurement values are distributed linearly throughout the grid.
That means the entire range of measured values is divided by the number of rows in
the grid (10) and each row corresponds to 1/10 of the total range. Linear scaling is use-
ful to determine precise levels for a small range of values. However, if large and small
values appear in the same display, it is difficult to determine individual values precisely
or to distinguish values that are close together.

In a logarithmic display, smaller values are distributed among a much larger area of the
display, while large values are condensed to a smaller area. Now it is much easier to
distinguish several lower values, as they are spread over a wider area. Logarithmic
scaling is useful when large ranges of values must be combined in one display. Loga-
rithmic scaling is best applied to measurement values in logarithmic units (dB, dBm
etc.).

In addition to linear or logarithmic scaling, the vertical axis can be set to display either
absolute or relative values. Absolute values show the measured levels, while relative
values show the difference between the measured level and the defined reference
level. Relative values are indicated in percent for linear scaling, and in dB for logarith-
mic scaling.

10.3.3.2 Amplitude Settings

Access: "Overview" > "Amplitude”
Or: "Input & Output" > "Amplitude”

Amplitude settings determine how the connected instrument must process or display
the expected input power levels.

Which amplitude settings are available depends on the connected instrument.
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Amplitude

r Reference Level r Input Settings
Walue 0.0 dEm Preamplifier oy Off
Offset 0.0 dB
e Input Coupling “ D
Unit dBm T
Ao Level Impedance m 750
r Attenuation r Electronic Attenuation
State on Off
Mode hanual
Mode Auto I |
Walue 10.0 dBE
Walue 0.0 de
RETEIENCE LEVEI .. ..t e e e e e e e e s 206
L Shifting the DiSplay ( OffSEt )......ceeveueeeeeeeeeeeeeeeeseee e ee e eeeese e ee e 207
L UNIE ettt ettt n e, 207
L @ Setting the Reference Level Automatically ( Auto Level ).........c.cccevvneee.. 208
R N £ (=T 0 U F= i o PPN 208
L AtenUAtioN MOGE / VAIUE ....veeeeeeeeeeeeeeeeeeeeeeeeee et ee et ee et e e e eaeeeee e 208
L 10 dB Minimum AteNUAHON. ............ccoveveeeeeeeeeeeeeeceeee s 208
Using Electronic AHENUALION .........cooiiiiiiiii e 208
INPUL SEHINGS e s e 209
L PIEAMPIIIET ...ttt 209

Reference Level

Defines the expected maximum input signal level. Signal levels above this value may
not be measured correctly, which is indicated by the "IF Overload" status display

( "OVLD" for analog baseband or digital baseband input).

Defines the expected maximum reference level. Signal levels above this value may not
be measured correctly. This is indicated by an "IF Overload" status display.

The reference level can also be used to scale power diagrams; the reference level is
then used as the maximum on the y-axis.

Since the hardware of the connected instrument is adapted according to this value, it is
recommended that you set the reference level close above the expected maximum sig-
nal level. Thus you ensure an optimum measurement (no compression, good signal-to-
noise ratio).

Note that for input from the External Mixer (R&S VSE-B21) the maximum reference
level also depends on the conversion loss; see the R&S VSE base software user man-
ual for details.
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Remote command:
DISPlay[:WINDow<n>] : TRACe<t>:Y[:SCALe] :RLEVel<ant> on page 610

Shifting the Display ( Offset ) — Reference Level
Defines an arithmetic level offset. This offset is added to the measured level. In some
result displays, the scaling of the y-axis is changed accordingly.

Define an offset if the signal is attenuated or amplified before it is fed into the R&S VSE
so the application shows correct power results. All displayed power level results are
shifted by this value.

The setting range is £200 dB in 0.01 dB steps.

Note, however, that the internal reference level (used to adjust the hardware settings to
the expected signal) ignores any "Reference Level Offset" . Thus, it is important to
keep in mind the actual power level the R&S VSE must handle. Do not rely on the dis-
played reference level (internal reference level = displayed reference level - offset).

Remote command:
DISPlay[:WINDow<n>] :TRACe<t>:Y[:SCALe] :RLEVel<ant>:0FFSet
on page 610

Unit — Reference Level
The connected instrument measures the signal voltage at the RF input.

In the default state, the level is displayed at a power level of 1 mW (= dBm). Via the
known input impedance (50 Q or 75 Q, see " Impedance " on page 189), conversion to
other units is possible.

The following units are available and directly convertible:
dBm

dBmV

dBuV

dBuA

dBpW

Volt

Ampere

Watt

Additional units available only for installed R&S VSE-K54 (EMI measurements) option:
® dBmV/MHz (normalized to 1 MHz)
e dBpV/MHz (normalized to 1 MHz)
® dBpV/mMHz (normalized to 1 MHz)
(only available for active transducers with dBuV/m values)
dBuA/MHz (normalized to 1 MHz)
dBpA/mMHz (normalized to 1 MHz)
(only available for active transducers with dBuA/m values)
® dBpW/MHz (normalized to 1 MHz)

Remote command:
INPut<ip>:IMPedance<ant> on page 590
CALCulate<n>:UNIT:POWer on page 609
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Setting the Reference Level Automatically ( Auto Level ) — Reference Level
The connected instrument automatically determines the optimal reference level for the
current input data. At the same time, the internal attenuators and the preampilifier are
adjusted so the signal-to-noise ratio is optimized, while signal compression, clipping
and overload conditions are minimized. This function is not available on all supported
instruments.

You can change the measurement time for the level measurement if necessary (see
"Automatic Measurement Time Mode and Value" on page 243).

Remote command:
[SENSe:]ADJust:LEVel on page 643

RF Attenuation
Defines the attenuation applied to the RF input of the R&S VSE.

Attenuation Mode / Value — RF Attenuation

The RF attenuation can be set automatically as a function of the selected reference
level (Auto mode). This ensures that no overload occurs at the RF Input connector for
the current reference level. It is the default setting.

In "Manual" mode, you can set the RF attenuation in 1 dB steps (down to 0 dB). Other
entries are rounded to the next integer value. The range is specified in the data sheet.
If the defined reference level cannot be set for the defined RF attenuation, the refer-
ence level is adjusted accordingly and the warning "limit reached" is displayed.

NOTICE! Risk of hardware damage due to high power levels. When decreasing the
attenuation manually, ensure that the power level does not exceed the maximum level
allowed at the RF input, as an overload may lead to hardware damage.

Remote command:
INPut<ip>:ATTenuation on page 611
INPut<ip>:ATTenuation:AUTO on page 611

10 dB Minimum Attenuation — RF Attenuation
Turns the availability of attenuation levels of less than 10 dB on and off.

When you turn on this feature, the attenuation is always at least 10 dB. This minimum
attenuation protects the input mixer and avoids accidental setting of 0 dB, especially if
you measure EUTs with high RFI voltage.

When you turn it off, you can also select attenuation levels of less than 10 dB.

The setting applies to a manual selection of the attenuation as well as the automatic
selection of the attenuation.

Remote command:
INPut<ip>:ATTenuation:PROTection:RESet on page 587

Using Electronic Attenuation
If the (optional) Electronic Attenuation hardware is installed on the connected instru-
ment, you can also activate an electronic attenuator.

In "Auto" mode, the settings are defined automatically; in "Manual" mode, you can
define the mechanical and electronic attenuation separately.
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Note: Note that restrictions may apply concerning which frequencies electronic attenu-
ation is available for, depending on which instrument is connected to the R&S VSE
software. Check your instrument documentation for details.

In "Auto" mode, RF attenuation is provided by the electronic attenuator as much as
possible to reduce the amount of mechanical switching required. Mechanical attenua-
tion may provide a better signal-to-noise ratio, however.

When you switch off electronic attenuation, the RF attenuation is automatically set to
the same mode (auto/manual) as the electronic attenuation was set to. Thus, the RF
attenuation can be set to automatic mode, and the full attenuation is provided by the
mechanical attenuator, if possible.

If the defined reference level cannot be set for the given attenuation, the reference
level is adjusted accordingly and the warning "limit reached" is displayed in the status
bar.

Remote command:

INPut<ip>:EATT:STATe on page 613

INPut<ip>:EATT:AUTO on page 613

INPut<ip>:EATT on page 612

Input Settings
Some input settings affect the measured amplitude of the signal, as well.

The parameters "Input Coupling” and "Impedance" are identical to those in the "Input”
settings.

See Chapter 10.3.2.1, "Radio Frequency Input", on page 187.

Preamplifier — Input Settings
If the (optional) internal preamplifier hardware is installed, a preamplifier can be activa-
ted for the RF input signal.

If the (optional) internal preamplifier hardware is installed on the connected instrument,
a preamplifier can be activated for the RF input signal.

You can use a preamplifier to analyze signals from DUTs with low output power.

Note that if an optional external preamplifier is activated, the internal preamplifier is
automatically disabled, and vice versa.

This function is not available for input from the (optional) Digital Baseband Interface.
For R&S VSES, 13, and 26 models, the following settings are available:

"Off" Deactivates the preamplifier.
"15 dB" The RF input signal is amplified by about 15 dB.
"30 dB" The RF input signal is amplified by about 30 dB.

Depending on the connected instrument, different settings are available. See the
instrument's documentation for details.

Remote command:
INPut<ip>:GAIN<ant>:STATe on page 614
INPut<ip>:GAIN<ant>[:VALue] on page 614
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10.3.3.3 Amplitude Settings for Oscilloscope Baseband Input

Access: "Overview" > "Amplitude”

The following settings and functions are available to define amplitude settings for Oscil-
loscope Baseband Input in the applications that support it.

Amplitude Scale

r Reference Lewve| r Input Settings
Walue -0.01 dBm L Mode e T
Offset 0.0 dB
Unit dEm T
Auta Level

r Full Scale Lewvel

Maode hanual

“Walue 1.0%
REFEIENCE LEVEI ...ttt ettt e e e e e e 210
L Shifting the DiSplay ( OffSEt )......ceeveueeeeeeeeeeeeeeeeseeeee e e e ee e ee e 211
U1 OO OO 211
L @ Setting the Reference Level Automatically ( Auto Level )..........c.ccooee..... 212
Full Scale Level MOde / ValUE......c.ccooieeieeiiiiieeeeeeeeeeecee et e e e e e e e e e e e eeeeeensnnns 212
FL @ 1Y oo [T OO 212

Reference Level

Defines the expected maximum input signal level. Signal levels above this value may
not be measured correctly, which is indicated by the "IF Overload" status display

( "OVLD" for analog baseband or digital baseband input).

Defines the expected maximum reference level. Signal levels above this value may not
be measured correctly. This is indicated by an "IF Overload" status display.

The reference level can also be used to scale power diagrams; the reference level is
then used as the maximum on the y-axis.

Since the hardware of the connected instrument is adapted according to this value, it is
recommended that you set the reference level close above the expected maximum sig-
nal level. Thus you ensure an optimum measurement (no compression, good signal-to-
noise ratio).

Note that for input from the External Mixer (R&S VSE-B21) the maximum reference
level also depends on the conversion loss; see the R&S VSE base software user man-
ual for details.

Remote command:
DISPlay[:WINDow<n>] : TRACe<t>:Y[:SCALe] :RLEVel<ant> on page 610
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Shifting the Display ( Offset ) < Reference Level
Defines an arithmetic level offset. This offset is added to the measured level. In some
result displays, the scaling of the y-axis is changed accordingly.

Define an offset if the signal is attenuated or amplified before it is fed into the R&S VSE
so the application shows correct power results. All displayed power level results are
shifted by this value.

The setting range is +200 dB in 0.01 dB steps.

Note, however, that the internal reference level (used to adjust the hardware settings to
the expected signal) ignores any "Reference Level Offset" . Thus, it is important to
keep in mind the actual power level the R&S VSE must handle. Do not rely on the dis-
played reference level (internal reference level = displayed reference level - offset).

Remote command:
DISPlay|[:WINDow<n>] :TRACe<t>:Y[:SCALe] :RLEVel<ant>:0FFSet
on page 610

Unit — Reference Level
The connected instrument measures the signal voltage at the RF input.

In the default state, the level is displayed at a power level of 1 mW (= dBm). Via the
known input impedance (50 Q or 75 Q, see " Impedance " on page 189), conversion to
other units is possible.

The following units are available and directly convertible:
dBm

dBmV

dBuV

dBpA

dBpW

Volt

Ampere

Watt

Additional units available only for installed R&S VSE-K54 (EMI measurements) option:
® dBmV/MHz (normalized to 1 MHz)
® dBpV/MHz (normalized to 1 MHz)
e dBpV/mMHz (normalized to 1 MHz)
(only available for active transducers with dBuV/m values)
® dBPA/MHz (normalized to 1 MHz)
® dBYA/mMHz (normalized to 1 MHz)
(only available for active transducers with dBuA/m values)
® dBpW/MHz (normalized to 1 MHz)

Remote command:
INPut<ip>:IMPedance<ant> on page 590
CALCulate<n>:UNIT:POWer on page 609
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Setting the Reference Level Automatically ( Auto Level ) — Reference Level
The connected instrument automatically determines the optimal reference level for the
current input data. At the same time, the internal attenuators and the preampilifier are
adjusted so the signal-to-noise ratio is optimized, while signal compression, clipping
and overload conditions are minimized. This function is not available on all supported
instruments.

You can change the measurement time for the level measurement if necessary (see
"Automatic Measurement Time Mode and Value" on page 243).

Remote command:
[SENSe:]ADJust:LEVel on page 643

Full Scale Level Mode / Value
The full scale level defines the maximum power for Oscilloscope Baseband Input pos-
sible without clipping the signal.

The full scale level can be defined automatically according to the reference level, or
manually.

For manual input, this setting corresponds to the setting on the oscilloscope. Thus,
possible scaling values of the oscilloscope are allowed.

Remote command:
INPut<ip>:IQ:0SC:FULLscale:AUTO on page 598
INPut<ip>:TQ:0SC:FULLscale[:LEVel] on page 597

1/Q Mode
Defines the format of the input signal.

For more information, see Chapter 10.2.5.1, "I/Q Processing Modes", on page 178.

"/Q" Both components of the complex input signal (in-phase component,
quadrature component) are filtered and resampled to the sample rate
of the application.

"I Only / Low IF I"
The input signal at the channel providing | data is filtered and resam-
pled to the sample rate of the application.
The input signal is down-converted with the center frequency (Low IF

).
Remote command:
INPut<ip>:IQ:0SC:TYPE on page 599

10.3.3.4 Scaling the Y-Axis

The individual scaling settings that affect the vertical axis are described here.
Access: "Overview" > "Amplitude" > "Scale" tab
Or: "Input & Output" > "Scale"

The settings for statistics results are described in Chapter 10.3.3.5, "Scaling for Statis-
tics Diagrams", on page 214.
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Amplitade | Tl

Amplitude Scale

- Range - Sealing
3 1
-':ﬂ?- . .
Range 1.0 dE @ Logarithmic
(") Linear Percent
REHEERIN 100.0 % (71 Linear with Unit

RefValue | -10.0 dBm Relative

Specifics for 3: Spectrum -

= T = PSR 213
RETf LEVEI POSIHION ....eeeeeeeeeee ettt e e e e e e e eeaaaeaes 213
Y 2= 11 213
S To=1 1 0o [ R PTR 213
Y-AXIS IMAX .eeieiiiiiieiee ettt e e e e e e e e e s e e e e e e ae e e e e aaee—n——rarrraeaaaeaeaeaaaannnn 214
Range

Defines the displayed y-axis range in dB.
The default value is 100 dB.

Remote command:
DISPlay[:WINDow<n>] : TRACe<t>:Y[:SCALe] on page 615

Ref Level Position
Defines the reference level position, i.e. the position of the maximum AD converter
value on the level axis in %.

0 % corresponds to the lower and 100 % to the upper limit of the diagram.
Values from -120 % to +600 % are available. Larger values are useful for small scales,
such as a power range of 10 dB or 20 dB, and low signal levels, for example 60 dB

below the reference level. In this case, large reference level position values allow you
to see the trace again.

Remote command:
DISPlay[:WINDow<n>]:TRACe<t>:Y[:SCALe] :RPOSition on page 616

Ref Value
The reference level value (configured in Amplitude Settings), indicated for reference

only.

Scaling
Defines the scaling method for the y-axis.
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"Logarithmic" Logarithmic scaling (only available for logarithmic units - dB..., and A,

V, Watt)

"Linear with Linear scaling in the unit of the measured signal

Unit"

"Linear Per- Linear scaling in percentages from 0 to 100

cent"

"Absolute"” The labeling of the level lines refers to the absolute value of the refer-
ence level (not available for "Linear Percent" )

"Relative” The scaling is in dB, relative to the reference level (only available for
logarithmic units - dB...). The upper line of the grid (reference level) is
always at 0 dB.

Remote command:

DISPlay[:WINDow<n>] [ : SUBWindow<w>] : TRACe<t>:Y:SPACing on page 617
DISPlay[:WINDow<n>] [ :SUBWindow<w>] :TRACe<t>:Y[:SCALe] :MODE

on page 615

Y-Axis Max

Defines the maximum value of the y-axis in the currently selected diagram in either
direction (in Volts). Thus, the y-axis scale starts at -<Y-Axis Max> and ends at +<Y-Axis
Max>.

This command is only available if the evaluation mode for the I/Q Analyzer is set to
"l/Q-Vector" or "Real/lmag (1/Q)" .

Remote command:
DISPlay[:WINDow<n>] : TRACe<t>:Y[:SCALe] on page 615

10.3.3.5 Scaling for Statistics Diagrams

Access: "Overview" > "Amplitude" > "Scale" tab
Or: "Input & Output" > "Scale"
For statistics displays, scale settings are available for both the y-axis and the x-axis.

The remote commands required to perform these tasks are described in Chap-
ter 13.6.2.3, "Configuring the Axes for Statistical Displays", on page 617.
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Amplitude Scale
r X-AxXis r ¥-Axis
Refalue 0,0 dBm Y-Lnit Pt
Range 20,0 dB Y-Max 1.0
Cffset 0.0 dB ¥-Min  1.0E-06
Adjust Settings Default Settings

Specifics for 21 Statistic CCOF =

Figure 10-10: Scale settings for CCDF diagram

r X-Axis r Y-Axis
Ref'walue 0.0 dBm
Y-Unit
Range 100.0 4B
Y-Max 1.0

Offset 0.0 dB

Quantize 101 ¥-Min  1.0E-08

Specifics for 3 StatisticAPD  ~

Figure 10-11: Scale settings for APD diagram

In statistical diagrams, the x-axis displays the signal level values (= y-axis in standard
display), while the y-axis displays the probability of the values.

D N SRR 216
L REF LEVEI .ueeieiceieee ettt 216
L Yo 1= TR 216
L Shifting the Display ( OffSEt )........c.eceveeeerreeeeeeeeteeeeee e e eeeaeeeee e 216
QUANEIZE BINS...uiiiiiiiiiiiie et s e e e s e e e s rate e e e e s st e e e e e e eantaeeeesanrraeaaean 216
YoAXIS eeeitteeee e e ettt e e ettt e e e e et e e e e e e e e et et ——— e e e e ———eeeaaat———eeeaaatr—eeeeaaar—aeeeaatraeeaeaanrares 216
L YoUNIE cttttttiie ettt 216
L YAMEX T YAMIN sttt 217
Default SEHINGS ... ————— 217
Adjust Settings (CCDF ONIY)....euiiiiieiieieie et e e e e 217
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X-Axis
Defines the scaling settings for signal level values.

Ref Level «— X-Axis
Defines the reference level for the signal levels in the currently active unit (dBm, dBuV,
etc.).

For the APD function this value corresponds to the right diagram border. For the CCDF
function there is no direct representation of this value on the diagram as the x-axis is
scaled relatively to the measured mean power.

Remote command:
CALCulate<n>:STATistics:SCALe:X:RLEVel on page 619
CALCulate<n>:TQ:STATistic:SCALe:X:RVALue on page 619

Range — X-Axis

Defines the level range in dB to be evaluated by the statistics measurement.
Remote command:
CALCulate<n>:STATistics:SCALe:X:RANGe on page 618
CALCulate<n>:IQ:STATistic:SCALe:X:RANGe on page 618

Shifting the Display ( Offset ) < X-Axis

Defines an arithmetic level offset. This offset is added to the measured level irrespec-
tive of the selected unit. The scaling of the x-axis is changed accordingly. The setting
range is +200 dB in 0.1 dB steps.

Remote command:

DISPlay[:WINDow<n>] :TRACe<t>:Y[:SCALe] :RLEVel<ant>:0FFSet
on page 610

CALCulate<n>:IQ:STATistic:SCALe:X:RLEVel:OFFSet on page 618

Quantize Bins

For Statistic APD displays, this value defines the number of quantize bins used to cre-
ate the histogram, that is, the number of different measurement values the statistical
occurrence is determined for.

For Statistic CCDF displays, the number of bins is fixed to 2048.

Remote command:
APD only:
CALCulate<n>:IQ:STATistics:SCALe:X:QUANtize on page 618

Y-Axis
Defines the scaling settings for the probability distribution.

Y-Unit — Y-Axis
(CCDF only)

Defines the scaling type of the y-axis as either percentage or absolute. The default
value is absolute scaling.

Remote command:
CALCulate<n>:STATistics:SCALe:Y:UNIT on page 620
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Y-Max / Y-Min — Y-Axis

Defines the upper (max) and lower (min) limit of the displayed probability range. Values
on the y-axis are normalized which means that the maximum value is 1.0. The mini-
mum value must be in the range:

1E-9 < Y-Min < 0.1

The distance between "Y-Max" and "Y-Min" must be at least one decade.
Remote command:

CALCulate<n>:STATistics:SCALe:Y:UPPer on page 619
CALCulate<n>:STATistics:SCALe:Y:LOWer on page 619

CALCulate<n>:IQ:STATistic:SCALe:Y:UPPer on page 619
CALCulate<n>:TQ:STATistic:SCALe:Y:LOWer on page 619

Default Settings
Resets the x- and y-axis scalings to their preset values.

(CCDF only)

X-axis ref level: -10 dBm
X-axis range CCDF: 20 dB
Y-axis upper limit: 1.0
Y-axis lower limit: 1E-6

Remote command:
CALCulate<n>:STATistics:PRESet on page 620

Adjust Settings (CCDF only)

Adjusts the level settings according to the measured difference between peak and
mean power for CCDF measurement in order to obtain maximum power resolution.
Adjusts the reference level to the current input signal.

Remote command:
CALCulate<n>:STATistics:SCALe:AUTO ONCE on page 620

10.3.4 Frequency Settings

Access: "Overview" > "Frequency"

Or: "Input & Output" > "Frequency"”
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Fequeney L ==

Frequency

Center 13.25 GHz

Center Frequency Stepsize

Stepsize = Center T Value | 1.0 MHz

Frequency Offset

Malue 0.0 Hz

(07210 (=T gl (=T U= o o3 PSP 218
Center FreqUENCY SEEPSIZE ...occeeviiiiieiiee ettt e e e e e eeaeees 218
FrequenCy OffSEL ... e e e e e e e e e e an 219

Center Frequency
Defines the center frequency of the signal in Hertz.

OHzs fcenter ES fmax
fmax @nd span,,, depend on the instrument and are specified in the data sheet.

Note: For file input, you can shift the center frequency of the current measurement
compared to the stored measurement data. The maximum shift depends on the sam-
ple rate of the file data.

SRy
2

CFahift,,. = CFpie £

maz

If the file does not provide the center frequency, it is assumed to be 0 Hz.

In order to ensure that the input data remains within the valid analysis bandwidth,
define the center frequency and the analysis bandwidth for the measurement such that
the following applies:

ABW shanne ABW,
or + ABWeamnd o, 25V ie
2 2
cF - ABWetannel W;’“‘”"d > CFy, — —AB;Vf =

Remote command:
[SENSe: ] FREQuency:CENTer on page 621

Center Frequency Stepsize
Defines the step size by which the center frequency is increased or decreased using
the arrow keys.

When you use the mouse wheel, the center frequency changes in steps of only 1/10 of

the span.

The step size can be coupled to another value or it can be manually set to a fixed
value.

"= Center" Sets the step size to the value of the center frequency. The used

value is indicated in the "Value" field.
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"Manual" Defines a fixed step size for the center frequency. Enter the step size
in the "Value" field.

Remote command:
[SENSe: ] FREQuency:CENTer: STEP on page 621

Frequency Offset
Shifts the displayed frequency range along the x-axis by the defined offset.

This parameter has no effect on the instrument's hardware, or on the captured data or
on data processing. It is simply a manipulation of the final results in which absolute fre-
quency values are displayed. Thus, the x-axis of a spectrum display is shifted by a
constant offset if it shows absolute frequencies. However, if it shows frequencies rela-
tive to the signal's center frequency, it is not shifted.

A frequency offset can be used to correct the display of a signal that is slightly distorted
by the measurement setup, for example.

The allowed values range from -1 THz to 1 THz. The default setting is 0 Hz.

Remote command:
[SENSe: ] FREQuency:0FFSet on page 622

Trigger and Gate Configuration

Triggering means to capture the interesting part of the signal. Choosing the right trigger
type and configuring all trigger settings correctly allows you to detect various incidents
in your signals.

Gating allows you to restrict measurement analysis to the important part or parts of the
signal, for example bursts.

L I I 4T To [T 4 o o TP OO PPPPPTUPRIINE 219
L I €T (] o R 229
Triggering

Triggered Measurements

In a basic measurement with default settings, the measurement is started immediately
when you select the P "Capture" icon. However, sometimes you want the measure-
ment to start only when a specific condition is fulfilled on the connected instrument, for
example a signal level is exceeded, or in certain time intervals. For these cases you
can define a trigger for the measurement.

An "Offset" can be defined to delay the measurement after the trigger event, or to
include data before the actual trigger event in time domain measurements (pre-trigger
offset).

For complex tasks, advanced trigger settings are available:

® Hysteresis to avoid unwanted trigger events caused by noise
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® Holdoff to define exactly which trigger event will cause the trigger in a jittering sig-

nal
®  THIGGET SOUICE....eiiiiiiiiiie ettt ettt ettt e e et e e e et e e e e s e e nbe e e e e e sabre e e e e anres 220
O THQGEr OffSEL..... e 220
o Trigger HySteresis.........ccoooviviiiiiiiiiiiiii 220
®  Trigger Drop-Out TIME.....ccuiii it 221
®  Trigger HOIOR ... 222

Trigger Source

The trigger source defines which source must fulfill the condition that triggers the mea-
surement. Basically, this can be:

® Time: the measurement is repeated in a regular interval

® Power: an input signal is checked for a defined power level
The trigger signal can be any of the following:
— The input signal at one of various stages in the signal analysis process - before
or after the input mixer, after the video filter etc.
— A signal from an external device via one of the TRIGGER INPUT / OUTPUT
connectors on the instrument
— A signal from one of the input channels from a connected oscilloscope
® Complex trigger settings defined on a connected R&S RTP: using a manual trigger
source, any trigger settings in the R&S VSE software are ignored; only trigger set-
tings defined on the connected instrument are considered. Thus, you can make
use of the more complex trigger settings available on an R&S RTP.

For details on the available trigger sources see " Trigger Source " on page 224.

Trigger Offset

An offset can be defined to delay the measurement after the trigger event, or to include
data before the actual trigger event in time domain measurements (pre-trigger offset).
Pre-trigger offsets are possible because the R&S VSE captures data continuously in
the time domain, even before the trigger occurs.

See " Trigger Offset " on page 227.

Trigger Hysteresis

Setting a hysteresis for the trigger helps avoid unwanted trigger events caused by
noise, for example. The hysteresis is a threshold to the trigger level that the signal
must fall below on a rising slope or rise above on a falling slope before another trigger
event occurs.
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Example:

In the following example, the second possible trigger event on the rising edge is
ignored as the signal does not drop below the hysteresis (threshold) before it reaches
the trigger level again. On the falling edge, however, two trigger events occur as the
signal exceeds the hysteresis before it falls to the trigger level the second time.

Trigger on rising edge Trigger on falling edge

Trigger level

Figure 10-12: Effects of the trigger hysteresis

See " Hysteresis " on page 228

Trigger Drop-Out Time

If a modulated signal is instable and produces occasional "drop-outs" during a burst,
you can define a minimum duration that the input signal must stay below the trigger
level before triggering again. This is called the "drop-out" time. Defining a dropout time
helps you stabilize triggering when the analyzer is triggering on undesired events.

T

VAR RN

Figure 10-13: Effect of the trigger drop-out time

See " Drop-Out Time " on page 227.
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@ Drop-out times for falling edge triggers
If a trigger is set to a falling edge ( "Slope" = "Falling" , see " Slope " on page 228) the
measurement is to start when the power level falls below a certain level. This is useful,
for example, to trigger at the end of a burst, similar to triggering on the rising edge for
the beginning of a burst.

If a drop-out time is defined, the power level must remain below the trigger level at
least for the duration of the drop-out time (as defined above). However, if a drop-out
time is defined that is longer than the pulse width, this condition cannot be met before
the final pulse, so a trigger event will not occur until the pulsed signal is over!

Figure 10-14: Trigger drop-out time for falling edge trigger

Trigger Holdoff

The trigger holdoff defines a waiting period before the next trigger after the current one
will be recognized.

Frame 1 Frame 2

nAn NnAn
NRIATANNATATAN

Figure 10-15: Effect of the trigger holdoff
See " Trigger Holdoff " on page 228.

Trigger Settings

Access: "Overview" > "Trigger/Gate"
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r Gate Settings
Gated Trigger an Off
- Source Magnitude Trigger =
—E‘ Level -20.0 dBm Drop-Out Time 0.0 s Gate Mode I Edge I
=
=T,
o | Offset 0.0 s ACEE m T Gate Delay 005
Hysteresis 3.0 dB Holdoff 0.0s Gate Length 400.0 ps

Ommit Gates | 2;4,5-25

External triggers from one of the TRIGGER INPUT / OUTPUT connectors on the
R&S VSE are configured in a separate tab of the dialog box.

See Chapter 7.7, "Receiving and Providing Trigger Signals", on page 106.
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Preview

The preview mode allows you to try out trigger and gate settings before actually apply-
ing them to the current measurement.

The preview diagram displays a zero span measurement at the center frequency with
the defined RBW and sweep time. This is useful to analyze bursts, for example, to
determine the required gate settings.
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The trigger and gate settings are applied to the measurement when the dialog box is
closed.

Note: The zero span settings refer only to the preview diagram. The main diagram
remains unchanged.

If preview mode is switched off, any changes to the settings in this dialog box are
applied to the measurement diagram directly. In this case, the zero span settings for
the preview diagram are not displayed.

Frequency — Preview
Defines the center frequency.

Remote command:
[SENSe: ] FREQuency:CENTer on page 621

RBW « Preview
Defines the bandwidth value. The available resolution bandwidths are specified in the
data sheet. Numeric input is always rounded to the nearest possible bandwidth.

Remote command:
[SENSe: ]BANDwidth[:RESolution] on page 739

Sweep Time « Preview

Defines the sweep time. Allowed values depend on the ratio of span to RBW and RBW
to VBW. For details refer to the data sheet. Numeric input is always rounded to the
nearest possible sweep time.

Remote command:
[SENSe: ] SWEep: TIME on page 637

Trigger Source
Selects the trigger source. If a trigger source other than "Free Run" is set, "TRG" is dis-
played in the channel bar and the trigger source is indicated.

Note that the availability of trigger sources depends on the connected instrument.

Remote command:
TRIGger [:SEQuence] : SOURce on page 628

Free Run < Trigger Source
No trigger source is considered. Data acquisition is started manually or automatically
and continues until stopped explicitly.

Remote command:
TRIG:SOUR IMM, see TRIGger [:SEQuence] : SOURce on page 628

External Trigger / Trigger Channel X «— Trigger Source
Data acquisition starts when the signal fed into the specified input connector or input
channel of the connected instrument meets or exceeds the specified trigger level.

Note: Which input and output connectors are available depends on the connected
instrument. For details, see the instrument's documentation.

For a connected R&S oscilloscope, the following signals are used as trigger input:

e "External Trigger": EXT TRIGGER INPUT connector on rear panel of instrument
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® "Trigger Channel 2"/"Trigger Channel 3"/"Trigger Channel 4": Input at channel con-
nectors CH 2/3/4 on front panel of instrument - if not used as an input source

Remote command:
TRIG:SOUR EXT, TRIG:SOUR EXT2, TRIG:SOUR EXT3, TRIG:SOUR EXT4
See TRIGger [ : SEQuence] : SOURce on page 628

External Channel 3 — Trigger Source
Data acquisition starts when the signal fed into the Ch3 input connector on the oscillo-
scope meets or exceeds the specified trigger level.

Note: In previous firmware versions, the external trigger was connected to the Ch2
input on the oscilloscope. As of firmware version R&S FSW 2.30, the Ch3 input on the
oscilloscope must be used!

This trigger source is only available if the optional 2 GHz bandwidth extension
(R&S VSE-B2000) is active (see R&S VSE I/Q Analyzer and I/Q Input User Manual).

Note: Since the external trigger uses a second channel on the oscilloscope, the maxi-
mum memory size, and thus record length, available for the input channel 1 may be
reduced by half. For details, see the oscilloscope's data sheet and documentation.

Remote command:
TRIG:SOUR EXT, see TRIGger [:SEQuence] : SOURce on page 628

External Analog < Trigger Source
Data acquisition starts when the signal fed into the EXT TRIGGER INPUT connector
on the oscilloscope meets or exceeds the specified trigger level.

This trigger source is only available if the optional 2 GHz bandwidth extension (R&S
FSW-B2000) is active in power splitter mode (see "Oscilloscope Splitter Mode"

on page 192).

Remote command:

TRIG:SOUR EXT, see TRIGger [ : SEQuence] : SOURce on page 628

IF Power «— Trigger Source
The R&S VSE starts capturing data as soon as the trigger level is exceeded around
the third intermediate frequency.

(The third IF represents the center frequency.)
This trigger source is only available for RF input.

The available trigger levels depend on the RF attenuation and preamplification. A refer-
ence level offset, if defined, is also considered.

When using the optional 2 GHz bandwidth extension (R&S FSW-B2000) with an IF

power trigger, the IF power trigger corresponds to a "width" trigger on the oscilloscope,

with a negative polarity and the range "longer". Thus, data acquisition starts when both

of the following conditions apply to the signal fed into the CH1 input connector on the

oscilloscope:

® The power level has remained below the specified trigger level for a duration lon-
ger than the drop-out time.

® The power level then rises above the specified trigger level.

For details on available trigger levels and trigger bandwidths, see the data sheet.
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Remote command:
TRIG:SOUR IFP, see TRIGger [:SEQuence] : SOURce on page 628

I/Q Power «— Trigger Source
This trigger source is only available in the I/Q Analyzer application and in applications
that process 1/Q data.

It is not available for analysis bandwidths = 160 MHz.

Triggers the measurement when the magnitude of the sampled 1/Q data exceeds the
trigger threshold.

The trigger bandwidth corresponds to the bandwidth setting for 1/Q data acquisition.
(See "Analysis Bandwidth" on page 235.)

Remote command:
TRIG:SOUR IQP, see TRIGger [:SEQuence] : SOURce on page 628

RF Power < Trigger Source
Defines triggering of the measurement via signals which are outside the displayed
measurement range.

For this purpose, the software uses a level detector at the first intermediate frequency.

The resulting trigger level at the RF input depends on the RF attenuation and preampli-
fication. For details on available trigger levels, see the instrument's data sheet.

Note: If the input signal contains frequencies outside of this range (e.g. for fullspan
measurements), the measurement may be aborted. A message indicating the allowed
input frequencies is displayed in the status bar.

A "Trigger Offset" , "Trigger Polarity" and "Trigger Holdoff" (to improve the trigger stabil-
ity) can be defined for the RF trigger, but no "Hysteresis" .

Remote command:
TRIG:SOUR RFP, see TRIGger [:SEQuence] : SOURce on page 628

Time — Trigger Source
Triggers in a specified " Repetition Interval " on page 227.

For file input, data is taken from the file in the specified time interval. Overlap settings
for the R&S VSE Player are ignored.

(See Chapter 8.3.4.2, "Restoring the Measurement Results - R&S VSE Player",

on page 131).

Remote command:
TRIG:SOUR TIME, See TRIGger [ : SEQuence] : SOURce on page 628

Magnitude (Offline) — Trigger Source
For (offline) input from a file, rather than an instrument. Triggers on a specified signal
level.

Remote command:
TRIG:SOUR MAGN, see TRIGger [ : SEQuence] : SOURce on page 628

Manual — Trigger Source
Only available for a connected R&S RTP:
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Any trigger settings in the R&S VSE software are ignored; only trigger settings defined
on the connected instrument are considered. Thus, you can make use of the more
complex trigger settings available on an R&S RTP.

Remote command:
TRIG:SOUR MAN, see TRIGger [ : SEQuence] : SOURce on page 628

Trigger Level
Defines the trigger level for the specified trigger source.

For details on supported trigger levels, see the data sheet.

Remote command:

TRIGger [:SEQuence] : LEVel: IFPower on page 625

]
TRIGger [:SEQuence] : LEVel: IQPower On page 625
TRIGger[:SEQuence] : LEVel [ :EXTernal<port>] on page 625
TRIGger [:SEQuence] : LEVel :RFPower on page 626
TRIGger[:SEQuence] : LEVel :MAPower On page 626

Repetition Interval
Defines the repetition interval for a time trigger. The shortest interval is 2 ns.

The repetition interval should be set to the exact pulse period, burst length, frame
length or other repetitive signal characteristic.

Remote command:
TRIGger[:SEQuence] : TIME:RINTerval on page 629

Drop-Out Time

Defines the time the input signal must stay below the trigger level before triggering
again.

Remote command:

TRIGger [ :SEQuence] : DTIMe on page 623

Trigger Offset
Defines the time offset between the trigger event and the start of the measurement.

Offset > 0: Start of the measurement is delayed

Offset < 0: Measurement starts earlier (pretrigger)
Only possible for zero span (e.g. I/Q Analyzer application) and gated trigger switched off
Maximum allowed range limited by the measurement time:

Pretriggerax = measurement time,, .4

Tip: To determine the trigger point in the sample (for "External” or "IF Power" trigger
source), use the TRACe: TQ: TPTISample? command.

(If supported by the connected instrument.)
For the "Time" trigger source, this function is not available.

Remote command:
TRIGger [:SEQuence] :HOLDoff [: TIME] on page 624
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Hysteresis

Defines the distance in dB to the trigger level that the trigger source must exceed
before a trigger event occurs. Setting a hysteresis avoids unwanted trigger events
caused by noise oscillation around the trigger level.

When using the optional 2 GHz bandwidth extension (R&S FSW-B2000) with an IF
power trigger, the hysteresis refers to the robust width trigger.

This setting is only available for "IF Power" or "Magnitude (Offline)" trigger sources.
The range of the value depends on the connected instrument.
Remote command:

TRIGger[:SEQuence] : IFPower:HYSTeresis on page 624
TRIGger [:SEQuence] :MAPower:HYSTeresis on page 627

Trigger Holdoff

Defines the minimum time (in seconds) that must pass between two trigger events.
Trigger events that occur during the holdoff time are ignored.

Remote command:

TRIGger [:SEQuence] : IFPower:HOLDof f on page 624

TRIGger [:SEQuence] :MAPower:HOLDoff on page 626

Slope
For all trigger sources except time, you can define whether triggering occurs when the
signal rises to the trigger level or falls down to it.

For gated measurements in "Edge" mode, the slope also defines whether the gate
starts on a falling or rising edge.

When using the optional 2 GHz bandwidth extension (R&S FSW-B2000) with an IF
power trigger, only rising slopes can be detected.

Remote command:
TRIGger [:SEQuence] : SLOPe on page 627

How to Determine the Required Trigger/Gate Parameters

1. In the "Trigger And Gate" dialog box, switch on "Show Preview" .

A zero span measurement for the currently defined center frequency is displayed.

2. Setthe "Frequency" , "RBW" and "Meas Time" such that the relevant part of the
signal is displayed, for example a complete burst.

3. Determine the parameters you want to use to define the trigger and gate conditions
from the preview diagram, for example:

the length of a burst or slot

the upper or lower power level of a pulse

the maximum noise level

the power level or time at which a certain incident occurs

4. Try out different trigger and gate settings as described in How to Configure a Trig-
gered Measurement and How to Configure a Gated Measurement, then select
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"Update Main Diagram" to see the effect of the current settings on the main mea-
surement in the background.

If the results are as expected, close the dialog box to keep the changes perma-
nently. Otherwise, correct the settings as necessary.

How to Configure a Triggered Measurement

To define an external trigger:

1.

Connect an external device that will provide the trigger signal to one of the TRIG-
GER INPUT / OUTPUT connectors on the R&S VSE (for details see the R&S VSE
"Getting Started" manual).

In the "Trigger And Gate" dialog box, define the "Trigger Source" = "External” .

Configure the external trigger as described for the other power triggers.

To define a power trigger:

1.
2.
3.

In the "Trigger And Gate" dialog box, define the "Trigger Source" = "IF Power" .
Define the "Trigger Level" : the power level at which the measurement will start.

Define whether the signal must cross the trigger level on a falling or on a rising
edge ( "Slope" ) to trigger the measurement.

To start the measurement with a time delay, define a "Trigger Offset” .

To reject triggers due to noise or jittering in the signal, define a "Hysteresis" that is
larger than the expected noise or jittering. After the previous trigger, the signal
must exceed this threshold before the next level crossing triggers a new measure-
ment.

To skip multiple triggers in a burst, define a "Holdoff" time that must pass between
two triggers. The holdoff time should be slightly larger than the burst.

10.3.5.2 Gating

Gated MeasUIrEMENTS.......coii et e e e e e e e e e e e e e e eennnee 229
Gate SEtliNGS. . eieeiii e a e 230
ContinUous Gate SetliNgS......ccoiiiiiiciiiiee e e e e 231
How to Configure a Gated Measurement............cccoeeeveeciiiiieeeeece e 232

Gated Measurements

Like a gate provides an opening in a fence, a gated measurement lets data from the
input signal pass in defined areas only. The gate controls exactly when data is included
in the measurement results and when not. The gate is opened by the trigger source,
which is also the gate source.
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Conditions

The R&S VSE 1/Q Analyzer supports gating under the following conditions:

® File input

® "Edge" mode

® Using a time or magnitude (offline) trigger

® For RF measurements such as SEM, OBW, ACLR

The gate opens and the measurement starts when a defined level in the gate source is

exceeded or the time is reached, and stops when the defined "Gate Length" is
reached.

Additionally, a delay time can be defined so that the first few measurement points after
the gate opening are ignored.

To indicate that a gate is used for the sweep, "GAT" and the gate source is displayed in
the channel bar.

Gate Settings

Access: "Overview" > "Trigger" > "Trigger / Gate Config." > "Gate Settings"

Gate settings define one or more extracts of the signal to be measured.

Gate Settings Caont. Gate
Gated Trigger “ Off
Gate Made Edge

Gate Delay 0.0s

Gate Length 400.0 ps

Skip Gates e.q.1,3.5-19

(€= (=T N I 4T [ 1Y SRR 230
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Gate LENGIN ..o ——————————————— 231
T o J = - 231

Gated Trigger
Switches gated triggering on or off.

If the gate is switched on, an (offline) magnitude or a time trigger controls the gates for
the measurement.

Remote command:
[SENSe: ] SWEep:EGATe on page 630
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Gate Mode
Sets the gate mode.

The R&S VSE 1/Q Analyzer supports gating in edge mode only. After the gate signal
has been detected, the gate remains open until the gate length is over.

Gate Delay
Defines the delay time between the gate signal and the continuation of the measure-
ment.

Remote command:
[SENSe: ] SWEep:EGATe: HOLDof f on page 631

Gate Length
Defines how long the gate is open when it is triggered.

The gate length in relation to the sweep is indicated by a line labeled "GL" .

Note: The gate length must be larger than or equal to the FFT Window Length to
determine the correct spectrum. If necessary, increase the RBW or decrease the Win-
dow Length in the 1/Q data acquisition settings to obtain the required relation to the
selected gate length.

Remote command:
[SENSe: ] SWEep:EGATe : LENGth on page 631

Skip Gates
Ignores the specified gates in a continuous gate measurement. This setting is only
available for magnitude (offline) triggered measurements.

Enter a comma separated list of gate numbers or gate ranges.

Example:
1,6-9 ignores gates 1,5,6,7,8,9

Remote command:

[SENSe: ] SWEep:EGATe: SKIP on page 632

Continuous Gate Settings

Access: "Overview" > "Trigger" > "Trigger / Gate Config." > "Cont. Gate" tab

Continuous gating allows you to perform a continuous gated sweep after a single mag-
nitude (offline) trigger is received.
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Gate Settings Eiﬂﬂ
Continuous Gate “ Off

Gate Period Length 5.0 m3

Gate Period Count 100

(070] 01 (110 To 10 E-J 1= (= 232
Gate Period LENGLN.......oeeiiecccrie e e e e e e e e e e e e e aeaae 232
(CF=) (S =T 070 [0 18] o | ST 232

Continuous Gate

Activates or deactivates continuous gating.

This setting is only available if Gated Trigger is "On".
It is only available for magnitude (offline) triggers.

Remote command:
[SENSe: ] SWEep:EGATe:CONTinuous [:STATe] on page 631

Gate Period Length

Defines the length in seconds of a single gate period in continuous gating. The length
is determined from the beginning of one gate measurement to the beginning of the
next one.

Remote command:
[SENSe: ] SWEep:EGATe: CONTinuous : PLENgth on page 631

Gate Period Count
Defines the number of gate periods to be measured after a single trigger event in con-
tinuous gating.

Remote command:
[SENSe: ] SWEep:EGATe: CONTinuous:PCOunt on page 630
How to Configure a Gated Measurement

A gated measurement records data only while the gate conditions are fulfilled. These
step-by-step instructions demonstrate how to configure a gated measurement man-
ually.

To configure a common gated measurement

1. Determine the required parameters as described in "How to Determine the
Required Trigger/Gate Parameters" on page 228.

2. The gate is opened by a trigger event. Define the trigger as described in "How to
Configure a Triggered Measurement” on page 229. As the "Trigger Source" , use
"Magnitude (offline)".
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3. Define how long the gate is to remain open:
Define the time to measure for each gate: "Gate Length" .

4. To open the gate with a time delay, for example to ignore an overshoot, define a
"Gate Delay" .

5. Select "Gated Trigger" ="On" .

To configure a continuous gated measurement

A continuous gated measurement is based on a common gated measurement. How-
ever, after a single magnitude (offline) trigger event, multiple further gate measure-
ments are performed.

1. The gate is opened by a trigger event. Define the trigger as described in "How to
Configure a Triggered Measurement" on page 229. As the "Trigger Source" , use
"Magnitude (offline)".

2. Inthe "Gate Settings" of the "Trigger and Gate" dialog box, select "Gated Trigger":
"On"_

3. Define the gate settings as described in "To configure a common gated measure-
ment" on page 232.

4. Select the "Cont. Gate" tab next to the "Gate Settings".
5. Set "Continuous Gate" to "On".

6. Define the length in seconds from the beginning of one gate measurement to the
beginning of the next one ("Gate Period Length").

7. Define how many gate measurements are to be performed after a single trigger
event ("Gate Period Count").

8. Run a measurement and wait for the magnitude (offline) trigger event to occur.

10.3.6 Data Acquisition and Bandwidth Settings

Access: "Overview" > "Bandwidth"
or: "Meas Setup" > "Data Acquisition"
The signal bandwidth to be captured and analyzed is configurable.

@  Data ACQUISITION.....coiiiiii it e e e e e e e e e e e e e e ——————— 233
L I 07 o) (0 SIS =1 11T 1 PRSP 238

10.3.6.1 Data Acquisition

Access: "Overview" > "Bandwidth" > "Data Acquisition"
or: "Meas Setup" > "Data Acquisition"

The data acquisition settings define which parts of the input signal are captured for fur-
ther evaluation in the applications.
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Freq 13.25 GHz Rec Length 1001 RBW 123 kHz

Data Acquisition Capture

Data Acquisition—— DAd\ran(ed Fourier Transformation Params
Sample Rate 32.0 MH ¢ i
P iz Tra_nsf_:urmatl:un [Single ]
T Algorithm
nalysis Bandwi
256 MH
[ABW] ‘ FFT Length 1024
Maximum Bandwidth 500 MHz. Window Function [Flatt-:up [amplitude acc) ]
MeasTime 31,281 s Window Overlap | 0.75
Record Length 1001 Window Length 1001
Swap I'Q On Off
, | — |
3 Y
| Window Length | 2 |
REW  122,5654345654346 kHz
| FFT Length |
<< Basic

Figure 10-16: Data acquisition settings with advanced FFT parameters

The remote commands required to perform these tasks are described in Chap-
ter 13.6.2.6, "Configuring Data Acquisition", on page 633.
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Sample Rate
Defines the 1/Q data sample rate of the R&S VSE. This value is dependent on the
Analysis Bandwidth and the signal source.

sample rate = analysis bandwidth / 0.8

For details on the dependencies see Chapter 10.2.1.1, "Sample Rate, Record Length
and Analysis Bandwidth", on page 169.

Remote command:
TRACe:IQ:SRATe on page 639
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Analysis Bandwidth
Defines the flat, usable bandwidth of the final I/Q data. This value is dependent on the
defined Sample Rate and the defined signal source.

analysis bandwidth = 0.8 * sample rate

However, the analysis bandwidth used by the R&S VSE software may be restricted by
the bandwidth provided by the connected instrument.

For a connected R&S FSW using an external mixer, the bandwidth is restricted to
512 MHz, regardless of any installed larger bandwidth extension options.

Remote command:
TRACe:IQ:BWIDth on page 637

Maximum Bandwidth

Depending on the connected instrument, the maximum bandwidth to be used by the
R&S VSE for I/Q data acquisition can be restricted. This setting is only available if a
bandwidth extension option is installed on the connected instrument. Otherwise the
maximum bandwidth is determined automatically.

The available values depend on the instrument and the installed bandwidth extension
options. For details see the instrument's documentation.

Remote command:
TRACe:TQ:WBANd[:STATe] on page 640
TRACe: TQ:WBANd:MBWidth on page 641

200 MHz Filter

Activates a 200 MHz filter before the A/D converter, thus restricting the processed
bandwidth to 200 MHz while using the wideband processing path in the connected
instrument.

This is useful for signals that have a bandwidth of approximately 200 MHz (for example
Docsis 3.1). In this case, the connected instrument can optimize signal processing for
the relevant signal and filter out unwanted signal parts from adjacent channels, while
taking advantage of a higher sample rate.

If you simply reduce the specified Analysis Bandwidth, the sample rate, which is cou-
pled, is also reduced.

If the filter is active, "200 MHZz" is indicated in the channel information bar.

Remote command:
TRACe:IQ:WFILter on page 641

Meas Time

Defines the 1/Q acquisition time. By default, the measurement time is calculated as the
number of I/Q samples ( "Record Length" ) divided by the sample rate. If you change
the measurement time, the Record Length is automatically changed, as well.

For details on the maximum number of samples see also Chapter 10.2.1.1, "Sample
Rate, Record Length and Analysis Bandwidth", on page 169. Note that the measure-
ment time used by the R&S VSE software may be restricted by the measurement time
available on the connected instrument.

Remote command:
[SENSe: ] SWEep:TIME on page 637
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Record Length

Defines the number of I/Q samples to record. By default, the number of measurement
points is used. The record length is calculated as the measurement time multiplied by
the sample rate. If you change the record length, the Meas Time is automatically
changed, as well.

Note: For the 1/Q vector result display, the number of I/Q samples to record ( "Record
Length" ) must be identical to the number of trace points to be displayed ("Capture
Points"). Thus, the measurement points are not editable for this result display. If the
"Record Length" is edited, the measurement points are adapted automatically.

For record lengths outside the valid range of measurement points (see "Points"

on page 239) the diagram does not show valid results.

Note: If the optional 2 GHz bandwidth extension (R&S FSW-B2000) or the optional

Oscilloscope Baseband Input is used, the record length may be restricted by the con-
nected oscilloscope (see its data sheet).

Remote command:
TRACe:IQ:RLENgth on page 638
TRACe:TQ:SET on page 638

Swap 1/Q
Activates or deactivates the inverted I/Q modulation. If the | and Q parts of the signal
from the DUT are interchanged, the R&S VSE can do the same to compensate for it.

On I and Q signals are interchanged
Inverted sideband, Q+j*|

Off | and Q signals are not interchanged

Normal sideband, 1+j*Q

Remote command:
[SENSe: ] SWAPiqg on page 636

RBW
Defines the resolution bandwidth for Spectrum results. The available RBW values
depend on the sample rate and record length.

Depending on the selected RBW mode, the value is either determined automatically or
can be defined manually. As soon as you enter a value in the input field, the RBW
mode is changed to "Manual" .

If the "Advanced Fourier Transformation Params" option is enabled, advanced FFT
mode is selected and the RBW cannot be defined directly.

Note that the RBW is correlated with the Sample Rate and Record Length (and possi-
bly the Window Function and Window Length ). Changing any one of these parameters
may cause a change to one or more of the other parameters. For more information see
Chapter 10.2.3.1, "Frequency Resolution of FFT Results - RBW", on page 171.

"Auto mode" (Default) The RBW is determined automatically depending on the
Sample Rate and Record Length . A single window function is used
(window length = record length). The number of measurement points
is automatically adapted to the FFT length.
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"Manual mode" The RBW can be defined by the user.
The user-defined RBW is used and the Window Length (and possibly
Sample Rate) are adapted accordingly. A single window function is
used (window length = record length)

"Advanced This mode is used if the "Advanced Fourier Transformation Params"
FFT mode" option is enabled.
The RBW is determined by the advanced FFT parameters.
An averaging window function can be used (window length < record
length).
Remote command:
[SENSe:]IQ:BWIDth:MODE on page 633
[SENSe:]IQ:BWIDth:RESolution on page 634

Advanced FFT mode / Basic Settings
Shows or hides the "Advanced Fourier Transformation" parameters in the "Data Acqui-
sition" dialog box.

These parameters are required for Spectrum results and are thus only available if a
Spectrum window is active.

Note that if the advanced FFT mode is used, the RBW settings are not available.
For more information see Chapter 10.2.3.2, "FFT Calculation Methods", on page 172.

Transformation Algorithm — Advanced FFT mode / Basic Settings
Defines the FFT calculation method.

"Single" One FFT is calculated for the entire record length; if the FFT Length
is larger than the record length, zeros are appended to the captured
data.

"Averaging" Several overlapping FFTs are calculated for each record; the results

are combined to determine the final FFT result for the record. The
number of FFTs to be averaged is determined by the Window Overlap
and the Window Length .

Remote command:
[SENSe:]IQ:FFT:ALGorithm on page 634

FFT Length — Advanced FFT mode / Basic Settings

Defines the number of frequency points determined by each FFT calculation. The more
points are used, the higher the resolution in the spectrum becomes, but the longer the
calculation takes.

For Spectrum displays, the number of measurement points is set to the FFT length
automatically.

Note: If you use the arrow keys or the mouse wheel to change the FFT length, the
value is incremented or decremented by powers of 2.
If you enter the value manually, any integer value from 3 to 524288 is available.

Remote command:
[SENSe:]IQ:FFT:LENGth on page 635
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Window Function «— Advanced FFT mode / Basic Settings
In the I/Q analyzer you can select one of several FFT window types.

The following window types are available:
® Blackman-Harris

Flattop

Gauss

Rectangular

5-Term

Remote command:
[SENSe:]IQ:FFT:WINDow: TYPE on page 636

Window Overlap — Advanced FFT mode / Basic Settings
Defines the part of a single FFT window that is re-calculated by the next FFT calcula-
tion when using multiple FFT windows.

Remote command:
[SENSe:]IQ:FFT:WINDow:OVER]lap on page 635

Window Length — Advanced FFT mode / Basic Settings

Defines the number of samples to be included in a single FFT window in averaging
mode. (In single mode, the window length corresponds to the " Record Length "
on page 236.)

In manual or advanced FFT mode, values from 3 to 524288 are available. (In Auto
mode, averaging is not used.)

However, the window length may not be longer than the FFT Length .

Remote command:
[SENSe:]IQ:FFT:WINDow: LENGth on page 635

10.3.6.2 Capture Settings

Access: "Overview" > "Bandwidth" > "Capture"
or: "Meas Setup" > "Capture"

Spectrogram settings are only available if a spectrogram is active for the selected win-
dow (see "State" on page 378).
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Data Acquisition Eﬁm-
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Capture Count 0
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Spectrogram Clear

Specifics for 1: Magnitude ~

Figure 10-17: Capture settings with active spectrogram
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Figure 10-18: Capture settings for statistical results
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Points

This value defines the number of measurement points that are evaluated and dis-
played in the result diagrams.

In "Auto" mode, the number of capture points is coupled with the FFT Length .
In "Manual" mode or Advanced FFT mode, the number is user-definable.

Note: The capture settings are window-specific. For some result displays, the points
may not be editable as they are determined automatically, or restrictions may apply.
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For the 1/Q vector result display, the number of I/Q samples to record ("Record
Length") must be identical to the number of trace points to be displayed ("Points").
Thus, the points are not editable for this result display. If the "Record Length" is edited,
the points are adapted automatically. For record lengths outside the valid range of
points, i.e. fewer than 51 points or more than 524288 points, the diagram does not
show valid results.

Using fewer points than the FFT Length with a detector other than Auto Peak may lead
to wrong level results. For details see "Combining Results - Trace Detector"
on page 175.

Remote command:
[SENSe: ] SWEep [ :WINDow<n>] : POINts on page 637

Quantize Bins

For Statistic APD displays, this value defines the number of quantize bins used to cre-
ate the histogram, that is, the number of different measurement values the statistical
occurrence is determined for.

For Statistic CCDF displays, the number of bins is fixed to 2048.

Remote command:
APD only:
CALCulate<n>:TQ:STATistics:SCALe:X:QUANtize on page 618

Capture Count

Defines the number of times data is captured in single measurement mode. Values
from 0 to 200000 are allowed. If the values 0 or 1 are set, one measurement is per-
formed.

The capture count is applied to all the traces in all diagrams.

If the trace modes "Average", "Max Hold" or "Min Hold" are set, this value also deter-
mines the number of averaging or maximum search procedures.

In continuous measurement mode, if capture count = 0 (default), averaging is per-
formed over 10 measurement. For capture count =1, no averaging, maxhold or minhold
operations are performed.

For more information see Chapter 10.2.2, "How Much Data is Measured: Capture
Count and Measurement Points", on page 170.

For spectrogram displays, the capture count determines how many captures are com-
bined in one frame in the spectrogram, i.e. how many captures the R&S VSE performs
to plot one trace in the spectrogram result display. For more details see "Time Frames"
on page 368.

Remote command:
[SENSe: ] AVERage<n>:COUNt on page 749

Select Frame
Selects a specific frame, loads the corresponding trace from the memory, and displays
it in the Spectrum window.

Note that activating a marker or changing the position of the active marker automati-
cally selects the frame that belongs to that marker.
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This function is only available in single sweep mode or if the sweep is stopped, and
only if a spectrogram is selected.

The most recent frame is number 0, all previous frames have a negative number.
For more details see "Time Frames" on page 368.

Remote command:
CALCulate<n>:SPECtrogram:FRAMe: SELect on page 756
CALCulate<n>:SPECtrogram:FRAMe: SELect on page 756

Continue Frame
Determines whether the results of the previous sweeps are included in the analysis of
the next sweeps for trace modes "Max Hold" , "Min Hold" , and "Average" .

This function is available in single sweep mode only.

® On
When the average or peak values are determined for the new sweep, the results of
the previous sweeps in the spectrogram are also taken into account.

o Off
The average or peak values are determined from the results of the newly swept
frames only.

Remote command:
CALCulate<n>:SPECtrogram:CONTinuous on page 755

Frame Count

Determines how many frames are plotted during a single capture (as opposed to a
continuous capture). The maximum number of possible frames depends on the history
depth (see " History Depth " on page 379).

For more details see "Time Frames" on page 368.

Remote command:
CALCulate<n>:SPECtrogram: FRAMe : COUNt on page 755

Clear Spectrogram
Resets the spectrogram result display and clears the history buffer.

This function is only available if a spectrogram is selected.

Remote command:
CALCulate<n>:SPECtrogram:CLEar[:IMMediate] on page 754

10.3.7 CCDF (Statistics) Settings

The following settings are only available for CCDF statistics results (see "Statistic
CCDF" on page 164).

Percent Marker (CCDF ONIY)..coii ittt a e e 241
Adjust Settings (CCDF ONIY).iiiiiiiii et e e e e e e e e e e 242

Percent Marker (CCDF only)
7.'\
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Defines a probability value. Thus, the power which is exceeded with a given probability
can be determined very easily. If marker 1 is deactivated, it is switched on automati-
cally.

Remote command:
CALCulate<n>:MARKer<m>:Y:PERCent on page 826

Adjust Settings (CCDF only)

Adjusts the level settings according to the measured difference between peak and
mean power for CCDF measurement in order to obtain maximum power resolution.
Adjusts the reference level to the current input signal.

Remote command:
CALCulate<n>:STATistics:SCALe:AUTO ONCE on page 620

Adjusting Settings Automatically

Access: "Auto Set" toolbar

Depending on the connected instrument, some settings can be adjusted by the instru-
ment automatically according to the current measurement settings. In order to do so, a
measurement is performed. The duration of this measurement can be defined automat-
ically or manually.

To activate the automatic adjustment of a setting from the R&S VSE, select the corre-
sponding function in the "Auto Set" toolbar or in the configuration dialog box for the set-
ting, where available.

Adjusting settings automatically during triggered measurements

When you select an auto adjust function a measurement is performed to determine the
optimal settings. If you select an auto adjust function for a triggered measurement, you
are asked how the connected instrument should behave:

® (default:) The measurement for adjustment waits for the next trigger

® The measurement for adjustment is performed without waiting for a trigger.
The trigger source is temporarily set to "Free Run". After the measurement is com-
pleted, the original trigger source is restored. The trigger level is adjusted as fol-
lows for IF Power and RF Power triggers:
Trigger Level = Reference Level - 15 dB

Remote command:
[SENSe: ]ADJust:CONFigure:TRIGger on page 643

Adjusting all Determinable Settings Automatically ( Auto All )....oeveeeeiiiiiiiiiiieeeeeeeee, 243
Adjusting the Center Frequency Automatically ( Auto Frequency )..........cccooevvveeeeees 243
Setting the Reference Level Automatically ( Auto Level )......cccoooviciiiiniiieninnien. 243
Auto Settings Configuration.........c.ooi i 243
L Automatic Measurement Time Mode and Value..............ccccoeeveveeeveeeuerererennnns 243
L UpPEr LEVEl HYSEIESIS ....o.eeeeeeeeeeeeeeeeeeeee e ee et ee s en s s 244
L LOWET LEVEl HYSEIESIS ...ttt st ee e en s s e 244
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Adjusting all Determinable Settings Automatically ( Auto All )
Activates all automatic adjustment functions for the current measurement settings.

This includes:

® Auto Frequency
® "B Setting the Reference Level Automatically ( Auto Level )" on page 208

Remote command:
[SENSe: ] ADJust:ALL on page 641

Adjusting the Center Frequency Automatically ( Auto Frequency )
The connected instrument adjusts the center frequency automatically.

The optimum center frequency is the frequency with the highest S/N ratio in the fre-
quency span. As this function uses the signal counter, it is intended for use with sinus-
oidal signals.

Remote command:
[SENSe: ]ADJust : FREQuency on page 643

Setting the Reference Level Automatically ( Auto Level )

The connected instrument automatically determines the optimal reference level for the
current input data. At the same time, the internal attenuators and the preamplifier are
adjusted so the signal-to-noise ratio is optimized, while signal compression, clipping
and overload conditions are minimized. This function is not available on all supported
instruments.

You can change the measurement time for the level measurement if necessary (see
"Automatic Measurement Time Mode and Value" on page 243).

Remote command:
[SENSe:]ADJust:LEVel on page 643

dcx Auto Settings Configuration
For some automatic settings, additional parameters can be configured. The "Auto Set
Config" dialog box is available when you select the icon from the "Auto Set" toolbar.

Meas Time

Mode Manual
Value 1.0 ms

Hysteresis

Upper Value 1.0 dBE

Lower Value 1.0 dB

Automatic Measurement Time Mode and Value — Auto Settings Configuration
To determine the optimal reference level automatically, a level measurement is per-
formed on the connected instrument. You can define whether the duration of this mea-
surement is determined automatically or manually.

To define the duration manually, enter a value in seconds.
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Remote command:
[SENSe:]ADJust:CONFigure:LEVel:DURation:MODE on page 642
[SENSe:]ADJust:CONFigure:LEVel:DURation on page 642

Upper Level Hysteresis < Auto Settings Configuration

When the reference level is adjusted automatically using the Auto Level function, the
internal attenuators and the preamplifier (if available) of the connected instrument are
also adjusted. To avoid frequent adaptation due to small changes in the input signal,
you can define a hysteresis. This setting defines an upper threshold the signal must
exceed (compared to the last measurement) before the reference level is adapted
automatically.

Remote command:
[SENSe:]ADJust:CONFigure:HYSTeresis:UPPer on page 643

Lower Level Hysteresis < Auto Settings Configuration

When the reference level is adjusted automatically using the Auto Level function, the
internal attenuators and the preampilifier (if available) of the connected instrument are
also adjusted. To avoid frequent adaptation due to small changes in the input signal,
you can define a hysteresis. This setting defines a lower threshold the signal must fall
below (compared to the last measurement) before the reference level is adapted auto-
matically.

Remote command:
[SENSe:]ADJust:CONFigure:HYSTeresis:LOWer on page 642

10.4 RF Measurement Configuration

: Access: "Meas Setup" > "Select Measurement"
"Meas Setup" > "Overview"

For RF measurements, the configuration steps described in the overview are slightly
different. The available settings are described here.

The remote commands required to perform these tasks are described in Chap-
ter 13.6.3, "Configuring RF Measurements", on page 644.

e Channel Power and Adjacent-Channel Power (ACLR) Measurement.................. 244
e Occupied Bandwidth Measurement (OBW).........oooiiiiiiiiiiiiiiieeee e 293
e Spectrum Emission Mask (SEM) Measurement..........cccccviviiieiii e enniiieee e 300
e Time Domain Power Measurement.......cccoooeeii i 341
e Frequency and Span SettiNgS......ccccuiiiiiiiieeii e 345
e Bandwidth, Filter and Capture Configuration..........c.ccccceiiiiiiiiiiereeeeee, 348

10.4.1 Channel Power and Adjacent-Channel Power (ACLR) Measurement
Measuring the power in channels adjacent to the carrier or transmission channel is

useful to detect interference. The results are displayed as a bar chart for the individual
channels.
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o About Channel Power MeasuremMents.........cooeevuueeeieeiieiieieeeeeeeee e 245
@  Channel POWEr RESUILS........couuuieieieeeeee et e e e e e e e e e 245
@  Channel POWEE BaSICS....uuiiiiiiiiiie ittt e e et e e e e eea s 248
o Channel Power Configuration...........cooiciiiiiiiiiiiee e 257
o MSR ACLR Configuration.........c.uuueeeeiieeeiiiieccciiiiiieeee e e e e scinree e e e e e e e e e e e e e senenes 266
e How to Perform Channel Power Measurements...........ccceeeieeeieiiiiieeeeeeviiceeeeeeeeeen, 280
o Measurement EXamPIES.......uuuuuuiiiiiiiie e 285
e Optimizing and Troubleshooting the Measurement..............ccccoiiiiiiiiinicee 290
e Reference: Predefined CP/ACLR Standards..........ccoooveiieeieeieiiiieieee e 290
e Reference: Predefined ACLR User Standard XML Files........cccoceeeeeiiiiiieniinnnnnn... 292

About Channel Power Measurements

Measuring channel power and adjacent channel power is one of the most important
tasks during signal analysis with the necessary test routines in the field of digital trans-
mission. Theoretically, a power meter could be used to measure channel power at
highest accuracy. However, its low selectivity means that it is not suitable for measur-
ing adjacent channel power as an absolute value or relative to the transmit channel
power. Only a selective power meter can measure the power in the adjacent channels.

A signal analyzer cannot be classified as a true power meter, because it displays the IF
envelope voltage. However, it is calibrated such as to display the power of a pure sine
wave signal correctly, irrespective of the selected detector. This calibration cannot be
applied for non-sinusoidal signals. Assuming that the digitally modulated signal has a
Gaussian amplitude distribution, the signal power within the selected resolution band-
width can be obtained using correction factors. The internal power measurement rou-
tines in a signal analyzer normally use these correction factors to determine the signal
power from IF envelope measurements. These factors apply if and only if the assump-
tion of a Gaussian amplitude distribution is correct.

Apart from this common method, the connected instrument also has a true power
detector, i.e. an RMS detector. It displays the power of the test signal within the
selected resolution bandwidth correctly, irrespective of the amplitude distribution, with-
out additional correction factors being required.

The R&S VSE software allows you to perform ACLR measurements on input contain-
ing multiple signals for different communication standards. A measurement standard is
provided that allows you to define multiple discontiguous transmit channels at specified
frequencies, independent from the selected center frequency. The ACLR measurement
determines the power levels of the individual transmit, adjacent, and gap channels, as
well as the total power for each sub block of transmit channels.

A detailed measurement example is provided in Chapter 10.4.1.7, "Measurement
Examples", on page 285.

Channel Power Results

For channel or adjacent-channel power measurements, the individual channels are
indicated by different colored bars in the diagram. The height of each bar corresponds
to the measured power of that channel. In addition, the name of the channel ( "Adj"
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"Alt %1" , "Tx %1" , etc., or a user-defined name) is indicated above the bar (separated
by a line which has no further meaning).

@ Multi-standard radio (MSR) channel power results

The channel power results for MSR signals are described in "Measurement on Multi-
Standard Radio (MSR) Signals" on page 252.

All Spectrum

Ref Level

Att 3

1 ACLR ® 1Rm Clrw

nh "o 1| h

"' Wl '|'| WAl
1001 pts 419.0 kHz/
COMA2000
Offset Power
-0.86 dBm

-80.34 dB
-83.85 dB

Results are provided for the TX channel and the number of defined adjacent channels
above and below the TX channel. If more than one TX channel is defined, you must
specify the channel to which the relative adjacent-channel power values refer. By
default, it is the TX channel with the maximum power.

Table 10-2: Measurements performed depending on the number of adjacent channels

Number | Measurement results
of adj.
chan.
0 Channel powers
1 ®  Channel powers
®  Power of the upper and lower adjacent channel
2 ®  Channel powers
®  Power of the upper and lower adjacent channel
®  Power of the next higher and lower channel (alternate channel 1)
3 ®  Channel powers
®  Power of the upper and lower adjacent channel
®  Power of the next higher and lower channel (alternate channel 1)
®  Power of the second next higher and lower adjacent channel (alternate channel 2)
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Number | Measurement results
of adj.
chan.

12 ®  Channel powers
®  Power of the upper and lower adjacent channel
®  Power of all the higher and lower channels (alternate channels 1 to 11)

In the R&S VSE display, only the first neighboring channel of the carrier (TX) channel
is labeled "Adj" (adjacent) channel; all others are labeled "Alt" (alternate) channels. In
this manual, "Adjacent" refers to both adjacent and alternate channels.

The measured power values for the TX and adjacent channels are also output as a
table in the Result Summary window. Which powers are measured depends on the
number of configured channels.

For each channel, the following values are displayed:

Label Description

Channel Channel name as specified in the "Channel Settings" (see " Channel Names "
on page 265).

Bandwidth Configured channel bandwidth (see " Channel Bandwidth " on page 263)

Offset Offset of the channel to the TX channel (configured channel spacing, see " Channel
Bandwidth " on page 263)

Power The measured power values for the TX and lower and upper adjacent channels. The
powers of the transmission channels are output in dBm or dBm/Hz, or in dBc, relative

Lower/Upper
( pper) to the specified reference TX channel.

Retrieving Results via Remote Control

All or specific channel power measurement results can be retrieved using the
CALC:MARK:FUNC: POW:RES? command from a remote computer (see
CALCulate<n>:MARKer<m>:FUNCtion:POWer<sb>:RESult? on page 676).
Alternatively, the results can be output as channel power density, i.e. in reference to
the measurement bandwidth.

Furthermore, the measured power values of the displayed trace can be retrieved as
usual using the TRAC: DATA? commands (see TRACe<n> [ :DATA] ? on page 823). In
this case, the measured power value for each sweep point (by default 1001) is
returned.

For a full list of remote commands for ACLR measurements, see "Retrieving and Ana-
lyzing Measurement Results" on page 679.
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Channel Power Basics

Some background knowledge on basic terms and principles used in channel power
measurements is provided here for a better understanding of the required configuration
settings.

o  Measurement MEthOG.........oooueiiii e e e e e 248
e Recommended Common Measurement Parameters.........cccoovvvveiiiiieeieiiiieeinneee, 248
e Measurement on Multi-Standard Radio (MSR) Signals........cccccooieiiiiiiiiiiiiis 252

Measurement Method

The channel power is defined as the integration of the power across the channel band-
width.

The Adjacent Channel Leakage Power Ratio (ACLR) is also known as the Adjacent
Channel Power Ratio (ACPR). It is defined as the ratio between the total power of the
adjacent channel to the power of the carrier channel. An ACLR measurement with sev-
eral carrier channels (also known as transmission or TX channels) is also possible and
is referred to as a multicarrier ACLR measurement.

The R&S VSE software captures data once for the span defined by the I/Q bandwidth
of the connected instrument. Then it calculates multiple FFTs based on the selected
RBW.

Recommended Common Measurement Parameters

The following sections provide recommendations on the most important measurement
parameters for channel power measurements.

All instrument settings for the selected channel setup (channel bandwidth, channel
spacing) can be optimized automatically using the "Adjust Settings" function (see "Opti-
mized Settings ( Adjust Settings )" on page 262).

L |V == T I o =P 248
L I o = To [ =T o T3 VAT o Y- o 249
e Resolution Bandwidth (RBW)......ccoooiiiiieeeecicree e 250
o  Video Bandwidth (VBW)......cui it ste et e et e e nnsnaee s 250
@ DBLECION . e e e e e e e ————— 251
I | = (T3 V=T =T | o T PP PO PPPPPPPPPP 251
@  REFEIENCE LEBVEL...ceveieeiiteeee ettt e e e e e e e e e e e e e e e e eeeeeaaaas 252
Meas Time

The "Meas Time" is selected depending on the desired reproducibility of results.
Reproducibility increases with "Meas Time" since power measurement is then per-
formed over a longer time period. As a general approach, approximately 500 non-cor-
related measured values are required for a reproducibility of 0.5 dB. (That means:

95 % of the measurements are within 0.5 dB of the true measured value). Approxi-
mately 5000 measured values are required for a reproducibility of 0.1 dB (99 %).
These values are valid for white noise. The measured values are considered as non-
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correlated if their time interval corresponds to the reciprocal of the measured band-
width.

The number of A/D converter values, N, used to calculate the power, is defined by the
"Meas Time" . The time per trace pixel for power measurements is directly proportional
to the selected "Meas Time" .

If the sample detector is used, it is best to select the smallest "Meas Time" possible for
a given span and resolution bandwidth. The minimum time is obtained if the setting is
coupled, that is: the time per measurement is minimal. Extending the measurement
time does not have any advantages. The number of samples for calculating the power
is defined by the number of trace points in the channel.

If the RMS detector is used, the selection of "Meas Time" s can affect the repeatability
of the measurement results. Repeatability is increased at longer "Meas Time" s.

If the RMS detector is used, the number of samples can be estimated as follows:

Since only uncorrelated samples contribute to the RMS value, the number of samples
can be calculated from the "Meas Time" and the resolution bandwidth.

Samples can be assumed to be uncorrelated if sampling is performed at intervals of 1/
RBW. The number of uncorrelated samples is calculated as follows:

Ngecorr = SWT * RBW
(Ngecorr means uncorrelated samples)

The number of uncorrelated samples per trace pixel is obtained by dividing Ngecorr BY
1001 (= pixels per trace).

Frequency Span

The frequency span must cover at least the channels to be measured plus a measure-
ment margin of approximately 10 %.

If the frequency span is large in comparison to the channel bandwidth (or the adjacent-
channel bandwidths) being analyzed, only a few points on the trace are available per
channel. The calculated waveform for the used channel filter is less accurate, which
has a negative effect on the measurement accuracy. It is therefore strongly recommen-
ded that you consider the described formulas when you select the frequency span.

The frequency span for the defined channel settings can be optimized. Use the "Adjust
Settings" function in the "Ch Power" menu or the "General Settings" tab of the "ACLR
Setup" dialog box (see "Optimized Settings ( Adjust Settings )" on page 262). You can
set the frequency span manually in the "Frequency" configuration dialog box.

For channel power measurements the "Adjust Settings" function sets the frequency
span as follows:

"(No. of transmission channels — 1) x transmission channel spacing + 2 x transmission
channel bandwidth + measurement margin"

For adjacent-channel power measurements, the "Adjust Settings" function sets the fre-
quency span as a function of the following parameters:

® Number of transmission channels
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® Transmission channel spacing
® Adjacent-channel spacing

® Bandwidth of one of adjacent-channels ADJ, ALT1 or ALT2, whichever is furthest
away from the transmission channels

"(No. of transmission channels — 1) * (transmission channel spacing + 2) * (adjacent-
channel spacing + adjacent-channel bandwidth) + measurement margin"

The measurement margin is approximately 10 % of the value obtained by adding the
channel spacing and the channel bandwidth.

Resolution Bandwidth (RBW)

It is important to suppress spectral components outside the channel to be measured,
especially of the adjacent channels. At the same time, you expect an acceptable mea-
surement speed. To fulfill both these requirements, the appropriate resolution band-
width is essential. As a general approach, set the resolution bandwidth to values
between 1 % and 4 % of the channel bandwidth.

If the spectrum within the channel to be measured and the spectrum around the chan-
nel has a flat characteristic, you can select a larger resolution bandwidth. In the stan-
dard setting, e.g. for standard IS95A REV at an adjacent channel bandwidth of 30 kHz,
a resolution bandwidth of 30 kHz is used. This yields correct results since the spectrum
near the adjacent channels normally has a constant level.

You can optimize the resolution bandwidth for the defined channel settings. Use the
"Adjust Settings" function in the "Ch Power" menu or the "General Settings" tab of the
"ACLR Setup" dialog box (see "Optimized Settings ( Adjust Settings )" on page 262).
You can set the RBW manually in the "Bandwidth" configuration dialog box, see " RBW
"on page 354.

Except for the IS95 CDMA standards, the "Adjust Settings" function sets the resolution
bandwidth (RBW) as a function of the channel bandwidth:

"RBW" = 1/40 of "Channel Bandwidth"

The maximum resolution bandwidth (concerning the requirement RBW < 1/40) result-
ing from the available RBW steps (1, 3) is selected.

Video Bandwidth (VBW)

For a correct power measurement, the video signal must not be limited in bandwidth. A
restricted bandwidth of the logarithmic video signal causes signal averaging and thus
results in a too low indication of the power (-2.51 dB at very low video bandwidths).
Thus, select the video bandwidth at least three times the resolution bandwidth:

VBW 23 * RBW

For FFT sweeps, instead of increasing the VBW, you can also select the trace average
mode "Power" to ensure correct power measurements (see " Average Mode "

on page 374). Note that in power measurements this setting affects the VBW regard-
less of whether or not a trace is actually averaged.

The video bandwidth for the defined channel settings can be optimized. Use the
"Adjust Settings" function in the "Ch Power" menu or the "General Settings" tab of the
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"ACLR Setup" dialog box (see "Optimized Settings ( Adjust Settings )" on page 262).
You can set the VBW manually in the "Bandwidth" configuration dialog box, see " VBW
"on page 355.

The video bandwidth (VBW) is set as a function of the channel bandwidth (see formula
above) and the smallest possible VBW with regard to the available step size is
selected.

Detector

The RMS detector correctly indicates the power irrespective of the characteristics of
the signal to be measured. The whole IF envelope is used to calculate the power for
each measurement point. The IF envelope is digitized using a sampling frequency
which is at least five times the resolution bandwidth which has been selected. Based
on the sample values, the power is calculated for each measurement point using the
following formula:

P,.= ! isz
RMS N P i

Where:
s; = linear digitized video voltage at the output of the A/D converter

N = number of A/D converter values per measurement point

Prus = power represented by a measurement point

When the power has been calculated, the power units are converted into decibels and
the value is displayed as a measurement point.

In principle, the sample detector would be possible as well. Due to the limited number
of measurement points used to calculate the power in the channel, the sample detector
would yield less stable results.

The RMS detector can be set for the defined channel settings automatically. Use the
"Adjust Settings" function in the "Ch Power" menu or the "General Settings" tab of the
"ACLR Setup" dialog box (see "Optimized Settings ( Adjust Settings )" on page 262).
You can set the detector manually in the "Traces" configuration dialog box, see "
Detector " on page 373.

Trace Averaging

Avoid averaging, which is often performed to stabilize the measurement results but
leads to a level indication that is too low. The reduction in the displayed power depends
on the number of averages and the signal characteristics in the channel to be mea-
sured.

The "Adjust Settings" function switches off trace averaging. You can deactivate the
trace averaging manually in the "Traces" configuration dialog box, see " Average Mode
"on page 374.
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Reference Level

To achieve an optimum dynamic range, set the reference level so that the signal is as
close to the reference level as possible without forcing an overload message. However,
if the signal-to-noise ratio becomes too small, the dynamic range is also limited. The
measurement bandwidth for channel power measurements is significantly smaller than
the signal bandwidth. Thus, the signal path can be overloaded although the trace is still
significantly below the reference level.

reference level. The reference level can be set automatically using the "Auto Level"
function in the [Auto Set] menu, or manually in the "Amplitude" menu.

@ Selecting a predefined standard or automatically adjusting settings does not affect the

Measurement on Multi-Standard Radio (MSR) Signals

Modern base stations can contain multiple signals for different communication stand-
ards. A new measurement standard is provided for the R&S VSE ACLR measurement
that allows you to measure such MSR signals, including non-contiguous setups. Multi-
ple (also non-) contiguous transmit channels can be specified at absolute frequencies,
independent from the common center frequency selected for display.

Signal structure

Up to 18 transmit channels can be grouped in a maximum of 5sub blocks. Between
two sub blocks, two gaps are defined: a lower gap and an upper gap. Each gap in turn
contains two channels (gap channels). The channels in the upper gap are identical to
those in the lower gap, but inverted. To either side of the outermost transmit channels,
lower and upper adjacent channels can be defined as in common ACLR measurement
setups.

i

T o s, TS b e b Sy AR

CF 1,015 GHz 1001 pts 12.9 MHz/ ] Span 129.0

[CowerAWT) [CowerAg)) [ SubblockA |[ ABav | [ ABw ]| ENE [ UpperAd ) [ UpperAT |

: A Adj : Lo : : s : AhAdj
: Lower : A Gapl H : AGap1 : Upper
A AN Lower A Gap2 4 Gap2 AAILT Upper

Figure 10-19: MSR signal structure
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Asymmetrical gap channels

Gap channels between sub blocks can now also be asymmetrical, that is: channels in
the lower and upper gaps are not identical. For example, in Figure 10-20, the gap
between sub blocks A and B contains one lower channel (AB:Gap1L), but two upper
channels (AB:Gap1U, AB:Gap2U). Furthermore, the gaps between different sub blocks
need not be identical. For example, the gap between sub blocks A and B contains 3
gap channels, while the gap between sub blocks B and C contains only two gap chan-
nels (BC:Gap1L, BC:Gap2L, which are not identical to the lower gap channels in gap
AB.

1 ACLR

CF 1.047 GHz 1001 pts ) Span 135.0 MH2z

: : : : o I :
. L e e .
P o AdiLower s &apiL © o agGapiU &GaptL | & AdjUpper
& Alt Lower & Gapzl & Gap2 L & Al Uppe

Figure 10-20: Asymmetrical MSR signal structure

Sub block and channel definition

The sub blocks are defined by a specified center frequency, RF bandwidth, and num-
ber of transmit channels.

Figure 10-21: Sub block definition

User Manual 1176.8839.02 — 14 253



R&S®VSE I/Q Analyzer Measurements

RF Measurement Configuration

As opposed to common ACLR channel definitions, the Tx channels are defined at
absolute frequencies, rather than by a spacing relative to the (common) center fre-
quency. Each transmit channel can be assigned a different technology, used to prede-
fine the required bandwidth.

Gap channels and CACLR

If two or more sub blocks are defined, the power in the gaps between the sub blocks
must also be measured. Gap channels are defined using bandwidths and spacings,
relative to the outer edges of the surrounding sub blocks.

If the upper and lower gap channels are symmetrical, only two gap channels must be
configured. The required spacing can be determined according to the following formula
(indicated for lower channels):

Spacing = [CF of gap channel] - [left sub block CF] + ([RF bandwidth of left sub
block] /2)

ALTE_10mM1
ALTE_10M2

Lediarl bl oo L ik

II'|.__| r '.--._I_I‘ltI | Uj.*hfl'l' |".l-

CF
Sub block CF
Gap1

Figure 10-22: Gap channel definition for lower gap

If the gap channels are not symmetrical, you must configure up to four channels indi-
vidually. The formula indicated above applies for the lower channels. For the upper
channels, the spacing is defined as:

Spacing = [right sub block CFJ- [CF of gap channel] - ([RF bandwidth of right sub
block] /2)

According to the MSR standard, the Cumulative Adjacent Channel Leakage Ratio
(CACLR) power must be determined for the gap channels. The CACLR power is mea-
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sured in the two gap channels for the upper and lower gap. The power in the gap chan-
nels is then set in relation to the power of the two closest transmission channels to
either side of the gap. The CACLR power for the gap channels is indicated in the
Result Summary.

In addition, the ACLR power for the individual gap channels is indicated in the Result

Summary. The ACLR power of the lower gap channels refers to the TX channel to the
left of the gap. The ACLR power of the upper gap channels refers to the TX channel to
the right of the gap. A separate relative limit value can be defined for the ACLR power.

Adjacent channels

Adjacent channels are defined as in common ACLR measurements using bandwidths
and spacings, relative to the uppermost or lowermost transmit channels in the sub
blocks (see also Figure 10-19):

® The spacing of the lower adjacent channels refers to the CF of the first Tx channel
in the first sub block.

® The spacing of the upper adjacent channels refers to the CF of the last Tx channel
in the last sub block.

The upper and lower adjacent channels can also be defined asymmetrically (see "

@ Symmetrical Adjacent Setup " on page 270). This is particularly useful if the lowest Tx
channel and highest Tx channel use different standards and thus require different
bandwidths for adjacent channel power measurement.

Channel display for MSR signals

As in common ACLR measurements, the individual channels are indicated by different
colored bars in the diagram. The height of each bar corresponds to the measured
power of that channel. In addition, the name of the channel is indicated above the bar.
Sub blocks are named A,B,C,D,E and are also indicated by a slim blue bar along the
frequency axis.

Tx channel names correspond to the specified technology (for LTE including the band-
width), followed by a consecutive number. (If the channel is too narrow to display the
channel name, "..." is displayed instead.) The assigned sub block is indicated with the
channel name, e.g. "B: LTE_5M1" for the first Tx channel in sub block B that uses the
LTE 5 MHz bandwidth technology.

Adjacent and alternate channels are displayed as in common ACLR measurements.

Gap channels are indicated using the following syntax:

® The names of the surrounding sub blocks (e.g. "AB" for the gap between sub
blocks A and B),

® The channel name ( "Gap1" or "Gap2")
e "L" (for lower) or "U" (for upper)

For example: "ABGap1L" indicates the first lower gap channel between sub blocks A
and B.

Both the lower and upper gap channels are displayed.
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O For symmetrical configuration, gap channels can be hidden if they do not reach a mini-
= mum size.

For asymmetrical configuration, you can define the number of upper or lower gap
channels to be displayed.

In both cases, you can deactivate all gap channels. This enhances the result display,
as fewer lines and bars are displayed. If gap channels are deactivated, the power
results are not calculated and thus are not shown in the Result Summary table.

Furthermore, channel names for all TX, adjacent, and alternate channels are user-
definable (not gap channels).

Channel power results

The Result Summary for MSR signal measurements is similar to the table for common
signals (see Chapter 10.4.1.2, "Channel Power Results", on page 245). However, the
Tx channel results are grouped by sub blocks, and sub block totals are provided
instead of a total Tx channel power. Instead of the individual channel frequency offsets,
the absolute center frequencies are indicated for the transmit channels.

The CACLR and ACLR power results for each gap channel are appended at the end of
the table. The CACLR results are calculated as the power in the gap channel divided
by the power sum of the two closest transmission channels to either side of it.

2 Result Summary USER{MSR_ACLR_Example)
i Bandwidth Power
iz MHz -92.97 dBm
-80.45 dBm
=79.65 dBm
=-93.46 dBm
-76.82 dBm
Bandwidth Power
10 Mz 1 ( -81.98 dBm
-81.98 dBm
Power
=-82.10 dBm
-82.10 dBm
ACLR Lower ACLR Upper
-0.73 dBc -2.33 dBc
-0.83 dBc -2.44 dBc
ACLR Lower ACLR Upper
13.19 dBc 0.04 dBc
0.05 dBc

-2.99 dBc

ACLR_Example)
Bandwi Power
- ] -92.92 dBm
-80.41 dBm
=79.61 dBm
-93.37 dBm
-76.78 dBm
Bandwidth Frequency Power
; iz 1.050 GHz -82.01 dBm
-82.01 dBm
Frequency Power
1.1 =82.10 dBm
-82.10 dBm
Offset ACLR Lower ACLR Upper
L r =0.77 dBc -2.35 dBc
-0.89 dBc -2.42 dBc
ACLRE Power CACLR Power
13.08 dBc
0.09 dBc
0.09 dBc
0.01 dBc
-0.03 dBc

Figure 10-24: Result summary for asymmetrical channel definition
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Remote command:

CALCulate:MARKer:FUNCtion:POWer<sb>:RESult? GACLr or
CALCulate:MARKer:FUNCtion:POWer<sb>:RESult? MACM , see
CALCulate<n>:MARKer<m>:FUNCtion:POWer<sb>:RESult? on page 676

Restrictions and dependencies

As the signal structure in multi-standard radio signals can vary considerably, you can
define the channels very flexibly for the ACLR measurement with the R&S VSE. No
checks or limitations are implemented concerning the channel definitions, apart from
the maximum number of channels to be defined. Thus, you are not notified if transmit
channels for a specific sub block lie outside the defined frequency range for the sub
block, or if transmit and gap channels overlap.

10.4.1.4 Channel Power Configuration

Access: "Overview" > "Select Measurement" > "Channel Power ACLR" > "CP / ACLR
Config"

Both Channel Power (CP) and Adjacent-Channel Power (ACLR) measurements are
available.

If the "Multi-Standard Radio" standard is selected (see " Standard " on page 259), the
"ACLR Setup" dialog box is replaced by the "MSR ACLR Setup" dialog box. See Chap-
ter 10.4.1.5, "MSR ACLR Configuration", on page 266 for a description of these set-
tings.
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General Settings Channel Settings

Standard

Channel Coun
EUTRA/LTE Square | Tx
Manage User Standards

PSR R oG EN N MAX POWER TX CHANNEL ACLR Mode

Fast ACLR Or Power Mode |

Set CP Reference Adjust Settings

The remote commands required to perform these tasks are described in Chap-
ter 13.6.3.1, "Measuring the Channel Power and ACLR", on page 644.

e General CP/ACLR Measurement Settings..........coveiiiiiiiiiiiiine e 258
L J O = o 1= 7= (1] o PSRRI 262

General CP/ACLR Measurement Settings

General measurement settings are defined in the "ACLR Setup" dialog, in the "General

Settings" tab.
8 =1 Lo =1 o [P UUUPPUP RN 259
L Predefined Standards ............ccceeeeeeieeeeeeeeeeeeeeeese s ee e 259
L USEr StANAAIAS ...t 259
Number of channels: TX , Adj coooiieiciiiier e r e e e e e e enees 260
Reference Channel .........coiiiiiiiii e 260
FAST ACLR ..ttt ettt s e e e s s et e e e s sb e e e e st e e e e e s abtreeeeeareeeeeeaas 261
S T=1[=Ter (Yo I I = o7 SO PPRTPPRR 261
Absolute and Relative Values (ACLR MOAE) .....ccovvriiiiiiiiiiiiiiiieiee e, 261
Channel power level and density ( Power Unit )........cooooiiiiiiiiie e 261
01T g 1Y/ [ o [ 261
Setting a fixed reference for Channel Power measurements ( Set CP Reference )... 262
Optimized Settings ( Adjust SEttNGS )eeeveeeeiiieiicee e 262
MEAS TIME .ttt e e e e e e e e e et e e e e e e e e e e e e nenreeeees 262
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Standard

The main measurement settings can be stored as a standard file. When such a stan-
dard is loaded, the required channel and general measurement settings are automati-
cally set on the R&S VSE. However, the settings can be changed. Predefined stand-
ards are available for standard measurements, but standard files with user-defined
configurations can also be created.

Predefined Standards — Standard

Predefined standards contain the main measurement settings for standard measure-
ments. When such a standard is loaded, the required channel settings are automati-
cally set on the R&S VSE. However, you can change the settings.

The predefined standards contain the following settings:

Channel bandwidths

Channel spacings

Detector

Trace Average setting

Resolution Bandwidth (RBW)

Weighting Filter

For details on the available standards, see Chapter 10.4.1.9, "Reference: Predefined
CP/ACLR Standards", on page 290.

Remote command:
CALCulate<n>:MARKer<m>:FUNCtion:POWer<sb>:PRESet on page 644

User Standards — Standard
Access: "CP / ACLR Config" > "General Settings" tab > "Manage User Standards"

In addition to the predefined standards, you can save your own standards with your
specific measurement settings in an XML file so you can use them again later. User-
defined standards are stored on the instrument in the
C:\ProgramData\Rohde-Schwarz\VSE\<version>\acp_ std directory.

Note: User standards created on an analyzer of the R&S FSP family are compatible to
the R&S VSE. User standards created on an R&S VSE, however, are not necessarily
compatible to the analyzers of the R&S FSP family and may not work there.

The following parameter definitions are saved in a user-defined standard:
® Number of adjacent channels

® (Channel bandwidth of transmission (Tx), adjacent (Adj) and alternate (Alt) chan-
nels

Channel spacings

Weighting filters

Resolution bandwidth

Video bandwidth

Detector

ACLR limits and their state

"Meas Time" and "Meas Time" coupling

Trace and power mode

(MSR only: sub block and gap channel definition)

Save the current measurement settings as a user-defined standard, load a stored mea-
surement configuration, or delete an existing configuration file.
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For details see "How to Manage User-Defined Configurations" on page 284.

Remote command:

To query all available standards:
CALCulate<n>:MARKer<m>:FUNCtion:POWer<sb>:STANdard:CATalog?
on page 645

To load a standard:
CALCulate<n>:MARKer<m>:FUNCtion:POWer<sb>:PRESet on page 644
To save a standard:
CALCulate<n>:MARKer<m>:FUNCtion:POWer<sb>:STANdard:SAVE

on page 646

To delete a standard:
CALCulate<n>:MARKer<m>:FUNCtion:POWer<sb>:STANdard:DELete
on page 645

Number of channels: Tx , Adj
Up to 18 carrier channels and up to 12 adjacent channels can be defined.

Results are provided for the Tx channel and the number of defined adjacent channels
above and below the Tx channel. If more than one Tx channel is defined, the carrier
channel to which the relative adjacent-channel power values should be referenced
must be defined (see " Reference Channel " on page 260).

Note: If several carriers (Tx channels) are activated for the measurement, the number
of sweep points is increased to ensure that adjacent-channel powers are measured
with adequate accuracy.

For more information on how the number of channels affects the measured powers,
see Chapter 10.4.1.2, "Channel Power Results", on page 245.

Remote command:

Number of Tx channels:

[SENSe: ] POWer:ACHannel : TXCHannel : COUNt on page 650
Number of Adjacent channels:

[SENSe: ] POWer:ACHannel :ACPairs on page 646

Reference Channel

The measured power values in the adjacent channels can be displayed relative to the
transmission channel. If more than one Tx channel is defined, define which one is used
as a reference channel.

Tx Channel 1 Transmission channel 1 is used.
(Not available for MSR ACLR)

Min Power Tx Channel | The transmission channel with the lowest power is used as a reference channel.

Max Power Tx Chan- | The transmission channel with the highest power is used as a reference channel

nel (Default).
Lowest & Highest The outer left-hand transmission channel is the reference channel for the lower
Channel adjacent channels, the outer right-hand transmission channel that for the upper

adjacent channels.
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Remote command:
[SENSe: ] POWer:ACHannel :REFerence: TXCHannel :MANual on page 653
[SENSe: ] POWer:ACHannel :REFerence: TXCHannel : AUTO on page 653

Fast ACLR
Not available for the R&S VSE software.

Selected Trace
The CP/ACLR measurement can be performed on any active trace.

Remote command:
[SENSe: ] POWer: TRACe on page 660

Absolute and Relative Values (ACLR Mode)
The powers of the adjacent channels are output in dBm or dBm/Hz (absolute values),
or in dBc, relative to the specified reference Tx channel.

"Abs" The absolute power in the adjacent channels is displayed in the unit
of the y-axis, e.g. in dBm, dBuV.

"Rel" The level of the adjacent channels is displayed relative to the level of
the transmission channel in dBc.

Remote command:
[SENSe: ] POWer:ACHannel :MODE on page 681

Channel power level and density ( Power Unit )

By default, the channel power is displayed in absolute values. If "/Hz" is activated, the
channel power density is displayed instead. Thus, the absolute unit of the channel
power is switched from dBm to dBm/Hz.

Note: The channel power density in dBm/Hz corresponds to the power inside a band-
width of 1 Hz and is calculated as follows:
"channel power density = channel power — logo(channel bandwidth)"

Thus you can measure the signal/noise power density, for example, or use the addi-
tional functions Absolute and Relative Values (ACLR Mode) and Reference Channel to
obtain the signal to noise ratio.

Remote command:
CALCulate<n>:MARKer<m>:FUNCtion:POWer<sb>:RESult:PHZ on page 681

Power Mode

The measured power values can be displayed directly for each trace ( "Clear/ Write" ),
or only the maximum values over a series of measurements can be displayed ( "Max
Hold" ). In the latter case, the power values are calculated from the current trace and
compared with the previous power value using a maximum algorithm. The higher value
is retained. If "Max Hold" mode is activated, "Pwr Max" is indicated in the table header.
Note that the trace mode remains unaffected by this setting.

Remote command:
CALCulate<n>:MARKer<m>:FUNCtion:POWer<sb>:MODE on page 661
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Setting a fixed reference for Channel Power measurements ( Set CP Reference )
If only one Tx channel and no adjacent channels are defined, the currently measured

channel power can be used as a fixed reference value for subsequent channel power
measurements.

When you select this button, the channel power currently measured on the Tx channel
is stored as a fixed reference power. In the following channel power measurements,
the power is indicated relative to the fixed reference power. The reference value is dis-
played in the "Reference" field (in relative ACLR mode); the default value is 0 dBm.

Note: In adjacent-channel power measurement, the power is always referenced to a
transmission channel (see " Reference Channel " on page 260), thus, this function is
not available.

Remote command:
[SENSe: ] POWer:ACHannel :REFerence:AUTO ONCE on page 652

Optimized Settings ( Adjust Settings )
All instrument settings for the selected channel setup (channel bandwidth, channel
spacing) can be optimized automatically.

The adjustment is carried out only once. If necessary, the instrument settings can be
changed later.

The following settings are optimized by "Adjust Settings" :
"Frequency Span" on page 249

"Resolution Bandwidth (RBW)" on page 250

"Video Bandwidth (VBW)" on page 250

"Detector" on page 251
"Trace Averaging" on page 251

Note: The reference level is not affected by this function. To adjust the reference level
automatically, use the "Amplitude" > Reference Level function.

Remote command:
[SENSe: ] POWer:ACHannel : PRESet on page 660

Meas Time

With the RMS detector, a longer "Meas Time" increases the stability of the measure-
ment results. For recommendations on setting this parameter, see " Meas Time "

on page 248.

The "Meas Time" can be set via the "Meas Setup" > "Meas Time" menu item and is
identical to the general setting in the "Bandwidth" dialog box.

Remote command:
[SENSe: ] SWEep: TIME on page 637
Channel Setup

The "Channel Settings" tab in the "ACLR Setup" dialog box provides all the channel
settings to configure the channel power or ACLR measurement. You can define the
channel settings for all channels, independent of the defined number of used Tx or
adjacent channels (see " Number of channels: Tx , Adj " on page 260).

For details on setting up channels, see "How to Set Up the Channels" on page 281.
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In addition to the specific channel settings, the general settings " Standard "
on page 259 and " Number of channels: Tx , Adj " on page 260 are also available in
this tab.

The following settings are available in individual subtabs of the "Channel Settings" tab.

Channel BandWidth .........co e e e e e e e —————— 263
Channel SPACINGS ..ceeeiiueiiiieiaieiiie et e e s et e e s s abee e e e e snreas 264
LIMIE CRECK .ttt et e e e e e e aeaaaaaaas 264
WeIghting FILEIS ..ooeeeieee e e e 265
107 g T T ol 0 1= I NN F= 0 1= PR 265

Channel Bandwidth

General Settings Channel Settings
Standard Channel Count

EUTRA/LTE Square

Manage User Standards

Bandwidths Spacing Limits Weighting Filters Names
Tx Channels Adjacent Chanrels

-

RSN 9.015 MHz ADJ] 9.015MHz

9.015 MHz NN 9.015 MHz

-

9.015 MHz CIRRaN| 9.015 MHz

-
=
9%)

9.015 MHz RSN 9.015 MHz

TR
TR

=

9.015 MHz CINEEAN9.015 MHz

|

9.015 MHz CINESEN 9.015 MHz

|

-

9.015 MHz CIRNGEN | 9.015 MHz

The Tx channel bandwidth is normally defined by the transmission standard.

The correct bandwidth is set automatically for the selected standard. The bandwidth for
each channel is indicated by a colored bar in the display.

The value entered for any Tx channel is automatically also defined for all subsequent
Tx channels. Thus, only enter one value if all Tx channels have the same bandwidth.

The value entered for any ADJ or ALT channel is automatically also defined for all
alternate (ALT) channels. Thus, only enter one value if all adjacent channels have the
same bandwidth.
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Remote command:

[SENSe: ] POWer:ACHannel :BANDwidth [:CHANnel<ch>] on page 647
[SENSe: ] POWer:ACHannel :BANDwidth:ACHannel on page 647
[SENSe: ] POWer:ACHannel :BANDwidth:ALTernate<ch> on page 647

Channel Spacings
Channel spacings are normally defined by the transmission standard but can be

changed.

If the spacings are not equal, the channel distribution in relation to the center frequency
is as follows:

Odd number of Tx channels The middle Tx channel is centered to center frequency.

Even number of Tx channels The two Tx channels in the middle are used to calculate the fre-

quency between those two channels. This frequency is aligned to
the center frequency.

The spacings between all Tx channels can be defined individually. When you change
the spacing for one channel, the value is automatically also defined for all subsequent
Tx channels. This allows you to set up a system with equal Tx channel spacing quickly.
For different spacings, set up the channels from top to bottom.

Tx1-2 Spacing between the first and the second carrier

Tx2-3 Spacing between the second and the third carrier

If you change the adjacent-channel spacing (ADJ), all higher adjacent channel spac-
ings (ALT1, ALT2, ...) are multiplied by the same factor (new spacing value/old spacing
value). Again, only enter one value for equal channel spacing. For different spacing,
configure the spacings from top to bottom.

For details, see "How to Set Up the Channels" on page 281

Remote command:

[SENSe: ] POWer:ACHannel : SPACing:CHANnel<ch> on page 649
[SENSe: ] POWer:ACHannel:SPACing[:ACHannel] on page 648
[SENSe: ] POWer:ACHannel : SPACing:ALTernate<ch> on page 649

Limit Check

During an ACLR measurement, the power values can be checked whether they
exceed user-defined or standard-defined limits. A relative or absolute limit can be
defined, or both. Both limit types are considered, regardless whether the measured lev-
els are absolute or relative values. The check of both limit values can be activated
independently. If any active limit value is exceeded, the measured value is displayed in
red and marked by a preceding asterisk in the result table.
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Power Abs Po imit
053 GHz -40.68 dBm -71.22 dB -17.18 dB
268 GHz =40.13 dBm J -20.63 dB
-52.60 dBm 3

-54.30 dBm
-51.51 dBm
270 GHZ =54.13 dBm -84.67 dB -33.63 dB

0355 GHz -51.94 dBm -82.48 dB -19.44 dB
0725 GHz -40.01 dBm -70.55 dB -20.51 dB
0911 GHz -40.28 dBm -70.82 dB -16.78 dB

The results of the power limit checks are also indicated in the STAT: QUES : ACPL sta-
tus registry (see "STATus:QUEStionable:ACPLimit Register" on page 470).

Remote command:

CALCulate<n>:LIMit<1i>:ACPower [:STATe] on page 659
CALCulate<n>:LIMit<1li>:ACPower:ACHannel:ABSolute:STATe on page 654
CALCulate<n>:LIMit<li>:ACPower:ACHannel :ABSolute on page 654
CALCulate<n>:LIMit<li>:ACPower:ACHannel[:RELative] :STATe

on page 656

CALCulate<n>:LIMit<1li>:ACPower:ACHannel[:RELative] on page 655
CALCulate<n>:LIMit<li>:ACPower:ALTernate<ch>:ABSolute:STATe

on page 657
CALCulate<n>:LIMit<1li>:ACPower:ALTernate<ch>:ABSolute on page 656
CALCulate<n>:LIMit<li>:ACPower:ALTernate<ch>[:RELative] :STATe
on page 658
CALCulate<n>:LIMit<li>:ACPower:ALTernate<ch>[:RELative]

on page 657

CALCulate<n>:LIMit<1i>:ACPower:ACHannel:RESult? on page 655

Weighting Filters

Weighting filters allow you to determine the influence of individual channels on the total
measurement result. For each channel you can activate or deactivate the use of the
weighting filter and define an individual weighting factor ( "Alpha:" value).

Weighting filters are not available for all supported standards and cannot always be
defined manually where they are available.

Remote command:

Activating/Deactivating:

[SENSe: ] POWer:ACHannel :FILTer [:STATe] : CHANnel<ch> on page 652
[SENSe: ] POWer:ACHannel :FILTer [:STATe] :ACHannel on page 651
[SENSe: ] POWer:ACHannel :FILTer [:STATe] :ALTernate<ch> on page 652
Alpha value:

[SENSe: ] POWer:ACHannel :FILTer:ALPHa:CHANnel<ch> on page 651
[SENSe: ] POWer:ACHannel :FILTer:ALPHa:ACHannel on page 650
[SENSe: ] POWer:ACHannel :FILTer:ALPHa:ALTernate<ch> on page 650

Channel Names

In the R&S VSE's display, carrier channels are labeled "Tx" by default; the first neigh-
boring channel is labeled "Adj" (adjacent) channel; all others are labeled "Alt" (alter-
nate) channels. You can define user-specific channel names for each channel which
are displayed in the result diagram and result table.
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Remote command:

[SENSe: ] POWer:ACHannel : NAME : ACHannel on page 647
[SENSe: ] POWer:ACHannel :NAME : ALTernate<ch> on page 648
[SENSe: ] POWer:ACHannel : NAME : CHANnel<ch> on page 648

MSR ACLR Configuration

Access: "Overview" > "Select Measurement" > "Channel Power ACLR" > "CP / ACLR
Standard" > "Standard" : "Multi-Standard Radio" > "CP / ACLR Config"

ACLR measurements can also be performed on input containing multiple signals for
different communication standards. A new measurement standard is provided that
allows you to define multiple discontiguous transmit channels at specified frequencies,
independent from the selected center frequency. If the "Multi-Standard Radio" standard
is selected (see " Standard " on page 259), the "ACLR Setup" dialog box is replaced by
the "MSR ACLR Setup" dialog box.

For more information, see "Measurement on Multi-Standard Radio (MSR) Signals"
on page 252.

The remote commands required to perform these tasks are described in Chap-
ter 13.6.3.1, "Measuring the Channel Power and ACLR", on page 644.

e General MSR ACLR Measurement Settings......ccccuuveirriiieiiiiiiiceieeeee e 266
e MSR Sub Block and Tx Channel Definition.........c.ccceeieeicciiiiiiieeee e 271
e MSR Adjacent Channel SEtUP......ccccuiiiiiiiiiee e 273
e MSR Gap Channel SEIUP.......cueiiiiiiiie it e e e e 276
®  MSR Channel NamMES....cccooi ittt e e 279

General MSR ACLR Measurement Settings

Access: "Overview" > "Select Measurement" > "Channel Power ACLR" > "CP / ACLR
Standard" > "Standard" : "Multi-Standard Radio" > "CP / ACLR Config" > "MSR Gen-
eral Settings" tab
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MSR General Settings Tx Channels Adjacent Channels Gap Channels Names

Standard Sub Blacks

Multi-Standard Radio = .
Sub Block Count
-

2

Reference Channel ACLR Mode

Noise Cancellation Power Unit

Selected Trace Power Mode CILRW
:E%T;:?;:Itup Limit Checking

Adjust Settings

R = o £= 1o N 267

L Predefined StANAArS .......c.eeeeeeeeeeeeeeeeeeeeeeeeeeeeeeteeeeeeseeeeeeeet e eeeeteseneeeeeeenens 267

L USEr SEANAAIAS ..ottt ettt et ee et et eeeereere et eeeeee et eneaeeeen 268
NUMDBEr Of SUD BIOCKS ...t eeaaaas 268
ReferenCe ChanNEl ........cooueiieeeeeee ettt e e e 269
ST (=Tt (= To I =TT = R 269
Absolute and Relative Values (ACLR MOdE) .......ceeiiiiiiiiiiiiiieie e 269
Channel power level and density ( Power Unit )........ccoooiiiiiiiniiiiiee e 269
o) =T Y [ Yo L= PP 270
Optimized Settings ( Adjust SEttNGS ).eeveeeeiiiiiie e 270
Symmetrical Adjacent SEIUP .....ccooiiii i ————— 270
Limit CheCKING ...ueeeeiieeiiieee ettt e s e s s e e e s aanneeeas 270
Standard

The main measurement settings can be stored as a standard file. When such a stan-
dard is loaded, the required channel and general measurement settings are automati-
cally set on the R&S VSE. However, the settings can be changed. Predefined stand-
ards are available for standard measurements, but standard files with user-defined
configurations can also be created.

Predefined Standards < Standard

Predefined standards contain the main measurement settings for standard measure-
ments. When such a standard is loaded, the required channel settings are automati-
cally set on the R&S VSE. However, you can change the settings.

The predefined standards contain the following settings:

Channel bandwidths
Channel spacings

Detector

Trace Average setting
Resolution Bandwidth (RBW)
Weighting Filter
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For details on the available standards, see Chapter 10.4.1.9, "Reference: Predefined
CP/ACLR Standards", on page 290.

Remote command:
CALCulate<n>:MARKer<m>:FUNCtion:POWer<sb>:PRESet on page 644

User Standards — Standard
Access: "CP / ACLR Config" > "General Settings" tab > "Manage User Standards"

In addition to the predefined standards, you can save your own standards with your
specific measurement settings in an XML file so you can use them again later. User-
defined standards are stored on the instrument in the
C:\ProgramData\Rohde-Schwarz\VSE\<version>\acp std directory.

Note: User standards created on an analyzer of the R&S FSP family are compatible to
the R&S VSE. User standards created on an R&S VSE, however, are not necessarily
compatible to the analyzers of the R&S FSP family and may not work there.

The following parameter definitions are saved in a user-defined standard:
® Number of adjacent channels

® Channel bandwidth of transmission (Tx), adjacent (Adj) and alternate (Alt) chan-
nels

Channel spacings

Weighting filters

Resolution bandwidth

Video bandwidth

Detector

ACLR limits and their state

"Meas Time" and "Meas Time" coupling

Trace and power mode

(MSR only: sub block and gap channel definition)

Save the current measurement settings as a user-defined standard, load a stored mea-
surement configuration, or delete an existing configuration file.

For details see "How to Manage User-Defined Configurations" on page 284.

Remote command:

To query all available standards:
CALCulate<n>:MARKer<m>:FUNCtion:POWer<sb>:STANdard:CATalog?
on page 645

To load a standard:
CALCulate<n>:MARKer<m>:FUNCtion:POWer<sb>:PRESet on page 644
To save a standard:
CALCulate<n>:MARKer<m>:FUNCtion:POWer<sb>:STANdard:SAVE

on page 646

To delete a standard:
CALCulate<n>:MARKer<m>:FUNCtion:POWer<sb>:STANdard:DELete
on page 645

Number of Sub Blocks

Defines the number of sub blocks, i.e. groups of transmission channels in an MSR sig-
nal.

User Manual 1176.8839.02 — 14 268



R&S®VSE 1/Q Analyzer Measurements

RF Measurement Configuration

For more information, see "Measurement on Multi-Standard Radio (MSR) Signals"
on page 252.

Remote command:
[SENSe: ] POWer:ACHannel : SBCount on page 663

Reference Channel

The measured power values in the adjacent channels can be displayed relative to the
transmission channel. If more than one Tx channel is defined, define which one is used
as a reference channel.

Tx Channel 1 Transmission channel 1 is used.
(Not available for MSR ACLR)

Min Power Tx Channel | The transmission channel with the lowest power is used as a reference channel.

Max Power Tx Chan- | The transmission channel with the highest power is used as a reference channel

nel (Default).
Lowest & Highest The outer left-hand transmission channel is the reference channel for the lower
Channel adjacent channels, the outer right-hand transmission channel that for the upper

adjacent channels.

Remote command:
[SENSe: ] POWer:ACHannel :REFerence: TXCHannel :MANual on page 653
[SENSe: ] POWer:ACHannel :REFerence: TXCHannel : AUTO on page 653

Selected Trace
The CP/ACLR measurement can be performed on any active trace.

Remote command:
[SENSe: ] POWer: TRACe on page 660

Absolute and Relative Values (ACLR Mode)
The powers of the adjacent channels are output in dBm or dBm/Hz (absolute values),
or in dBc, relative to the specified reference Tx channel.

"Abs" The absolute power in the adjacent channels is displayed in the unit
of the y-axis, e.g. in dBm, dBuV.

"Rel" The level of the adjacent channels is displayed relative to the level of
the transmission channel in dBc.

Remote command:
[SENSe: ] POWer:ACHannel :MODE on page 681

Channel power level and density ( Power Unit )

By default, the channel power is displayed in absolute values. If "/Hz" is activated, the
channel power density is displayed instead. Thus, the absolute unit of the channel
power is switched from dBm to dBm/Hz.

Note: The channel power density in dBm/Hz corresponds to the power inside a band-
width of 1 Hz and is calculated as follows:
"channel power density = channel power — log,o(channel bandwidth)"
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Thus you can measure the signal/noise power density, for example, or use the addi-
tional functions Absolute and Relative Values (ACLR Mode) and Reference Channel to
obtain the signal to noise ratio.

Remote command:
CALCulate<n>:MARKer<m>:FUNCtion:POWer<sb>:RESult:PHZ on page 681

Power Mode

The measured power values can be displayed directly for each trace ( "Clear/ Write" ),
or only the maximum values over a series of measurements can be displayed ( "Max
Hold" ). In the latter case, the power values are calculated from the current trace and
compared with the previous power value using a maximum algorithm. The higher value
is retained. If "Max Hold" mode is activated, "Pwr Max" is indicated in the table header.
Note that the trace mode remains unaffected by this setting.

Remote command:
CALCulate<n>:MARKer<m>:FUNCtion:POWer<sb>:MODE on page 661

Optimized Settings ( Adjust Settings )
All instrument settings for the selected channel setup (channel bandwidth, channel
spacing) can be optimized automatically.

The adjustment is carried out only once. If necessary, the instrument settings can be
changed later.

The following settings are optimized by "Adjust Settings" :
"Frequency Span" on page 249

"Resolution Bandwidth (RBW)" on page 250

"Video Bandwidth (VBW)" on page 250

"Detector" on page 251
"Trace Averaging" on page 251

Note: The reference level is not affected by this function. To adjust the reference level
automatically, use the "Amplitude" > Reference Level function.

Remote command:
[SENSe: ] POWer:ACHannel : PRESet on page 660

Symmetrical Adjacent Setup
If enabled, the upper and lower adjacent and alternate channels are defined symmetri-
cally. This is the default behavior.

If disabled, the upper and lower channels can be configured differently. This is particu-
larly useful if the lowest Tx channel and highest Tx channel use different standards and
thus require different bandwidths for adjacent channel power measurement.

Remote command:
[SENSe: ] POWer:ACHannel : SSETup on page 667

Limit Checking
Activates or deactivates limit checks globally for all adjacent and gap channels. In addi-
tion to this setting, limits must be defined and activated individually for each channel.

The results of the power limit checks are also indicated in the STAT: QUES : ACPL sta-
tus registry (see "STATus:QUEStionable:ACPLimit Register" on page 470).
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Remote command:
CALCulate<n>:LIMit<1i>:ACPower[:STATe] on page 659

MSR Sub Block and Tx Channel Definition

Access: "Overview" > "Select Measurement" > "Channel Power ACLR" > "CP / ACLR
Standard" > "Standard" : "Multi-Standard Radio" > "CP / ACLR Config" > "Tx Chan-
nels" tab

The "Tx Channels" tab provides all the channel settings to configure sub blocks and Tx
channels in MSR ACLR measurements.

MSR General Settings  SRERSENTH Adjacent Channels Gap Channels Names

r Sub Block Definition
Center 1,96 GHz RF Bandwidth 10,0 MHz T« Count 1
r Tc Channels
-
Center Technology Bandwidth ‘Weighting Fi[ |
Tl 196 GHz WICDA T 3.84 MHz 0.22
o
E, T2 1.96 GHz WICDRAA T 3.84 MHz 0.22 =
[ Sub
E’ Block B T3 196 GHz WCDMA T 364 MHZ 0.22
Tcd 196 GHz WWC DAL T 364 MHz 0.22 |
T 5 1.96 GHz WICDRAA T 3.84 MHz 0.22
Tx 6 1.96 GHz WICDRAA T 3.84 MHz 0.22
Te ¥ 1.96 GHz WCDRA, T 384 MHz 0.22
Ted 1.98 GHz WCDRMA T 344 MHz 0.22
Ted 108 TH- AT Mk - ER-ERYINES ’j‘ noa7 kv

For details on MSR signals, see "Measurement on Multi-Standard Radio (MSR) Sig-
nals" on page 252.

For details on setting up channels, see "How to Configure an MSR ACLR Measure-
ment" on page 282.

The Tx channel settings for the individual sub blocks are configured in individual sub-
tabs of the "Tx Channel Settings" tab.

18] o8 =1 o Yo [ I 1= 11 o ) o [ 272
L SUD BIOCK / CENEET FIEQ ..ttt ee e n e enee 272
L RF BaNAWIAth .......veeeeviceceeeccecte ettt 272
L Number of Tx Channels ( TX COUNt ).....c.oveueueiereeeeieeeeeeeeeeee e e seseeessee e, 272
IR T a T a1 = T o o RS 272
L TX Center FIEQUENCY ......cveeeeereeeeeeteeeeeeeeeeeeeeeeeseseseseetesesesssssssesesessananeneeseens 272
L Technology Used for TranSMISSION ............cccveveueeeeeeureeeeeieeeeeseeseeeeseee e 273
L Tx Channel Bandwidth .............ccceveeeeuernieeeiniiicieeise e 273
L WEIGHEING FIETS ...ttt en e e 273
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Sub Block Definition

Sub blocks are groups of transmit channels in an MSR signal. Up to 5 sub blocks can
be defined. They are defined as an RF bandwidth around a center frequency with a
specific number of transmit channels (max. 18).

Sub blocks are named A,B,C,D,E and are indicated by a slim blue bar along the fre-
quency axis.

Sub Block / Center Freq < Sub Block Definition
Defines the center of an MSR sub block. Note that the position of the sub block also
affects the position of the adjacent gap channels.

Remote command:
[SENSe: ] POWer:ACHannel : SBLock<sb>:FREQuency:CENTer on page 664

RF Bandwidth — Sub Block Definition
Defines the bandwidth of the individual MSR sub block. Note that sub block ranges
also affect the position of the adjacent gap channels.

Remote command:
[SENSe: ] POWer:ACHannel : SBLock<sb>:RFBWidth on page 665

Number of Tx Channels ( Tx Count ) — Sub Block Definition
Defines the number of transmit channels the specific sub block contains. The maxi-
mum is 18 Tx channels.

Remote command:
[SENSe: ] POWer:ACHannel : SBLock<sb>:TXCHannel : COUNt on page 666

Tx Channel Definition

As opposed to common ACLR channel definitions, the Tx channels are defined at
absolute frequencies, rather than by a spacing relative to the (common) center fre-
quency. Each transmit channel can be assigned a different technology, used to prede-
fine the required bandwidth.

The Tx channel settings for the individual sub blocks are configured in individual sub-
tabs of the "Tx Channel Settings" tab.

For details on configuring MSR Tx channels, see "How to Configure an MSR ACLR
Measurement" on page 282.

Remote command:
[SENSe: ] POWer:ACHannel:SBLock<sb>:NAME [ : CHANnel<ch>] on page 676

Tx Center Frequency — Tx Channel Definition

Defines the (absolute) center frequency of an MSR Tx channel. Each Tx channel is
defined independently of the others; automatic spacing as in common ACLR measure-
ments is not performed.

Note that the position of the adjacent channels is also affected by:

® The position of the first Tx channel in the first sub block
® The position of last Tx channel in the last sub block

Remote command:
[SENSe: ] POWer:ACHannel : SBLock<sb>:CENTer [ : CHANnel<ch>] on page 663
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Technology Used for Transmission < Tx Channel Definition

The technology used for transmission by the individual channel can be defined for
each channel. The required channel bandwidth and use of a weighting filter are pre-
configured automatically according to the selected technology standard.

"GSM" Transmission according to GSM standard

"W-CDMA" Transmission according to W-CDMA standard

"LTE_ xxx"
Transmission according to LTE standard for different channel band-
widths

"USER" User-defined transmission; no automatic preconfiguration possible

Remote command:
[SENSe: ] POWer:ACHannel : SBLock<sb>:TECHnology [ :CHANnel<ch>]
on page 665

Tx Channel Bandwidth < Tx Channel Definition

The Tx channel bandwidth is normally defined by the transmission technology stan-
dard. The correct bandwidth is predefined automatically for the selected technology.
Each Tx channel is defined independently of the others; automatic bandwidth configu-
ration for subsequent channels as in common ACLR measurements is not performed.

The bandwidth for each channel is indicated by a colored bar in the display.

Remote command:
[SENSe: ] POWer:ACHannel :SBLock<sb>:BANDwidth[:CHANnel<ch>]
on page 663

Weighting Filters < Tx Channel Definition

Weighting filters allow you to determine the influence of individual channels on the total
measurement result. For each channel, you can activate or deactivate the use of the
weighting filter and define an individual weighting factor ( "Alpha:" value).

Remote command:

Activating/Deactivating:

[SENSe: ] POWer:ACHannel :FILTer [:STATe] : SBLock<sb>:CHANnel<ch>

on page 662

Alpha value:

[SENSe: ] POWer:ACHannel:FILTer:ALPHa:SBLock<sb>:CHANnel<ch>

on page 662
MSR Adjacent Channel Setup

Access: "Overview" > "Select Measurement" > "Channel Power ACLR" > "CP / ACLR
Standard" > "Standard" : "Multi-Standard Radio" > "CP / ACLR Config" > "Adjacent
Channels" tab

The "Adjacent Channels" tab provides all the channel settings to configure adjacent
and gap channels in MSR ACLR measurements.

For symmetrical channel definition (see " Symmetrical Adjacent Setup " on page 270),
the dialog box is reduced as the upper and lower channels are identical.
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MSR General Settings Tx Channels Adjacent Channels Gap Channels Names

Settings

Adj Channels
Spacdng Bandwidth Weighting Rlter Relative Limit Absolute Limit
Adjacent

Lower { 12.5 MHz

Upper [20.!] MHz

Alternate 1

1SS 22.5 MHz ‘
Upper ldl].l] MHz 8.015 MHz | 022 | -49.2 dBc | [n.n dBm

Alternate 2

Figure 10-25: Asymmetrical adjacent channel definition

For details on setting up channels, see "How to Configure an MSR ACLR Measure-
ment" on page 282.

Number of Adjacent Channels ( Adj Count )......cooiiiiiiiiiiiiiccccre e 274
Adjacent Channel Definition ........ ..o 274
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L Adjacent Channel Bandwidths .............cccccoveveceeeeerereeeeeeeeeeeeeeeeseeeseeseeeeeees 275
L WEIGhtING FIEIS ......veeececececeeeeeeeeeeeeee e st n s e e e 275
L Limit CRECKING ..ottt ettt s e es 276

Number of Adjacent Channels ( Adj Count)

Defines the number of adjacent channels above and below the Tx channel block in an
MSR signal. You must define the carrier channel to which the relative adjacent-channel
power values refer (see " Reference Channel " on page 260).

Remote command:
[SENSe: ] POWer:ACHannel : ACPairs on page 646

Adjacent Channel Definition

Defines the channels adjacent to the transmission channel block in MSR signals. A
maximum of 12 adjacent channels can be defined.

User Manual 1176.8839.02 — 14 274



R&S®VSE 1/Q Analyzer Measurements

RF Measurement Configuration

For MSR signals, adjacent channels are defined in relation to the center frequency of

the first and last transmission channel in the entire block, i.e.:

® The lower adjacent channels are defined in relation to the CF of the first Tx chan-
nel in the first sub block.

® The upper adjacent channels are defined in relation to the CF of the last Tx chan-
nel in the last sub block.

Adjacent channels are named "Adj" and "Alt1" to "Alt11" by default; the names can be
changed manually (see "MSR Channel Names" on page 279).

In all other respects, channel definition is identical to common ACLR measurements.

Adjacent Channel Spacings < Adjacent Channel Definition
Channel spacings are normally predefined by the selected technology but can be
changed.

For MSR signals, adjacent channels are defined in relation to the center frequency of

the first and last transmission channel in the entire block, i.e.:

® The spacing of the lower adjacent channels refers to the CF of the first Tx channel
in the first sub block.

® The spacing of the upper adjacent channels refers to the CF of the last Tx channel
in the last sub block.

For details, see "How to Configure an MSR ACLR Measurement" on page 282

Remote command:

[SENSe: ] POWer:ACHannel:SPACing[:ACHannel] on page 648
[SENSe: ] POWer:ACHannel : SPACing:ALTernate<ch> on page 649
[SENSe: ] POWer:ACHannel : SPACing:UACHannel on page 666
[SENSe: ] POWer:ACHannel : SPACing:UALTernate<ch> on page 667

Adjacent Channel Bandwidths < Adjacent Channel Definition

The adjacent channel bandwidth is normally predefined by the transmission technology
standard. The correct bandwidth is set automatically for the selected technology. The
bandwidth for each channel is indicated by a colored bar in the display.

Remote command:

[SENSe: ] POWer:ACHannel : BANDwidth:ACHannel on page 647
[SENSe: ] POWer:ACHannel :BANDwidth:ALTernate<ch> on page 647
[SENSe: ] POWer:ACHannel : BANDwidth:UACHannel on page 667
[SENSe: ] POWer:ACHannel : BANDwidth:UALTernate<ch> on page 668

Weighting Filters < Adjacent Channel Definition

Weighting filters allow you to determine the influence of individual channels on the total
measurement result. For each channel, you can activate or deactivate the use of the
weighting filter and define an individual weighting factor ( "Alpha:" value).

Remote command:

Activating/Deactivating:

[SENSe: ] POWer:ACHannel:FILTer [:STATe] : ACHannel on page 651
[SENSe: ] POWer:ACHannel :FILTer [:STATe] :ALTernate<ch> on page 652
[SENSe: ] POWer:ACHannel:FILTer[:STATe] : UACHannel on page 669
[SENSe: ] POWer:ACHannel :FILTer [:STATe] :UALTernate<ch> on page 669
Alpha value:
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[SENSe: ] POWer:ACHannel :FILTer:ALPHa:ACHannel on page 650
[SENSe: ] POWer:ACHannel :FILTer:ALPHa:ALTernate<ch> on page 650
[SENSe: ] POWer:ACHannel :FILTer :ALPHa:UACHannel on page 668
[SENSe: ] POWer:ACHannel :FILTer:ALPHa:UALTernate<ch> on page 668

Limit Checking < Adjacent Channel Definition

During an ACLR measurement, the power values can be checked whether they
exceed user-defined or standard-defined limits. A relative or absolute limit can be
defined, or both, for each individual adjacent channel. Both limit types are considered,
regardless whether the measured levels are absolute or relative values. The check of
both limit values can be activated independently. If any active limit value is exceeded,
the measured value is displayed in red and marked by a preceding asterisk in the
result table.

Note that in addition to activating limit checking for individual channels, limit checking
must also be activated globally for the MSR ACLR measurement (see " Limit Checking
" on page 270).
2 Result Summary i-Standard Radio

Bandwidth g Power

=80.44 dBm
-29.15 dEm

Channel fan g Lower Upper

-49.76 dB -50.37 dB

Remote command:

CALCulate<n>:LIMit<1li>:ACPower[:STATe] on page 659
CALCulate<n>:LIMit<1li>:ACPower:ACHannel:ABSolute:STATe On page 654
CALCulate<n>:LIMit<1i>:ACPower:ACHannel:ABSolute on page 654
CALCulate<n>:LIMit<li>:ACPower:ACHannel[:RELative] :STATe

on page 656

CALCulate<n>:LIMit<1i>:ACPower:ACHannel[:RELative] on page 655
CALCulate<n>:LIMit<li>:ACPower:ALTernate<ch>:ABSolute:STATe

on page 657
CALCulate<n>:LIMit<li>:ACPower:ALTernate<ch>:ABSolute on page 656
CALCulate<n>:LIMit<li>:ACPower:ALTernate<ch>[:RELative] :STATe
on page 658
CALCulate<n>:LIMit<li>:ACPower:ALTernate<ch>[:RELative]

on page 657

CALCulate<n>:LIMit<1i>:ACPower:ACHannel:RESult? on page 655

MSR Gap Channel Setup

Access: "Overview" > "Select Measurement" > "Channel Power ACLR" > "CP / ACLR
Standard" > "Standard" : "Multi-Standard Radio" > "CP / ACLR Config" > "Gap Chan-
nels" tab

The "Gap Channels" tab provides all the channel settings to configure gap channels in
MSR ACLR measurements.
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Snackeiim 7
MSR General Settings Tx Channels Adjacent Channels Gap Channels Names

Gap Activation

Activate Gaps Off

Minimum gap size to show Gap 1 [FRiR 1F |
Minimum gap size to show Gap 2 |JUNKIE " [iF] |

Gap Channels Configuration (for measuring ACLR and CACLR)

Weighting
Filter

CAELR
B e Looome [ Lo | oo BN
CAL'LH.

Spadng Bandwidth Absolute Limit Relative Limit

Figure 10-26: Symmetrical (auto) gap channel configuration
For details on MSR signals, see "Measurement on Multi-Standard Radio (MSR) Sig-
nals" on page 252.

For details on setting up channels, see "How to Configure an MSR ACLR Measure-
ment" on page 282.
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L Minimum gap size to show Gap 1 / Minimum gap size to show Gap 2 ........ 278
L Gap Channel SPACING .......ccveucuieeeeceieeeeeeeeee et ettt n e 278
L Gap Channel BandWIdths ...........ccocoeeviucieeeeeeeeeeeeeeee e 279
L WEIGHEING FIETS ...ttt en e 279
L Limit CRECKING ...vevvveee ettt s st n e 279

Activate Gaps
If enabled, the gap channels are displayed and channel power results are calculated
and displayed in the Result Summary.

Remote command:
[SENSe: ] POWer:ACHannel : AGCHannels on page 669

Gap Channel Definition
Between two sub blocks in an MSR signal, two gaps are defined: a lower gap and an
upper gap. Each gap in turn can contain two channels, the gap channels.

Gap channels are indicated using the following syntax:

® The names of the surrounding sub blocks (e.g. "AB" for the gap between sub
blocks A and B)
The channel name ( "Gap1" or "Gap2" )
"L" (for lower) or "U" (for upper)
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Minimum gap size to show Gap 1/ Minimum gap size to show Gap 2 — Gap
Channel Definition

If the gap between the sub blocks does not exceed the specified bandwidth, the gap
channels are not displayed in the diagram. The gap channel results are not calculated
in the result summary.

Remote command:
[SENSe: ] POWer:ACHannel : GAP<gap>[:AUTO] :MSIZe on page 674

Gap Channel Spacing < Gap Channel Definition
Gap channel spacings are normally predefined by the MSR standard but can be
changed.

Gap channels are defined using bandwidths and spacings, relative to the outer edges
of the surrounding sub blocks.

The required spacing can be determined according to the following formula (indicated
for lower channels):

Spacing = [CF of gap channel] - [left sub block CF] + ([RF band-
width of left sub block] /2)

AILTE_10M1

AILTE_10MZ

e R ]

Sub block CF

Figure 10-27: Gap channel definition for lower gap

For details, see "How to Configure an MSR ACLR Measurement" on page 282.

Remote command:
[SENSe: ] POWer:ACHannel : SPACing:GAP<gap>[:AUTO] on page 674
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Gap Channel Bandwidths < Gap Channel Definition

The gap channel bandwidth is normally predefined by the transmission technology
standard. The correct bandwidth is set automatically for the selected technology. The
bandwidth for each channel is indicated by a colored bar in the display (if the gap is not
too narrow, see "Channel display for MSR signals" on page 255).

Remote command:
[SENSe: ] POWer:ACHannel : BANDwidth:GAP<gap>[:AUTO] on page 673

Weighting Filters — Gap Channel Definition

Weighting filters allow you to determine the influence of individual channels on the total
measurement result. For each channel, you can activate or deactivate the use of the
weighting filter and define an individual weighting factor ( "Alpha:" value).

Remote command:
[SENSe: ] POWer:ACHannel:FILTer [:STATe] : GAP<gap>[:AUTO] on page 674
[SENSe: ] POWer:ACHannel :FILTer:ALPHa:GAP<gap>[:AUTO] on page 673

Limit Checking < Gap Channel Definition

During an ACLR measurement, the power values can be checked whether they
exceed user-defined or standard-defined limits. A relative or absolute limit can be
defined, or both, for each individual gap channel. Both limit types are considered,
regardless whether the measured levels are absolute or relative values. The check of
both limit values can be activated independently. Furthermore, relative limits can be
defined and activated individually for ACLR or CACLR power levels.

If any active limit value is exceeded, the measured value is displayed in red and
marked by a preceding asterisk in the result table.

Note that in addition to activating limit checking for individual channels, limit checking
must also be activated globally for the MSR ACLR measurement (see " Limit Checking
"on page 270).

Remote command:
"Automatic (Symmetrical) Configuration" on page 670
MSR Channel Names

Access: "Overview" > "Select Measurement" > "Channel Power ACLR" > "CP / ACLR
Standard" > "Standard" : "Multi-Standard Radio" > "CP / ACLR Config" > "Names" tab

Channel names for all TX, adjacent, and alternate channels are user-definable.

In the "Names" tab, you can define a customized name for each channel in each sub
block. Note that the names are not checked for uniqueness.
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x

MSR General Settings Tx Channels Adjacent Channels Gap Channels Names
Tx Channels Adjacent Channels

SBA SBB Adjacent

g . ;
Tx1 |A:LTE_1DM1 | Adj Lower

Tx 2 Upper \Adj Upper

Tx 3 ] Alternate 1

IFE N A:WCDMAZ? IGIET Altl Lower
., -

1F &0 A:WCDMA3 IR Altl Upper

Tx 6 . Alternate 2

Tx7 'A:WCDMAS I AlL2 Lower

P A:WCDMAG Upper ‘Ntl Upper

Tx9 [n:wcuua? Alternate 3

S s upper -

Figure 10-28: Channel name definition for asymmetric adjacent channels

Remote command:

[SENSe: ] POWer:ACHannel:SBLock<sb>:NAME [ : CHANnel<ch>] on page 676
[SENSe: ] POWer:ACHannel :NAME : ACHannel on page 647

[SENSe: ] POWer:ACHannel :NAME: ALTernate<ch> on page 648

[SENSe: ] POWer:ACHannel : NAME : UACHannel on page 675

[SENSe: ] POWer:ACHannel : NAME : UALTernate<ch> on page 675

10.4.1.6 How to Perform Channel Power Measurements

The following step-by-step instructions demonstrate the most common tasks when per-
forming channel power measurements.

O For remote operation, see "Programming Examples for Channel Power Measure-
= ments" on page 682.
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How to Perform a Standard Channel Power Measurement

Performing a channel power or ACLR measurement according to common standards is
a very easy and straightforward task with the R&S VSE.

1. Select "Meas Setup" > "Select Measurement" .

2. Select "Channel Power ACLR" .

The measurement is started immediately with the default settings.
3. Select "Meas Setup" > "CP / ACLR Standard" .

4. Select a standard from the list.

The measurement is restarted with the predefined settings for the selected stan-
dard.

5. If necessary, edit the settings for your specific measurement as described in "How
to Set Up the Channels" on page 281, or load a user-defined configuration (see
"To load a user-defined configuration" on page 284).

How to Set Up the Channels

Channel definition is the basis for measuring power levels in certain frequency ranges.
Usually, the power levels in one or more carrier (Tx) channels and possibly the adja-
cent channels are of interest. Up to 18 carrier channels and up to 12 adjacent channels
can be defined.

When a measurement standard is selected, all settings including the channel band-
widths and channel spacings are set according to the selected standard. Select a stan-
dard in the "Ch Power" menu or the "ACLR Setup" dialog box. You can adjust the set-
tings afterwards.

Channel setup consists of the following settings:

® The number of transmission (Tx) and adjacent channels

® The bandwidth of each channel

® For multicarrier ACLR measurements: which Tx channel is used as a reference

® The spacing between the individual channels

® Optionally: the names of the channels displayed in the diagram and result table

® Optionally: the influence of individual channels on the total measurement result
( "Weighting Filter" )

® Optionally: limits for a limit check on the measured power levels

Changes to an existing standard can be stored as a user-defined standard, see "How
to Manage User-Defined Configurations" on page 284.
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» To configure the channels in the "Ch Power" dialog box, select "Ch Power" > "CP /
ACLR Config" > "Channel Settings" tab.

In the "Channel Setup" dialog box, you can define the channel settings for all channels,
independent of the defined number of used Tx or adjacent channels.

To define channel spacings
Channel spacings are normally defined by the selected standard but can be changed.

» In the "Channel Settings" tab of the "ACLR Setup" dialog box, select the "Spacing"
subtab.
The value entered for any Tx channel is automatically also defined for all subse-
quent Tx channels. Thus, only enter one value if all Tx channels have the same
spacing.
If the channel spacing for the adjacent or an alternate channel is changed, all
higher alternate channel spacings are multiplied by the same factor (new spacing
value/old spacing value). The lower adjacent-channel spacings remain unchanged.
Only enter one value for equal channel spacing.

Example: Defining channel spacing

In the default setting, the adjacent channels have the following spacing: 20 kHz
("ADJ"), 40 kHz ("ALT1"), 60 kHz ("ALT2"), 80 kHz ("ALT3"), 100 kHz ("ALT4"), ...

Set the spacing of the first adjacent channel ("ADJ") to 40 kHz. For all other adjacent
channels, the spacing is multiplied by factor 2: 80 kHz ("ALT1"), 120 kHz ("ALT2"), 160
kHz ("ALT3"), ...

Starting from the default setting, set the spacing of the fifth adjacent channel ("ALT4")
to 150 kHz. For all higher adjacent channels, the spacing is multiplied by factor 1.5:
180 kHz ("ALT5"), 210 kHz ("ALT6"), 240 kHz ("ALT7"), ...

How to Configure an MSR ACLR Measurement

You configure ACLR measurements on MSR signals in a special configuration dialog
box on the R&S VSE.
1. Select "Meas Setup" > "Select Measurement" .
2. Select "Channel Power ACLR" .
The measurement is started immediately with the default settings.
3. Select the "CP / ACLR Standard" softkey.
4. Select the "Multi-Standard Radio" standard from the list.

5. Select the "CP / ACLR Config" softkey to configure general MSR settings, including
the number of sub blocks (up to 5).
To configure asymmetric adjacent channels, deactivate the "Symmetrical" option in
the general MSR settings.

User Manual 1176.8839.02 — 14 282



R&S®VSE I/Q Analyzer Measurements

RF Measurement Configuration

6. Select the "Tx Channels" tab to configure the sub blocks and transmission chan-
nels.
For each sub block:

a) Define the (center frequency) position and bandwidth of the sub block, as well
as the number of transmission channels it contains.
b) For each transmission channel in the sub block:

Define the center frequency.

Select the technology used for transmission.

Check the bandwidth.

If necessary, define the use of a weighting filter for the channel.

7. Select the "Adjacent Channels" tab to configure the adjacent channels.

8. Define the number of adjacent channels and the settings for each channel:

e The spacing, defined as the distance of the center frequency from the center
frequency of the first transmission channel in the first sub block.
For asymmetrical channels, define the upper adjacent channel spacing as the
distance from the center frequency of the last transmission channel in the last
sub block.

e The bandwidth
If necessary, a weighting filter
Optionally, define and activate relative or absolute limits, or both, against which
the power levels of the channel are to be checked.

9. Select the "Gap Channels" tab to configure the gap channels.

10. Define the following settings for the two (upper or lower) gap channels. Since the
upper and lower channels are identical, it is only necessary to configure two chan-
nels.

e The spacing, defined as the distance of the center frequency from the outer
edge of the sub block to the left or right of the gap. You can determine the
required spacing as follows:

Spacing = [CF of the gap channel] - [left sub block center] + ([RF bandwidth of
left sub block] /2)

The bandwidth

If necessary, a weighting filter

Optionally, define and activate relative or absolute limits, or both, against which
the power levels of the channel are to be checked.

11. If power limits are defined and activated, activate global limit checking for the mea-
surement on the "MSR General Settings" tab.

12. Optionally, store the settings for the MSR ACLR measurement as a user-defined
standard as described in "To store a user-defined configuration" on page 284. Oth-
erwise the configuration is lost when you select a different measurement standard.
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How to Manage User-Defined Configurations

You can define measurement configurations independently of a predefined standard
and save the current ACLR configuration as a "user standard" in an XML file. You can
then load the file and thus the settings again later.

User-defined standards are not supported for multicarrier ACLR measurements.

@ Compatibility to R&S FSP
User standards created on an analyzer of the R&S FSP family are compatible to the
R&S VSE. User standards created on an R&S VSE, however, are not necessarily com-
patible to the analyzers of the R&S FSP family and may not work there.

To store a user-defined configuration

1.

5.

In the "Ch Power" menu, select the "CP / ACLR Config" softkey to display the
"ACLR Setup" dialog box.

Configure the measurement as required (see also "How to Set Up the Channels"
on page 281).
In the "General Settings" tab, select the "Manage User Standards" button to display

the "Manage" dialog box.

Define a filename and storage location for the user standard.

By default, the XML file is stored in

C:\Program Files\Rohde-Schwarz\VSE\<version>\acp std\. However,
you can define any other storage location.

Select "Save" .

To load a user-defined configuration

1.

In the "General Settings" tab of the "ACLR Setup" dialog box, select the "Manage
User Standards" button to display the "Manage" dialog box.

Select the user standard file.
Select "Load" .

The stored settings are automatically set on the R&S VSE and the measurement is
restarted with the new parameters.

How to Compare the Tx Channel Power in Successive Measurements

For power measurements with only one Tx channel and no adjacent channels, you can
define a fixed reference power and compare subsequent measurement results to the
stored reference power.

1.

2.

Configure a measurement with only one Tx channel and no adjacent channels (see
also "How to Set Up the Channels" on page 281).

In the "ACLR Setup" dialog box, select the "Set CP Reference" button.
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The channel power currently measured on the Tx channel is stored as a fixed ref-
erence power. The reference value is displayed in the "Reference" field of the
result table (in relative ACLR mode).

Start a new measurement.

The resulting power is indicated relative to the fixed reference power.
Repeat this for any number of measurements.

To start a new measurement without the fixed reference, temporarily define a sec-
ond channel or preset the instrument.

10.4.1.7 Measurement Examples

The R&S VSE has test routines for simple channel and adjacent channel power mea-
surements. These routines give quick results without any complex or tedious setting
procedures.

A programming example demonstrating an ACLR measurement in a remote environ-
ment is provided in "Programming Examples for Channel Power Measurements"

on page 682.
Measurement Example 1 — ACPR Measurement on a CDMA2000 Signal.......... 285
Measurement Example 2 — Measuring Adjacent Channel Power of a W-CDMA
L0 0] T TG |- U PPRPRRRR 287
Measurement Example 3 — Measuring the Intrinsic Noise of the connected instru-
ment with the Channel Power FUNCHON.......coooiii e 288

Measurement Example 1 — ACPR Measurement on a CDMA2000 Signal

Test setup:
Signal Signal
generator ™ analyzer —— | VSE software

Signal generator settings (e.g. R&S SMW):

Frequency: 850 MHz
Level: 0dBm
Modulation: CDMA2000
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Procedure:

1. Set up a basic measurement with instrument input in the R&S VSE as described in
Chapter 11.1, "How to Perform a Basic Measurement with Instrument Input"”,
on page 439.

Set the center frequency to 850 MHz.

Set the span to 4 MHz.

Set the reference level to +10 dBm.

Select "Meas Setup” > "Select Measurement" .

Select the "Channel Power ACLR" measurement function.

N o o » DN

Set the "CDMA2000 1X" standard for adjacent channel power measurement in the
"ACLR Setup" dialog box.

The R&S VSE sets the channel configuration according to the 2000 standard with
two adjacent channels above and 2 below the transmit channel. The spectrum is
displayed in the upper part of the screen, the numeric values of the results and the
channel configuration in the lower part of the screen. The various channels are rep-
resented by vertical lines on the graph.

The frequency span, resolution bandwidth, video bandwidth and detector are
selected automatically to give correct results. To obtain stable results — especially
in the adjacent channels (30 kHz bandwidth) which are narrow in comparison with
the transmission channel bandwidth (1.23 MHz) — the RMS detector is used.

8. Set the optimal reference level and RF attenuation for the applied signal level using
the "Auto Level" function in the [Auto Set] menu.

The R&S VSE sets the optimal RF attenuation and the reference level based on
the transmission channel power to obtain the maximum dynamic range.
The Figure 10-29 shows the result of the measurement.
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Figure 10-29: Adjacent channel power measurement on a CDMA2000 signal

Measurement Example 2 — Measuring Adjacent Channel Power of a W-CDMA
Uplink Signal

Test setup:
Signal Signal
generator — analyzer —={ VSE software

Signal generator settings (e.g. R&S SMW):

Frequency: 1950 MHz

Level: 4 dBm

Modulation: 3GPP W-CDMA Reverse Link
Procedure:

1. Set up a basic measurement with instrument input in the R&S VSE as described in
Chapter 11.1, "How to Perform a Basic Measurement with Instrument Input",
on page 439.

2. Set the center frequency to 1950 MHz.

3. Select the "Channel Power ACLR" measurement function from the "Select Mea-
surement" dialog box.
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4. Setthe "W-CDMA 3GPP REV" standard for adjacent channel power measurement
in the "ACLR Setup" dialog box.

The R&S VSE sets the channel configuration to the W-CDMA standard for mobiles
with two adjacent channels above and below the transmit channel. The frequency
span, the resolution and video bandwidth and the detector are automatically set to
the correct values. The spectrum is displayed in the upper window and the channel
power, the level ratios of the adjacent channel powers and the channel configura-
tion in the lower window. The individual channels are displayed as bars in the
graph.

5. Set the optimal reference level and RF attenuation for the applied signal level using
the "Auto Level" function.

The R&S VSE sets the optimum RF attenuation and the reference level for the
power in the transmission channel to obtain the maximum dynamic range. The fol-
lowing figure shows the result of the measurement.

Multiview Spectrum

G223 dbm = RBW
1ade  SWT 2 ms = VBW
® IRm Clrw

PPN iy Jm-'rﬁ_.q,wg‘.r*'- ,\Jl,‘_,qd | SN
> Span 25.7 MHz
ult Summary W-CDMABGPP REV
ch Bandwidth Offset Power
TX 3.840 MHz 0.93 dBm
0.9|3 dBm |
ower

-66.60 dB -67.33 dB
-69.82 dB -69.35 dB

Figure 10-30: Measuring the relative adjacent channel power on a W-CDMA uplink signal

The R&S VSE measures the power of the individual channels. A root raised cosine
filter with the parameters a = 0.22 and chip rate 3.84 Mcps (= receive filter for W-
CDMA\) is used as channel filter.

Measurement Example 3 — Measuring the Intrinsic Noise of the connected instru-
ment with the Channel Power Function

Noise in any bandwidth can be measured with the channel power measurement func-
tions. Thus the noise power in a communication channel can be determined, for exam-
ple.
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Test setup:

» Leave the RF input of the connected instrument open-circuited or terminate it with
50 Q.

Procedure:

1. Set up a basic measurement with instrument input in the R&S VSE as described in
Chapter 11.1, "How to Perform a Basic Measurement with Instrument Input"”,
on page 439.

2. Set the center frequency to 7 GHz and the span to 1 MHz.

3. To obtain maximum sensitivity, set RF attenuation to 0 dB and the reference level
to -40 dBm.

4. Select the "Channel Power ACLR" measurement function from the "Select Mea-
surement” dialog box.

5. Inthe "ACLR Setup" dialog box, set up a single Tx channel with the channel band-
width 1.23 MHz.

6. Select the "Adjust Settings" softkey.
The settings for the frequency span, the bandwidth (RBW and VBW) and the
detector are automatically set to the optimum values required for the measure-
ment.

7. Stabilize the measurement result by increasing the "Meas Time" .
Set the "Meas Time" to 7 s.
(If the connected instrument allows, otherwise the maximum "Meas Time" .)

The trace becomes much smoother because of the RMS detector and the channel
power measurement display is much more stable.
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Figure 10-31: Measurement of the R&S VSE's intrinsic noise power in a 1.23 MHz channel band-
width.

10.4.1.8 Optimizing and Troubleshooting the Measurement

If the results do not meet your expectations, or if you want to minimize the measure-
ment duration, try the following methods to optimize the measurement:

® Only activate as many adjacent channels as necessary to minimize the required
span and thus the required measurement time for the measurement.

® |ncrease the RBW to minimize the measurement time; however, consider the
requirements of the standard if you need to measure according to standard! The
automatic settings are always according to standard.

® Reduce the "Meas Time" and thus the amount of data to be captured and calcula-
ted; however, consider the requirements regarding the standard deviation.

® To improve the stability of the measured results, increase the "Meas Time"
which also leads to more averaging steps.

® |Instead of trace averaging, use an RMS detector with a higher "Meas Time" to
obtain better average power results in less time.

10.4.1.9 Reference: Predefined CP/ACLR Standards
When using predefined standards for ACLR measurement, the test parameters for the
channel and adjacent-channel measurements are configured automatically.

You can select a predefined standard via the "CP / ACLR Standard" softkey in the "Ch
Power" menu or the selection list in the "General Settings" tab of the "ACLR Setup”
dialog box (see " Standard " on page 259).
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Table 10-3: Predefined CP / ACLR standards with remote command parameters

Standard Remote parameter
None NONE
Multi-Standard Radio MSR
EUTRA/LTE Square EUTRa
EUTRA/LTE Square/RRC REUTra
W-CDMA 3GPP FWD FW3Gppcdma
W-CDMA 3GPP REV RW3Gppcdma
CDMA IS95A FWD F8CDma
CDMA IS95A REV R8CDma
CDMA IS95C Class 0 FWD*) FIS95c0
CDMA IS95C Class 0 REV*) RIS95c0
CDMA J-STD008 FWD F19Cdma
CDMA J-STD008 REV R19Cdma
CDMA IS95C Class 1 FWD*) FIS95c1
CDMA IS95C Class 1 REV*) RIS95¢1
CDMA2000 S2CDma
TD-SCDMA FWD FTCDma
TD-SCDMA REV TRCDma
WLAN 802.11A AWLAN
WLAN 802.11B BWLAN
WIMAX WiIMax
WIBRO WIBRo
RFID 14443 RFID14443
TETRA TETRa

PDC PDC

PHS PHS

CDPD CDPD
APCO-25 P2 PAPCo025
5G NR DL FR1 20MHz F1D20nr5g
5G NR DL FR1 100MHz F1D100nr5g
5G NR UL FR1 20MHz F1U20nr5g
5G NR UL FR1 100MHz F1U100nr5g
5G NR DL FR2 100MHz F2D100nr5g
5G NR DL FR2 200MHz F2D200nr5g
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Standard Remote parameter
5G NR UL FR2 100MHz F2U100nr5g

5G NR UL FR2 200MHz F2U200nr5g

User Standard USER

Customized Standard <string>

For the R&S VSE, the channel spacing is defined as the distance between the center

CD frequency of the adjacent channel and the center frequency of the transmission chan-
nel. The definition of the adjacent-channel spacing in standards 1IS95C and CDMA
2000 is different. These standards define the adjacent-channel spacing from the center
of the transmission channel to the closest border of the adjacent channel. This defini-
tion is also used by the R&S VSE for the standards marked with an asterisk *).

10.4.1.10 Reference: Predefined ACLR User Standard XML Files

In addition to the predefined standards, some user standards with specific measure-
ment settings for common ACLR measurements are provided in XML files on the
instrument in the

C:\Program Files\Rohde-Schwarz\VSE\<version>\acp std directory.

Furthermore, the following XML files are provided:

5GNR\DL

e 5GNR\DL\5GNR_DL_FR1_20MHz
e 5GNR\DL\5GNR_DL_FR1_100MHz
e 5GNR\DL\5GNR_DL_FR2_100MHz
e 5GNR\DL\5GNR_DL_FR2_200MHz

5GNR\UL

e 5GNRWL\SGNR_UL_FR1_20MHz
e 5GNRWL\5GNR_UL_FR1_100MHz
e 5GNRWL\SGNR_UL_FR2_ 100MHz
e 5GNR\WL\5GNR_UL_FR2_200MHz

LTE\DL

e LTE\DL\LTE_DL_5MHZ.XML
e |TE\DL\LTE_DL_10MHZ.XML
e LTE\DL\LTE_DL_15MHZ. XML
e |TE\DL\LTE_DL_20MHZ.XML

LTE\UL

e |TEWL\WTE_UL_5MHZ.XML
e | TEWUL\LTE_UL_10MHZ.XML
e |TEWL\LTE_UL_15MHZ.XML
e |TE\WUL\LTE_UL_20MHZ.XML
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WLAN
e WLAN\802_11ac\802_11ac_20MHZ.XML
e WLAN\802_11ac\802_11ac_40MHZ.XML
e WLAN\802_11ac\802_11ac_80MHZ.XML
e WLAN\802_11ac\802_11ac_160MHZ.XML

To load a stored measurement configuration, in the "General Settings" tab of the
"ACLR Setup" dialog box, select the "Manage User Standards" button to display the
"Manage" dialog box. Select the user standard file, then "Load" .

The stored settings are automatically set on the R&S VSE and the measurement is
restarted with the new parameters.

For details, see "How to Manage User-Defined Configurations" on page 284.

Occupied Bandwidth Measurement (OBW)

An important characteristic of a modulated signal is its occupied bandwidth, that is: the
bandwidth which must contain a defined percentage of the power. In a radio communi-
cations system, for instance, the occupied bandwidth must be limited to enable distor-
tion-free transmission in adjacent channels.

o About the MeasUremMeNt........coooiiiiiiiiiereere e 293
@ OBWW RESUILS....uiitititieieie ettt e e e e e e e e e e e e e e e e e e e e e eeeeeeeesaararasananas 295
®  OBW CoNfigUration..........ccieiccciiiiiiiiies ettt e e e e e e s s rr e e e e e e e e e e s e ssnnnes 296
e How to Determine the Occupied Bandwidth.............cooooiiiiiiiiiiiiiiii e, 298
o Measurement EXample.........ooo ot 299

About the Measurement

The occupied bandwidth is defined as the bandwidth containing a defined percentage
of the total transmitted power. A percentage between 10 % and 99.9 % can be set.

Measurement principle

The bandwidth containing 99% of the signal power is to be determined, for example.
The algorithm first calculates the total power of all displayed points of the trace. In the
next step, the points from the right edge of the trace are summed up until 0.5 % of the
total power is reached. Auxiliary marker 1 is positioned at the corresponding frequency.
Then the points from the left edge of the trace are summed up until 0.5 % of the power
is reached. Auxiliary marker 2 is positioned at this point. 99 % of the power is now
between the two markers. The distance between the two frequency markers is the
occupied bandwidth which is displayed in the marker field.
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@ OBW within defined search limits - multicarrier OBW measurement in one sweep

The occupied bandwidth of the signal can also be determined within defined search
limits instead of for the entire signal. Thus, only a single sweep is required to determine
the OBW for a multicarrier signal. To do so, search limits are defined for an individual
carrier and the OBW measurement is restricted to the frequency range contained
within those limits. Then the search limits are adapted for the next carrier and the OBW
is automatically recalculated for the new range.

MultiView 2= Spectrum

Ref Level -10. n = RBW
Att > = SWT 2 ms = VBW Mode Aute FFT

PN e,
i'l N

i

ol ngTAR L A P
rw\- LR . W IL""!‘*"TF’ (e

CF 497.5 MHz 10001 pts 2.57 MHz/ Span 25.7 MHz
2 Marker Table
Type "Ref "Trc Stimulus Response Function Function Result

M1 1 496.63
T 192, C 4.165553445 MH:z

For step-by-step instructions, see "How to determine the OBW for a multicarrier signal
using search limits" on page 298.

Prerequisites

To ensure correct power measurement, especially for noise signals, and to obtain the
correct occupied bandwidth, the following prerequisites and settings are necessary:

® Only the signal to be measured is displayed in the window, or search limits are
defined to include only one (carrier) signal. An additional signal would falsify the
measurement.

® RBW << occupied bandwidth (approx. 1/20 of occupied bandwidth, for voice com-
munication type: 300 Hz or 1 kHz)

e VBW =3 xRBW

® RMS detector

® Span = 2 to 3 x occupied bandwidth

Some of the measurement specifications (e.g. PDC, RCR STD-27B) require measure-

ment of the occupied bandwidth using a peak detector. The detector setting of the
R&S VSE has to be changed accordingly then.
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10.4.2.2 OBW Results

As a result of the OBW measurement the occupied bandwidth ( "Occ Bw" ) is indicated
in the marker results. Furthermore, the marker at the center frequency and the tempo-
rary markers are indicated.

The measurement is performed on the trace with marker 1. In order to evaluate
another trace, marker 1 must be placed on another trace (see Assigning the Marker to
a Trace ).

The OBW calculation is repeated if the Search Limits are changed, without performing
a new sweep. Thus, the OBW for a multicarrier signal can be determined using only
one sweep.

Centroid frequency

The centroid frequency is defined as the point in the center of the occupied bandwidth,
calculated using the temporary OBW markers T1 and T2. This frequency is indicated
as a function result ( "Occ Bw Centroid" ) in the marker table.

Frequency offset

The offset of the calculated centroid frequency to the defined center frequency of the
R&S VSE is indicated as a function result ( "Occ Bw Freq Offset" ) in the marker table.

Multiview 22 Spectrum
Ref Level 0.0( RBW 100 kHz
Att dB ® SWT 1 ms(~12 ms) VBW 1MHz Mode FFT
1 Occupied Bandwidth e 1Rm
MI1[1] -46, m,
2.09975000 GHz,

1001 pts 1.0 MHz/ Span 10.0 MHz

2 Marker Table
Type "Ref "Trc Function Function Result
M1 4.181448168 MH:z
T1 00
T2

Remote command:

The determined occupied bandwidth can also be queried using the remote command
CALC:MARK:FUNC:POW:RES? OBW Or CALC:MARK:FUNC:POW:RES? AOBW. While
the oBwW parameter returns only the occupied bandwidth, the AOBW parameter also
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returns the position and level of the temporary markers T1 and T2 used to calculate the
occupied bandwidth.

CALC:MARK:FUNC:POW:SEL OBW, see CALCulate<n>:MARKer<m>:FUNCtion:
POWer<sb>:SELect on page 678

CALCulate<n>:MARKer<m>:FUNCtion:POWer<sb>[:STATe] on page 678

CALC:MARK:FUNC:POW:RES? OBW, see CALCulate<n>:MARKer<m>:FUNCtion:
POWer<sb>:RESult? on page 676

CALC:MARK:FUNC:POW:RES? COBW, see CALCulate<n>:MARKer<m>:FUNCtion:
POWer<sb>:RESult? on page 676

10.4.2.3 OBW Configuration

Access: "Overview" > "Select Measurement" > "OBW" > "OBW Config"
it

- OBW Settings

X

2% Power Bandwidth 99,0 %

Channel Bandwidth 14,0 kHz

Adjust Settings

r Search Limits

LeftLimit  [] 0.0 Hz
Right Limit [| 26.5 GHz

Search Limits Off

This measurement is not available in zero span.

(D Configuring search limits for OBW measurement

The OBW measurement uses the same search limits as defined for marker search
(see " Search Limits " on page 402). However, only the left and right limits are consid-
ered.

The remote commands required to perform these tasks are described in Chap-
ter 13.6.3.2, "Measuring the Occupied Bandwidth", on page 690.
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% Power Bandwidth
Defines the percentage of total power in the displayed frequency range which defines
the occupied bandwidth. Values from 10 % to 99.9 % are allowed.

Remote command:
[SENSe: ] POWer :BANDwidth on page 691

Channel Bandwidth

Defines the channel bandwidth for the transmission channel in single-carrier measure-
ments. This bandwidth is used to optimize the test parameters (for details see " Adjust
Settings " on page 297). The default setting is 14 kHz.

For measurements according to a specific transmission standard, define the bandwidth
specified by the standard for the transmission channel.

For multicarrier measurements, this setting is irrelevant.

Remote command:
[SENSe: ] POWer:ACHannel : BANDwidth [ :CHANnel<ch>] on page 647

Adjust Settings
Optimizes the instrument settings for the measurement of the occupied bandwidth
according to the specified channel bandwidth.

This function is only useful for single carrier measurements.
All instrument settings relevant for power measurement within a specific frequency
range are optimized:

® Frequency span: 3 x channel bandwidth
e RBW < 1/40 of channel bandwidth

e \VBW =3 x RBW

® Detector: RMS

The reference level is not affected by "Adjust Settings" . For an optimum dynamic
range,select the reference level such that the signal maximum is close to the reference
level.

See "Amplitude" > Reference Level .

The adjustment is carried out only once. If necessary, the instrument settings can be
changed later.

Remote command:
[SENSe: ] POWer:ACHannel : PRESet on page 660

Search Limits ( Left / Right )

If activated, limit lines are defined and displayed for the search. Only results within the
limited search range are considered.
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Remote command:
CALCulate<n>:MARKer<m>:X:SLIMits[:STATe] on page 777
CALCulate<n>:MARKer<m>:X:SLIMits:LEFT on page 778
CALCulate<n>:MARKer<m>:X:SLIMits:RIGHt on page 778

Deactivating All Search Limits
Deactivates the search range limits.

Remote command:
CALCulate<n>:MARKer<m>:X:SLIMits[:STATe] on page 777
CALCulate<n>:THReshold:STATe on page 780

10.4.2.4 How to Determine the Occupied Bandwidth

The following step-by-step instructions demonstrate how to determine the occupied
bandwidth.

O For remote operation, see "Programming Example: OBW Measurement" on page 691.

How to determine the OBW for a single signal
1. Select "Meas Setup" > "Select Measurement" .

2. Select the "OBW" measurement function.

The measurement is started immediately with the default settings.

3. Select "Meas Setup" > "OBW Config" .
The "Occupied Bandwidth" configuration dialog box is displayed.

4. Define the percentage of power ( "% Power Bandwidth" ) that defines the band-
width to be determined.

5. If necessary, change the channel bandwidth for the transmission channel.

6. To optimize the settings for the selected channel configuration, select "Adjust Set-
tings" .

7. Start a sweep.

The result is displayed as OBW in the marker results.

How to determine the OBW for a multicarrier signal using search limits
1. Select "Meas Setup" > "Select Measurement" .

2. Select the "OBW" measurement function.

3. Select "Meas Setup" > "OBW Config" .
4

Define the percentage of power ( "% Power Bandwidth" ) that defines the band-
width to be determined.

5. Define search limits so the search area contains only the first carrier signal:
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a) Enter values for the left or right limits, or both.
b) Enable the use of the required limits.

6. Start a sweep.

The result for the first carrier is displayed as OBW in the marker results.

7. Change the search limits so the search area contains the next carrier signal as
described in step 5.

The OBW is recalculated and the result for the next carrier is displayed. A new
sweep is not necessary!

8. Continue in this way until all carriers have been measured.

10.4.2.5 Measurement Example

In the following example, the bandwidth that occupies 99 % of the total power of a PDC
signal at 800 MHz, level 0 dBm is measured.

O A programming example demonstrating an OBW measurement in a remote environ-
= ment is provided in "Programming Example: OBW Measurement" on page 691.

1. Set up a basic measurement with instrument input in the R&S VSE as described in
"Programming Example: OBW Measurement" on page 691.

Set the "Center Frequency" to 800 MHz.

Set the "Reference Level" to -10 dBm.

Select "Meas Setup” > "Select Measurement" .

Select the "OBW" measurement function.

Select "Meas Setup" > "OBW Config" .

Set the "% Power Bandwidth" to 99 %.

Set the "Channel Bandwidth" to 271 kHz as specified by the PDC standard.

© ©®© N o o ~ 0 DN

Optimize the settings for the selected channel configuration by selecting "Adjust
Settings" .

10. Adjust the reference level to the measured total power by selecting "Auto Level” in
the toolbar.

11. The PDC standard requires the peak detector for OBW measurement. In the
"Traces" configuration dialog, set the trace detector to "PositivePeak" .

12. Start a sweep.

The result is displayed as OBW in the marker results.
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Spectrum Emission Mask (SEM) Measurement

Spectrum Emission Mask (SEM) measurements monitor compliance with a spectral
mask.

o  AboUt the MeasSUreMENT.........coeviiiiii e 300
L I Y/ o1 Toz= 1IN o] o] [ o7= 1 1 o] o F= TSRS 300
@ SEM RESUIS ..ot e e e e e e aaaaaaaeaees 301
@ SEM BaSICS....oiiiiiii i ——————————— 304
®  SEM CONfiQUratioN....c..coiuieiiiiiiiiei ettt 313
e How to Perform a Spectrum Emission Mask Measurement................ccccceevvvvnennns 328
e Measurement Example: Multi-SEM Measurement...........cccccceeeeeeeeeeeeccccnvvevneenenn. 333
e Reference: SEM File DesCriptionS.........cuuuiuiuiuiiiiiiiiiiiie e eeee e 334

About the Measurement

The Spectrum Emission Mask (SEM) measurement defines a measurement that moni-
tors compliance with a spectral mask. The mask is defined with reference to the input
signal power. The R&S VSE allows for a flexible definition of all parameters in the SEM
measurement. The R&S VSE software performs a measurement on the connected
instrument, then calculates an FFT sweep from the captured data.

Spectrum emissions can be measured for multiple sub blocks of channels, where the
sub blocks can include gaps or overlap, and define separate masks. Radio signals
using multiple standards can also be analyzed.

SEM measurement configurations can be saved to an XML file which can then be
exported to another application or loaded on the R&S VSE again later. Some prede-
fined XML files are provided that contain ranges and parameters according to the
selected standard.

To improve the performance of the R&S VSE for spectrum emission mask measure-
ments, a "Fast SEM" mode is available.

A special limit check for SEM measurements allows for monitoring compliance of the
spectrum.

Typical Applications

Spectrum Emission Mask measurements are typically performed to ensure that modu-
lated signals remain within the valid signal level ranges. These ranges are defined by a
particular transmission standard, both in the transmission channel and neighboring
channels. Any violations of the mask can interfere with other transmissions.

The 3GPP TS 34.122 standard, for example, defines a mask for emissions outside the
transmission channel. This mask is defined relative to the input signal power. Three
frequency ranges to each side of the transmission channel are defined.
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10.4.3.3 SEM Results

As a result of the Spectrum Emission Mask measurement, the following results are dis-
played in a diagram (see also "Limit Lines in SEM Measurements" on page 306):

® The measured signal levels

® The result of the limit check (mask monitoring)

® The defined limit lines

e TX channel power "P"

® The used power class

@ Multi-SEM measurements
Multi-SEM measurements are SEM measurements with more than one sub block. In
these measurements, each sub block has its own power class definitions. In this case,
the power class is not indicated in the graphical result displays.

Example:

For example, in Figure 10-32, "31 < P < 39" is indicated as the used power class is
defined from 31 to 39.

MultiView  Spectrum
Ref Level 41,00 dBm Offset 40.00 dB Mode

1 Spectrum Emission Mask

LT I T Ty TR T ST TP

w
x Bandwidth AHz RBW 1.000 MHz

Frequency Power Abs Power Rel AlLimit

2.09153 GHz =-39.37 dBm -73.11 dB -18.61 dB
2.09494 GHz -39.75 dBm -73.48 dB -22.98 dB
2.09642 GHz -50.91 dBm -84.65 dB -21.15 dB
2.09652 GHz -51.84 dBm -85.57 dB -22.65 dB
2.09739 GHz -52.33 dBm -86.07 dB -34.57 dB
2.10259 GHz -49,37 dBm -83.11 dB -31.61 dB
2.10342 GHz -50.68 dBm -84.42 dB -22.27 dB
2.10373 GHz -51.81 dBm -85.55 dB -22.05 dB
2.10439 GHz -38.64 dBm -72.37 dB -21.87 dB
2.11026 GHz -39.24 dBm -72.97 dB -18.47 dB

Figure 10-32: Spectrum Emission Mask result displays

In addition to the graphical results of the SEM measurement displayed in the diagram,
a result summary is displayed to evaluate the limit check results (see also "Limit Lines
in SEM Measurements" on page 306).

The following information is provided in the result summary:
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Label

Description

General information

"Standard"

Loaded standard settings

"Tx Power"

Power of the reference range

"Tx Bandwidth"

Tx bandwidth used by the reference range

"RBW"

RBW used by the reference range

Range results

"Range Low"

Start of the frequency range the peak value was found in

"Range Up"

Frequency range end the peak value was found in

"RBW"

RBW of the range

"Frequency"”

Frequency of the peak power level

"Power Abs"

Absolute peak power level within the range

"Power Rel"

Peak power level within the range, relative to the "Tx Power"

"ALimit"

Deviation of the peak power level from the limit line

You can define in which detail the data is displayed in the result summary in the "List
Evaluation” settings (see "List Evaluation (Results Configuration)" on page 327). By
default, one peak per range is displayed. However, you can change the settings to dis-
play only peaks that exceed a threshold ( "Margin" ).

Detected peaks are not only listed in the Result Summary, they are also indicated by
colored squares in the diagram (optionally, see Show Peaks in the "List Evaluation"

settings).

1 Spectrum Emission Mask

il bt bl p iy sty

CF 2.1 GHz

l|'J“h""|""|'-||.|'|.|""--"""""|'h"|I'"l""r._.‘ |.

I
| 1

‘ A any

||11.1..,-_,.I|".‘u ||-"..||.|'J|'.-,l|||

1001 pts 2.55 MHz/

Figure 10-33: Detected peak display in SEM measurement

User Manual 1176.8839.02 — 14

302




R&S®VSE 1/Q Analyzer Measurements

RF Measurement Configuration

Furthermore, you can export the results of the result summary to a file which can be
exported to another application for further analysis.

Results for SEM with multiple sub blocks

In the Spectrum application only, spectrum emissions can be measured for multiple

sub blocks of channels (see "SEM with Multiple Sub Blocks ("Multi-SEM")"

on page 310 for details). Up to 3 sub blocks (with 2 gaps) can be defined. For each

sub block and each gap, the results described above are provided individually in the
result summary.

1 Spectrum Emission Mask o 1Rm Clrw

I-"\lllh"lll'"|r|'1|'r'.II"‘,P]-'I-'Ilr.'.|"-|'|.']-'q}n,|‘r|"'r..|'||’|1'

L e
‘wﬂ""“l“-"-1'W.¥F'M'M“Wf-'ﬂ-'r I 1 | W ! IMW " A liﬂM-m‘v;-'Ll‘~'u'i'.'-"'*W-l\'l'-'ﬂ"1'r-1-'ﬂ'
\J"r-.'-‘uﬂll."lw Il r!\l.ﬂr'n
CF MHz 3001 pts 2.55 MHz/ Span 25.5 MHz

2 Result Summary
Sub Block A 900.00 MHz Tx Power 23.51 dBm RBW 30.000 kHz
width 3.840 M MNone
>MICY C \bs Power Rel ALimit
. 8 MHz -34.4 Bm -57.95 dB -22.94 dB
896.14890 MHz -47.37 dBm -70.88 dB -22.87 dB
896.65096 MHz -49.41 dBm -72.92 dB -27.40 dB
897.39370 MHz -50.91 dBm -74.42 dB -38.41 dB
Gap of sub block:
ange Low Frequency Power Abs Power Rel ALimit
Hz = 30 1 902.70196 MHz -50.62 dBm -74.13 dB -38.38 dB
00 902.92839 MHz -50.31 dBm -73.82 dB -35.18 dB
903.33976 MHz -232.52 dBm -47.03 dB -6.24 dB
903.59774 MH:z -20.99 dBm -44.50 dB -6.21 dB
903.81543 MHz =20.35 dBm -43.86 dB -8.11 dB
Tx Power n RBW 30.000 kHz
Tx Bandwidth 3,84 MNone
Frequency Power Abs Power Rel ALimit
909.06283 MHz =15.51 dBm -38.54 dB -3.01 dB
909.34691 MHz =-19.93 dBm -42.96 dB -5.45dB
910.02776 MHz -49.22 dBm -72.25 dB -24.72 dB
911.94088 MHz -33.58 dBm -56.61 dB -22.08 dB

Figure 10-34: SEM results for multiple sub blocks

Retrieving results via remote control

The measurement results of the spectrum emission mask test can be retrieved using
the CALC:LIM:FAIL? command from a remote computer; see CALCulate<n>:
LIMit<1li>:FAIL? on page 814 for a detailed description.

The power result for the reference range can be queried using
CALC:MARK:FUNC:POW:RES? CPOW,

The peak power for the reference range can be queried using
CALC:MARK:FUNC:POW:RES? PPOW, see CALCulate<n>:MARKer<m>:FUNCtion:
POWer<sb>:RESult? on page 676.

The measured power trace can be queried using TRAC: DATA? and TRAC:DATA:X?,
see TRACe<n>[:DATA] ? on page 823 and TRACe<n>[ :DATA] : X? on page 825:

The measured peak power list can be queried using TRAC:DATA? LIST, see
TRACe<n>[:DATA] ? on page 823.
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SEM Basics

Some background knowledge on basic terms and principles used in SEM measure-
ments is provided here for a better understanding of the required configuration set-
tings.

e Ranges and Range SettingS.......oooiiiiiiiiiiiiiiccccccce e 304
e LimitLines in SEM Measurements.........ccovuviuiiiiiiiiiiiiiie e ee e 306
o Fast SEM MeasUremMeENtS.......ooe it e e e e e e e e eeeeeas 308
e Multi-Standard Radio (MSR) SEM Measurements..........cccoicuveeeeiiiiieeeeniiieeeee e 309
e SEM with Multiple Sub Blocks ("Multi-SEM")..........uuuiimiiiiiiiiee e 310

Ranges and Range Settings

In the Spectrum Emission Mask measurements, a range defines a segment for which
you can define the following parameters separately:

e Start and stop frequency
e RBW

e VBW

® "Meas Time"

® "Capture Points"

® Limit values

Via the capture list, you define the ranges and their settings. For details on settings,
refer to " Sweep List " on page 314.

For details on defining the limits (masks), see "Limit Lines in SEM Measurements"
on page 306.

Range definition

After a preset, the capture list contains a set of default ranges and parameters. For
each range, you can change the parameters listed above. You can insert or delete
ranges.

The changes of the capture list are only kept until you load another parameter set (by
pressing [PRESET] or by loading an XML file). If you want a parameter set to be avail-
able permanently, create an XML file for this configuration (for details refer to "How to
save a user-defined SEM settings file" on page 332).

If you load one of the provided XML files, the capture list contains ranges and parame-
ters according to the selected standard.

Reference range

The range containing the center frequency is defined as the reference range for all
other ranges in the capture list. All range limits are defined in relation to the reference
range. The TX power used as a reference for all power level results in the result sum-
mary is also calculated for this reference range. You can define whether the power
used for reference is the peak power level or the integrated power of the reference
range. In the "Sweep List" , the reference range is highlighted in blue and cannot be
deleted.
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Rules

The following rules apply to ranges:

® The minimum span of a range is 20 Hz.

® The individual ranges must not overlap (but can have gaps).
® The maximum number of ranges is 30.

® The minimum number of ranges is 3.

® The reference range cannot be deleted.

® Center the reference range on the center frequency.

® The current "Tx Bandwidth" defines the minimum span of the reference range (see
" Channel Power Settings " on page 320).

® Define frequency values for each range relative to the center frequency.

To change the start frequency of the first range or the stop frequency of the last range,
select the appropriate span with the [SPAN] key. You can define a span that is smaller
than the combined span of all ranges. In this case, the measurement includes only the
ranges that lie within the defined span and have a minimum span of 20 Hz. The first
and last ranges are adapted to the given span as long as the minimum span of 20 Hz
is not violated.

@ Changing the frequency range of the measurement

If you change the used frequency range of the measurement, for example by changing
the input file or instrument providing the data, the R&S VSE maintains the configured
span. Only if the span is larger than the available frequency range, the span is
reduced. In this case, the ranges for the SEM measurement can change, as well.

Capture points

You can define a minimum number of capture points for each range. The total number
of available capture points is then distributed among the ranges in consideration of the
minimum values. If the total number of capture points is not enough to satisfy the mini-
mum capture point requirements in all ranges, the R&S VSE adjusts the global number
of Capture Points accordingly. By default, each range has a minimum of one capture
point.

This allows you to increase the resolution within a specific range for detailed analysis.
You do not have to increase the overall number of capture points and thus the mea-
surement time for the SEM measurement.

Symmetrical ranges

You can easily define a capture list with symmetrical range settings, i.e. the ranges to
the left and right of the reference range are defined symmetrically. When symmetrical
setup is activated, the current capture list configuration is changed to define a symmet-
rical setup regarding the reference range. The number of ranges to the left of the refer-
ence range is reflected to the right, i.e. any missing ranges on the right are inserted,
while superfluous ranges are removed. The values in the ranges to the right of the ref-
erence range are adapted symmetrically to those in the left ranges.
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Symmetrical ranges fulfill the conditions required for "Fast SEM" mode (see "Fast SEM
Measurements" on page 308).

Power classes

If the signal power level to be monitored varies and the limits vary accordingly, you can
define power classes, which can then be assigned to the frequency ranges. Thus, the
limits for the signal levels can be defined differently for varying input levels. For
instance, for higher input levels a transmission standard can allow for higher power lev-
els in adjacent channels, whereas for lower input levels the allowed deviation can be
stricter. Up to four different power classes can be defined.

Limit Lines in SEM Measurements

For the R&S VSE, the spectrum emission mask is defined using limit lines. Limit lines
allow you to check the measured data (that is, the trace results) against specified limit
values. Generally, it is possible to define limit lines for any measurement in the 1/Q
Analyzer application using the [Lines] function. For SEM measurements, however, spe-
cial limit lines are available via the "Sweep List" , and it is strongly recommended that
you use only these limit line definitions.

In the "Sweep List" , you can define a limit line for each power class that varies its level
according to the specified frequency ranges. Special limit lines are automatically
defined for each power class according to the current "Sweep List" settings every time
the settings change. These limit lines are labeled " SEM_LINE_<xxx>_ ABS<0...3>"
and "_SEM_LINE_<xxx>_REL<0...3>" , where <xxx> is an index to distinguish limit
lines between different channels.

The limit line defined for the currently used power class is indicated by a red line in the
display. The result of the limit check is indicated at the top of the diagram. Note that
only "Pass" or "Fail" is indicated; a "Margin" function as for general limit lines is not
available.

MultiView  Spectrum
Ref Level 41,00 dBm  Offset 40,00 dB Mode A

1 Spectrum Emission Mask o 1Rm Clrw

I'x Bandwidth 3.840 MHz RBW 1.000 MH

Frequency Power Abs Power Rel ALimit

2.09053 GHz -40.68 dBm -71.22 dB -17.18 dB
2.09268 GHz -40.13 dBm -70.67 dB -20.63 dB
2.09647 GHz -52.60 dBm -83.14 dB -20.10 dB
2.09652 GHz -54.30 dBm -84.84 dB -22.38 dB
2.09728 GHz -51.51 dBm -82.05 dB -31.01 dB
2.10270 GHz -54.13 dBm -84.67 dB -33.63 dB

2.10355 GHz -51.94 dBm -82.48 dB -19.44 dB
2.10725 GHz -40.01 dBm -70.55 dB -20.51 dB
2.10911 GHz -40.28 dBm -70.82 dB -16.78 dB
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The indicated limit line depends on the settings in the "Sweep List" . Several types of
limit checks are possible:

Table 10-4: Limit check types

Limit check type

Pass/fail criteria

Limit line definition

"Absolute"

Absolute power levels must not
exceed limit line

Defined by the "Abs Limit Start" / "Abs Limit
Stop" values for each range

"Relative"

Power deviations relative to the TX
channel power must not exceed limit
line

Defined by the "Rel Limit Start" / "Rel Limit
Stop" values (relative to the TX channel
power), fixed for each range.

"Relative with
function f(x)"

If the power exceeds both the abso-
lute and the relative limits, the check
fails (see Relative limit line functions
below)

Defined by the maximum of the absolute or
relative start and stop limit values for each
range. Thus, the start or stop point of the limit
range, or both, are variable (since the maxi-
mum can vary).

"Abs and Rel"

If the power exceeds both the abso-
lute and the relative limits, the check
fails.

The less strict (higher) limit line is displayed
for each range.

If you use a function to define the relative limit
start or stop value, the signal is checked
against an additional condition: the power
must exceed the absolute limit, as well as the
absolute and relative function values.

"Abs or Rel"

If the power exceeds either the
absolute or the relative limits, the
check fails.

The stricter (lower) limit line is displayed for
each range.

If you use a function to define the relative limit
start or stop value, the signal is checked
against an additional condition: if the power
exceeds the absolute limit, or the higher of the
absolute and relative function values, the
check fails.

Relative limit line functions

A new function allows you to define limit lines whose start or end points (or both) are
variable, depending on the carrier power. Thus, the resulting limit line can change its
slope within the range, depending on the carrier power. Common relative limit lines are
calculated once for the defined start and end points and maintain a constant slope.

If the relative limit value function is used in combination with the "Abs and Rel" or "Abs
or Rel" limit check types, an additional condition is considered for the limit check (see

Table 10-4).

Limit check results in the result summary

For each range, the peak measured value and the deviation of these values from the
limit line are displayed in the result summary. If the limit check is passed for the range,
the deviation represents the closest value to the limit line. If the limit check is passed
for the range, the deviation represents the closest value to the limit line. If the limit
check for the range fails, the deviation represents the maximum violation against the
limit line. Furthermore, the absolute power levels and the relative deviation of the
peaks from the TX channel power are displayed. Values that exceed the limit are indi-
cated in red and by an asterisk (*).
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Tx Bandwidth 3.840 MHz

Frequency Towe [ ALimit

O Although a margin functionality is not available for the limit check, a margin (threshold)
= for the peak values to be displayed in the Result Summary can be defined. (In the "List
Evaluation" settings, see "List Evaluation (Results Configuration)" on page 327).

Fast SEM Measurements

To improve the performance of the R&S VSE for spectrum emission mask measure-
ments, a "Fast SEM" mode is available. If this mode is activated, several consecutive
ranges with identical capture settings are combined to one capture internally, which
makes the measurement considerably faster. The displayed results remain unchanged
and still consist of several ranges. Thus, measurement settings that apply only to the
results, such as limits, can nevertheless be defined individually for each range.

Prerequisites

"Fast SEM" mode is available if the following criteria apply:
® The frequency ranges are consecutive, without frequency gaps

® The following capture settings are identical (for details see " Sweep List "
on page 314):

— "Filter Type"

- "RBW"

- "VBW"

— "Sweep Time Mode"

Activating Fast SEM mode

"Fast SEM" mode is activated in the capture list (see " Sweep List " on page 314) or
using a remote command. Activating the mode for one range automatically activates it
for all ranges in the capture list.

Remote command:

[SENSe: ]ESPectrum<sb>:HSPeed on page 697

@ Fast SEM not supported for multiple sub blocks

For SEM with multiple sub blocks, fast SEM is not available. If more than one sub
block is defined and a standard is loaded which contains an active fast SEM setting,
this setting is disabled.

For more information on multi-SEM measurements, see "SEM with Multiple Sub Blocks
("Multi-SEM")" on page 310.
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Consequences

When the "Fast SEM" mode is activated, the ranges for which these criteria apply are
displayed as one single range. The capture time is defined as the sum of the individual
capture times, initially, but can be changed.

If "Symmetrical Setup" mode is active when "Fast SEM" mode is activated, not all cap-
ture list settings can be configured symmetrically automatically (see also " Symmetrical
Setup " on page 318).

Any other changes to the capture settings of the combined range are applied to each
included range and remain changed even after deactivating "Fast SEM" mode.

Example

Range 1 |Range
-13.25 GHz -12.75 MHz B

-12.75 MHz -2.515 MH3

on on

Mormal{3... Channel
3 MHz 30 kHz
3 MHz - 3 MHz
27.5 ms = 37.5ms
0 dBm . = 0 dBm
Auto - Auto

RF Attenuator 10 dB 10 dB

Transducer | None MNone MNone None MNone
| Relative Relative Relative Relative Relative
Abs Limit Start 1 13 dBm 13 dBm 13 dBm 13 dBm 13 diém

Abs Limit Stop 1 13 dBm 13 dBm 13 dBm 13 dBm 13 dBm

Rel Limit Start 1 | -50 dBc -50 dBc 300 dBc -50 dBc -50 dic

-50 dBc -50 dBc 300 dBc -50 dBc -50 dic

Symetrical Setup

Figure 10-35: Capture list using Fast SEM mode

In Figure 10-35, a capture list is shown for which Fast SEM is activated. The formerly
five separately defined ranges are combined to two capture ranges internally.

Multi-Standard Radio (MSR) SEM Measurements

Multi-standard radio (MSR) measurements allow you to perform SEM tests on signals
with multiple carriers using different digital standards. MSR measurements are descri-
bed in the specification 3GPP TS 37.141. Various typical combinations of standards for
base station tests are described, e.g. LTE FDD and W-CDMA carriers. By performing
an MSR SEM measurement you can determine if or how the different carriers affect
each other, i.e. if unwanted emissions occur. On the R&S VSE, the MSR SEM mea-
surement is a standard measurement as for single carriers. The MSR settings merely
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provide a convenient way of configuring the capture list for all required ranges accord-
ing to the specification quickly.

Refined settings allow the R&S VSE to calculate the SEM limits according to standard
3GPP 37.141 V12.2.0, which distinguishes between base station configurations and
power values.

SEM with Multiple Sub Blocks ("Multi-SEM")

In the 1/Q Analyzer application only, spectrum emissions can be measured for multiple
sub blocks of channels (also referred to as a "Multi-SEM" measurement). Sub blocks
are a set of multiple ranges around a defined center frequency (carrier). Multiple sub
blocks can include gaps or overlap, and each sub block defines a separate mask. In
the overlapping masks, multi-limit lines are calculated. Up to 3 sub blocks (with 2 gaps)
can be defined. For each sub block, the familiar configuration settings concerning
ranges, limit lines etc. can be defined individually.

Comparison to "traditional” SEM measurement

The default SEM measurement is simply a special case of "Multi-SEM" - consisting of
one single block. Only if the number of sub blocks in the basic SEM configuration is
larger than 1, multiple sub blocks are inserted in the configuration settings and result
tables.

Particular features of configuring multiple sub blocks

The sub blocks are independent of the global start, stop, center and span frequencies
for the complete SEM measurement. Thus, there can be gaps that can even include
other carrier ranges, but are not configured for the SEM measurement.

For each sub block, you define:

® The center frequency of the reference range of the sub block; center frequencies
must be defined in ascending order for sub blocks A,B,C

® The reference range; note that although individual ranges of different sub blocks
can overlap, reference ranges for different sub blocks cannot; they must define dis-
tinct frequency ranges

® The capture list, including the limit lines

® Optionally: a standard file or MSR settings to be used for measurement (if one is
selected, the other is disabled)

@ Fast SEM not supported for multiple sub blocks

For SEM with multiple sub blocks, fast SEM is not available. If more than one sub
block is defined and a standard is loaded which contains an active fast SEM setting,
this setting is disabled.

Absolute vs relative frequencies

In the default configuration with only one sub block, frequencies are defined relative to
the center frequency; this is the familiar configuration.
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For setups with more than one sub block, frequencies are defined relative to the center
frequency of the reference ranges for the individual sub blocks. However, in the result
summary, frequencies are indicated as absolute values. Relative frequencies that refer
to different reference ranges would be inconvenient and difficult to analyze.

Limit check behavior for overlapping masks

Since spectrum emission masks are defined individually for each sub block, and sub
blocks can overlap, the question arises what happens during the limit check in the
overlapping regions? To answer this question, we must distinguish the following cases:

® For the reference range, no limit checking is performed, as the reference range
contains the carrier

® For other ranges, only the limit lines defined for ranges between the carriers, that is
the reference ranges to either side, are significant. In other words: if a limit line def-
inition covers the frequency area of several carriers, only the limit lines for ranges
between the corresponding reference range and the next closest reference range
are significant.

ignificant

i G
ant

Figure 10-36: Behavior for overlapping masks

® For the ranges in which multiple limit lines are significant, a range-specific function
determines the behavior of the limit check

Limit calculation for individual ranges
For each range a function can be defined that determines the behavior of the limit
check if there are multiple limit lines:

® "NONE" : In reference ranges no limit check is performed;
Reference ranges always use the function "NONE" .
For other ranges, see the combinations for overlapping ranges below.

e "SUM" : sum of the two limit lines (calculated for linear powers) is used
e "MAX" : maximum of the two limit lines is used

This leads to the following combinations for overlapping ranges:

e "MAX" + "MAX" : maximum of the two limit lines is used
e "MAX" + "SUM" : maximum of the two limit lines is used
e "SUM" + "SUM" : sum of the two limit lines (calculated for linear powers) is used

e "NONE" + "MAX" / "NONE" + "SUM" : limit line (and parameters) of the "NONE"
range are ignored

® "NONE" + "NONE" : depends on the position of the overlapping ranges in relation
to the mid-frequency between the two neighboring sub blocks:
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— Overlap is completely below the mid-frequency: limits and parameters of the
left sub block are used

— Overlap is completely above the mid-frequency: limits and parameters of the
right sub block are used

— Overlap crosses the mid-frequency: new subranges are created: one to the left
of the mid-frequency, one to the right of the mid-frequency. The left subrange
uses the limits and parameters of the left sub block, the right subrange uses
the limits and parameters of the right sub block.

@ Different RBWs in overlapping ranges

If different RBWs are defined for the overlapping ranges, the following parameters from
the range with the smaller RBW are considered for both ranges:

e RBW

® Filter type

® (proportional) capture time

In the range with the higher RBW, the following offset is applied to the limit line:
-10"1og(RBW zyge / RBW;pmay)

Table 10-5: Limit lines in overlapping ranges crossing the mid-frequency

Mid-frequency Mid-frequency
Sub SB1-SB2  Sub | SB1-SB2  Sub
block 1} ‘ iblock 2 ; iblock 2
N
i i i
TX1 | TX2 ™14 | TX2
| ; J
1 I 1
| ; |
1 I 1
I 1 / i
| I / |
! ; |
1 I / 1
| / !
! ! /& !
1 {\ .‘I‘/ %I
Initial situation: overlapping ranges Result: Subranges 4a and 5a are created left and right of the
Range 4 ("None") + Range 5 ("None") overlap and cross the mid-frequency;
mid-frequency between sub blocks 1 and 2 For subrange 4a: limit line and parameters of range 4 apply
For subrange 5a: limit line and parameters of range 5 apply

Global SEM limit check

For the complete SEM measurement, which can consist of multiple sub blocks, only
one single limit check is performed. A single limit line is calculated according to the
individual range limit lines and the defined functions for overlapping ranges. The mea-
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sured values are then compared with this single limit line. If the limit is exceeded in any
range, the result of the limit check is . " failed!"

1 Spectrum Emission Mask ¢ 1Rm Clrw

r\'[i “Uﬁiﬁ“mlr\l'“l|]lM ’r’w‘l[’l\l}lﬂ( ll:\|r'.l'|['ﬂ"{||-'|}['il|‘.|l\l-

I
” 1-\ ’ |
‘ I

ki o T
i | mu'ﬁln.ﬁw' L i

CF 903.25 MHz 3001 pts N Span 25.5 MHz

Figure 10-37: Summarized limit line for multiple sub blocks

SEM Configuration

Access: "Overview" > "Select Measurement" > "Spectrum Emission Mask"
The SEM measurement is started immediately with the default settings.

The remote commands required to perform these tasks are described in Chap-
ter 13.6.3.3, "Measuring the Spectrum Emission Mask", on page 693.

Global span settings

The span of the signal to be monitored is configured in the general span settings (see
Chapter 10.4.5, "Frequency and Span Settings", on page 345). Only ranges within this
global span are considered for the SEM measurement.

Multi-SEM configuration

In the 1/Q Analyzer application only, spectrum emissions can be measured for multiple
sub blocks of channels (see "SEM with Multiple Sub Blocks ("Multi-SEM")"

on page 310). Up to 3 sub blocks (with 2 gaps) can be defined. For each sub block, the
familiar configuration settings concerning ranges, limit lines etc. can be defined in indi-
vidual tabs. In addition, settings on the sub blocks themselves must be configured in
the "Sub Block " tab of the "Spectrum Emission Mask" configuration dialog box (see
"Multi-SEM (Sub Block) Settings " on page 318).

The following settings are available in individual tabs of the "Spectrum Emission Mask"
configuration dialog box.

User Manual 1176.8839.02 — 14 313



R&S®VSE 1/Q Analyzer Measurements

RF Measurement Configuration

@ SWEEP LSt oottt e e e e e e e ————— 314
e  Multi-SEM (Sub BIOCK) SEttiNgS ..ccccviviiiieiiiiiii ettt 318
@ ReferenCe RaANQGE......c e 320
@ POWET ClASSES..uuuuiiieii i et e e e e e e e e e e e e e e e e e e e e e e e e eeeeaersba b aaaaanan 321
® ISR SEtINGS. . ututiiiiiiiiiie et e e e e e e e e e s e e e e e e e e e aannrnes 322
O StANAard Files......ooo e 325
e List Evaluation (Results Configuration)...........coouiiiiiiiiiiiciiiiieie e, 327

Sweep List

Access: "Overview" > "Select Measurement" > "Spectrum Emission Mask" > "Sweep
List"

For SEM measurements, the R&S VSE software captures data from the connected
instrument once, then performs FFTs sweeps and calculates the SEM for each range
individually.

If you edit the capture list, always follow the rules and consider the limitations descri-
bed in "Ranges and Range Settings" on page 304.

Sweep List Subblocks Reference Range Power Classes MSR Settings

Range 2 Range 3
Block A  [:PRRET 12,75 MHz EFRIERTIIFY 2.515 MKz

Range Stop -2,515 MHz IEES RN [IF 12.75 MHz
Sub

Filter Type P Mormal(3...
Block B [

RBW 30 kHz
sub VBW 3 MHz
Block C [EMEE FEYTRRE Auto

Sweep Time 140 ps

Ref Level o dBm

RF Att Mode Auto

RF Attenuation 10 dB
Preamp o o

Transducer None None
Multi Limit Calc SUM NONE

Relative Relative

50 dBC 300 dBg

Insert

Range Start / Range S0P ....cooiiiiiiiiiiiie e 315
= S ] ! 1Y SRR 315
10T Y/ o= S PSP PP PPURPPPPPP 315
= SR 315
LY PSP 315
V= T=T o B T =01, o T = RSP 316
Y L= TS T = PR PRR 316
Limit CheCK SN> ..t e e e e e e e e e e e e e s e 316
Abs Limit Start / STOP SN> ... 316
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Rel Limit Start / StOp N> o 316
MUulti-Limit CalC SN> ... e e e e e e e e e e e e e e e e e e eannns 317
Min SWEEP POINTS ... e e e e e s e s e e e e e e e e e e e e e nnnns 317
Insert before Range / Insert after RaNge ........ccuueeiiiiiiiiiiiiiic e 318
Delete RANGE ....cooeeeeeeeeeee et e et a e e e e e e e e e e e aeeaans 318
LT gToz= 1B T= (] o RN 318

Range Start / Range Stop
Sets the start frequency/stop frequency of the selected range.

To change the start/stop frequency of the first or last range, respectively, select the
appropriate span in the [SPAN] configuration dialog. You can set a span that is smaller
than the overall span of the ranges. In this case, the measurement includes only the
ranges that lie within the defined span and have a minimum span of 20 Hz. The first
and last ranges are adapted to the given span as long as the minimum span of 20 Hz
is not violated.

Define frequency values for each range relative to the center frequency. Center the ref-
erence range on the center frequency. The current "Tx Bandwidth" defines the mini-
mum span of the reference range (see " Channel Power Settings " on page 320).
Remote command:

[SENSe:]ESPectrum<sb>:RANGe<ri>[:FREQuency] :STARt on page 699
[SENSe: ]ESPectrum<sb>:RANGe<ri>[:FREQuency] :STOP on page 700

Fast SEM
Activates "Fast SEM" mode for all ranges in the capture list. For details, see "Fast SEM
Measurements" on page 308.

Note: If you deactivate "Fast SEM" mode while "Symmetrical Setup" mode is on,
"Symmetrical Setup" mode is automatically also deactivated.

If you activate "Fast SEM" mode while "Symmetrical Setup" mode is on, not all range
settings can be configured symmetrically automatically.

Remote command:
[SENSe: ]ESPectrum<sb>:HSPeed on page 697

Filter Type
Sets the filter type for this range.

For details on filter types, see "Which Data May Pass: Filter Types" on page 352.

Remote command:
[SENSe: ]ESPectrum<sb>:RANGe<ri>:FILTer:TYPE on page 699

RBW
Sets the resolution bandwidth for this range.

For details on the RBW, see "Separating Signals by Selecting an Appropriate Resolu-
tion Bandwidth" on page 349.

Remote command:
[SENSe: ]ESPectrum<sb>:RANGe<ri>:BANDwidth:RESolution on page 697

VBW
Sets the video bandwidth for this range.
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For details on the VBW, see "Smoothing the Trace Using the Video Bandwidth"
on page 349.

Remote command:
[SENSe: ] ESPectrum<sb>:RANGe<ri>:BANDwidth:VIDeo on page 698

Sweep Time Mode
Activates or deactivates the auto mode for the capture time.

For details on the capture time mode, see "How Long the Data is Measured: Meas
Time " on page 352

Remote command:

[SENSe: ]ESPectrum<sb>:RANGe<ri>:SWEep:TIME:AUTO on page 709

Meas Time
Sets the capture time value for the range.

For details on the capture time, see "How Long the Data is Measured: Meas Time "
on page 352

Remote command:
[SENSe: ]ESPectrum<sb>:RANGe<ri>:SWEep:TIME on page 708

Limit Check <n>
Sets the type of limit check for the n-th power class in the range. Up to four limits are
possible.

For details on limit checks, see "Limit Lines in SEM Measurements" on page 306.
The limit state affects the availability of all limit settings.

Remote command:
[SENSe: | ESPectrum<sb>:RANGe<ri>:1IMit<li>:STATe on page 706
CALCulate<n>:LIMit<1i>:FATIL? on page 814

Abs Limit Start / Stop <n>
Sets an absolute limit value for the n-th power class at the start or stop frequency of
the range [dBm].

Remote command:

[SENSe: ]ESPectrum<sb>:RANGe<ri>:LIMit<li>:ABSolute:STARt
on page 702

[SENSe: |ESPectrum<sb>:RANGe<ri>:LIMit<1li>:ABSolute:STOP
on page 702

Rel Limit Start / Stop <n>

Sets a relative limit value for the n-th power class at the start or stop frequency of the
range [dBc].

By default, this value is a fixed relative limit, i.e. no function is defined. To define a
function for the relative limit, select the input field for "Rel Limit Start" or "Rel Limit
Stop" and then the "f(x)" icon that appears.
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Rel Limit Start 1 -50 dB{:l Function for Limitpoint | }=|

Rel Limit Stop 1 -50 dBc

-50.0 dBc

[-13.0 dBm

If the function is set to "Max" , you can define a relative and an absolute limit level. In
this case, the maximum of the two values is used as the limit level.

For more information, see "Relative limit line functions" on page 307.

Remote command:

[SENSe: |ESPectrum<sb>:RANGe<ri>:LIMit<li>:RELative:STARt

on page 703

[SENSe: ]ESPectrum<sb>:RANGe<ri>:LIMit<li>:RELative:STOP

on page 705

[SENSe: ]ESPectrum<sb>:RANGe<ri>:LIMit<li>:RELative:STARt:
FUNCtion on page 704

[SENSe: |ESPectrum<sb>:RANGe<ri>:LIMit<li>:RELative:STOP:FUNCtion

on page 706

[SENSe: |ESPectrum<sb>:RANGe<ri>:LIMit<li>:RELative:STARt:ABS
on page 703
[SENSe:]ESPectrum<sb>:RANGe<ri>:LIMit<li>:RELative:STOP:ABS
on page 705

Multi-Limit Calc <n>

Defines the function used to calculate the limit line for the n-th power class for overlap-
ping ranges in Multi-SEM measurements. For details, see "Limit calculation for individ-
ual ranges" on page 311.

"NONE" (reference ranges only:) the limit of the reference range is used
"SUM" Sum of the two limit lines (calculated for linear powers) is used
"MAX" Maximum of the two limit lines is used

Remote command:
[SENSe: |ESPectrum<sb>:RANGe<ri>:MLCalc on page 707

Min Sweep Points
Defines the minimum number of capture points for the range.

If necessary to fulfill all minimum capture point requirements in all ranges, the global
Capture Points setting is increased. By default, each range is supplied with a minimum
of one capture point.

For details, see "Capture points" on page 305

Remote command:
[SENSe: ]ESPectrum<sb>:RANGe<ri>:POINts:MINimum[:VALue] on page 707
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Insert before Range / Insert after Range

Inserts a new range to the left (before) or to the right (after) of the range in which the
cursor is currently displayed. The range numbers of the currently focused range and all
higher ranges are increased accordingly. The maximum number of ranges is 30.

Remote command:
[SENSe: ]ESPectrum<sb>:RANGe<ri>:INSert on page 701

Delete Range

Deletes the currently focused range, if possible. (The reference range cannot be
deleted. A minimum of three ranges is required.) The range numbers are updated
accordingly.

Remote command:
[SENSe: ]ESPectrum<sb>:RANGe<ri>:DELete on page 698

Symmetrical Setup
Any changes to the range settings in active "Symmetrical Setup" mode lead to sym-
metrical changes in the other ranges (where possible). In particular, this means:

® |nserting ranges: a symmetrical range is inserted on the other side of the reference

range

® Deleting ranges: the symmetrical range on the other side of the reference range is
also deleted

® Editing range settings: the settings in the symmetrical range are adapted accord-
ingly

Note: If "Fast SEM" mode is deactivated while "Symmetrical Setup” mode is on, "Sym
Setup" mode is automatically also deactivated.

If "Fast SEM" mode is activated while "Symmetrical Setup" mode is on, not all range
settings can be set automatically.

Remote command:
[SENSe: ]ESPectrum<sb>:SSETup on page 710

Multi-SEM (Sub Block) Settings

Access: "Overview" > "Select Measurement" > "Spectrum Emission Mask" > "Sub
Blocks"

In the I/Q Analyzer application only, spectrum emissions can be measured for multiple
sub blocks of channels (see "SEM with Multiple Sub Blocks ("Multi-SEM")"

on page 310). Sub blocks are a set of multiple ranges around a defined center fre-
quency (carrier).

By default, a single sub block is assumed. If more than one sub blocks are defined,
additional tabs are inserted for each sub block in the individual tabs of the "Spectrum
Emission Mask" configuration dialog box.
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Sweep List Subblocks Reference Range Power Classes MSR Settings

-

Subblock / Center Freq Standard Sweep List

T T - T BT

goe. W M e

S T0] o =1 o Yo | 701U o | U PPRRI 319
S TU] o3 =] (oot QU 02=Y 01 (=T il =l (=T [ TRRPRP 319
Standard / MSR SetliNGS ...ccoeiiuiiiiiiiii e e 319
Edit SWEEP LISt ... e e e e e e e 319

Sub Block Count
Defines the number of sub blocks. By default, the familiar SEM measurement with just
one single block of ranges is configured.

Remote command:
[SENSe: | ESPectrum<sb>:SCOunt on page 696

Sub Block / Center Freq
Defines the center frequency for an individual sub block. The center frequency deter-
mines the reference range used for each block.

For measurements with only one sub block, this setting corresponds to the global set-
ting in the "Frequency" settings (see Center Frequency ).

Remote command:
[SENSe: ]ESPectrum<sb>:SCENter on page 695

Standard / MSR Settings

Defines the use of a standard settings file or a multi-standard radio configuration for a
particular sub block. For details, see "Standard Files" on page 325 and "MSR Set-
tings" on page 322.

Note that either a standard or an MSR setting can be selected; if one is selected, the
other is disabled.

Remote command:
[SENSe: ]ESPectrum<sb>:PRESet [:STANdard] on page 693
"Configuring a Multi-SEM Measurement" on page 695

Edit Sweep List

Switches to the "Sweep List" tab of the "Spectrum Emission Mask" dialog box to con-
figure the individual frequency ranges and mask limits for the corresponding sub block.
See " Sweep List " on page 314.
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Reference Range

Access: "Overview" > "Select Measurement" > "Spectrum Emission Mask" > "Refer-
ence Range"

The range around the center frequency is defined as the reference range for all other
ranges in the capture list.

Sweep List Reference Range Power Classes Standard Files

. Channel Power . Peak Power

Channel Pot =ttings

TxBandwidth 3.84 MHz
RRC FilterState || Off |t
Alpha |0.22 |

Power REfErenCe TYPE ..ocoo ittt e e e e e e 320
Channel POWEr SEtliNgS ....ccooi it e e e e e 320
L TX BANAWIALH ...evvecececcceceeeteeecce ettt seneas 321
O RO 1L C=Y S =1 C= YOO 321
L AIDNA: ettt et n et n e e 321

Power Reference Type
Defines how the reference power is calculated.

"Channel Power"
Measures the channel power within the reference range using the
integration bandwidth method. Additional settings can be configured
for this method.

"Peak Power"
Determines the peak power within the reference range.

Remote command:
[SENSe: | ESPectrum<sb>:RTYPe on page 711

Channel Power Settings

If the "Power Reference Type:" "Channel Power" was selected, additional parameters
can be configured.
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Tx Bandwidth < Channel Power Settings
Defines the bandwidth used for measuring the channel power, with:

Minimum span < "Tx Bandwidth" < of reference range

Remote command:
[SENSe: ]ESPectrum<sb>:BWID on page 710

RRC Filter State < Channel Power Settings
Activates or deactivates the use of an RRC filter.

Remote command:
[SENSe: ]ESPectrum<sb>:FILTer[:RRC] [:STATe] on page 711

Alpha: — Channel Power Settings
Sets the alpha value of the RRC filter (if activated).

Remote command:
[SENSe:]ESPectrum<sb>:FILTer [:RRC] :ALPHa on page 710
Power Classes

Access: "Overview" > "Select Measurement" > "Spectrum Emission Mask" > "Power
Classes"

You can configure power classes which you can then assign to capture list ranges. For
details, see "Power classes" on page 306.

Sweep List Reference Range Power Classes Standard Files

Power Class PMin <=P< PMax

—"'\I  m Ty
Power Class 1 ( | L+II‘\IF
R

USEA POWET ClaSSES: ...uuvviiiiiiiiiiiieeiiiieee e sttt e st tee e e s st e e s s sabee e e s s snbee e e s e snnreeeeeenanees 321
Y T I /- SRR 322
V= T=T o B ) P 322
Adding or Removing @ POWET Class .....ccccoiiiiiiiiiiiiiiee et 322

Used Power Classes:

Defines which power classes are considered for the SEM measurement. Limits can be
defined only for used power classes. It is only possible to select either one specific
power class or all the defined power classes.
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If "All" is selected, the power class that corresponds to the currently measured power
in the reference range is used for monitoring. The limits assigned to that power class
are applied (see " Abs Limit Start / Stop <n> " on page 316 and " Rel Limit Start / Stop
<n>"on page 316).

Remote command:
CALCulate<n>:LIMit<li>:ESPectrum<sb>:PCLass<pc>[:EXCLusive]

on page 714

To define all limits in one step:
CALCulate<n>:LIMit<li>:ESPectrum<sb>:PCLass<pc>:LIMit[:STATe]
on page 715

PMin / PMax

Defines the power limits for each power class. The first range always starts at -200
dBm (-INF) and the last range always stops at 200 dBm (+INF). These fields cannot be
modified. If more than one power class is defined, the value of "PMin" must be equal to
the value of "PMax" of the previous power class and vice versa.

Note that the power level can be equal to the lower limit(s), but must be lower than the
upper limit(s):

|:’min§P<Pmax
Otherwise the ranges are corrected automatically.

Remote command:
CALCulate<n>:LIMit<li>:ESPectrum<sb>:PCLass<pc>:MINimum
on page 716
CALCulate<n>:LIMit<li>:ESPectrum<sb>:PCLass<pc>:MAXimum
on page 716

Sweep List

Switches to the "Sweep List" tab of the "Spectrum Emission Mask" dialog box and
focuses the "Limit Check" setting for the corresponding power class (1-4) in the refer-
ence range (see " Limit Check <n>" on page 316).

Adding or Removing a Power Class

Adds a new power class at the end of the list or removes the last power class. After
adding or removing, the last power class is adapted to end at "+INF" . Note that a max-
imum of four power classes are available.

Remote command:
CALCulate<n>:LIMit<1li>:ESPectrum<sb>:PCLass<pc>:COUNt on page 714
MSR Settings

Access: "Overview" > "Select Measurement" > "Spectrum Emission Mask" > "MSR
Settings”

Multi-standard radio (MSR) measurements allow you to perform SEM tests on multiple
carriers using different digital standards.

For details, see "Multi-Standard Radio (MSR) SEM Measurements" on page 309.

User Manual 1176.8839.02 — 14 322



R&S®VSE 1/Q Analyzer Measurements

RF Measurement Configuration

Sweep List Sub Blocks Reference Range Power Classes MSR Settings

sub Common Settings

Block A
Band Category BC2

Base Station Class Wide Area
BS Max Output Power

Bands

Base Station RF Bandwidth |10.0 MHz

1.

Carrier Adjacent to RF Bandwidth Edge

GSM/Edge Present

Power Gsm Carrier

LTE FDD 1.4MHz/3MHz Present

Apply to SEM

S F= T aTe I 0= (=Te (o] VA UPUPPRRRUPIRE 323
Base Station ClasS ........ceiiiiiiiiiii e 323
Base Station Maximum OULPUL POWET ........oooeiiiiiiiiicccccciece e, 324
5= T £ PSR 324
Base Station RF Bandwidth ............oooiiiiiiiiiiiiieeee e 324
Carrier Adjacent to RF Bandwidth EAge .........cooiiiiiiiiiiiiii e 324
POWEE GSIM CAITIEN ...veiieiiieiee e e i ettt e e e e e e e e et ee e e e e e ae e e s e s s eansteraeeeeaaaeaseesaaannnns 324
N o] 0] 1Y (0TS 1 = |V PP 325

Band Category
Defines the band category for MSR measurements, i.e. the combination of available
carriers to measure.

"BC1" LTE FDD and W-CDMA
"BC2" LTE FDD, W-CDMA and GSM/EDGE
"BC3" LTE TDD and TD-SCDMA

Remote command:
[SENSe: ] ESPectrum<sb>:MSR:BCATegory on page 718

Base Station Class
Defines the class of the base station according to its sending range.

This setting is required to calculate the SEM limits according to standard 3GPP 37.141
V12.2.0.
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Remote command:
[SENSe: | ESPectrum<sb>:MSR:CLASs on page 719

Base Station Maximum Output Power
Defines the maximum output power of the base station. Possible values are from
0 dBm to 100 dBm in 1 dB steps.

This setting is only available for base stations with a medium range Base Station
Class .

This value is required to calculate the SEM limits according to standard 3GPP 37.141
V12.2.0.

Remote command:
[SENSe: | ESPectrum<sb>:MSR:MPOWer on page 721

Bands
Defines the frequency range of the bands used by the base station.

This setting is only available for Band Category 1 or 3.

This setting is required to calculate the SEM limits according to standard 3GPP 37.141
V12.2.0.

Remote command:
[SENSe: ]ESPectrum<sb>:MSR:BAND on page 717

Base Station RF Bandwidth
Defines the relevant RF bandwidth (span) required to measure all available carriers in
MSR SEM measurements.

Remote command:
[SENSe: ]ESPectrum<sb>:MSR:RFBWidth on page 722

Carrier Adjacent to RF Bandwidth Edge
For particular measurement setups, the specification demands specific limits for the
SEM ranges.

These settings are only available for Band Category 2.

"GSM/Edge Present"
A GSM/EDGE carrier is located at the edge of the RF band.
In this case, the power of the GSM carrier must be specified (see "
Power Gsm Carrier " on page 324).

"LTE FDD 1.4MHz/3MHz Present"
An LTE FDD 1.4 MHz or 3 MHz carrier is located at the edge of the
RF band.

Remote command:
[SENSe: | ESPectrum<sb>:MSR:GSM:CPResent on page 720
[SENSe: ]ESPectrum<sb>:MSR:LTE:CPResent on page 721

Power Gsm Carrier
Defines the power of the GSM carrier (if available, see " Carrier Adjacent to RF Band-
width Edge " on page 324). Possible values are from 0 dBm to 100 dBm in 1 dB steps.

This setting is only available for Band Category 2.
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This setting is required to calculate the SEM limits according to standard 3GPP 37.141
V12.2.0.

Remote command:
[SENSe: ]ESPectrum<sb>:MSR:GSM:CARRier on page 720

Apply to SEM
Configures the SEM capture list according to the specified MSR settings.

Remote command:
[SENSe: ]| ESPectrum<sb>:MSR:APPLy on page 717

Standard Files

Access: "Overview" > "Select Measurement" > "Spectrum Emission Mask" > "Stan-
dard Files"

You can save the current measurement settings as a user-defined standard (XML file),
or load stored measurement settings. Furthermore, you can delete an existing settings
file.

i Sweep List Reference Range Power Classes MSR Settings Standard Files

| Drive: CRUS | DL (C:/FSW/FSW_1.80_27 /sem_std /WCDMA /3GPP/DL)

Size

=

1 3GPP_DL.xml

1 3GPP_HomeBS.xml

B PowerClass_31_39.xml
L1 PowerClass_39_ 43.xml
1 PowerClass_43 _INF.xmil

1 PowerClass_negINF_31.oml

File Name .I'owerﬂass_Sl_Sﬂ.xml

For details, see "How to Manage SEM Settings Files" on page 331.

O Standard files for sub blocks (Multi-SEM measurements)

If more than one sub blocks are defined, the "Standard Files" tab and softkey are not
available. To load a standard file for an individual sub block, use the Standard / MSR
Settings setting in the "Sub Blocks" tab.
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Selecting Storage Location - Drive/ Path/ Files.........cooiiiiiiiii e 326
1TSS NN F=T 0 = 326
(oY= 1o 53 7= [T =1 o 326
FIlE EXPIOTEI ...ttt e e e r e e e e e e s e e aneeee 326
SAVE SEANAAI ....cooeeeeeeeee e e e e e e e e e e e e ea e e e rrraaraaa 326
Delete StaNAArd ........cooeieiiiiiiiie e e rr s 326
Restore Standard FileS ........oooeuuiiiiieeeee et 327

Selecting Storage Location - Drive/ Path/ Files
Select the storage location of the file on the software or an external drive.

The default storage location for the settings files is:
C:\ProgramData\Rohde-Schwarz\VSE\<version no>\Save.

Note that the Programbata folder is not visible in the Windows Explorer in its default
settings. However, if you enter the path with the filename, you can access the files
stored there. See also "Hidden folder" on page 115.

The default storage location for the SEM settings files is:
C:\ProgramData\Rohde-Schwarz\VSE\<version>\sem std.

File Name
Contains the name of the data file without the path or extension.

File names must be compatible with the Windows conventions for file names. In partic-

nanwEn non

ular, they must not contain special characters such as ":", "*",

For details on the filename and location, see Chapter 8.2.2.2, "Storage Location and
File Name", on page 114.

For details on the filename and location, see Chapter 8.2.2.2, "Storage Location and
File Name", on page 114.

Load Standard
Loads the selected measurement settings file.

Remote command:
[SENSe: ]ESPectrum<sb>:PRESet [:STANdard] on page 693

File Explorer
Opens the Microsoft Windows File Explorer.

Remote command:
not supported

Save Standard
Saves the current measurement settings for a specific standard as a file with the
defined name.

Remote command:
[SENSe: ]ESPectrum<sb>:PRESet:STORe On page 694

Delete Standard

Deletes the selected standard. Standards predefined by Rohde & Schwarz can also be
deleted. A confirmation query is displayed to avoid unintentional deletion of the stan-
dard.
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Note: Restoring predefined standard files. The standards predefined by Rohde &
Schwarz available at the time of delivery can be restored using the "Restore Standard
Files" function (see " Restore Standard Files " on page 327).

Restore Standard Files

Restores the standards predefined by Rohde & Schwarz available at the time of deliv-
ery.

The XML files from the

C:\Program Files\Rohde-Schwarz\VSE\<version>\sem backup folder are
copied to the C: \Program Files\Rohde-Schwarz\VSE\<version>\sem std
folder.

Note that this function will overwrite customized standards that have the same name
as predefined standards.

Remote command:
[SENSe: ]ESPectrum<sb>:PRESet:RESTore on page 694
List Evaluation (Results Configuration)

Access: "Overview" > "Select Measurement" > "Spectrum Emission Mask" > "List
Evaluation"

In the "List Evaluation" dialog box, you configure the contents and display of the SEM
results.

List Evaluation State

ings

Show Peaks Off

>

Margin [200.0 dB

e Evaluation List

Decimal Seperator | POINT EMMHI

List Evaluation State (Result SUMMArY)........ccuiiiiiiiiiiiiiie e 328
SNOW PEAKS ..eiiiiiiiiiiie ettt ettt e e e e ettt e e e e s ea e e e e e sbbe e e e e sanreeeeeeanes 328
= o 11 PN 328
Saving the Result Summary (Evaluation List) to @ File ..o, 328
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List Evaluation State (Result Summary)
Activates or deactivates the Result Summary.

Remote command:
CALCulate<n>:ESPectrum:PEAKsearch:AUTO on page 723
TRACe<n>[:DATA] ? on page 823

Show Peaks
If activated, all peaks that have been detected during an active SEM measurement are
marked with blue squares in the Spectrum diagram.

Remote command:
CALCulate<n>:ESPectrum:PEAKsearch:PSHow on page 724

Margin

Although a margin functionality is not available for the limit check, you can define a
margin (or: threshold) for the peak values to be displayed in the result summary. Only
peaks that exceed the margin value are displayed (also in the diagram, if activated).

Remote command:
CALCulate<n>:ESPectrum:PEAKsearch:MARGin on page 723

Saving the Result Summary (Evaluation List) to a File

Exports the Result Summary of the SEM measurement to an ASCI| file for evaluation
in an external application. If necessary, change the decimal separator for evaluation in
other languages.

Define the filename and storage location in the file selection dialog box that is dis-
played when you select the "Save" function.

For details, see "ASCII File Export Format (Spectrum Emission Mask)" on page 340.

Remote command:
MMEMory : STORe<n>:LIST on page 846
FORMat : DEXPort:DSEParator on page 822

10.4.3.6 How to Perform a Spectrum Emission Mask Measurement

SEM measurements can be performed according to a specific standard or freely con-
figured. Configuration for signals with a regular channel definition can be configured
quickly and easily. Selecting the SEM measurement is a prerequisite for all other tasks.

For signals with multiple carriers, also in non-contiguous ranges, an SEM measure-
ment with multiple sub blocks can be configured.

For multi-standard radio SEM measurements, configuration for specified scenarios can
be done automatically.

The following tasks are described:

® "To select an SEM measurement" on page 329

® "To perform an SEM measurement according to a standard" on page 329
® "To configure a user-defined SEM measurement” on page 329

® "To perform an MSR SEM measurement" on page 330
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® "To perform a Multi-SEM measurement" on page 331

O For remote operation, see "Example: SEM Measurement" on page 724.

To select an SEM measurement

> Select "Meas Setup" > "Select Measurement" , then select the "Spectrum Emission
Mask" measurement.

To perform an SEM measurement according to a standard

» Load the settings file as described in "How to load an SEM settings file"
on page 332 and start a measurement.

To configure a user-defined SEM measurement
1. Define the span of the signal you want to monitor in the general span settings.

2. Split the frequency span of the measurement into ranges for signal parts with simi-
lar characteristics.
Starting from the center frequency, determine which sections of the signal to the
left and right can be swept and monitored using the same parameters. Criteria for
such a range definition may be, for example:

The signal power level

The required resolution bandwidth or capture time

Transducer factors

Permitted deviation from the defined signal level, i.e. the required limit values
for monitoring

If the signal consists of a transmission channel and adjacent channels, the channel
ranges can usually be used for the range definition.

3. If the signal power level to be monitored varies and the limits vary, define power
classes. For each range of levels that can be monitored in the same way, define a
power class.

a) Select the "Overview" softkey.

b) Select the "SEM Setup" button.

c) Switch to the "Power Classes" tab.

d) To add a power class, select the "Add" button.

e) Enter the start and stop power levels to define the class.

f) Select the power classes to be used for the current measurement:

e a specific class
e all classes, to have the required class selected automatically according to
the input level measured in the reference range

4. Select the "Sweep List" tab of the "Spectrum Emission Mask" dialog box.
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5. Insert the required ranges using the "Insert before Range" and "Insert after Range"
buttons, which refer to the currently selected range (the reference range by
default).

If the signal trace is symmetric to the center frequency, activate the "Sym Setup”
option to make setup easier and quicker.

6. Define the measurement parameters for each range as required. If symmetrical
setup is activated, you only have to configure the ranges to one side of the center
range.

In particular, define the limits for each range of the signal, i.e. the area in which the
signal level can deviate without failing the limit check. If several power classes
were defined (see step 3), define limits for each power class.

a) Define the type of limit check, i.e. whether absolute values or relative values
are checked, or both. The type of limit check is identical for all power classes.
b) Define the limit start and stop values.

7. If the capture list settings - other than the limit and transducer values - are identical
for several adjacent ranges, activate "Fast SEM" mode to speed up the measure-
ment. You only have to activate the mode for one range, the others are adapted
automatically.

8. If necessary, change the settings for the reference power to which all SEM results
refer in the "Reference Range" tab.

9. To indicate the determined peaks in the display during an SEM measurement,
select "Overview" > "Analysis" > "Show Peaks" .

10. To save the current SEM measurement settings to a file to re-use them later, save
a settings file as described in "How to save a user-defined SEM settings file"
on page 332.

11. Start a capture.

The determined powers and limit deviations for each range are indicated in the
Result Summary. If activated, the peak power levels for each range are also indica-
ted in the Spectrum diagram.

12. To save the Result Summary, export the results to a file as described in "How to
Save SEM Result Files" on page 332.

To perform an MSR SEM measurement

1. Select "Meas Setup" > "MSR Config" .

2. Select the band category that determines the digital standards used in the mea-
surement setup (see " Band Category " on page 323).

3. Define the bandwidth that contains all relevant carrier signals to be measured.

4. For measurements with GSM/EDGE, LTE FDD and W-CDMA carriers (BC2),
define whether a GSM/EDGE or an LTE FDD carrier, or both, are located at the
edge of the bandwidth.
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5. Select the "Apply to SEM" button.

The capture list is configured according to the MSR specification, with the required
number of ranges and defined limits.

6. Start a capture.

The determined powers and limit deviations for each range are indicated in the
Result Summary. If activated, the peak power levels for each range are also indica-
ted in the Spectrum diagram.

7. To save the Result Summary, export the results to a file as described in "How to
Save SEM Result Files" on page 332.

To perform a Multi-SEM measurement

1. Define the span of the signal to be monitored in the general span settings.
2. Select "Meas Setup” > "Multi-SEM Config" .

3. Define the number of sub blocks (up to 3) that contain the relevant carriers.
4

For each sub block, define the center frequency, that is, the frequency of the TX
carrier or a frequency in the dedicated reference range.

5. For each sub block, do one of the following:

Select a standard settings file to be used.
Select the "MSR Settings" button and define the MSR configuration as descri-
bed in "To perform an MSR SEM measurement" on page 330.

e Select the "Edit" button and configure the capture list manually as defined in
"To configure a user-defined SEM measurement" on page 329. Be sure to
select the correct vertical tab for the corresponding sub block within each sub-
tab of the "Spectrum Emission Mask" configuration dialog.

Define a function to be used for overlapping ranges in the "Multi-Limit Calc"
field of the capture list.

6. Start a capture.

The determined powers and limit deviations for each sub block, each gap, and
each range are indicated in the Result Summary. If activated, the peak power lev-
els for each range are also indicated in the Spectrum diagram.

7. To save the Result Summary, export the results to a file as described in "How to
Save SEM Result Files" on page 332.

How to Manage SEM Settings Files

SEM measurement settings can be saved to an XML file which can then be exported to
another application or loaded on the R&S VSE again later. Some predefined XML files
are provided that contain ranges and parameters according to the selected standard.
All XML files are stored under

C:\Program Files\Rohde-Schwarz\VSE\<version>\sem std.

For details on the file format of the SEM settings file, see "Format Description of SEM
XML Files" on page 335.
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SEM settings or standard files are managed in the "Standard" tab of the "Spectrum
Emission Mask" dialog box. To display this dialog box, select the "Overview" softkey
and then the "SEM Setup" button.
How to load an SEM settings file
1. From the file selection dialog box, select the settings file (with a .xm1 extension).
2. Select the "Load" button.
The settings from the selected file are restored to the R&S VSE and you can
repeat the SEM measurement with the stored settings.
How to save a user-defined SEM settings file

1. Configure the SEM measurement as required (see Chapter 10.4.3.6, "How to Per-
form a Spectrum Emission Mask Measurement”, on page 328).

2. Inthe "Standard Files" tab of the "Spectrum Emission Mask" dialog box, define a
filename and storage location for the settings file.

3. Select the "Save" button.

The settings are stored to a file with the extension . xm1 as specified.

How to delete an SEM settings file

1. In the "Standard Files" tab of the "Spectrum Emission Mask" dialog box, select the
file you want to delete.

2. Select the "Delete" button.
3. Confirm the message.

The settings file is removed from the R&S VSE.

How to restore default SEM settings files

The R&S VSE is delivered with predefined settings files which can be edited and over-
written. However, you can restore the original files.

» In the "Standard Files" tab of the "Spectrum Emission Mask" dialog box, select the
"Restore Standard Files" button.

The original predefined settings files are available for selection on the R&S VSE.

How to Save SEM Result Files

The Result Summary from an SEM measurement can be saved to a file, which can be
exported to another application for further analysis, for example.

For details on the file format of the SEM export file, see "ASCII File Export Format
(Spectrum Emission Mask)" on page 340.

1. Configure and perform an SEM measurement as described in Chapter 10.4.3.6,
"How to Perform a Spectrum Emission Mask Measurement", on page 328.
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2. Inthe "Overview" , select the "Analysis" button.

3. If necessary, change the "Decimal Separator" to "COMMA" for evaluation in other
languages.

4. Select the "Save" button.

5. In the file selection dialog box, select a storage location and filename for the result
file.

6. Select the "Save" button.

The file with the specified name and the extension .dat is stored in the defined
storage location.

10.4.3.7 Measurement Example: Multi-SEM Measurement

The following measurement example demonstrates an SEM measurement for a signal
with multiple sub blocks.

O A programming example demonstrating a SEM measurement in a remote environment
= is provided in "Example: SEM Measurement" on page 724.

Test setup:
Signal
Generator 1 l
Coupler Spectrum
e ———p R&S VSE
[- 6 dB] Analyzer

Signal T

Generator 2

Signal generator settings (e.g. R&S VSE SMW):

Device Standard Center frequency Level Test model
SigGen 1 3GPP/FDD 900 MHz 0dBm 1-16
SigGen 2 EUTRA/LTE 906.5 MHz 0dBm 1_1_5MHz

Setting up the measurement

1. Set up a basic measurement with instrument input in the R&S VSE as described in
Chapter 11.1, "How to Perform a Basic Measurement with Instrument Input",
on page 439.
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Set the center frequency to 903.25 MHz.

Set the reference level to 10 dBm with an offset of to 30 dB.
Select "Meas Setup" > "Select Measurement" .

Select the "SEM" measurement function.

Select the "Sub Blocks" softkey and enter "Sub Block Count" of 2.

N o o » BN

For "Sub Block A", define the settings for the 3GPP/FDD signal:

Set the "Center Frequency" to 900 MHz

Select "MSR Settings" .

Set the "Base Station RF Bandwidth" to 5 MHz.
Select "Apply to SEM" .

8. For "Sub Block B", define the settings for the EUTRA/LTE signal:

Set the "Center Frequency" to 906.5 MHz
Select "MSR Settings" .

Set the "Base Station RF Bandwidth" to 5 MHz.
Select "Apply to SEM" .

9. Select [RUN SINGLE] to perform a measurement with the new settings.

The results of the measurement for each sub block are displayed in the Result
Summary. The summarized limit line is indicated in the Spectrum graph.

1 Spectrum Emission Mask
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894.16808 MHz -34.44 dBm -57.95 dB -22.94 dB
896.14890 MHz -47.37 dBm -70.88 dB -22.87 dB
896.65096 MHz -49.41 dBm -72.92 dB -27.40 dB
897.39370 MHz -50.91 dBm -74.42 dB -38.41 dB

Frequency Power Abs Power Rel ALimit
902.70196 MHz =50.62 dBm -74.13 dB -38.38 dB
902.92839 MHz -50.31 dBm -73.82 dB -35.18 dB
903.33976 MHz -23.52 dBm -47.03 dB -6.24 dB
903.59774 MHz -20.99 dBm -44.50 dB -6.21 dB
, 903.81543 MHz -20.35 dBm -43.86 dB -8.11 dB
ter 906.50 MHz LES Fowrr 23.03 dBm RBW 30.000 kHz
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Figure 10-38: Multi-SEM measurement: results of the measurement for each sub block

10.4.3.8 Reference: SEM File Descriptions

This reference provides details on the format of the SEM settings and result files.

e Format Description of SEM XML Fil€S......cccoviiiiiiiiiiiiiiciciie e 335
e ASCII File Export Format (Spectrum Emission Mask).........ccccocceeeieeriiiiiiiccieee 340
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Format Description of SEM XML Files

The SEM XML files offer a quick way to change the measurement settings. A set of
predefined XML files for different standards is already provided. You can also create
and use your own XML files. Alternatively, edit the settings directly in the "Spectrum
Emission Mask" dialog box and save the XML file afterwards. This way, you do not
have to modify the XML file itself.

In addition to saving the current settings to a file, settings files can also be created
independently of the R&S VSE, in an external application. When creating your own
XML files, be sure to comply with the following conventions because the R&S VSE can
only interpret XML files of a known structure. For sample files, see the

C:\Program Files\Rohde-Schwarz\VSE\<version>\sem std directory of the
R&S VSE.

To load a settings file, use the "Load" function in the "Standard Files" tab of the "Spec-
trum Emission Mask" dialog box (see "How to load an SEM settings file" on page 332).
All XML files are stored under

C:\Program Files\Rohde-Schwarz\VSE\<version>\sem std.

The files for importing range settings obey the rules of the XML standard. The child
nodes, attributes, and structure defined for the data import are described here.

Be sure to follow the structure exactly as shown below or else the R&S VSE is not able
to interpret the XML file and error messages are shown on the screen. It is recommen-
ded that you make a copy of an existing file and edit the copy of the file.

Basically, the file consists of three elements that can be defined:

® The BaseFormat element
® The PowerClass element
® The Range element

The "BaseFormat" element

It carries information about basic settings. In this element, only the ReferencePower
child node has any effects on the measurement itself. The other attributes and child
nodes are used to display information about the Spectrum Emission Mask standard on
the measurement screen. The child nodes and attributes of this element are shown in
Table 10-6.

Example:

In the sample file PowerClass 39 43.xml under
C:\Program Files\Rohde-Schwarz\VSE\<version>\sem std\WCDMA\3GPP,
these attributes are defined as follows:

e Standard="W-CDMA 3GPP"
® LinkDirection="DL"
® PowerClass="(39,43)dBm"
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The "PowerClass™ element

It is embedded in the BaseFormat element and contains settings information about
the power classes. Up to four different power classes can be defined. For details, refer
to "Power Classes" on page 321. The child nodes and attributes of this element are
shown in Table 10-7.

The "Range™ element

This element is embedded in the PowerClass element. It contains the settings infor-
mation of the range. There have to be at least three defined ranges: one reference
range and at least one range to either side of the reference range. The maximum num-
ber of ranges is 30. Note that the R&S VSE uses the same ranges in each power
class. Therefore, the contents of the ranges of each defined power class have to be
identical to the first power class. The Start and Stop values of the two Limit nodes
that are used to determine the power class are an exception. Note also that you must
define two limit nodes: one that defines the limit in absolute values and one in relative
values. Make sure units for the Start and Stop nodes are identical for each Limit
node.

For details, refer to " Sweep List " on page 314. The child nodes and attributes of this
element are shown in Table 10-8.

The following tables show the child nodes and attributes of each element and show if a
child node or attribute is mandatory for the R&S VSE to interpret the file or not. The
hierarchy of the XML cannot be seen in the tables. View one of the predefined files
already stored on the R&S VSE in the "C: \Program
Files\Rohde-Schwarz\VSE\<version>\sem std" directory, or check the struc-
ture as shown below.

Below, a basic example of the structure of the file is shown, containing all mandatory
attributes and child nodes. Note that the PowerClass element and the Range element
are themselves elements of the BaseFormat element. They must be inserted where
noted. They are separated here simply to provide a better overview. Also, no example
values are given here to allow a quick reference to the tables above. Italic font shows
the placeholders for the values.

® The BaseFormat element is structured as follows:

— <RS_SEM_ACP_FileFormat Version="1.0.0.0">
<Name>"Standard"</Name>
<Instrument>
<Type>"Instrument Type"</Type>
<Application>"Application"</Application>
</Instrument>
<LinkDirection Name="Name">
<ReferencePower>
<Method>"Method"</Method>
</ReferencePower>
<PowerClass Index="n">
<!I-- For contents of the PowerClass node, see Table 10-7 -->
<!-- Define up to four PowerClass nodes -->
</PowerClass>
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</LinkDirection>
</RS_SEM_ACP_File>

® The "PowerClass" element is structured as follows:

— <PowerClass Index="n">
<StartPower Unit="dBm" InclusiveFlag="true" Value="StartPowerValue"/>
<StopPower Unit="dBm" InclusiveFlag="false" Value="StopPowerValue"/>
<DefaultLimitFailMode>"Limit Fail Mode"</DefaultLimitFailMode>
<Range Index="n">
<l-- For contents of the Range node, see Table 10-8 -->
<l-- Define up to twenty Range nodes -->

</Range>

</PowerClass>
® The "Range" element is structured as follows:

— <Range Index="n">
<Name="Name">
<ChannelType>"Channel Type"</Channel Type>
<WeightingFilter>
<Type>"FilterType"</Type>
<RollOffFactor>"Factor"</RollOffFactor>
<Bandwith>"Bandwidth"</Bandwidth>
</WeightingFilter>
<FrequencyRange>
<Start>"RangeStart"</Start>
<Stop>"RangeStop"</Stop>
</FrequencyRange>
<Limit>
<Start Unit="Unit" Value="Value"/>
<Stop Unit="Unit" Value="Value"/>
</Limit>
<Limit>
<Start Unit="Unit" Value="Value"/>
<Stop Unit="Unit" Value="Value"/>
</Limit>
<RBW Bandwidth="Bandwidth" Type="FilterType"/>
<VBW Bandwidth="Bandwidth"/>
<Detector>"Detector"</Detector>
<Sweep Mode="SweepMode" Time="SweepTime"/>
<Amplitude>
<ReferencelLevel Unit="dBm" Value="Value"/>
<RFAttenuation Mode="Auto" Unit="dB" Value="Value"/>
<Preamplifier State="State"/>
</Amplitude>
<MeasPointsMin>1</MeasPointsMin>
<CalcRuleMulti>Sum</CalcRuleMulti>
</Range>
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Table 10-6: Attributes and child nodes of the BaseFormat element

Child Node Attribute Value Parameter Description Mand.
FileFormatVersion 1.0.0.0 Yes
Date YYYY-MM-DD Date in ISO 8601 format No
HH:MM:SS
Name <string> Name of the standard Yes
Instrument Type FSL Name of the instrument No
Application SA | K72 | K82 Name of the application No
LinkDirection Name Downlink | Uplink | Yes
None
ShortName DL | UL No
Reference- Yes
Power
Method TX Channel Power | Yes
TX Channel Peak
Power
Reference- <string> No
Channel
Table 10-7: Attributes and child nodes of the PowerClass element
Child Node Attribute Value Parameter description Mand.
StartPower Value <power in dBm> The start power must be equal | Yes
to the stop power of the previ-
ous power class. The Start-
Power value of the first range
is -200
Unit dBm Yes
InclusiveFlag true Yes
StopPower Value <power in dBm> The stop power must be equal | Yes
to the start power of the next
power class. The StopPower
value of the last range is 200
Unit dBm
InclusiveFlag false Yes
DefaultLimitFailMode Absolute | Relative Yes
| Absolute and Rel-
ative | Absolute or
Relative
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Table 10-8: Attributes and child nodes of the Range element (normal ranges)

Child node Attribute | Value Parameter description Mand.
Index 0...19 Indices are continuous and | Yes
have to start with 0
Name <string> Name of the range Only if Referen-
ceChannel con-
tains a name and
the range is the
reference range
Short- <string> Short name of the range No
Name
ChannelType TX | Adjacent Yes
WeightingFilter Only if Referen-
cePower method
is TX Channel
Power and the
range is the ref-
erence range
Type RRC | CFilter Type of the weighting filter | Yes
Roll Off Factor 0...1 Excess bandwidth of the fil- | Only if the filter
ter type is RRC
Bandwidth <bandwidth in Hz> | Filter bandwidth Only if the filter
type is RRC
FrequencyRange Yes
Start <frequency in Hz> | Start value of the range Yes
Stop <frequency in Hz> | Stop value of the range Yes
Limit dBm/Hz | dBm | A Range must contain Yes
dBc | dBr | dB exactly two limit nodes; one
of the limit nodes has to
have a relative unit (e.g.
dBc), the other one must
have an absolute unit (e.g.
dBm)
Start Value <numeric_value> Power limit at start fre- Yes
quency
Unit dBm/Hz | dBm | Sets the unit of the start
dBc | dBr | dB value
Stop Value <numeric_value> Power limit at stop fre-
quency
Unit dBm/Hz | dBm | Sets the unit of the stop
dBc | dBr | dB value
LimitFailMode Absolute | Relative | If used, it has to be identical | No
| Absolute and Rel- | to DefaultLimitFailMode
ative | Absolute or
Relative
RBW Bandwidth | <bandwidth in Hz> | " RBW " on page 315 Yes
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Child node Attribute | Value Parameter description Mand.
Type NORM | PULS | No
CFIL
VBW Bandwidth | <bandwidth in Hz> | " VBW " on page 315 Yes
Detector NEG | POS | If used, it has to be identical | No
SAMP | RMS | in all ranges.
AVER | QUAS
Sweep Mode Manual | Auto " Sweep Time Mode " Yes
on page 316
Time <time in sec> " Meas Time " on page 316 | No
Amplitude No

ASCII File Export Format (Spectrum Emission Mask)

When trace data from an SEM measurement is exported, the data is stored in ASCII
format as described below. The first part of the file lists information about the signal
analyzer and the general setup.

File contents Explanation
File header

Model
Version;1.00; Firmware version
Date;31.Mar 17; Storage date of data set
Mode;ANALYZER;SEM; Operating mode and measurement function
Center Freq;13250000000.000000;Hz X-axis settings

Freq Offset;0.000000;Hz

Span;25500000.000000;Hz

x-Axis;LIN;

Start;13237250000.000000;Hz

Stop;13262750000.000000;Hz

Level Offset;0.000000;dB Y-axis settings

Ref Position;100.000000;%

y-Axis;LOG;

Level Range;100.000000;dB

Trace settings

Trace Mode;CLR/WRITE;

Detector;RMS;

Sweep Count;0;

Trace 1;;
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File contents

Explanation

x-Unit;Hz;

y-Unit;dBm;

List evaluation settings

Margin;200;

Peak List margin

Reference range settings

RefType; CPOWER;

Reference power type

TxBandwidth;3840000;;Hz

Filter State; ON;

Alpha;0.22;

Channel power settings

PeaksPerRange;1;

Max. number of peaks per range to be detected

Values;2;

Number of detected peaks

File data section

0;-12750000;-2515000;30000;13242367500;-43.844 | Measured peak values:
722747802734;-0.33028793334960938;49.6697120

<range number>;
66650391;FAIL;

<start frequency>;

2;2515000;12750000;30000;13257632500;-43.8447

22747802734;-0.33028793334960938;49.66971206
6650391;FAIL; <resolution bandwidth of range>;

<stop frequency>;

<frequency of peak>;
<absolute power in dBm of peak>;

<relative power in dBc of peak>; (related to the
channel power)

<distance to the limit line in dB>; (positive value
means above the limit)

<limit fail (pass = 0, fail =1)>;

10.4.4 Time Domain Power Measurement

The Time Domain Power measurement determines the power of a signal in the time
domain.

A time domain power measurement is only possible for zero span.

o  ADbOoUt the MEASUIEMENT........coiieeeeee e 341
o Time Domain POWEr RESUILS........cooveeeeeeeeeeee e 342
e Time Domain Power Basics - Range Definition Using Limit Lines...........ccco....... 343
e Time Domain Power Configuration...........cccceeiiieeiiiiccciiiiieeeee e 343
e How to Measure Powers in the Time Domain.........ccccceeeeiiiviiiiieeiiiiiiee e 344

10.4.4.1 About the Measurement

Using the Time Domain Power measurement function, the R&S VSE determines the
power of the signal in zero span by summing up the power at the individual measure-
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ment points and dividing the result by the number of measurement points. Thus it is
possible to measure the power of TDMA signals during transmission, for example, or
during the muting phase. Both the mean power and the RMS power can be measured.

For this measurement, the sample detector is activated.

10.4.4.2 Time Domain Power Results

Several different power results can be determined simultaneously:

Mode Description

Peak Peak value from the points of the displayed trace or a segment
thereof.

RMS RMS value from the points of the displayed trace or a segment
thereof.

Mean Mean value from the points of the displayed trace or a segment
thereof. The linear mean value of the equivalent voltages is calcula-
ted.

For example to measure the mean power during a GSM burst

Std Dev The standard deviation of the measurement points from the mean
value.

The result is displayed in the marker results, indicated by "Power" and the selected
power mode, e.g. "RMS" . The measured values are updated after each sweep or
averaged over a user-defined number of sweeps (trace averaging).

MultiView =8 Spectrum IQ Analyzer X

Ref Level 14 Meas Time 1 SRate 2.5 MHz
Rec Length

L)
M1[1] 1 dBm
275.197 ps
.w'ﬁ‘\,"‘ﬂpll M’"

i
) |‘ ! u}wh} "&{1""\,']‘ ‘rﬁ {: HJ"‘V" L|{'||'\|*N‘fﬁ‘fﬂf\ |-)L'JI,,H)\W’,

CF 853.0 MHz 1001 pts 100.04 ps/

2 Marker Table
Wwnd Type Ref  Trc X-Value ¥Y-Value Function Function Result
1 M1 1 275.197 ps 5.01 dBm ! 2.48 dBm
1 1.35dBm
1 ) 1.23 dBm
1 1.59dB

The results can also be queried using the remote commands described in Chap-
ter 13.6.3.4, "Measuring the Time Domain Power", on page 728.
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10.4.4.3 Time Domain Power Basics - Range Definition Using Limit Lines

The range of the measured signal to be evaluated for the power measurement can be
restricted using limit lines. The left and right limit lines (S1, S2) define the evaluation
range and are indicated by vertical red lines in the diagram. If activated, the power
results are only calculated from the levels within the limit lines.

For example, if both the on and off phase of a burst signal are displayed, the measure-
ment range can be limited to the transmission or to the muting phase. The ratio
between signal and noise power of a TDMA signal for instance can be measured by
using a measurement as a reference value and then varying the measurement range.

In order to get stable measurement results for a limited evaluation range, usually a trig-
ger is required.

10.4.4.4 Time Domain Power Configuration

Time Domain Power

Mean

Std Dev
Limits
State

Left

Right

The remote commands required to perform these tasks are described in Chap-
ter 13.6.3.4, "Measuring the Time Domain Power", on page 728.
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(RS T U] LT 344
[T RS =) (SO 344
Left Limit / RIght LImit .....cooooiiie et 344
Results

Activates the power results to be evaluated from the displayed trace or a limited area
of the trace.

"Peak" Peak power over several measurements (uses trace averaging, Max
Hold)

"RMS" RMS value from the points of the displayed trace or a segment
thereof.

"Mean" Mean value from the points of the displayed trace or a segment
thereof. The linear mean value of the equivalent voltages is calcula-
ted.

"Std Dev" The standard deviation of the measurement points from the mean
value.

The measurement of the mean power is automatically switched on at
the same time.

Remote command:
CALCulate<n>:MARKer<m>:FUNCtion:SUMMary:PPEak[:STATe] on page 730
CALCulate<n>:MARKer<m>:FUNCtion:SUMMary:PPEak:RESult? on page 733
CALCulate<n>:MARKer<m>:FUNCtion:SUMMary:RMS[:STATe] on page 730
CALCulate<n>:MARKer<m>:FUNCtion:SUMMary:RMS:RESult? on page 735
CALCulate<n>:MARKer<m>:FUNCtion:SUMMary:MEAN[:STATe] on page 730
CALCulate<n>:MARKer<m>:FUNCtion:SUMMary:MEAN:RESult? on page 732

Limit State
Switches the limitation of the evaluation range on or off. Default setting is off.

If deactivated, the entire sweep time is evaluated. If switched on, the evaluation range
is defined by the left and right limit. If only one limit is set, it corresponds to the left limit
and the right limit is defined by the stop frequency. If the second limit is also set, it
defines the right limit.

Remote command:
CALCulate<n>:MARKer<m>:X:SLIMits[:STATe] on page 777

Left Limit / Right Limit
Defines a power level limit for line S1 (left) or S2 (right).

Remote command:
CALCulate<n>:MARKer<m>:X:SLIMits:LEFT on page 778
CALCulate<n>:MARKer<m>:X:SLIMits:RIGHt on page 778

How to Measure Powers in the Time Domain

The step-by-step procedure to measure powers in the time domain is described here in
detail.
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To measure the power in the time domain
1. Select a result window in the time domain, for example a "Magnitude" window.
2. Select the [MARK FUNC] key.

3. From the "Select Marker Function" dialog box, select the "Time Domain Power"
function.

4. Select the type of power measurement results to be determined by selecting the
corresponding softkeys.

5. To restrict the power evaluation range, define limits:

a) Select the "Time Dom Power Config" softkey to display the "Time Domain
Power" configuration dialog box.

b) Switch on the limits by setting the "Limit State" to "On" .
The limit lines S1 and S2 are displayed.

c) Define the left limit (limit line S1), the right limit (S2), or both.

6. Start a sweep.

The measured powers are displayed in the marker results.

10.4.5 Frequency and Span Settings

Access: "Overview" > "Frequency"

Freguency

r Frequency/Span
Center 13.25 GHz Full Span
Span 2551006008 GHz Zero pan
Start 494,96996 MHz Last Span
Stop 26,00503004 GHz

r Center Frequency Stepsize

Stepsize 0.1% Span T | A-Factor | 10.0%

r Frequency Offset

Walue 0.0 Hz

(02T g (=T gl (=T U= o o3 PSRRI 346
ST - o R 346
0= o B ] (o ) U EEURPR R 346
U1 ST o7 o U SPURRRS 346
A=Y (o TS o - o PP 347
LaSt SPaAN ... eaaaaaaaaaaaaeeraeaaaae 347
Center FrequeNCy SEPSIZE ...t 347
Frequency OffSEt ... ... et 347
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Center Frequency
Defines the center frequency of the signal in Hertz.

OHzs fcenter = fmax
frax @nd span,,, depend on the instrument and are specified in the data sheet.

Note: For file input, you can shift the center frequency of the current measurement
compared to the stored measurement data. The maximum shift depends on the sam-
ple rate of the file data.
SR e

2

CFuift,.. = CFpe £

maz

If the file does not provide the center frequency, it is assumed to be 0 Hz.

In order to ensure that the input data remains within the valid analysis bandwidth,
define the center frequency and the analysis bandwidth for the measurement such that
the following applies:

AB channe ABWy;
CF + # > CFpye + — 1%

2
cF — ABWetannel W;’“‘”"d > CFy, — —ABZVf =

Remote command:
[SENSe: ] FREQuency:CENTer on page 621

Span
Defines the frequency span. The center frequency is kept constant. The following
range is allowed:

span =0: 0 Hz

span >0:

$PANin < f o < F ma

frax @nd span,,, are specified in the data sheet.

Remote command:
[SENSe: ] FREQuency: SPAN on page 738

Start / Stop

Defines the start and stop frequencies.
Remote command:

[SENSe: ] FREQuency: STARt on page 738
[SENSe: ] FREQuency: STOP on page 739

Full Span
Sets the span to the full frequency range of the R&S VSE specified in the data sheet.
This setting is useful for overview measurements.

Remote command:
[SENSe: ] FREQuency:SPAN:FULTL on page 738
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Zero Span
Sets the span to 0 Hz (zero span). The x-axis becomes the time axis with the grid lines
corresponding to 1/10 of the current sweep time ( "SWT" ).

Remote command:
FREQ:SPAN OHz, see [SENSe: ] FREQuency: SPAN on page 738

Last Span
Sets the span to the previous value. With this function you can switch between an
overview measurement and a detailed measurement quickly.

Remote command:
[SENSe: ] FREQuency: SPAN on page 738

Center Frequency Stepsize

Defines the step size by which the center frequency is increased or decreased when
the arrow keys are pressed. When you use the rotary knob the center frequency
changes in much smaller steps (1/10 the size as for the arrow keys).

The step size can be coupled to the span (span > 0) or the resolution bandwidth (span
= 0), or it can be manually set to a fixed value.

"0.1 *Span"/  Sets the step size for the center frequency to 10 % of the span /
"0.1 * RBW" RBW.
This is the default setting.

"0.5 * Span"/  Sets the step size for the center frequency to 50 % of the span /
"0.5 * RBW" RBW.

"x * Span"/ Sets the step size for the center frequency to a manually defined fac-
"X * RBW" tor of the span / RBW. The "X-Factor" defines the percentage of the
span / RBW.

Values between 1 and 100 % in steps of 1 % are allowed. The default
setting is 10 %.

"= Center" Sets the step size to the value of the center frequency and removes
the coupling of the step size to span or resolution bandwidth. The
used value is indicated in the "Value" field.

"= Marker" This setting is only available if a marker is active.
Sets the step size to the value of the current marker and removes the
coupling of the step size to span or resolution bandwidth. The used
value is indicated in the "Value" field.

"Manual" Defines a fixed step size for the center frequency. Enter the step size
in the "Value" field.

Remote command:

[SENSe: ] FREQuency:CENTer: STEP: LINK on page 737

[SENSe: ] FREQuency:CENTer:STEP: LINK: FACTor on page 738
[SENSe: ] FREQuency:CENTer: STEP on page 621

Frequency Offset
Shifts the displayed frequency range along the x-axis by the defined offset.
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This parameter has no effect on the instrument's hardware, or on the captured data or
on data processing. It is simply a manipulation of the final results in which absolute fre-
quency values are displayed. Thus, the x-axis of a spectrum display is shifted by a
constant offset if it shows absolute frequencies. However, if it shows frequencies rela-
tive to the signal's center frequency, it is not shifted.

A frequency offset can be used to correct the display of a signal that is slightly distorted
by the measurement setup, for example.

The allowed values range from -1 THz to 1 THz. The default setting is 0 Hz.

Remote command:
[SENSe: ] FREQuency:OFFSet on page 622

10.4.6 Bandwidth, Filter and Capture Configuration
The basic bandwidth, filter and capture settings that apply to most measurements are

described here. These parameters define how the data is measured: how much data is
collected internally and which filters are used.

e Impact of the Bandwidth, Filter and Capture Settings..........coovvvvririiiiiiiicicccieennn, 348
e Bandwidth, Filter and Capture Settings...........uuuiiiiiiiiiiiieeeeeeeeeeeee 353
e Reference: List of Available Channel Filters...........oooo e 358

10.4.6.1 Impact of the Bandwidth, Filter and Capture Settings

The bandwidth, filter and capture settings are closely related and interdependent. The
values available for resolution bandwidth and video bandwidth depend on the selected
filter type. In addition, these settings have an impact on other measurement parame-
ters. The following equation shows the interdependency of these settings:

Tuin = K*Span/RBW?
where K = Filter constant

By default, a Gaussian filter is used. The resolution bandwidth, the video bandwidth
and the "Meas Time" are set automatically according to the set span, and default cou-
pling is used. Thus, the following settings are applied:

RBW =100 * Span
VBW = RBW = 100 * Span
"Meas Time" = T,,, for set Span, RBW, VBW

When defining the bandwidth and filter settings, consider the impact of the individual
settings on the other settings and the measurement result, as described in more detail
in the following sections.

e Separating Signals by Selecting an Appropriate Resolution Bandwidth............... 349
e Smoothing the Trace Using the Video Bandwidth..........cccoccoiiiiiiiiiiniie 349
o Coupling VBW and RBW.........cco ittt e e et e e e e e e e e e 350
o Coupling Span and RBW........coo it e e e e e e e e e e ee e 350
e How Data is Measured: the Capture TYPE......uceeeieiiieiiiiii e 351
e Which Data May Pass: Filter TYPesS.....cccoi i 352
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e How Long the Data is Measured: Meas TiMe ..........ccccvieaiiiiiiiiiiiiiiiieeeee e 352
e How Much Data is Measured: Capture Points and Capture Count....................... 352
e How Often Data is Measured: Capture Mode.........cccccceeeiiiiicciiiiiiieeeeeeee s 353

Separating Signals by Selecting an Appropriate Resolution Bandwidth

The resolution bandwidth defines the 3 dB bandwidth of the resolution filter to be used.
An RF sinusoidal signal is displayed according to the passband characteristic of the
resolution filter (RBW), i.e. the signal display reflects the shape of the filter.

A basic feature of a signal analyzer is being able to separate the spectral components
of a mixture of signals. The resolution at which the individual components can be sepa-
rated is determined by the resolution bandwidth. Selecting a resolution bandwidth that
is too large may make it impossible to distinguish between spectral components, i.e.
they are displayed as a single component. Smaller resolution bandwidths, however,
increase the required "Meas Time" .

Two signals with the same amplitude can be resolved if the resolution bandwidth is
smaller than or equal to the frequency spacing of the signal. If the resolution bandwidth
is equal to the frequency spacing, the spectrum display screen shows a level drop of 3
dB precisely in the center of the two signals. Decreasing the resolution bandwidth
makes the level drop larger, which thus makes the individual signals clearer.

The highest sensitivity is obtained at the smallest bandwidth (1 Hz). If the bandwidth is
increased, the reduction in sensitivity is proportional to the change in bandwidth.
Increasing the bandwidth by a factor of 3 increases the displayed noise by approx. 5
dB (4.77 dB precisely). If the bandwidth is increased by a factor of 10, the displayed
noise increases by a factor of 10, i.e. 10 dB.

If there are large level differences between signals, the resolution is determined by
selectivity as well as by the resolution bandwidth that has been selected. The measure
of selectivity used for signal analyzers is the ratio of the 60 dB bandwidth to the 3 dB
bandwidth (= shape factor).

For the R&S VSE, the shape factor for bandwidths is < 5, i.e. the 60 dB bandwidth of
the 30 kHz filter is <150 kHz.

The higher spectral resolution with smaller bandwidths is won by longer sweep times
for the same span. The sweep time has to allow the resolution filters to settle during a
capture at all signal levels and frequencies to be displayed.

If the RBW is too large, signal parts that are very far away (e.g. from a different signal)
are considered in the measurement and distort the results. The noise increases.

If the RBW is too small, parts of the signal are lost. As the displayed signal always
reflects the shape of the filter, select a bandwidth large enough so the displayed signal
reflects the entire shape of the filter.

Smoothing the Trace Using the Video Bandwidth

The video filters are responsible for smoothing the displayed trace. Using video band-
widths that are small compared to the resolution bandwidth, only the signal average is
displayed and noise peaks and pulsed signals are repressed. If pulsed signals are to
be measured, it is advisable to use a video bandwidth that is large compared to the
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resolution bandwidth (VBW = 10 x RBW) for the amplitudes of pulses to be measured
correctly.

The level of a sine wave signal is not influenced by the video bandwidth. A sine wave
signal can therefore be freed from noise by using a video bandwidth that is small com-
pared with the resolution bandwidth, and thus be measured more accurately.

@ RMS/Average detector and VBW

If an RMS or average detector is used, the video bandwidth in the hardware is
bypassed. Thus, duplicate trace averaging with small VBWs and RMS or average
detector no longer occurs. However, the VBW is still considered when calculating the
"Meas Time" . This leads to a longer "Meas Time" for small VBW values. Thus, you can
reduce the VBW value to achieve more stable trace curves even when using an RMS
or average detector. Normally, if the RMS or average detector is used the "Meas Time"
should be increased to get more stable traces.

Coupling VBW and RBW

The video bandwidth can be coupled to the resolution bandwidth automatically. In this
case, if the resolution bandwidth is changed, the video bandwidth is automatically
adjusted.

Coupling is recommended if a minimum "Meas Time" is required for a selected resolu-
tion bandwidth. Narrow video bandwidths require longer "Meas Time" s due to the lon-
ger settling time. Wide bandwidths reduce the signal/noise ratio.

Table 10-9: Overview of RBW/VBW ratios and recommendations for use

Ratio RBW/VBW Recommendation for use

17 Recommended for sinusoidal signals

This is the default setting for automatic coupling.

0.1 Recommended when the amplitudes of pulsed signals are to be measured
correctly. The IF filter is exclusively responsible for the pulse shape. No
additional evaluation is performed by the video filter.

10 Recommended to suppress noise and pulsed signals in the video domain.

Manually set (0.001 to 1000) | Recommended for other measurement requirements

Coupling Span and RBW

The resolution bandwidth can be coupled to the span setting, either by a manually
defined factor or automatically. If the span is changed, the resolution bandwidth is
automatically adjusted. The automatic coupling adapts the resolution bandwidth to the
currently set frequency span/100.

With a span/RBW ratio of 100 and a screen resolution of 1000 pixels, each frequency
in the spectrum is displayed by 10 pixels. A span/RBW ratio of 1000 provides the high-
est resolution.

A higher span/RBW ratio (i.e. low RBW values and large frequency spans), however,
results in large amounts of data.
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How Data is Measured: the Capture Type

In a standard analog frequency sweep, the local oscillator of the analyzer sweeps the
applied signal quasi analog from the start to the stop frequency to determine the fre-
quency spectrum.

Alternatively, the analyzer can sample signal levels over time at a defined frequency
and transform the data to a spectrum by Fast Fourier Transformation (FFT). Although
this measurement method requires additional calculations, it can provide results much
faster than the frequency sweep, in particular for small RBWs.

Which sweep mode is appropriate for the current measurement depends on the span,
RBW, VBW and "Meas Time" settings. By default ( "Auto" capture type), the R&S VSE
automatically uses the capture type with the highest capture rate depending on these

measurement settings.

Optimization

In FFT mode, FFT analysis is performed to determine a spectrum of frequencies. Sev-
eral analysis steps are required to cover the entire span. The subspan which is cov-
ered by one FFT analysis depends on the RBW. The subspan cannot be defined
directly, but it can be optimized according to measurement requirements.

Narrow subspans provide a higher dynamic range, and also allow you to perform mea-
surements near a carrier with a reduced reference level. With a wide subspan, the car-
rier and the useful signal are likely to be measured at the same time, in which case the
powers of both signals are summarized, so the reference level must be high enough to
consider this factor. With a narrow subspan, this is less likely to happen, so the refer-
ence level can be reduced.

On the other hand, the narrower the subspan, the more steps are required to cover the
entire span, thus increasing analysis and calculation time. To optimize the capture
rate, the widest possible subspan (depending on the RBW) is used.

O For an optimal capture rate, it is recommended that you set the "Meas Time" to "Auto" ,
= as well.

For general purpose measurements, an "Auto" mode is available, which provides a
compromise between a large dynamic range and a fast capture. In this case, a
medium-sized subspan is used.

Optimization for zero span sweeps

For normal sweeps in the time domain (zero span), the optimization mode determines
the selection of the A/D converter prefilter, which depends on the RBW.

In "Dynamic™ mode, the narrowest possible prefilter is used.
In "Speed"” mode, the widest possible prefilter is used.

In "Auto" mode, a medium-sized prefilter is used.
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Which Data May Pass: Filter Types

While the filter is irrelevant when measuring individual narrowband signals (as long as
the signal remains within the RBW), the measurement result for broadband signals is

very dependant on the selected filter type and its shape. If the filter is too narrow, the

signal is distorted by the filter. If the filter is too wide, multiple signals can no longer be
distinguished. Generally, the smaller the filter width and the steeper its edges, the lon-
ger the settling time and thus the longer the "Meas Time" must be.

All resolution bandwidths are realized with digital filters. Normal (3dB) Gaussian filters
are set by default. Some communication standards require different filters.

For a list of available filter types, see Chapter 10.4.6.3, "Reference: List of Available
Channel Filters", on page 358.

Normal (3 dB) Gaussian filters

Gaussian filters provide a good compromise between steep edges and a short settling
time. This filter is suitable for most measurement tasks and is used by default.

The available Gaussian (3 dB) filters are listed in the R&S VSE data sheet.

Channel filters

Channel filters are fairly steep but require a long settling time; they are useful for pulse
measurements in the time domain.

How Long the Data is Measured: Meas Time

Each filter has a settling time that must be awaited in order to obtain correct results.
Since the resolution bandwidth and video bandwidth define the filter, the smaller of the
two determines the minimum "Meas Time" required for the measurement. Allowed val-
ues depend on the ratio of span to RBW and RBW to VBW.

If the selected "Meas Time" is too short for the selected bandwidth and span, level
measurement errors will occur. In this case, the R&S VSE displays the error message
"Sweep time too low" and marks the indicated "Meas Time" with a red bullet. Further-
more, a status bit indicates an error.

(For more information see "STATus:QUEStionable:TIMe Register" on page 474.)

The "Meas Time" can be coupled to the span (not zero span), video bandwidth (VBW)
and resolution bandwidth (RBW) automatically. If the span, resolution bandwidth or
video bandwidth is changed, the "Meas Time" is automatically adjusted.

Note that the "Meas Time" only indicates how long data is captured; the time required

@ to process the captured data may be considerably longer, in particular for FFT mode.
For FFT mode, an estimated duration is indicated behind the "Meas Time" in the chan-
nel bar (for RF measurements only).

How Much Data is Measured: Capture Points and Capture Count

By default, 1001 data points are determined in a single capture. During the next cap-
ture, 1001 new data points are collected, and so on. The number of capture points
defines how much of the entire span is covered by a single data point. By increasing

User Manual 1176.8839.02 — 14 352



R&S®VSE 1/Q Analyzer Measurements

RF Measurement Configuration

the number of capture points you can increase the reliability of the individual data
points and thus the accuracy of the analyzed results. However, these data points are
all stored on the instrument, occupying a large amount of memory, and each capture
point increases the overall measurement time.

The number of captures to be performed in single capture mode is defined by the
"Capture Count" . Values from 0 to 200000 are allowed. If the values 0 or 1 are set,
one capture is performed. The capture count is applied to all the traces in a diagram.

If the trace configurations "Average" , "Max Hold" or "Min Hold" are set, the "Capture
Count" also determines the number of averaging or maximum search procedures (see
"Analyzing Several Traces - Trace Mode" on page 362).

For details on how the number of capture points and the capture count affect the trace
results on the screen, see "Mapping Samples to measurement Points with the Trace
Detector" on page 360.

How Often Data is Measured: Capture Mode

How often the spectrum is swept depends on the capture mode. Either a certain num-
ber of captures can be defined ( "Capture Count" ) which are performed in "Single
Sweep" mode, or the capture is repeated continuously ( "Continuous Sweep" mode).

By default, the data is collected for the specified number of captures and the corre-
sponding trace is displayed. When the next capture is started, the previous trace is
deleted.

However, the data from a single capture run can also be retained and displayed
together with the new data ( "Continue Single Sweep" mode). This is particularly of
interest when using the trace configurations "Average" or "Max Hold" to take previously
recorded measurements into account for averaging/maximum search (see "Analyzing
Several Traces - Trace Mode" on page 362).

10.4.6.2 Bandwidth, Filter and Capture Settings

Access: "Overview" > "Bandwidth"

The remote commands required to define these settings are described in Chap-
ter 13.6.3.6, "Configuring Bandwidth and Sweep Settings", on page 739.
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Figure 10-39: Bandwidth dialog box for RF measurements
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Figure 10-40: Capture dialog box for RF measurements
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Defines the resolution bandwidth. The available resolution bandwidths are specified in
the data sheet. Numeric input is always rounded to the nearest possible bandwidth.

If "Auto" is selected, the resolution bandwidth is coupled to the selected span (for span
> 0). If the span is changed, the resolution bandwidth is automatically adjusted.

If the resolution bandwidth is defined manually, a green bullet is displayed next to the
"RBW" display in the channel bar.
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For more information see "Separating Signals by Selecting an Appropriate Resolution
Bandwidth" on page 349.
Note: Restrictions.
® For measurements on I/Q data in the frequency domain, the maximum RBW is
1 MHz.
Remote command:
[SENSe: | BANDwidth[:RESolution] on page 739
[SENSe: ] BANDwidth[:RESolution] :AUTO on page 740

VBW
Defines the video bandwidth automatically or manually.

For more information see "Smoothing the Trace Using the Video Bandwidth"

on page 349.

"Auto" The video bandwidth is coupled to the resolution bandwidth. If the
resolution bandwidth is changed, the video bandwidth is automatically
adjusted.

"Manual" For manual mode, define the bandwidth value. The available video

bandwidths are specified in the data sheet. Numeric input is always
rounded to the nearest possible bandwidth.

If the video bandwidth is defined manually, a green bullet is displayed
next to the "VBW" display in the channel bar.

Remote command:
[SENSe: ]BANDwidth:VIDeo:AUTO on page 741
[SENSe: ] BANDwidth:VIDeo on page 740

Meas Time
Defines the duration of a single capture, during which the defined number of capture
points are measured. The "Meas Time" can be defined automatically or manually.

The allowed "Meas Time" s depend on the device model; refer to the data sheet.
For more information see "How Long the Data is Measured: Meas Time " on page 352.

Note: The "Meas Time" only indicates how long data is captured; the time required to
process the captured data may be considerably longer, in particular for FFT mode. For
FFT mode, an estimated duration is indicated behind the "Meas Time" in the channel
bar (for RF measurements only).

"Auto" The "Meas Time" is coupled to the span (not zero span), video band-
width (VBW) and resolution bandwidth (RBW). If the span, resolution
bandwidth or video bandwidth is changed, the "Meas Time" is auto-
matically adjusted.

"Manual" For manual mode, define the "Meas Time" . Allowed values depend
on the ratio of span to RBW and RBW to VBW. For details refer to the
data sheet. Numeric input is always rounded to the nearest possible
"Meas Time" .

Remote command:

[SENSe: ] SWEep: TIME: AUTO on page 743

[SENSe: ] SWEep:TIME on page 637

[SENSe: ] SWEep:DURation? on page 742
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Span/RBW
Sets the coupling ratio if RBW is set to auto mode.

For more information see "Coupling Span and RBW" on page 350.

"Auto[100]" "Resolution Bandwidth" = "Span/100"
This coupling ratio is the default setting of the R&S VSE.

"Manual" The coupling ratio is defined manually.
The span/resolution bandwidth ratio can be set in the range from 1 to
10000.

Remote command:
[SENSe: ] BANDwidth[:RESolution] :RATio on page 740

RBW/VBW
Sets the coupling ratio between the resolution bandwidth and the video bandwidth.

This setting is only effective if VBW is set to auto mode.
For more information see "Coupling VBW and RBW" on page 350.
"Sine[1/1]" "Video Bandwidth" = "Resolution Bandwidth"

This is the default setting for the coupling ratio RBW/VBW and is rec-
ommended if sinusoidal signals are to be measured.

"Pulse[0.1]" "Video Bandwidth" = 10 x "Resolution Bandwidth"
or
"Video Bandwidth" = "10 MHZz" (= max. VBW)
Recommended for pulse signals

"Noise[10]" "Video Bandwidth" = "Resolution Bandwidth/10"
Recommended for noise measurements

"Manual" The coupling ratio is defined manually.
The RBW/VBW ratio can be set in the range of 0.001 to 1000.

Remote command:
[SENSe: ] BANDwidth:VIDeo:AUTO on page 741
[SENSe: | BANDwidth:VIDeo:RATio on page 741

Filter Type
Defines the filter type.

The following filter types are available:

® Normal (3dB)
® Channel

For more information see "Which Data May Pass: Filter Types" on page 352.

Remote command:
[SENSe: ] BANDwidth[:RESolution] : TYPE on page 740

Default Coupling
Sets all coupled functions to the default state ( "Auto" ). In addition, the ratio "RBW/
VBW" is set to "Sine[1/1]" and the ratio "Span/RBW" to 7100.

For more information see "Coupling VBW and RBW" on page 350.
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Remote command:

[SENSe: ] BANDwidth[:RESolution] :AUTO on page 740
[SENSe: ] BANDwidth:VIDeo:AUTO on page 741

[SENSe: ] SWEep: TIME:AUTO on page 743

Capture Count

Defines the number of measurements to be performed in the single capture mode. Val-
ues from 0 to 200000 are allowed. If the values 0 or 1 are set, one measurement is
performed.

The capture count is applied to all the traces in all diagrams.

If the trace modes "Average" , "Max Hold" or "Min Hold" are set, this value also deter-
mines the number of averaging or maximum search procedures.

In continuous capture mode, if "Capture Count" = 0 (default), averaging is performed
over 10 measurements. For "Capture Count" =1, no averaging, maxhold or minhold
operations are performed.

For more information, see "How Much Data is Measured: Capture Points and Capture
Count" on page 352.

Remote command:
[SENSe: ] SWEep: COUNt on page 636
[SENSe: ] AVERage<n>:COUNt on page 749

Capture Points
Defines the number of measured values to be collected during one capture.

For details see "How Much Data is Measured: Capture Points and Capture Count"
on page 352.

Remote command:
[SENSe: ] SWEep [ :WINDow<n>] : POINts on page 637

Optimization

In FFT mode, several FFT analysis steps are required to cover the entire measurement
span. The span which is covered by one FFT analysis step is called subspan. The sub-
span cannot be defined directly, but it can be optimized according to measurement
requirements.

Table 10-10: Optimization parameters in FFT mode

Optimization mode | Description

Dynamic Optimizes the dynamic range by using the narrowest possible subspan (depending
on the RBW).

Speed Optimizes the capture rate by using the widest possible subspan (depending on the
RBW).

It is recommended that you set the Meas Time to "Auto" to optimize the capture
rate.

Auto Uses a medium-sized subspan to obtain a compromise between a large dynamic
range and a fast capture rate.

Zero span mode
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For zero span measurements, the optimization mode defines the selection of the A/D
converter prefilter.

Table 10-11: Optimization parameters in zero span mode

Optimization mode | Description

Dynamic The narrowest filter possible (depending on the RBW) is used.
Speed The widest filter possible (depending on the RBW) is used.
Auto A medium-sized prefilter is used.

Remote command:
[SENSe: ] SWEep:O0PTimize on page 743

Single Sweep / Run Single
After triggering, starts the number of sweeps set in "Capture Count" . The measure-
ment stops after the defined number of sweeps has been performed.

While the measurement is running, the "Single Sweep" softkey and the [RUN SINGLE]
key are highlighted. The running measurement can be aborted by selecting the high-
lighted softkey or key again.

Remote command:
INITiate<n>[:IMMediate] on page 525

Continuous Sweep / Run Cont

While the measurement is running, the "Continuous Sweep" softkey and the [RUN
CONT] key are highlighted. The running measurement can be aborted by selecting the
highlighted softkey or key again. The results are not deleted until a new measurement
is started.

Remote command:
INITiate<n>:CONTinuous on page 524

10.4.6.3 Reference: List of Available Channel Filters

For power measurement a number of especially steep-edged channel filters are availa-
ble (see the following table). The indicated filter bandwidth is the 3-dB bandwidth.

Table 10-12: Filter types

Filter Bandwidth Filter Type Application
100 Hz CFlLter

200 Hz CFlLter

300 Hz CFlLter

500 Hz CFlLter

1 kHz CFlLter

1.5 kHz CFlLter

2 kHz CFlLter

2.4 kHz CFlLter SSB
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Filter Bandwidth Filter Type Application
2.7 kHz CFlLter
3 kHz CFlLter
3.4 kHz CFlLter
4 kHz CFlLter DAB, Satellite
4.5 kHz CFlLter
5 kHz CFlLter
6 kHz CFlLter
8.5 kHz CFlLter ETS300 113 (12.5 kHz channels)
9 kHz CFlLter AM Radio
10 kHz CFlLter
12.5 kHz CFlLter CDMAone
14 kHz CFlLter ETS300 113 (20 kHz channels)
15 kHz CFlLter
16 kHz CFlLter ETS300 113 (25 kHz channels)
20 kHz CFlLter
21 kHz CFlLter PDC
25 kHz CFlLter APCO 25-P2
30 kHz CFlLter CDPD, CDMAone
50 kHz CFlLter
100 kHz CFlLter
150 kHz CFlLter FM Radio
192 kHz CFlLter PHS
200 kHz CFlLter GSM
300 kHz CFlLter
500 kHz CFlLter J.83 (8-VSB DVB, USA); RF ID 14333
1 MHz CFlLter CDMAone
1.228 MHz CFlLter CDMAone
1.5 MHz CFlLter DAB
2 MHz CFlLter
3 MHz CFlLter
3.75 MHz CFlLter
5 MHz CFlLter
CFlLter
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Filter Bandwidth Filter Type Application

CFlLter

CFlLter

10.5 Analysis

General result analysis settings concerning the trace, markers, lines etc..
®  Trace ConfiQUIatioN.........eeeeiiiiieiiiiiiccee e e e e e e e e e e aee s 360
L I Y = T4 = g Y= o = T 389
@  Z00MEd DiISPIAYS....cceeeiiiiiiiiiitrcceie et aaaaaaaaaaaeaees 421
o Display and Limit LINES.......ci et e e e 427

10.5.1 Trace Configuration

A trace is a collection of measured data points. The trace settings determine how the
measured data is analyzed and displayed on the screen.

o Basics 0N Setting UP TraCesS. .. .. it e e 360
o Trace Configuration..........ceuii i 372
o Trace / Data Export Configuration..........coccueeiiiiiiiiii it 381
®  HOW t0 CONfIQUIE TraCeS.....cccuieiieiieiiie e e e ettt e e e e e e e r e e e e e e e e e e e s nnnnes 384

10.5.1.1 Basics on Setting up Traces

Some background knowledge on traces is provided here for a better understanding of
the required configuration settings.

e Mapping Samples to measurement Points with the Trace Detector..................... 360
e Analyzing Several Traces - Trace MOdE.........ueeevveeeiiiiiiiciiiiiiieeeee e 362
e How Many Traces are Averaged - Capture Count + Measurement Mode............ 363
o X-Value of the Measurement POiINt.........cooiiiiiiiiii e 365
e How Trace Data is Averaged - the Averaging Mode..........cccociciiiiiiieiieeeeeeeee, 366
o Working with SPectrograms.......coooi i 366

Mapping Samples to measurement Points with the Trace Detector

A trace displays the values measured at the measurement points. The number of sam-
ples taken during a measurement can be much larger than the number of measure-
ment points that are displayed in the measurement trace.

Obviously, a data reduction must be performed to determine which of the samples are
displayed for each measurement point. This is the trace detector's task.

The trace detector can analyze the measured data using various methods:
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The detector activated for the specific trace is indicated in the corresponding trace
information by an abbreviation.

Table 10-13: Detector types

Detector Abbrev. | Description

Positive Peak | Pk Determines the largest of all positive peak values of the levels measured at the
individual frequencies which are displayed in one sample point

Negative Peak | Mi Determines the smallest of all negative peak values of the levels measured at
the individual frequencies which are displayed in one sample point

Auto Peak Ap Combines the peak detectors; determines the maximum and the minimum
value of the levels measured at the individual frequencies which are displayed
in one sample point

RMS Rm Calculates the root mean square of all samples contained in a measurement
point.

To do so, R&S VSE uses the linear voltage after envelope detection. The sam-
pled linear values are squared, summed and the sum is divided by the number
of samples (= root mean square). For logarithmic display, the logarithm is
formed from the square sum. For linear display, the root mean square value is
displayed. Each measurement point thus corresponds to the power of the
measured values summed up in the measurement point.

The RMS detector supplies the power of the signal irrespective of the wave-
form (CW carrier, modulated carrier, white noise or impulsive signal). Correc-
tion factors as needed for other detectors to measure the power of the different
signal classes are not required.

Average Av Calculates the linear average of all samples contained in a measurement
point.

To this effect, R&S VSE uses the linear voltage after envelope detection. The
sampled linear values are summed up and the sum is divided by the number of
samples (= linear average value). For logarithmic display, the logarithm is
formed from the average value. For linear display, the average value is dis-
played. Each measurement point thus corresponds to the average of the mea-
sured values summed up in the measurement point.

The average detector supplies the average value of the signal irrespective of
the waveform (CW carrier, modulated carrier, white noise or impulsive signal).

Sample Sa Selects the last measured value of the levels measured at the individual fre-
quencies which are displayed in one sample point; all other measured values
for the frequency range are ignored

The result obtained from the selected detector for a measurement point is displayed as
the value at this frequency point in the trace.
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: MAX PEAK
: AUTO PEAK
MIN PEAK

You can define the trace detector to be used for the individual traces manually, or the
R&S VSE can select the appropriate detector automatically.

The detectors of the R&S VSE are implemented as pure digital devices. All detectors
work in parallel in the background, which means that the measurement speed is inde-
pendent of the detector combination used for different traces.

Auto detector

If the R&S VSE is set to define the appropriate detector automatically, the detector is
set depending on the selected trace mode:

Trace mode Detector
Clear Write Auto Peak
Max Hold Positive Peak
Min Hold Negative Peak
Average Sample Peak
View -

Blank -

Analyzing Several Traces - Trace Mode

If several measurement are performed one after the other, or continuous measurement
are performed, the trace mode determines how the data for subsequent traces is pro-
cessed. After each measurement, the trace mode determines whether:

® The data is frozen (View)

® The data is hidden (Blank)

® The data is replaced by new values (Clear Write)

® The data is replaced selectively (Max Hold, Min Hold, Average)
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Each time the trace mode is changed, the selected trace memory is cleared.

The trace mode also determines the detector type if the detector is set automatically,
see "Mapping Samples to measurement Points with the Trace Detector" on page 360.

The R&S VSE supports the following trace modes:

Table 10-14: Overview of available trace modes

Trace Mode Description

Blank Hides the selected trace.

Clear Write Overwrite mode: the trace is overwritten by each measurement. This is the default set-
ting.

All available detectors can be selected.

Max Hold The maximum value is determined over several measurements and displayed. The
R&S VSE saves the measurement result in the trace memory only if the new value is
greater than the previous one.

This mode is especially useful with modulated or pulsed signals. The signal spectrum
is filled up upon each measurement until all signal components are detected in a kind
of envelope.

This mode is not available for statistics measurements.

Min Hold The minimum value is determined from several measurements and displayed. The
R&S VSE saves the measurement result in the trace memory only if the new value is
lower than the previous one.

This mode is useful for example for making an unmodulated carrier in a composite
signal visible. Noise, interference signals or modulated signals are suppressed,
whereas a CW signal is recognized by its constant level.

This mode is not available for statistics measurements.

Average The average is formed over several measurements and displayed.
The Capture Count determines the number of averaging procedures.

This mode is not available for statistics measurements.

View The current contents of the trace memory are frozen and displayed.

If a trace is frozen ( "View" mode), the measurement settings, apart from scaling set-
tings, can be changed without impact on the displayed trace. The fact that the dis-
played trace no longer matches the current measurement settings is indicated by a yel-
low asterisk B on the tab label.

If you change any parameters that affect the scaling of the diagram axes, the
R&S VSE automatically adapts the trace data to the changed display range. This
allows you to zoom into the diagram after the measurement to show details of the
trace.

How Many Traces are Averaged - Capture Count + Measurement Mode

In "Average" trace mode, the capture count and measurement mode determine how
many traces are averaged. The more traces are averaged, the smoother the trace is
likely to become.
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The algorithm for averaging traces depends on the measurement mode and capture
count.

capture count = 0 (default)

— In"Continuous™ measurement mode, a continuous average is calculated for
10 measurements, according to the following formula:

9*Trace,;, + MeasValue
10

Trace =

Figure 10-41: Equation 1

Due to the weighting between the current trace and the average trace, past val-
ues have practically no influence on the displayed trace after about ten mea-
surements. With this setting, signal noise is effectively reduced without need for
restarting the averaging process after a change of the signal.

— In "Single™ measurement mode, the current trace is averaged with the previ-
ously stored averaged trace. No averaging is carried out for the first measure-
ment but the measured value is stored in the trace memory. The next time a
measurement is performed, the trace average is calculated according to the fol-
lowing formula:

Trace,, + MeasValue
2

Trace =

The averaged trace is then stored in the trace memory.

capture count = 1
The currently measured trace is displayed and stored in the trace memory. No
averaging is performed.

capture count > 1

For both "Single™ measurement mode and "Continuous™ measurement mode,
averaging takes place over the selected number of measurements. In this case the
displayed trace is determined during averaging according to the following formula:

1 n-1
Trace, = —- {z (7)) + Meas Valuen}
nolia

Figure 10-42: Equation 2

Where n is the number of the current measurement (n = 2 ... Capture Count).

No averaging is carried out for the first measurement but the measured value is
stored in the trace memory. With increasing n, the displayed trace is increasingly
smoothed since there are more individual measurements for averaging.

After the selected number of measurements, the average trace is saved in the
trace memory. Until this number of measurements is reached, a preliminary aver-
age is displayed. When the averaging length defined by the "Capture Count" is
attained, averaging is continued in continuous measurement mode or for "Continue
Single Sweep" according to the following formula:

(N =D *Trace,, + MeasValue
N

Trace =
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Where N is the capture count

X-Value of the Measurement Point

As described in "Mapping Samples to measurement Points with the Trace Detector"
on page 360, the number of samples taken during a measurement can be much larger
than the number of measurement points that are displayed in the measurement trace.

To determine the x-value of the measurement point, two dif